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Recording

 

Recording and Playback Basics

 

The basic procedures for recording and playback are described in the Getting 
Started book. Here is a brief repetition:

 

D

 

To activate recording, click the Record button on the Transport 
panel or press [*] on the numeric keypad.

 

If your computer keyboard lacks a numeric keypad, you can activate record-
ing by holding down [Command] (Mac) or [Ctrl] (Windows) and pressing 
[Return].

 

D

 

Recording starts at the current song position.

 

D

 

You can get a metronome click during recording by activating Click 
on the transport panel.

 

The volume of the metronome click can be adjusted with the Level knob.

 

D

 

If the Loop is activated, the area between the Left and Right loca-
tors will be repeated, allowing you to add or replace material on 
each loop pass (depending on the Overdub/Replace switch - see 
below).

 

D

 

To start playback from the current song position, click the Play but-
ton or press [Enter] on the numeric keypad.

 

To stop, click the Stop button, press [0] on the numeric keypad or press 
[Return]. You can also toggle between Play and Stop by pressing the Space 
bar.

 

D

 

To move the song position, click in the ruler, use the Rewind/Fast 
Forward buttons or edit the position numerically on the transport 
panel.

 

You can also move the song position to the Left or Right Locator by pressing 
[1] or [2] on the numeric keypad.

 

Recording Notes

 

The Overdub/Replace switch

 

If you record over an area where there are notes recorded already, the result de-
pends on the Overdub/Replace switch on the transport panel:

 

D

 

In Overdub mode, the new recording is added to whatever was on 
the Track before. 

 

For example, this is useful for adding elements during loop recording or for 
adding controller data to recorded notes.

 

D

 

In Replace mode, the new recording replaces any previously re-
corded notes.

 

Only the notes in the actual recording area are replaced. 

 

!

 

It’s probably best to use Overdub mode as your default mode, to 
avoid removing material by mistake.

 

Quantizing during Recording

 

If the Quantize Notes During Recording switch is activated on the sequencer 
toolbar, notes will automatically be quantized when you record them. This is de-
scribed in detail on page 29.

 

Recording Controllers

 

In Reason, you can automate virtually all device parameters, creating completely 
automated mixes if you like. This is done by recording (or drawing) controllers in 
the sequencer.

 

Before you record automation

 

Before you start recording automation of a parameter, you may want to set it to 
a suitable “static value”. By this, we mean the value the parameter should have 
whenever it isn’t automated in the song. Here is why:

 

D

 

When you first record a section of automation for a parameter, its 
original value will be inserted throughout the rest of the song.

 

This is explained in detail on page 10.

Let’s say you want to create a fade-out by recording your lowering a fader in the 
Mixer. Then it’s a good idea to first set the fader to the correct static value (i.e. 
the value the fader should be set to before you start the fade-out). 

The same thing is true if you want to create a filter sweep for a synthesizer, 
somewhere within the song: First set the filter frequency to the value it should 
have elsewhere in the song, then record the filter sweep.
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Recording automation of a device parameter

 

1. Make sure there is a sequencer track for the device.

 

For the instrument devices and the Matrix, sequencer tracks are automati-
cally added when you create the device. For a mixer or effect device, you 
need to add tracks manually, by selecting “Create Sequencer Track for...” 
from the device context menu. You can also select “Sequencer Track” from 
the Create menu and connect the created track manually to the desired de-
vice (in the Out column in the track list).

 

2. Click in the In column for the track in the track list, so that a MIDI 
connector symbol appears.

 

This indicates that the track will receive MIDI and is ready for recording.

 

3. Start recording from the desired position.

4. During recording, adjust the desired parameter(s), from the device 
panel or from a MIDI controller.

 

You can record automation for several parameters in the same recording 
pass. However:

 

D

 

You can only record automation for one device at a time (the device 
whose track receives MIDI). 

 

If you want to record automation for parameters on another device, you need 
to click in the In column for the corresponding track, so that the MIDI con-
nector symbol is moved there.

 

5. Stop recording.

 

On the device panel, each automated parameter will have a green frame. 

 

The parameters Feedback and Pan are automated. 

In the Arrange view, recorded controllers are indicated in blue (the pale blue “strip” 
indicates that the track contains any kind of controller automation).

 

If you play back the recorded section again, the parameters will change automat-
ically. Outside the recorded section, the parameters will have their original set-
tings (the values they had before you started recording).

 

Recording more for the same controller

 

If you need to redo a section of recorded automation, or add some automation of 
the same controller elsewhere in the song, proceed as follows:

 

!

 

The Overdub/Replace switch does not affect controller recording. 
However, you should make sure this is set to “Overdub”, to avoid 
accidentally deleting any notes on the track.

1. Set up and start recording in the same way as described above.

 

As long as you don’t touch the parameter, its automation data will be played 
back normally.

 

2. At the desired position, adjust the parameter.

 

As soon as you start changing the parameter value, the Punched In indicator 
will light up on the transport panel. 

From this point on, the previously recorded automation will be replaced!

 

3. Stop recording when you are done.

 

You have now replaced the section from where you Punched In up to where 
you stopped recording.

 

D

 

Any time after Punching In, you can click the Reset button below 
the Punched In indicator.

 

This turns off the Punched In indicator and “resets” the controller recording 
(making the previously recorded automation active again, from that position). 
You are still in record mode, and as soon as you adjust the parameter again, 
the Punched In indicator will be lit. 
Basically, clicking the Reset button is the same as stopping recording and 
starting recording again.

 

Moving Automated Controllers during Playback - “Live Mode”

 

Even if you have automated a parameter, you can still “grab it” and adjust it dur-
ing playback, overriding the automation. This can be very useful when playing 
Reason live, for example:

 

1. During playback, click and drag an automated parameter.

 

The Punched In indicator lights up on the transport panel. From this point on, 
the recorded automation for the parameter is disabled.

 

2. To activate the automation again, click the Reset button.

 

This returns control of the parameter to the sequencer.

 

D

 

Automation override is automatically reset when you stop play-
back.
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Background: How recorded controllers are handled

 

Even though the recording procedures are practically the same, the sequencer 
handles controllers differently from notes. While each recorded note is a sepa-
rate event, there are no “controller events” as such in the sequencer. Instead, it 
works like this:

Each sequencer track has a number of controller “subtracks” (one for each au-
tomatable parameter in the corresponding device). A controller subtrack can be 
viewed as a length of magnetic tape, which you can fill with controller data.

When you haven’t yet recorded any automation for a parameter, its subtrack is 
empty. The parameter is not automated.

As soon as you record anything for the controller, anywhere in the song, the 

 

whole subtrack

 

 is filled with controller data:

This makes it possible to set up a static mix first, and then add some automated 
parameter changes anywhere in the song while maintaining the static values 
elsewhere in the song.

 

Recording Pattern Changes

 

If your song contains pattern devices, you probably want to use more than a sin-
gle pattern throughout the song. To facilitate this you can record pattern 
changes in the sequencer (or draw them in manually, as described on page 29).

 

1. If you want to use the same pattern for the main part of the song 
(and only want to add some variation patterns here and there), 
make sure this “main pattern” is selected before you start record-
ing.

 

When you first record a pattern change somewhere in the song, the origi-
nally selected pattern will be inserted throughout the rest of the song. This is 
similar to the way controller automation works - see page 8.

 

2. Locate the sequencer track for the device, and make sure MIDI is 
routed to the track.

 

That is, the MIDI connector symbol should be shown in the In column for the 
track in the track list.

 

3. Start recording from the desired position.

 

When playback starts, the pattern device will automatically start (provided 
the pattern section is enabled on the device).

 

4. During recording, change patterns with the Bank and Pattern but-
tons on the device panel.

 

Make sure to change the patterns slightly in advance - the actual pattern 
change will be recorded (and happen) on the next downbeat according to 
the main sequencer time signature.

 

5. When you are done, stop recording.

 

The green frame around the pattern buttons indicates that pattern changes are 
automated for the device.

In the Arrange view, recorded pattern changes are indicated as dark yellow bars (the 
pale yellow “strip” indicates that the track contains any pattern change data at all).

 

D

 

Each pattern change will be recorded on a downbeat (at the start of 
a new bar in the sequencer).

 

You can move pattern changes to other positions in the Edit View if needed 
(see page 30).

This is the section you recorded.

This is the original, static value for the parameter.
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D

 

You can punch in on recorded pattern changes, to replace a section 
of the track.

 

This works the same as punching in on controllers (see page 9).

 

D

 

After recording the pattern changes, you can use the function Con-
vert Pattern Track to Notes, to transfer the notes in the patterns to 
the main sequencer.

 

This allows you to create unlimited variations by later editing the notes in the 
Edit View. See below.
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Copying REX loops and 
Patterns to Sequencer 
Tracks

 

As described on page 188, you need to use the “To Track” function when using 
the Dr.Rex Loop Player device. This creates sequencer notes on the selected 
track, so that each slice in the REX loop gets a corresponding sequencer note. 
Playing back the sequencer track will then play all slices in the correct order, 
with the original timing of the loop.

Similar functions are available for the pattern devices (Redrum and Matrix). 

• By using the function Copy Pattern to Track on the Edit menu or device con-
text menu, you can copy the contents of the current pattern to notes on the 
selected sequencer track. 

• The function Convert Pattern Track to Notes works in a similar way, but con-
verts all patterns in a song to notes (taking pattern changes into account).

The procedures differ slightly for the different device types:

 

Using the “To Track” function for REX Loops

 

This assumes that you have loaded a REX loop into the Dr.Rex device. For de-
tails, see page 187.

 

1. Set the left and right locator to encompass the section you want to 
“fill” with notes for the REX loop.

2. Select the track connected to the Dr.Rex device.

 

To avoid confusion, make sure there are no events between the locators on 
the track.

 

3. Click the “To Track” button on the Dr.Rex device panel.

 

Notes are created for the slices in the loop, and added to the track.

 

D

 

If the length of the area between the locators is greater than the 
length of the REX loop, the loop will be repeated on the track.

 

This function always creates an exact number of loops, meaning that the last 
loop may “stick out” after the right locator.

 

The “Copy Pattern to Track” function

 

This is available for the Redrum and the Matrix. It is useful when you have cre-
ated a single pattern and want to use it as starting point for editing in the se-
quencer. You could also use this if you e.g. have created a drum pattern and 
want to have this pattern play back some other type of device.

Proceed as follows:

 

1. Set the left and right locator to encompass the section you want to 
“fill” with the notes in the pattern.

 

You may want to make sure the length of the area between the locators is a 
multiple of the pattern length, to avoid “cutting off” the pattern.

 

2. Select the track connected to the pattern device.

 

In fact, you can select any track. For example, if the device is a Matrix, it may 
make sense to copy the notes not to the Matrix track, but to the track for the 
device 

 

controlled

 

 by the Matrix (since the Matrix doesn’t produce any sound 
in itself, and thus can’t be played by the sequencer notes).

 

3. Select the device and select “Copy Pattern to Track” from the Edit 
menu or the device context menu.

 

D

 

If you selected a track not connected to the pattern device, an alert 
will appear, asking if that’s really what you want.

 

Click OK to proceed, or Cancel to abort.
The pattern is converted to sequencer notes on the track (see the notes below). 
If the length of the area between the locators is greater than the pattern length, 
the pattern will be repeated to fill out the area.

 

The created notes are automatically grouped (as indicated by the colored boxes). Read more 
about groups on page 18.

Here, the loop was 2 bars long. Since there are three bars between the 
locators, the second loop will stick out after the right locator.

The created notes are automatically grouped (as indicated by the 
colored boxes). Read more about groups on page 18.
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Redrum notes

 

When you use this function with the Redrum, you should note the following:

• The notes will have the pitch of the corresponding drum sound (see “Using 
Redrum as a Sound Module” on page 97) and the velocity depending on the 
Dynamic value.
Soft notes have velocity 30, medium notes have velocity 80 and hard notes 
have velocity 127.

• You probably want to turn off the “Enable Pattern Section” switch on the Re-
drum device panel. 
Otherwise, the drum sounds will be “double-triggered” when you start play-
back (once by the pattern section itself, once by the main sequencer).

 

Matrix notes

 

When you use this function for the Matrix, you should note the following:

• A note will be created for each pattern step with a gate value other than 
zero. 
The notes will have the pitch according to the key CV value for the step, and 
the velocity according to the gate value. 

• The curve CV is not copied.
• Make sure that the track is connected to the correct device! 

Having the track connected to the Matrix itself is pointless, since the Matrix 
cannot produce any sound.

• You may want to disconnect or even remove the Matrix after performing a 
“Copy Pattern to Track”. 
This is because you probably don’t want both the Matrix and the sequencer 
notes to play back at the same time.

 

The “Convert Pattern Track to Notes” function

 

If you have recorded or drawn pattern changes on a Redrum or Matrix track, you 
can have the whole track converted to notes, in the following way:

 

1. Select the track with the pattern changes.

2. Select “Convert Pattern Track to Notes” from the Edit menu or the 
context menu for the track.

 

For each bar, the corresponding pattern is converted to notes on the track 
(following the same rules as for the “Copy Pattern to Track” function). The 
track will play back just the same as when you played the pattern device with 
the pattern changes (including the Pattern Enabled/Mute switch).

 

D

 

All pattern changes are automatically removed from the track after 
the operation.

 

Redrum notes

 

• The “Enable Pattern Section” switch is automatically turned off when you 
use this function.

 

Matrix notes

 

• After performing “Convert Pattern Track to Notes”, you need to move the 
contents to another track, or re-route the track to another device.
Having the track connected to the Matrix itself is pointless, since the Matrix 
cannot produce any sound.

• You may want to disconnect or even remove the Matrix after performing this 
function. 
This is because you probably don’t want both the Matrix and the sequencer 
notes to play back at the same time.

In these sections, the pattern 
was muted (Pattern Enable off) 
in the pattern track.
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Editing - About Snap

 

When you select and edit material (both in the Arrange View and the Edit View), 
the Snap (Snap to Grid) function determines the result. By activating Snap, ed-
iting becomes “restricted” to the note values selected on the Snap pop-up menu 
(the Snap value). The Snap button and pop-up menu are located on the se-
quencer toolbar:

 

!

 

Note that you can select different Snap values for the Arrange View 
and the Edit View.

 

Snap has an effect on the following operations:

 

D

 

Moving the Song position, Locators and End marker.

 

When you adjust these markers with Snap activated, they will be “magnetic” 
to the Snap value.

 

D

 

Selecting events by enclosing them in a selection rectangle.

 

Since the selection rectangle is magnetic to the snap value, this determines 
the smallest “block” you can select. 
However, selecting by clicking directly on notes in the Edit View (or Groups 
in the Arrange View - see page 19) is not restricted by Snap.

 

D

 

Moving and duplicating events.

 

When you move one or several Events with Snap activated, they will keep 
their relative distance to the Snap value positions. In the example below, 
Snap is set to 1/4 (quarter notes):

 

D

 

Drawing Groups in the Arrange View.

 

When you create Groups with the Pencil tool, their start and end positions 
will be magnetic to the snap value positions. See page 18.

 

D

 

Drawing events in the Edit view.

 

The Snap value determines the smallest note position on which you can 
draw a note or insert a controller value or pattern change. Furthermore, the 
Snap value determines the smallest length of the events when you draw. 
See page 22.

 

D

 

Using the Eraser tool to delete events in the Edit and Arrange 
views.

 

With Snap activated, clicking directly on events with the Eraser tool will not 
only delete the events “touched”, but 

 

all

 

 events within the set snap value 
(e.g. 1 bar). The Eraser tool can also be used for making selection rectan-
gles and these will be magnetic to the snap value as well. See page 17.

Use this pop-up menu to select the Snap value.

Click here to turn Snap on or off.
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Editing in the Arrange 
View

 

The Arrange View allows you to view several tracks at the same time, and pro-
vides a good overview of the song. This view is best suited for large-scale edit-
ing, such as rearranging blocks of music, adding or removing bars or applying 
quantizing and editing functions to events on different tracks at the same time.

 

D

 

To select the Arrange View, click the Arrange/Edit View button in 
the top left corner of the sequencer area.

 

You can also toggle between Arrange View and Edit View by pressing 
[Shift]-[Tab] or [Command]/[Ctrl]-[E].

 

!

 

On the following pages we will use the word “event” as a collective 
name for notes, controller changes and pattern changes.

 

!

 

The procedures below apply to separate events in the Arrange 
View. Some techniques are different for Grouped events, as de-
scribed on page 18.

 

Selecting Events

 

Each track in the Arrange View is divided vertically into three “lanes”, in which 
events are shown as thin vertical lines. The top lane shows notes (including 
drum notes and REX slices) in red, the middle lane shows pattern changes in 
yellow and the lower lane shows controller value changes in blue.

To select events in the Arrange view, click and drag a selection rectangle.

 

D

 

If Snap is activated, the selection rectangle will be magnetic to the 
Snap value.

 

D You can drag a selection rectangle covering only one lane, thereby 
selecting only the notes, pattern changes or controllers.
You can also draw a selection rectangle covering several tracks.

D If you hold down [Shift] when you select events, any already se-
lected events remain selected.
This allows you to make multiple, non-contiguous selections: first select 
some events, then press [Shift] and select some more events, and so on.

D You can also use the “Select All” function on the Edit menu.
This selects all events, controllers and pattern changes in the song.

D The selection you make in the Arrange View will be maintained if 
you select the Edit View.
See page 23.

D To de-select events, just click anywhere in an empty area.

Moving Events
To move the selected events, click in the selection, and drag and drop it on a 
new position.

D When you move the selection, it is “magnetic” to the lanes.
That is, you cannot drag notes to a controller lane, etc.

D If you hold down [Shift] and drag, movement is restricted to hori-
zontal or vertical only.

D If Snap is activated, you will only be able to drop the selection so 
that it maintains its relative distance to the Snap value positions.
See page 14.
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Duplicating Events
To duplicate the selected events, hold down [Option] (Mac) or [Ctrl] (Windows) 
and proceed as when moving events.

D You can also use the Duplicate Track function on the Edit menu or 
the track context menu.
This creates a copy of the selected track, complete with all events. The du-
plicated track will appear below the original track in the track list.

Using Cut, Copy and Paste
You can move or duplicate events using the Cut, Copy and Paste commands on 
the Edit menu. When you Paste, the events appear at the song position, on their 
original track(s).

! If you have deleted the original tracks, or if you Paste into another 
Reason song document, new tracks will be created as needed.

D See the note below about Copying and Pasting whole tracks!

Using Copy and Paste to repeat a section

When you Cut or Copy a selection, the song position will automatically move to 
the end of the selection (or, if Snap is activated, to the closest Snap value posi-
tion after the end of the selection). This allows you to quickly repeat a section, in 
the following way:

1. Make sure playback is stopped.

2. Set the Snap value to “Bar” (or to the length of the section you want 
to repeat, if is smaller than one bar).

3. Activate Snap.

4. Select the section you want to repeat.
Since you can make selections over several tracks, this is a quick way to 
copy entire song sections.

! Note that Snap doesn’t apply in quite the same way when selecting 
Groups (see page 19). Make sure the selection contains exactly 
what you want before proceeding.

5. Select Copy from the Edit menu.
The song position is moved to the closest snap value after the end of the se-
lection (provided that playback is stopped).

6. Select Paste from the Edit menu.
The copied section is pasted in, and the song position is moved to the end 
of pasted section.

7. Paste again, as many times as you want to repeat the section.

Using Cut, Copy and Paste with Tracks

You can select one or several tracks by clicking or [Shift]-clicking in the track 
list. This allows you to use Cut or Copy on the track, complete with contents.

D If you Paste the track(s) into their original song, this simply dupli-
cates the tracks.
However, the Pasted tracks will not be connected to any devices in the rack.

D You can also Paste the track(s) into another song.
Note that only the tracks (complete with contents) are copied and pasted - 
not their respective devices. You may want to separately copy and paste the 
devices to the other song.

Deleting Events
D To delete an Event, either select it and press [Delete], [Backspace] 

or select Delete from the Edit menu.
Both of these methods will delete the Event.

You can also draw selection rectangles with the Selection tool, encompassing 
several Events and delete them all at once. The same rules apply as when se-
lecting Events. That is, if Snap is on, the selection rectangle will be magnetic to 
the Snap value positions. Also note that an Event doesn’t have to be fully en-
closed by the rectangle to be selected - the selection rectangle only needs to in-
tersect or touch the Event.

Deleting Events with the Eraser tool

You can also use the Eraser tool to delete Events and Groups in the Arrange 
view, as well as Notes, Controller sections and Pattern Change sections in the 
Edit view.

The Eraser tool can be used in two ways: You can single click on events or you 
can make a selection rectangle encompassing several events. See below.

About Snap and the Eraser tool

With Snap activated, clicking directly on events or making selection rectangles 
with the Eraser tool will not only delete the events “touched”, but all events 
within the set snap value (e.g. 1 bar). 
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Deleting events by single clicking

D Select the Eraser tool and click on the event you want to delete.

When using the Eraser tool to delete events with Snap on, the following applies:

• When single clicking, all events within the set Snap value will be deleted. 
The “area of effect” is indicated in a dark gray color.

In this example, the Eraser tool is used to delete notes in the Edit view. Snap is set to 
“Bar”, and therefore a single click will remove all the instances of the note C 2 on bar 6.

Deleting events by making a selection rectangle

D Select the Eraser tool, click and hold the mouse button and draw a 
selection rectangle.
This way, you can make a selection encompassing several events and delete 
them all at once.

If Snap is on when a selection rectangle is drawn, it will be magnetic to the near-
est snap value positions. For example, if Snap is set to “Bar”, dragging a rectan-
gle will select all notes within an exact range of bars.

Drawing a selection rectangle with Snap set to “Bar”. All notes enclosed in the “shaded” area 
will be deleted.

! Note that an Event doesn’t have to be fully enclosed to be selected 
- the selection rectangle only needs to intersect or touch the Event.

✪ If you hold down [Shift] when making a selection rectangle, direc-
tion is restricted to horizontal or vertical only.

Inserting and Removing Bars
When editing the overall structure of a song, you may need to rearrange the or-
der and length of whole sections (e.g. make the “verse” two bars shorter, add a 
few bars to the intro, etc.). On the Edit menu or sequencer context menu you will 
find two useful functions for this:

Insert Bars Between Locators

This function inserts an empty area between the locators. All events after the left 
locator are moved to the right to “make room” for the inserted area.

Remove Bars Between Locators

This function removes all material between the locators. All events after the right 
locator are moved to the left to “fill out” the gap after the removed section.

✪ The “Remove Bars Between Locators” function will automatically 
shorten any Groups intersected by the locators. This can be used as 
a feature in itself, as described on page 20.

Other Editing Functions in the Arrange View
You can also apply quantizing (see page 31) and use the Change Events func-
tion (see page 32) in the Arrange View. This is useful since it allows you to edit 
events on several tracks in one go.

D Note that you can select one or several tracks and have quantizing 
or Change Events apply to all events on the selected tracks.
Selecting several tracks is done by [Shift]-clicking in the track list.
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Using Groups
Sometimes it is practical to work with a section of events as one entity. This is 
done by Grouping the events. You may for example have a two-bar bass line that 
you want to move or repeat in the song - by Grouping the events, you can select, 
move and handle the bassline as a single object.

! This applies to the Arrange View only - you can still edit individual 
events in a Group in the Edit View.

Appearance and Color
In the Arrange View, Groups appear as colored boxes. 

The color of the Groups depends on their contents:

! Groups with the same color contain the same events. 

This makes it easy to get an overview of the song, since variations will appear as 
Groups in another color.

Creating Groups
There are two main ways to create Groups:

By using the Group command

1. Select the events that you want to Group.
It doesn’t matter which lanes you select - all notes, pattern changes and con-
trollers within the area will be included in the Group.

D If you select events on several tracks, one Group for each track will 
be created.
Each Group can only contain events on one track.

2. If you want the Group to have a specific length, activate Snap and 
select an appropriate Snap value.
Often it is practical to create Groups that are one or several whole bars long.

3. Select Group from the Edit menu or the sequencer context menu.
Or, hold down [Command] (Mac) or [Ctrl] (Windows) and press [G].

The events are Grouped.

By drawing with the Pencil tool

1. Select the Pencil tool.
You can also select the Pencil tool momentarily by holding down [Com-
mand] (Mac) or [Alt] (Windows).

2. If you want the Group to have a specific length, activate Snap and 
select an appropriate Snap value.
Often it is practical to create Groups that are one or several whole bars of 
length.

3. Click where you want the Group to start, drag to the right and re-
lease the mouse button.
A Group is created, containing the enclosed Events. It is also possible to 
create empty Groups this way.

✪ Groups are also automatically created when you use the “To Track”, 
“Copy Pattern to Track” and “Convert Pattern Track to Notes” func-
tions. See page 12.

These Groups are “variations”
- all the others have the same contents.
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Selecting Groups
To select a Group, just click on it in the Arrange View.

This Group is selected.

D If you hold down [Shift] and click, you can select multiple Groups.
You can de-select individual Groups by [Shift]-clicking them again.

D You can also select Groups by clicking and dragging a selection 
rectangle, just as with events.
If Snap is on, the selection rectangle will be magnetic to the Snap value po-
sitions. However, note that a Group doesn’t have to be fully enclosed by the 
rectangle to be selected - the selection rectangle only needs to intersect or 
touch the Group.

✪ Note that it’s possible to select Groups and “loose events” at the 
same time with this method. Make sure the selection rectangle en-
closes the elements you want!

D Another way of selecting Groups is to use the arrow keys on the 
computer keyboard.
Pressing the right arrow key selects the next Group on the track, pressing 
the down arrow key selects the closest Group on the track below, etc. Hold-
ing down [Shift] and using the arrow keys allows you to make multiple selec-
tions.

D If you select a Group and go to the Edit View, all events in the Group 
will be selected.

D To de-select the selected Group(s), click anywhere in an empty part 
of the Arrange View.

Resizing Groups
When a Group is selected, a handle appears on its right edge. You can click on 
this handle and drag to make the Group smaller or larger. The following rules ap-
ply:

D If you drag to the left to make the Group smaller, any events that 
end up outside the Group boundary are no longer included in the 
Group.
As a consequence, if you drag the handle all the way past the start of the 
Group, all events are Ungrouped (see below).

D If you drag to the right to make the Group larger, any events you en-
close will become part of the Group.

D Note: Groups cannot overlap! 
This means that if you enlarge a Group so that it partially covers another 
Group, this will automatically resize the other Group as well:

The second Group now starts here!
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Dividing Groups
You can divide a Group into two by clicking with the Pencil tool at the desired 
position and dragging to the end of the Group.

Actually, this is just a consequence of the fact that Groups cannot overlap. As 
soon as you create a Group that overlaps another Group, the other Group is au-
tomatically resized. For example, if you were to draw a small Group within a 
larger Group, you would end up with three Groups:

Tip: Splitting Groups on several Tracks

If you have Groups on several tracks and want to split these at the same posi-
tion, you can use the following method:

1. Set both the Left and the Right Locator to the desired split position.

2. Select “Insert Bars Between Locators” from the Edit menu.
The Groups are split.

Combining Groups
There are two main ways to combine two or more Groups into one:

By using the Group command

1. Select the first and the last Group that you want to combine.
All Groups in between these will be included as well.

2. Select Group from the Edit menu.
You will now have one larger Group.

By Resizing

1. Click the size handle of the first Group and drag to the right.

2. Release the mouse button at the end of the last Group.
All Groups in between are combined to one larger Group.

Find Identical Groups
This command on the Edit menu helps you locate all Groups with the same con-
tents:
1. Select a Group.

2. Select “Find Identical Groups” from the Edit menu.
All Groups with the same contents are selected in the Arrange View.

Ungrouping
There are two ways to dissolve a Group:

D Select it and select Ungroup from the Edit menu or sequencer con-
text menu,

or

D Click on the Group size handle and drag it all the way to the left.

Neither of these methods affect the events in the Group, they just remove the 
Grouping.

Editing with Groups
You can work with Groups much like you edit selected events in the Arrange 
view:

D To move a Group, click on it and drag it to a new position, taking the 
Snap value into account.
If you move the Group so that it partially overlaps another Group, the other 
Group will automatically be resized. If the moved Group overlaps the other 
Group completely, you will get one large Group containing the events from 
both.

D To duplicate a Group, hold down [Option] (Mac) or [Ctrl] (Windows) 
and proceed as when moving.
This duplicates the Group and all its contents. You can also use Copy and 
Paste for this, following the same rules as for selected events.

D To delete a Group, either select it and press [Delete], [Backspace] 
or select Delete from the Edit menu.

or

D Select the Eraser tool and click on a Group.

Both of these methods will delete the Group and all its contents.

You can also draw selection rectangles with the Selection tool or the Eraser 
tool, encompassing several groups and delete them all at once. The same rules 
apply as when selecting groups. That is, if Snap is on, the selection rectangle 
will be magnetic to the Snap value positions. Also note that a Group doesn’t 
have to be fully enclosed by the rectangle to be selected - the selection rectan-
gle only needs to intersect or touch the Group.
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The Edit View
The Edit View allows you to perform detailed editing to the events on a single 
track. This is also where you create notes, pattern changes and controller values 
from scratch by drawing.

D To select the Edit View, click the Edit/Arrange View button in the 
top left corner of the sequencer area.

You can also toggle between Arrange View and Edit View by pressing 
[Shift]-[Tab] or [Command]/[Ctrl]-[E].

Selecting a Track for Editing
The Edit View shows the events of the track that has the focus in the track list.

D If one track is selected when you enter Edit View, that track will 
have the focus and its events will be shown.

D If more than one track is selected in the track list when you select 
Edit View, the track you last clicked on will have focus.

D You can change edit track at any time, by clicking in the track list.
This way you can stay in the Edit View and select different tracks for editing, 
without having to go back to the Arrange View.

About the Lanes
The Edit View is (or can be) divided vertically into lanes. There are six different 
lanes, suitable for editing different types of events. Any combination of lanes can 
be shown. You show and hide lanes by clicking their respective buttons in the 
sequencer toolbar:

D If you hold down [Option] (Mac) or [Alt] (Windows) and click a Lane 
button, only that lane will be shown (all other lanes are hidden).

By default, the lanes that are shown when you select Edit View depends on the 
device type to which the track is connected (and whether the track contains 
controller data). For Redrum tracks, the Drum lane, Velocity lane and Pattern 
lane are shown, for Dr.Rex tracks, the REX lane and Velocity lane are shown, 
and so on. 

However, once you show or hide lanes, the new combination of lanes will be 
stored individually for each track. The next time you select Edit View for that 
track, the lane configuration will be the same.

Resizing and Zooming

D You can resize lanes by dragging the dividers between them.

D Where applicable, the lanes have individual zoom controls and 
scrollbars.

D The Magnifying Glass tool can be used for zooming in and out.
Click to zoom in, and click while pressing [Option] (Mac)/[Ctrl] (Windows) 
to zoom out.

Key lane Drum lane

Controller lane

REX lane

Pattern lane

Velocity lane
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D The Hand tool can be used for scrolling the view.
Just click, hold and drag in the desired direction.

D For extensive editing, you may want to detach the sequencer area 
from the rack and use it in a separate window. 
This is done either by clicking the Detach Sequencer button in the rack or by 
selecting “Detach Sequencer Window” from the Windows menu.

To reattach the sequencer, either click the Attach Sequencer button (in the rack 
or in the detached sequencer window) or select “Attach Sequencer Window” 
from the Windows menu.

D Alternatively, you can also maximize the sequencer area so that it 
fills the rack. 
This is done by clicking the Maximize Sequencer button or by holding down 
[Command] (Mac) or [Ctrl] (Windows) and pressing [2] on the left part of 
the computer keyboard.

About the Ruler and the Group strip

At the top of the Edit View you will find the ruler. Just like the ruler in the Arrange 
View, this shows meter positions (bars and beats), helping you find the right po-
sitions in the song.

D You can adjust the horizontal zoom individually for the Edit View 
and the Arrange View.
This makes sense, as you will probably work with a larger magnification 
when performing fine editing.

Just below the ruler is a narrow empty strip. This shows the Groups (if any) as 
colored bars, providing additional means of orientation in the Edit view.

✪ When you edit events within a Group, you will note that the Group 
indicator changes color. This is because the color of a Group de-
pends on its contents, as described on page 18.

Drawing and Editing Notes
Notes are drawn and edited in one of three lanes: the Key lane, the Drum lane 
and the REX lane:

The Key lane. The piano keyboard to the left indicates the pitch of the notes, covering the 
whole MIDI note range (C-2 to G8). Note that the black and white keys are reflected in the 

The Detach Sequencer button.

The Maximize Sequencer button.

Groups
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background colors of the grid, making it easier to find the right pitch when drawing and 
moving notes!
This is the lane to use when editing Synth or Sampler tracks.

The Drum lane. This is divided vertically into ten pitches, corresponding to the ten drum 
sound channels on a Redrum device (and named accordingly, if the track is connected to a 
Redrum device). Use this for editing drum tracks.

The REX lane. This is divided vertically into pitches (from C3 and up), corresponding to the 
slices in a Dr.Rex loop player device. Use this for editing Dr.Rex tracks.

D In all three lanes, the actual notes are shown as “boxes”, with the 
note length indicated by the width of the box and the velocity val-
ues indicated by the color of the box (the darker the color, the 
higher the velocity).
The basic note editing procedures are the same for all three lanes.

Drawing notes

1. If you want to restrict note input to certain note values (e.g. six-
teenth notes), set the Snap value accordingly and activate Snap.

2. Select the Pencil tool.
You can toggle temporarily between the Arrow tool and the Pencil tool by 
holding down [Command] (Mac) or [Alt] (Windows).

3. If needed, click in the piano keyboard display, drum sound list or 
slice list to find the correct pitch.
If the track is connected to a device, this will play the corresponding note.

4. Click in the note display part of the lane, at the desired position.
A note will be inserted at the closest Snap value position.

D If you just click, the note will get the length of the Snap value.
This is true regardless of whether Snap is activated or not.

D If you instead click and keep the mouse button pressed, you can 
drag to the right to set the length of the note.
If Snap is on, the length will be a multiple of the Snap value (unless you hold 
down [Shift] while you drag). Also, see the note about drum note lengths be-
low.

Selecting notes

To select notes in the Edit View, use one of the following methods:

D Click on a note with the Arrow tool to select it.

D To select several notes, hold down [Shift] and click.
You can de-select individual notes by [Shift]-clicking them again.

D You can also click and drag a selection rectangle around the notes 
you want to select.
If Snap is on, the selection rectangle will be magnetic to the nearest snap 
value positions. For example, if Snap is set to “Bar”, dragging a rectangle will 
select all notes within an exact range of bars (and within the pitches en-
closed by the rectangle).

D You can select the next or previous note on the track by pressing 
the right or left arrow key on the computer keyboard.
Holding down [Shift] and using the arrow keys allows you to make multiple 
selections.

D To select all notes on the track, use the Select All function on the 
Edit menu.
Make sure that the correct lane (Key, Drum or REX) has focus first - other-
wise you may select all controllers or pattern changes. To set focus to a lane, 
click somewhere in it (focus is indicated by a thin extra border within the 
lane).

D To deselect all notes, click somewhere in an empty area.
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Moving notes

D To move a note, click and drag it to a new position. 
If several notes are selected, all will be moved. The individual distance be-
tween the moved notes will be kept.

D If Snap is on, the moved events will keep their relative distance to 
the Snap value positions. 
For example, if Snap is set to “Bar”, you can move the selected notes to an-
other bar without affecting their timing.

D If you hold down [Shift] when you drag, movement is restricted to 
horizontal or vertical only.
This helps you move notes without accidentally transposing them, or trans-
posing notes without accidentally changing their meter position.

Duplicating notes

To duplicate the selected notes, hold down [Option] (Mac) or [Ctrl] (Windows) 
and proceed as when moving notes.

Using Cut, Copy and Paste

You can move or duplicate events using the Cut, Copy and Paste commands on 
the Edit menu.

D When you Cut or Copy, the song position is automatically moved to 
the end of the selection (or, if Snap is activated, to the closest Snap 
value position after the end of the selection).
You can use this for repeating events, as described on page 16.

D When you Paste, the events appear at the song position, on their 
original track(s).

Resizing notes

When you select a note, a handle appears on its right edge. You can click on 
this handle and drag to make the note shorter or longer.

D If Snap is on, the end of the note will be magnetic to the Snap value 
positions.
You can disable this function temporarily by pressing [Shift] when you drag. 
This allows you to resize the note to any length, regardless of the Snap 
value.

D If several notes are selected, all will be resized by the same 
amount.

About resizing drum notes

Drum notes can be resized as any other notes. However, the result of this de-
pends on the settings of the Decay/Gate switch and the Length knob for the 
drum sound on the Redrum panel:

D If Decay mode is selected, the drum sound will play to its end, re-
gardless of the note length.
Or rather, it will fade out according to the Length setting.

D If Gate mode is selected, the note length affects the resulting 
sound.
However, the maximum length of the sound is set by the Length knob - the 
sound will be cut off after this length, regardless of the note length. 
Finally, even if the Length knob is set to its maximum value, the sound will not 
play longer than the length of the drum sample.
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Deleting notes

You can delete notes in two ways: 

D Select them and press [Backspace] or [Delete], or select Delete 
from the Edit menu.

D Select the Eraser tool and click on the notes you want to delete.
You can also drag a selection rectangle with the Eraser tool and delete all 
notes encompassed by the rectangle. 

When using the Eraser tool with Snap on, the following applies:
• When single clicking, all notes of the same pitch within the set Snap value 

will be deleted. The “area of effect” is indicated in a dark gray color.

In this case, with Snap set to “Bar”, a single click will remove all the instances of the note 
C 2 on bar 6.

• If a selection rectangle is drawn, it will be magnetic to the nearest snap value 
positions. For example, if Snap is set to “Bar”, dragging a rectangle will se-
lect all notes within an exact range of bars.

D If you hold down [Shift] when making a selection rectangle, direc-
tion is restricted to horizontal or vertical only.

Editing velocity

The velocity values of notes are edited in the Velocity lane.

The velocity values are shown as bars, with higher bars indicating higher velocity. Note also 
that the color of the notes and bars reflect the velocity.

To change the velocity of a note, click on its velocity bar with the Pencil tool and 
drag the bar up or down. Clicking above a bar immediately raises the velocity to 
the level at which you click.



THE SEQUENCER26

Creating velocity ramps and curves

You can also edit the velocity of several notes at once, in two ways:

D By dragging the Line tool across the bars, at the desired height.

Drawing a velocity ramp with the Line tool.

D By dragging the pencil across the bars, at the desired height.

The Line tool is probably the preferred method for creating regular, smooth 
ramps, or for giving all the notes the same velocity (by drawing a straight line), 
while the Pencil tool can be used for creating more irregular curves.

! If you hold down [Shift] when you edit velocity values, only the se-
lected notes will be affected!

This can be very useful, especially in “crowded” sections with lots of notes. 
Consider for example if you have a busy drum beat, and want to adjust the veloc-
ity of the hi-hat notes only. Simply dragging with the line- or pencil tool would 
change the velocity of all other drum notes in the area too, but if you first select 
the hi-hat notes in the Drum lane and press [Shift] as you draw, you can edit their 
velocity without affecting any other notes!

Editing Controllers
Controllers are shown and edited in the Controller lane. This lane in turn is di-
vided into several “subtracks”, one for each automatable parameter for the cor-
responding device.

The Controller lane for a Subtractor track, with three controllers shown.

Showing and Hiding Controllers

For each track, you can select which controllers should be shown. This can be 
done in several ways:

D Hold down [Option] (Mac) or [Alt] (Windows) and click on a param-
eter on a device panel in the rack.
This sets focus to the first sequencer track connected to the device, opens 
Edit View, brings the Controller lane and shows the automation subtrack for 
the specified parameter, all in one go.

D You can do the same thing by selecting “Edit Automation” on the 
context menu for the parameter.
You bring up the parameter context menu by [Ctrl]-clicking (Mac) or right-
clicking (Windows) on the parameter on the device panel. 

✪ If you use a Mac with a two-button mouse, it’s a good idea to assign 
[Ctrl]-click to the right mouse button, allowing you to bring up con-
text menus by right clicking.



THE SEQUENCER 27

D By using the Controller pop-up menu on the sequencer toolbar, you 
can hide or show individual controllers from the sequencer.
Shown controllers are indicated by a tick mark on the pop-up menu - select 
a controller to show it or hide it. 
Controllers for which there is data (automation) in the track are indicated 
with an asterisk next to the controller name.

D Click the “Show Device Controllers” button to show all controllers 
available for the track’s device.

D Click the “Show Controllers in Track” button to show all controllers 
for which you have recorded or drawn automation in the Track.

D Select “Hide All Controllers” from the Controller pop-up menu to 
hide all controllers.
This will leave the Controller lane empty.

Drawing and Editing Controllers

Regardless of whether you’re editing recorded controllers or creating controller 
changes from scratch, you do it by drawing with the Line- or Pencil tool.

Note:

D When using the line tool, you can hold down [Shift] when drawing 
to restrict movement to horizontal only.

D If Snap is on, the controller value change you enter will snap to the 
nearest Snap value position. 
Also, the length of the changed section will be a multiple of the Snap value.

In this example, Snap is set to 1/4. Thus, the controller changes you enter will be in 
“steps”, one or more quarter notes in length.

D If the controller hasn’t been automated yet (the words “Not Auto-
mated” are shown in the Controller lane), it is a good idea to first 
set the parameter to a good “default value” on the device panel.
The reason is that as soon as you enter a controller value, the rest of the 
track will be filled with the original value of the parameter (the value set on 
the device panel). This works exactly the same as when recording control-
lers - see page 8.
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Selecting sections of a controller track

To select a section of the “subtrack” for a controller, click and drag a selection 
rectangle with the Arrow tool. If Snap is on, the selection will be magnetic to the 
Snap value positions, just as when selecting notes.

The selected section is shown as a shaded rectangle.

D By holding down [Shift] and dragging, you can select multiple, dis-
continuous sections of the controller subtrack.

✪ If you select Groups or sections of the controller lane in the Arrange 
View, this section will be selected when you got to Edit View and 
vice versa.

Moving and Duplicating Controller sections

D To move a selected controller section, click and drag it to another 
position on the same subtrack.
Snap is taken into account as usual.

D To duplicate a selected controller section, hold down [Option] 
(Mac) or [Ctrl] (Windows), click and drag it.

! Moving or duplicating controllers will replace the controller values 
at the new position (just as if you had edited them with the Line- or 
Pencil tool).

Using Cut, Copy and Paste

You can move or duplicate selected controller sections using the Cut, Copy and 
Paste commands on the Edit menu.

D When you Cut or Copy, the song position is automatically moved to 
the end of the selection (or, if Snap is activated, to the closest Snap 
value position after the end of the selection).
You can use this for repeating events, as described on page 16.

D When you Paste, the controller section appears at the song posi-
tion, on its original subtrack.

Deleting Controller sections

You can delete controller sections in two ways:

D By making a selection (as described above) and pressing [Back-
space] or [Delete] or by selecting Delete from the Edit menu. 

D By using the Eraser tool.
If Snap is on, you can single click to immediately erase the shaded area 
which corresponds to the set Snap value (e.g. Bar). You can also make a se-
lection range by clicking and dragging.

The result is this:

The controller value just before the deleted selection will remain until the end of the selection.

! You can´t remove all automation using this method - there will al-
ways be at least one controller value left. To remove all automation, 
use the Clear Automation function:

Clearing Automation

To remove all automation for a controller, select “Clear Automation” from one of 
the following menus:

D The context menu for the controller subtrack.
This appears when you [Ctrl]-click (Mac) or right-click (WIndows) in the sub-
track.

D The Edit menu.
Requires that the controller subtrack has focus. Click in the subtrack if you 
are uncertain.

D The parameter context menu.
This appears when you [Ctrl]-click (Mac) or right-click (WIndows) on the pa-
rameter on the device panel. 
Note that this clears all automation for the parameter, on all tracks!

Selecting “Clear Automation” will remove all controller values from the subtrack, 
and the text “Not Automated” will be shown.
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Inserting and Editing Pattern Changes
Pattern changes are viewed and edited in the Pattern lane:

A pattern change is shown as a yellow “tab” with the Bank and Pattern number. 
From the tab, a bar stretches to the right, for as long as the selected pattern is 
“active”, i.e. to the next pattern change.

! When you record pattern changes, they are automatically posi-
tioned on downbeats (at the beginning of new bars).

Inserting Pattern Changes

To insert a Pattern change, proceed as follows:

1. If you haven’t automated any pattern changes for the track yet (the 
words “Not Automated” are shown in the Pattern lane), it is a good 
idea to first select a “default pattern” in the pattern device.
This is especially useful if you are using a main pattern and want to insert 
changes to variation pattern here and there. 
The reason is that just like when you record pattern changes, the rest of the 
track will be “filled” with the original value as soon as you enter a pattern 
change somewhere on the track.

2. Activate Snap and set the Snap value to the note position where 
you want to insert pattern changes.
It is probably a good idea to set Snap to “Bar”, at least if you are working 
with patterns of a length corresponding to the time signature (e.g. 16 or 32 
step patterns and 4/4 time signature). However, if you are working with pat-
terns of another length, it can make sense to use other Snap values.

! Don’t insert pattern changes with Snap turned off, unless you want 
chaotic rhythm changes!

3. Pull down the Pattern pop-up menu to the left in the Pattern lane, 
and select the pattern you want to insert.
The selected pattern is shown next to the pop-up menu.

The patterns are listed with the bank letter and pattern number (A1, A2, A3, and so on).

4. Click with the Pencil tool at the position where you want the pattern 
change to happen, and keep the mouse button pressed.

5. Drag to the right.
When you drag, you will see the previous or original pattern being replaced 
by the pattern you insert.

6. Release the mouse button at the position where you want the pat-
tern change to “end”.

! The “Pattern Enable/Mute” switch (the button above the pattern 
selection buttons on the device panel, used for temporarily silenc-
ing the pattern playback) is automated using controller automation. 
The controller is called “Pattern Enabled”.
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Selecting Pattern Changes

To select a section of Pattern lane, click and drag a selection rectangle with the 
Arrow tool. If Snap is on, the selection will be magnetic to the Snap value posi-
tions, just as when selecting notes.

The selected section is shown as a shaded rectangle.

D By holding down [Shift] and dragging, you can select multiple, dis-
continuous sections of the Pattern lane.

✪ If you select Groups or sections of the pattern lane in the Arrange 
View, this section will be selected when you got to Edit View.

Moving and Duplicating Pattern Change sections

You can move and duplicate selected sections of the Pattern lane, just as when 
moving controller sections. Just like when inserting pattern changes, it is recom-
mended that Snap is activated (and in most cases set to “Bar”) when you do 
this.

You can also move or duplicate sections using the Cut, Copy and Paste com-
mands on the Edit menu. Again, the same rules apply as when editing control-
lers.

Deleting Pattern Change sections

You can delete a section of the Pattern Lane in two ways:

D By making a selection (as described above) and pressing [Back-
space] or [Delete] or by selecting Delete from the Edit menu. 

D By using the Eraser tool.
If Snap is on, you can single click to immediately erase the shaded area 
which corresponds to the set Snap value (e.g. Bar). You can also make a se-
lection range by clicking and dragging.

The result is this:

The pattern before the deleted section will remain selected until the end of the section.

! Again, make sure Snap is activated.

! You can´t remove all pattern change data using this method. To re-
move all pattern automation, use the Clear Automation function:

Clearing Automation

To remove all pattern changes, proceed as follows:

1. [Ctrl]-click (Mac) or right-click (WIndows) in the Pattern lane.
The context menu appears.

2. Select “Clear Automation”. 
This will remove all pattern changes from the track, and the text “Not Auto-
mated” will be shown.
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Quantizing
The Quantize function moves recorded notes to (or closer to) exact note value 
positions. This can be used for correcting errors, “tightening up” recorded music 
or changing the rhythmic feel.

Applying Quantizing
In Reason, you use the Quantize function in the following way:

1. Select the notes you want to quantize.
Only notes will be affected, so you can select Groups or complete Tracks if 
you like.

2. Pull down the Quantize pop-up menu on the sequencer toolbar and 
select a Quantize value.
This determines to which note values the notes will be moved when you 
quantize. For example, if you select sixteenth notes, all notes will be moved 
to (or closer to) the closest sixteenth note position.

The Quantize pop-up menu.

3. Select a value from the Quantize Strength pop-up menu.
This is a percentage, governing how much each note should be moved. If 
you select 100%, notes will be moved all the way to the closest Quantize 
value positions; if you select 50%, notes will be moved half-way, etc.

4. Click the Quantize button or select “Quantize Notes” from the Edit 
menu.
The selected notes are quantized.

In this example, a sloppily recorded hi-hat pattern is quantized to straight eight notes 
(Quantize value 1/8, Strength 100%).

Quantizing to Shuffle
On the Quantize pop-up menu, you will also find an option called “Shuffle”. If this 
is selected when you quantize, the notes are moved towards sixteenth note po-
sitions, but with the Shuffle applied. 

As described in the Getting Started book, Shuffle creates a “swing feel” by de-
laying the even-numbered sixteenth notes (the sixteenth notes that fall in be-
tween the eighth notes). The amount of Shuffle is set with the Pattern Shuffle 
control on the transport panel.

The Pattern Shuffle control.

Quantizing to Shuffle is useful if you want to match the timing of recorded notes 
with pattern devices in the song (if Shuffle is activated in the patterns).

D The Quantize Strength setting applies as when quantizing to regu-
lar Quantize values.

The Quantize 
button
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Quantizing to Grooves
The Quantize pop-up menu also contains three items named “Groove 1-3”. 
These are three different, slightly irregular rhythmic patterns. If you select one of 
these as Quantize value and apply Quantize, your notes will be moved towards 
the note positions in the Groove pattern, creating different rhythmic feels.

Creating your own Groove

You can create your own groove and apply this using Groove Quantize:

1. Create or record a rhythmic note “pattern” of some kind.
You may for example record a drum pattern, or use the notes playing the 
slices in a REX loop.

2. Select the notes you want to include in the user groove.
The groove can be of any length, but it’s usually most practical to make it 
one or two bars long.

3. Select “Get User Groove” from the Edit menu or sequencer context 
menu.
Your pattern is stored as the User groove.

4. Select any notes that you want to quantize, make sure “User” is se-
lected as Quantize value, and quantize as usual.
The rhythmic feel of your groove is applied to the notes.

! The User Groove is only stored temporarily - it isn’t included when 
you save your Song.

Quantizing during recording
You can have Reason quantize notes automatically when they are recorded. This 
is done by activating the “Quantize Notes during Recording” button on the se-
quencer toolbar, before you start recording.

The Quantize value and Strength settings apply as usual.

The Change Events Dialog
The Change Events dialog contains some special editing functions. Proceed as 
follows:

1. Select the events to which you want to apply the editing functions 
(in the Arrange view or Edit view).
The Change Events functions are mainly used with notes, but the Scale 
Tempo function will also affect controllers and pattern changes (see below).

2. Select Change Events from the Edit menu or the context menu for 
the selected events.
The Change Events dialog appears.

3. Make settings for one of the functions in the dialog and click the 
Apply button next to the settings.
All settings can be made by clicking the spin controls or by clicking in a 
value field and entering a value numerically. The functions are described be-
low.

4. If you like, use other settings in the same way.
You can use the transport controls as usual while the dialog is open. This al-
lows you to play back the events to check out the changes.

5. When you are done, close the dialog.
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Transpose

This function transposes the selected notes up or down, by the specified num-
ber of semitones.

Velocity

Adjusts the velocity of the selected notes.

D The Add field lets you add a fixed amount to the velocity values.
To subtract, enter a negative amount. Note that the possible velocity range is 
1-127. Adding an amount to a note with velocity 127 will not make any dif-
ference.

D The Scale field allows you to scale velocities by a percentage factor.
Scaling with a factor above 100% will increase the velocity values, but also 
make the difference between soft and hard notes bigger.
Scaling with a factor below 100% will decrease the velocity values, but also 
make the difference between soft and hard notes smaller.

D By combining the Add and Scale functions, you can adjust the “dy-
namics” of the notes in various ways.
For example, by using a Scale factor below 100% and Add a suitable 
amount, you can “compress” the velocity values (decreasing the difference 
between the velocity values without lowering the average velocity).

Scale Tempo

This function will make the selected events play back faster (Scale factor above 
100%) or slower (Scale factor below 100%). This is achieved by changing the 
position of the events (starting from the first selected event) and adjusting the 
length of the notes accordingly.

The result of applying Scale Tempo with the Scale factor 200% (double speed).

D The buttons [*2] and [/2] are “shortcuts” to Scale factors 200% and 
50%, respectively.
These are probably the most common values used, simulating double tempo 
and half tempo.

! This function affects all types of events: notes, controllers and pat-
tern changes! 

Alter Notes

This function alters the properties pitch, length and velocity of the selected 
notes, in a random fashion. 

D The function will only “use” values that already exist among the se-
lected notes.
For example, if you have selected notes within a specific pitch interval, the al-
tered notes will remain within this pitch interval. Similarly, only velocity values 
and note lengths that were already used in the selection will be applied by 
the Alter function. You could say that the function “shuffles” the existing 
properties in a selection and redistributes them among the notes.

! This means that the less variation there is among the selected 
notes, the less the effect of the Alter function.

D You can adjust the amount of Alteration with the Amount value.

✪ This function is especially useful for experimenting with REX loops. 
Select some notes on a Dr.Rex track and use Alter Notes to create 
instant variations, without losing the timing and rhythmic feel of the 
loop!
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Importing and Exporting 
MIDI Files
Reason can import and export standard midi files (SMF). This allows you to 
transfer MIDI data between Reason and other applications.

Importing a MIDI File
To import a Standard MIDI File, select “Import MIDI File” from the File menu In 
the file dialog that appears, locate and open the MIDI file.

D Under Windows, MIDI files have the extension “.mid”.
On a Macintosh, MIDI files are recognized if they have the file type “Midi”.

Now, a number of new tracks are created in Reason’s sequencer. The tracks will 
have their original name, with their original MIDI channel added.

D If the imported MIDI file is of “Type 1”, there will be one sequencer 
track for each track in the MIDI file.

D If the imported MIDI file is of “Type 0” (that is, it contains one track 
with MIDI events on multiple channels), there will be one sequencer 
track for each used MIDI channel.

D Any tempo changes in the MIDI file are disregarded.
The tempo in Reason will be set to the first tempo in the MIDI file.

D The new tracks will not be connected to devices in the rack.
You will need to connect the tracks manually to the proper devices, by using 
the Out pop-up menu in the track list.

D All controller data in the MIDI file is included.
This means that pitch bend, volume and modulation wheel data are pre-
served properly. However, some controllers may “mean” different things for 
the original MIDI instruments used when creating the MIDI file and the de-
vices in Reason. When you have connected a sequencer track to a device, 
you may therefore need to remove some unwanted automation from the 
track.

Green frames will appear for the automated parameters in the device panels. This helps 
you locate any unwanted controller data.

Exporting a MIDI File
To export your Reason song as a MIDI file, proceed as follows:

1. Set the End (E) marker at where you want the MIDI file to end.
The MIDI file will contain all events on all tracks from the start of the song to 
the End marker.

2. Select “Export MIDI File” from the File menu. 

3. In the file dialog that appears, specify a name and location for the 
file.
Under Windows, the file will automatically get the extension “.mid”. Under 
Mac OS, this is not required. However, if you want the MIDI file to be recog-
nizable under Windows (and by some hardware sequencers), you may want 
to activate the option “Add Extension to File Name” before saving.

4. Click Save.

MIDI files exported by Reason will have the following properties:

D The MIDI file will be of Type 1, with one MIDI track for each track in 
the Reason sequencer.
The tracks will have the same names as in the Reason sequencer.

D Since the Reason sequencer doesn’t use MIDI channels as such, all 
tracks will be set to MIDI channel 1.

D The sequencer tempo is included in the MIDI file.
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About the various signals 
that can be routed
This chapter describes the various ways you can route signals in Reason. The 
following signal types are used:

Audio
Apart from the Matrix Pattern Sequencer, all devices have audio connectors on 
the back. The audio connectors carries audio signals to or from devices via vir-
tual “cables”. 

D Audio connectors are shown as large “quarter inch” jacks.

D Audio Effects devices, which are used to process audio, have both 
audio inputs and outputs.

D Instrument devices, which generate audio, have either mono or ste-
reo left/right audio output connectors.
You do not have to use both outputs for devices with stereo outputs. Use 
the left output to get a mono signal from a stereo device.

D To monitor audio outputs from devices, the signals can be either be 
routed via a mixer - or directly- to the physical outputs of your audio 
hardware. 
Typically, if you are using audio hardware with standard stereo outputs, you 
will most probably use one or several mixers in Reason to mix the audio sig-
nals to the master outputs.

CV/Gate
CV (control voltage) signals are used to modulate parameter values, and do not 
carry audio. Gate signals are also a type of control voltage, but are “normally” 
used for slightly different purposes.

D CV/Gate connectors are shown as smaller “mini” jacks.

D CV is typically used for modulation purposes.
For example you could modulate one parameter with the value produced by 
another parameter. 

D Gate outputs/inputs are typically used to trigger events, such as 
note on/off values, envelopes etc.
Gate signals produce on/off values, plus a “value” which could be likened to 
(and used as) velocity.

D You can only route CV/Gate signals from an output to an input (or 
vice versa).
You cannot route an input to another input or an output to another output.

MIDI Routing
There are several ways you can route MIDI from external MIDI devices to Reason 
devices. This is described in the chapter “Routing MIDI to Reason”.

About Cables
Hiding and Showing
If you have made many connections in Reason, the cables can sometimes ob-
scure the view, making it difficult to read the text printed on the back panels of 
the devices. You can hide all cables in the following way:

D To hide all cables, press [Command]+[L] (Mac) or [Ctrl]+[L] (Win-
dows), or (de)select “Show cables” on the Options menu.
When cables are hidden, connections are indicated by a colored connector. 
Repeating the above procedure make the cables appear again.

Cables hidden

D When hidden, you can still connect or disconnect cables in the 
same way as when they are shown.
See page 38 for a description of the available routing methods.

Checking Connections
It is possible to check to which device a jack is connected (useful if the cables 
are hidden, or if the connected devices are located far apart in the rack):

D Positioning the pointer over a connector. 
A tool tip appears after a moment, showing the device and the specific con-
nector at the other end.
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Color Coding
Cables are color coded in the following way, making it easier to discern between 
the various connections:

• Audio connections are different shades of red.
• CV connections are different shades of yellow.
• Connections to and from Effects devices are different shades of green.

Automatic Routing
Auto-routing is when devices are automatically routed according to default rules. 
Auto-routing is performed in the following circumstances:

• When a new device is created.
• When moving, duplicating or pasting devices with [Shift] pressed.

Automatic Routing Rules

Reason Mixer Device

D The first created mixer device will be routed to the first available in-
put pair in the Hardware Device.
If more mixers are created they will be connected via the mixers Chaining 
connectors (see the Mixer chapter).

Routing Devices to the Mixer

D When an Instrument Device is created, it is auto-routed to the first 
available mixer channel(s).

Routing a Send Effect to the Mixer

D When you have a mixer selected and create an effect device, it will 
be connected as a send effect (to the first free Aux Send/Return).
Examples of effects that lend themselves well for use as send effects are re-
verb, delay and chorus.

Routing an Effect Directly to a Device (Insert)

D When you have an instrument device selected and create an effect, 
that effect will be connected as an insert effect. That is, the signal 
from the device will pass through that effect and to the mixer (or to 
another effect).

CV/Gate Auto-route

D The only instance of CV/Gate auto-routing in Reason is when you 
create a Matrix Pattern Sequencer with either a Subtractor or NN-19 
Sampler selected.
The Matrix Note and Gate CV outputs are automatically connected to the 
Sequencer Control CV and Gate inputs on the instrument device, respec-
tively.

Auto-routing Devices after they have been Created

Here follows some additional rules about auto-routing devices that are already in 
the rack:

D To reroute a device already in the rack, you can select it and use 
Disconnect Device and Auto-route Device, both on the Edit menu.

D If you delete a device connected between two devices, the connec-
tion between the two remaining devices is automatically preserved.
A typical example would be if you have an effect device, connected as an in-
sert effect between a synth and a mixer. If you delete the effect, the synth will 
be routed directly to the mixer.

D When you move a device, connections are not affected.
If you instead would like the program to re-route the device according to its 
new location in the rack, hold down [Shift] when you move it.

D When you duplicate devices (by dragging) or use copy and paste, 
the devices are not auto-routed at all.
If you would like them to be automatically routed, hold down [Shift] when you 
perform the operation.

These cables are green, indicating effect device connections.

This cable is yellow, indicating a 
CV connection.

These cables are red, indicating connections 
between instruments and mixer devices.
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Bypassing Auto-Routing

D If you wish to create a new device, without any auto-routing taking 
place, press [Shift] when creating the device.

Manual Routing
By selecting “Toggle Rack Front/Rear” from the Options menu or pressing [Tab] 
you turn the rack around. On the back of each device you will find connectors of 
two different types: audio and CV. As mentioned before, audio inputs and out-
puts are shown as large “quarter inch” jacks, while CV input and output jacks 
are smaller.

There are two ways to route audio from one device to another: 

• By connecting “virtual patch cables” between inputs and outputs.
• By selecting connections from a pop-up menu.

Using Cables
! For the cables to be visible, the option “Show Cables” must be acti-

vated on the Options menu. See below.

1. Click on the desired input or output jack on one of the devices, and 
drag the pointer away from the jack (with the mouse button 
pressed).
A loose cable appears.

2. Drag the cable to the jack on the other device.
When you move the cable end over a jack of the correct type (audio/CV, in-
put/output) it will be highlighted to show that a connection is possible. 

3. Release the mouse button.
The cable is connected. If both input and output are in stereo and you con-
nect the left channels, a cable for the right channel is automatically added.

D You can change an existing connection in the same way, by clicking 
on one end of the cable and dragging it to another connector.

Using pop-up menus
1. Click (or right-click) on a connector.

A pop-up menu appears, listing all devices in the rack. 

2. Move the pointer to the desired device (the device to which you 
want to create a connection).
A submenu appears, listing all suitable input/output connections. For exam-
ple, if you clicked on an audio output on a device, the hierarchical submenus 
will list all audio inputs in all other devices.

D If a device is greyed out on the pop-up menu, there are no connec-
tions of the suitable kind.

3. Select the desired connector from the submenu.
The connection is created.

Disconnecting Devices
Again, there are two ways to disconnect devices:

D Click on one end of the cable, drag it away from the jack and drop it 
anywhere away from a jack.

or 

D Click on one of the connectors and select “Disconnect” from the 
context menu that appears.
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Using CV and Gate
CV/Gate is used for modulating and triggering device parameters. Each sepa-
rate Device chapter lists the available CV/Gate connections, the parameters 
that can be modulated or be used for modulation outputs for the device.

Routing CV and Gate
There are not really any hard and fast “rules” applicable to CV/Gate routing. A 
few points should be mentioned though:

D The specific “Sequencer Control” inputs present on the Subtractor, 
Malström, NN-19 and NN-XT sampler devices are primarily intended 
for controlling these devices as (monophonic) instruments from the 
Matrix Pattern Sequencer.
If your intention is to use the Matrix CV/Gate outputs to create melodic pat-
terns using these Instrument devices, you should use the Sequencer Control 
inputs. 

✪ The Matrix Pattern Sequencer can be used in many other ways, be-
sides creating melodic patterns. For example you could use it to 
modulate any CV controllable parameter, with the added advantage 
of the modulation being synchronized to the tempo.

D Conversely, if you would like to apply Gate or CV modulation to 
more than one voice, you should not use the Sequencer Control in-
puts, as these only function monophonically.

D Feel free to experiment: Use Gate signals to control parameter val-
ues and CV signals to trigger notes and envelopes, if you like.
See the chapter “Matrix Pattern Sequencer” for more tips about using CV.

About the Voltage Trim Knobs
All CV inputs have an associated Trim knob. This is used to set the CV “sensitiv-
ity” for the associated parameter. The further clockwise a voltage trim knob is 
set, the more pronounced the modulation effect. 

• Turned fully clockwise, the modulation range will be 100% of the parameters 
range (0-127 for most parameters). 

• Turned fully anti-clockwise, no CV modulation will be applied.
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About the Various MIDI 
Inputs
All MIDI Inputs are set up in the Preferences-MIDI and Preferences-Advanced 
MIDI dialogs This chapter describes the various ways you can set up how in-
coming MIDI is received.

Sequencer Input

This is set in the Preferences-MIDI dialog. The Sequencer is the “standard” port 
for receiving MIDI input. This is what you should be using if you intend to use the 
Reason sequencer.

Once you have selected your MIDI interface on the Sequencer Port pop-up (and 
which channel it should receive on), you can direct incoming MIDI to any device 
by just clicking the “In” column to the left of a track name in the track list.

External Control Bus Inputs

This is set in the Preferences-Advanced MIDI dialog. The External Bus inputs 
provide up to 64 MIDI input channels divided into four buses, each with 16 
channels.

D These MIDI inputs are primarily for controlling Reason Devices from 
an external sequencer.

This could be an external hardware sequencer or sequencer software that is in-
stalled on the same computer as Reason. You should preferably use a multiple 
port MIDI interface, so you can select separate ports for Reason and the other 
MIDI devices to use, although this isn’t strictly required. See “Sending MIDI Data 
to Reason” below for further information.

Remote Control and MIDI Clock Input

These are set in the Preferences-Advanced MIDI dialog. 

• The Remote Control input is used for assigning a MIDI port for receiving 
MIDI Controller messages for “live” remote control. How to use Remote 
Control is described in the chapter “MIDI and Keyboard Remote Control”.

• Using MIDI Clock, you can slave (synchronize) Reason to hardware devices 
(tape recorders, drum machines, stand alone sequencers, workstations etc.) 
and other computer programs running on the same or another computer. 
MIDI Clock is a very fast “metronome” that can be transmitted in a MIDI Ca-
ble. As part of the MIDI Clock concept there are also instructions for Start, 
Stop and locating to sixteenth note positions.

D By first selecting the appropriate MIDI input using the MIDI Clock 
pop-up and then selecting “MIDI Clock Sync” on the Options menu, 
Reason is ready to receive MIDI Clock sync. 
See the “Synchronization” chapter for more information.
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Sending MIDI Data to 
Reason
Setting up MIDI Inputs under Mac OS 9
Under Mac OS 9, Reason requires OMS to receive MIDI. How to install OMS is 
described in the chapter “Installation” in the Getting Started book. OMS uses a 
concept of Devices, which basically means an external MIDI keyboard or sound 
module etc.

D Each of Reasons’ seven MIDI inputs can receive data from one OMS 
device.
Use OMS Setup to create the devices needed (for example one per input).

D One OMS device can be used for several of Reason’s MIDI inputs.
However, note that this may lead to some confusion about what MIDI signals 
go where.

✪ We recommend that you use separate OMS Devices to each MIDI 
Input in Reason.

D If you have several MIDI programs running at the same time, they 
can share MIDI ports between them. Again, this might lead to con-
fusing results and is probably best avoided.

! Please try to make sure that MIDI data sent to Reason is sent to 
Reason only, and not to any other application running at the same 
time.

Setting up MIDI Inputs under Mac OS X
If you’re using Mac OS X, there is no need for OMS. Reason instead makes use 
of the “CoreMIDI” services in Mac OS X, which eliminates the need for OMS. 

D For some MIDI interfaces connected via USB, no driver installation 
is required. Just plug in the interface and you’re ready to go!

D For other, more advanced MIDI interfaces (or at least to take advan-
tage of more advanced features, like multiple inputs) you will need 
to install a driver. Please consult the documentation that came with 
the interface for details.

Setting up MIDI Inputs under Windows
In the Preferences-MIDI and Advanced MIDI dialogs, each MIDI input pop-up 
will show all MIDI input ports currently installed in your system.

Each of Reasons’ seven MIDI inputs can receive data from any port. It is possi-
ble to route several MIDI inputs so that they receive data from the same physical 
MIDI In port, but you should generally avoid this as it can easily get confusing.

D Reason only “grabs” the MIDI inputs you are actually using. MIDI in-
puts not selected in the Preferences – MIDI dialog are available to 
other programs.

D Note that other MIDI programs may “grab” all MIDI ports in your 
system when you launch them! If no MIDI inputs are available to 
Reason on startup a warning alert will appear. 
However, some of these programs allow you to disable the use of a particu-
lar MIDI input. If for example you have two MIDI interfaces, you may be able 
to set things up so that one of them is used by Reason and the other by the 
other application. Please consult the documentation for the other application 
for details.
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Sending MIDI Data from 
Other Applications
Using ReWire 2
The preferred method for sending MIDI data into Reason from another applica-
tion is by using ReWire (version 2 or later). In this way no additional system ex-
tension or utility is required, simply launch the applications and set them up so 
that MIDI is transmitted from the host (the “other” program) to the slave (Rea-
son).

More about this on page 47.

Mac OS 9 - Using OMS
If the application you want to use together with Reason is not ReWire compati-
ble or if it only is compatible with ReWire version 1, you can instead use OMS to 
send MIDI from the application into Reason. To do this you need to have the 
OMS IAC (Inter Application Communication) driver installed.

! Note that the IAC driver is not installed with the “Easy Install” op-
tion in the OMS installer. If you have installed OMS using this op-
tion, you need to perform a Custom installation, where the IAC 
driver can be selected (ticked) separately.

Installing more than one IAC Port

Once the IAC driver is installed, it is shown in your OMS Studio Setup dialog. 
Up to four IAC ports can be defined.

1. Double click on the IAC Driver symbol.

2. Name as many ports as you require (up to four).

3. Close the dialog.

4. Save your OMS Studio Setup.

The OMS IAC port naming dialog.

Selecting IAC busses in Reason’s MIDI Preferences.

Setting up communication between two applications

Proceed as follows:

1. Open the OMS MIDI Setup dialog in OMS Setup and make sure that 
“Run MIDI In Background” is enabled.

2. Launch Reason.
It is important that you launch Reason after making changes to OMS, or the 
changes you have made will not be available.

3. Set up the other program so that it transmits MIDI to an OMS IAC 
port.

4. In Reason, open the MIDI section of the Preferences dialog.

5. Open the MIDI input pop-up for the MIDI Input port(s) that should 
receive the incoming MIDI, and select the IAC port that you set up in 
step 3.
Note that the Sequencer Port only receives MIDI on one selected channel at 
a time.
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Mac OS X
As of this writing, the only way to route MIDI between applications in any practi-
cal way is to use ReWire 2. See page 47.

Windows
If the application you want to use together with Reason is not ReWire compati-
ble or if it only is compatible with ReWire version 1, you need to install some 
third part MIDI routing utility to be able to send MIDI from the application into 
Reason.

However, since such utilities are non-standard additions to the operating sys-
tem, there is no guarantee that they will provide MIDI with reliable timing.

Please refer to the documentation that comes with the utility for detailed instruc-
tions.

Controlling Devices 
directly via MIDI
Routing MIDI to Devices
Depending on your MIDI interface, up to four separate ports, each with 16 chan-
nels, can be routed to Reason’s External Control inputs. The following applies 
regarding setting up the External Control buses:

D One port/device can be routed to each separate Bus input.
Simply select the port/device using the appropriate Bus pop-up menu in the 
External Control section. One port/device can be routed to several Bus in-
puts.

D When you have routed several MIDI ports/devices to corresponding 
External Buses, you use the Bus Select switch in the MIDI In Device 
to select a Bus (A-D) for editing the channel to device routing etc.

If you would like to use an external sequencer to control Reason, there are basi-
cally two scenarios that could apply:

D You have a “stand-alone” hardware sequencer or sequencer soft-
ware installed on another computer.
In this case, you should route the MIDI output from the sequencer (or the 
MIDI interface on the “other” computer) to the MIDI input on the interface 
connected to Reason. You should choose the External Control bus inputs 
for the incoming MIDI. This data is then routed to devices via Reason’s MIDI 
In device.
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D You have sequencer software installed on the same computer as 
Reason.
This requires the “OMS IAC Driver” under Mac OS 9, or a MIDI routing ap-
plication under Windows, as explained previously in this chapter.

D If you want to manually play (i.e not recorded MIDI data) Reason de-
vices in real time from inside another sequencer program, MIDI thru 
must be activated.
MIDI thru is when incoming MIDI is echoed out via the MIDI output. If you 
don’t know how to do this, refer to the program’s documentation. You will 
also need to make sure that the other application is “thruing” it’s data to the 
correct MIDI port and on the right MIDI channel.

Bypassing the sequencer completely
It is possible to use Reason devices purely as “sound modules”, bypassing the 
Reason sequencer completely. To do this, you should use the External Control 
busses to receive MIDI, and deselect the Sequencer port in the Preference dia-
log.

Once you have set up communication between Reason and the other device or 
application, you can hide the sequencer from view, by clicking the “maximize 
rack” button at the top of the rack’s vertical scrollbar.

Sending Controller Data via MIDI
It is possible to send controller data from an external sequencer to control Rea-
son parameters. Just set up your external device to transmit the correct MIDI 
controller messages on the right MIDI channel.

To find out which MIDI Controller number corresponds to which control on each 
device, please see the “MIDI Implementation Charts.pdf” document.

Once you have located the controller numbers and set everything up, you can 
record and edit the controller data in the external sequencer as you normally do, 
and the Reason parameters will react correspondingly.

✪ Do not confuse Remote Control and direct MIDI control. MIDI Re-
mote allows you to map any MIDI Controller to any control on the 
front panel, but is primarily intended for “live” tweaking of parame-
ters during playback.

Recording Pattern changes
As specified in the MIDI Implementation, MIDI Controller #3 can be used to 
switch patterns in a device. However, pattern changes activated this way occur 
immediately (not at the end of the bar), which may or may not be what you prefer.

Please see page 10 for information on recording and editing pattern changes.
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About this Chapter
This chapter describes how to use Reason as a ReWire slave, that is with Rea-
son delivering audio to another ReWire compatible application. It does not deal 
with using ReBirth and Reason together; that is described on page 208.

Why use Reason with 
ReWire?
While Reason is a complete music tool in its own right, you might want to add 
other elements to the music, such as:

• Vocals.
• Instrumental recordings.
• Hardware synthesizers (controlled via MIDI).

Connecting Reason to another application allows you to do just this, integrate 
your Reason songs with any other type of music, external MIDI and acoustic re-
cordings. By recording Reason onto audio Tracks in an audio sequencer you 
can also continue processing your Reason tracks with other internal and external 
effects.

Introducing ReWire!
To make this integration between two audio programs possible, Propellerhead 
Software has developed ReWire. This technology provides the following possi-
bilities and features:

In ReWire version 1

• Real time streaming of separate audio channels, at full bandwidth, into an-
other audio program.

• Automatic, sample accurate, synchronization between the audio in the two 
programs.

• The possibility to have the two programs share one sound card.
• Linked transport controls that allows you to play, rewind etc, from either pro-

gram.
• Less total system requirements than when using the programs together in 

the conventional way.

In ReWire 2

A number of features were added in Reason version 2. The following are the 
most important:

• Up to 256 audio channels (previously 64).
• Bi-directional MIDI communication of up to 4080 MIDI channels (255 de-

vices with 16 channels each)
• Automatic querying and linking features that (among other things) allow a 

host to display the slave’s devices, controllers, drum sounds etc. by name.

How Does it Work?
Basically the key to ReWire is the fact that Reason is divided into three compo-
nents:

• The Reason application.
• The Reason Engine (a DLL on the PC and a Shared Library file on the Mac-

intosh. Both located in the Reason program folder.)
• ReWire (also a DLL on the PC and a Shared Library on the Macintosh).

ReWire and the Reason Engine are common resources to the two programs 
(the other application and Reason) that generate the audio and passes it onto 
the other audio application.

! A note for Mac OS 9 users! In addition to being located in the Rea-
son program folder, an alias for the Reason Engine is also put in the 
Extensions folder. This allows you, if required, to remove the alias. 
This will prevent Reason from running in ReWire mode, but it will 
still run fine as a freestanding application.

Terminology
In this text we refer to Reason as a ReWire slave and the application receiving 
audio from Reason (this could be Steinberg Cubase, Emagic Logic Audio or 
Mark of the Unicorn Digital Performer for example) as the host application.

About System Requirements
To run Reason together with another audio application of course raises the de-
mands on computing power. However, adding ReWire to the equation does not 
in itself require a more powerful computer. On the contrary, it is likely that Re-
Wiring two programs requires less power than for example running them with 
one audio card each.

Still, you should be aware that running two powerful audio applications on one 
computer will require a fast processor and most of all a healthy amount of RAM.
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Preparations for Using 
ReWire - Mac OS 9 only
When you use ReWire, some of the system resources normally occupied by 
Reason are “transferred” to the other audio application: More specifically, the 
RAM required for loading samples in Reason, must now be provided by the host 
application instead. Therefore, when using ReWire we recommend you to make 
the following changes to your memory settings for the two programs (for details, 
see your Macintosh manual):

1. If you have raised the maximum memory setting in Reason (to be 
able to use more samples) lower it back to the recommended value, 
but make a mental note of how much it was set to.

2. Raise the Maximum memory for the host application by at least the 
amount that you just lowered for Reason.

Launching and Quitting
When using Rewire, the launch and quit order is very important:

Launching for normal use with ReWire

1. First launch the host application.

2. Then launch Reason.

Quitting a ReWire session

When you are finished, you also need to Quit the applications in a special order:

1. First quit Reason.

2. Then quit the host application.

Launching the host application for use without Reason/
ReWire

If you don’t plan to run Reason, just launch the host application as usual. We 
recommend that you then also deactivate all ReWire channels if required (see 
the relevant section for your program, below). But this is not completely critical, 
ReWire does not use up very much processing power when it isn’t used.

Launching Reason for use without the host application

If you want to use Reason as it is, without ReWire, just launch it as you normally 
do.

Launching both programs without using ReWire

We don’t know exactly why you would want to run Reason and a Rewire host 
application at the same time on the same computer, without using ReWire, but 
you can:

1. First launch Reason.

2. Then launch the host application.

You may get a warning message in the host application, regarding ReWire, but 
you can safely ignore it. Please also note that the two programs now compete 
for system resources such as audio cards, just as when running either with 
other, non-ReWire, audio applications.
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Using the Transport and 
Tempo Controls
Basic Transport Controls
When you run ReWire, the transports in the two programs are completely linked. 
It doesn’t matter in which program you Play, Stop, Fast Forward or Rewind. Re-
cording, however, is still completely separate in the two applications.

Loop Settings
The Loop in Reason and the corresponding feature (Loop, Cycle etc) in the host 
application are also linked. This means that you can move the start and end point 
for the Loop/Cycle or turn the Loop/Cycle on/off in either program, and this will 
be reflected in the other.

Tempo Settings
As far as tempo goes, the host application is always the Master. This means that 
both program will run in the tempo set in the host application.

However, if you are not using automated tempo changes in the host application, 
you can adjust the tempo on the transport in either program, and this will imme-
diately be reflected in the other.

! If you are using the automated tempo changes in the host applica-
tion, do not adjust the tempo on the Reason transport, since that 
tempo the doesn’t have any effect on playback!

Synchronization
All synchronization to other equipment is handled from the host application, not 
Reason. In fact there are no special synchronization issues. All that is said in the 
host application’s documentation about synchronizing audio channels is true for 
ReWire channels as well.

Routing Audio
Preparations in Reason

When you route audio from Reason to a ReWire host application, you make use 
of the Hardware Interface at the top of the rack. Basically, each output in the 
Hardware Interface is connected to a separate ReWire channel. Therefore:

D To take full advantage of the mixing features in the host application 
you need to connect the different Reason devices directly to the 
Hardware Interface.
For example, if your Reason Song contains eight different instrument de-
vices and you connect these to separate inputs on the Hardware Interface, 
they will appear on separate ReWire channels in the host application. You 
can then use the mixing facilities in the host application to adjust volume and 
pan, add effects and equalizing etc. - individually for each Reason device!
If you instead connect all your Reason devices via a Mixer to the stereo input 
pair on the Hardware Interface, all sounds will appear mixed on a single Re-
Wire stereo channel pair. While this works perfectly fine, you won’t be able 
to mix and process the devices separately in the host application.

Routing in the ReWire host application

The following description is based on using Reason with Cubase SX as the host 
application. For descriptions on how to activate and route ReWire channels in 
other host applications, please go to www.propellerheads.se/rewirehelp.

1. Pull down the Devices menu in Cubase SX and select the menu 
item with the name of the ReWire application (in this case Reason). 
All recognized ReWire compatible applications will be available on 
the Devices menu.
The ReWire panel appears. This consists of a number of rows, one for each 
available ReWire channel.

2. Click on the green buttons in the “Active” column to activate/deac-
tivate the desired channels.
The buttons light up to indicate activated channels. How many and which 
channels you need to activate depends on to which Hardware Interface in-
puts you have connected your Reason devices, as discussed above.

www.propellerheads.se/rewirehelp
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3. If desired, double click on the labels in the right column, and type in 
another name.
These labels will be used in the Cubase SX/SL Mixer to identify the ReWire 
channels.

4. Open the Cubase SX Mixer.
You will find that new channels have been added - one for each activated 
ReWire channel. If the channels aren’t visible, you may need to scroll the 
Mixer window or check the Mixer View options (different channel types can 
be shown or hidden as desired in the Cubase SX Mixer).

5. Start playback (in Reason or Cubase SX - it doesn’t matter as both 
programs will automatically be synchronized).
You will now see the level meters moving for the playing ReWire channel, 
and hear the sound of the Reason devices through Cubase SX’s Mixer. Of 
course, this requires that your Reason Song contains some music!

6. Use the mixing features in Cubase SX to add effects, EQ, etc.

Routing MIDI via ReWire 2
The following description is based on using Reason with Cubase SX as the host 
application. For descriptions on how to route MIDI to Reason from other host ap-
plications, please go to www.propellerheads.se/rewirehelp.

1. In Cubase SX, select a MIDI track that you want to route to a device 
in Reason.

2. Pull down the MIDI Output menu for the track (in the Inspector or 
track list).
All devices in the current Reason Song are listed on the pop-up menu, along 
with the conventional, “physical” MIDI outputs.

3. Select a Reason device from the pop-up menu.
The output of the MIDI track is now routed to that device.

D If you now play back a MIDI part on the track, the MIDI notes will be 
sent to the Reason device - just as if the track were connected to 
any regular MIDI sound source.
The sound of the device will be sent back into Cubase SX via ReWire - 
which channel it will appear on depends on how you have routed the device 
to the Hardware Interface in Reason, as discussed above.

D To play the device “live”, you need to select the proper MIDI input 
for the track in Cubase SX (the input to which your MIDI keyboard 
is connected) and activate the Monitor button for the track.
When the Monitor button is activated, all incoming MIDI (i.e. what you play 
on the keyboard) is immediately sent to the track’s MIDI Output (i.e. to the 
Reason device).

Converting ReWire 
Channels to Audio Tracks
Most often, there is no need to convert individual ReWire channels to regular au-
dio tracks! The channels already appear in the host application’s Mixer, and you 
can typically perform the same kind of real-time processing as with regular audio 
channels (effects, EQ, volume, pan and mute automation, etc.).

Still, you may need to convert the ReWire channels to audio tracks, for example 
if you want to continue working in Cubase SX only. This is probably easiest done 
by using the host application’s “Export Audio” or “Bounce” function. In Cubase 
SX, you would proceed as follows:

1. Make sure your Reason devices play back properly via ReWire.

2. In the Cubase SX Mixer, activate Solo for the ReWire channel you 
want to convert to a regular audio track.
Make sure no other channel is Soloed as well.

3. Go to Cubase SX’s Project window and set the left and right locator 
to encompass the whole song (or a section, if that’s what you want).
Make sure the Cycle (loop) function is turned off.

4. Pull down the File menu in Cubase SX and select “Audio Mixdown” 
from the Export submenu.
The Export Audio Mixdown dialog appears.

5. Activate the “Import to Pool” and “Import to Track” options and fill 
in the rest of the dialog as desired.
You can choose to include any Cubase SX mixer automation, select a file 
format and file name, etc.

6. Click Save.
The ReWire channel is now rendered to a new audio file on disk. A clip refer-
ring to the file will appear in the Pool, and an audio event playing this clip will 
be created and placed on a new audio track, starting at the left locator.

D If you now play back the audio track you will hear exactly what was 
played on the ReWire channel. 
This means you should keep that ReWire channel muted (or deactivated) 
now, since otherwise you would hear the sound twice - once via ReWire and 
once from the audio track.

D To convert all your ReWire channels this way, simply proceed as 
above (but solo another ReWire channel in the Cubase SX Mixer).

! Converting ReWire channels this way results in a number of audio 
files that can be very large (depending on the length of the song). 
Make sure you have enough disk space!

www.propellerheads.se/rewirehelp
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Details About Various 
ReWire Hosts
The Propellerhead Software website provides updated information on how to 
configure ReWire for most compatible host applications. Please go to: 
www.propellerheads.se/rewirehelp. 

http://www.propellerheads.se/rewirehelp
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Introduction
It is possible to assign computer keyboard commands and/or MIDI controller 
messages to most Reason device parameters or functions. Both methods allow 
you to use a “learn” function to instantly assign the parameter knob, slider or but-
ton to a keyboard command or a controller on an external device.

MIDI Remote Mapping
If you want to control one or several Reason parameters in real time from an ex-
ternal MIDI device, you can use MIDI Remote Mapping. The external device 
could be a dedicated MIDI performance controller, for example. 

Setting Up
! If you are using a single MIDI interface with only one MIDI Input, 

there are certain restrictions to how you can use MIDI Remote Map-
ping. See “Example MIDI Setups” below for an explanation. 

To set up Reason for MIDI Remote Mapping, proceed as follows:

1. Open the Preferences dialog from the Edit menu and select the Ad-
vanced MIDI page.

2. Open the Remote Control pop-up in the Miscellaneous section, and 
select your MIDI input.
This should preferably be a separate port that you “dedicate” to sending 
controller messages, see below.

3. Close the Preferences dialog.
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Example MIDI Setups
There are several possible variables when it comes to what type of MIDI setup 
you are using. Please read on. 

“Ideal” Setup

The ideal setup is a computer with two MIDI interfaces or one MIDI interface 
with multiple, separate inputs, a MIDI keyboard used for playing/recording and a 
separate MIDI Controller device (“fader box”) used for remote control.

1. Connect your MIDI keyboard to one MIDI Input. 

2. Connect your MIDI remote device to the other MIDI Input.

3. Open the Preferences – MIDI dialog and set things up so that the 
MIDI keyboard is used for playing and the fader box is used for 
MIDI Remote control.

If You are Using a Single MIDI Interface with one MIDI Input 
only

In this scenario we assume you have your MIDI keyboard and external MIDI con-
troller connected to the same MIDI Input on your computer. In this case it’s a lit-
tle bit trickier to get things to work correctly. Here’s the problem:

If you are using the sequencer input for playing a device, the device will react to 
MIDI controller messages via this input, since all devices are always set up to re-
act to MIDI controller messages (see page 287 for details).

Now, if you happen to set things up so that a control on a device reacts to the 
same MIDI Controller message as is used for remote control of another control 
(maybe even on another device) both controls will move simultaneously on 
screen!

The solution is to separate things via MIDI Channel messages. Proceed as fol-
lows:

1. If you are using the MIDI sequencer input to play your devices, open 
the Preferences - MIDI dialog and make a note of which MIDI Chan-
nel is used for sequencer input.

2. If you are instead using one of the direct MIDI buses A to D, check 
the Hardware Interface to find out which MIDI Channels are already 
taken by devices in the rack.

3. Set up your MIDI Controller (that you plan to use for MIDI Remote 
control) to transmit on any MIDI channel that is not already occu-
pied (as described above).

4. When you then set up MIDI remote Control, only use the MIDI Chan-
nel on which your MIDI Controller is now set to transmit on.
This will ensure that remote control doesn’t conflict with other MIDI.

If you only have one MIDI Device

If you only have one MIDI Device that you plan to use both for playing/recording 
and for remote control, there are severe restrictions. Actually there ‘s only one 
sensible way to avoid conflicts.

1. Open the “MIDI Implementation Charts.pdf” document.
This can be found in your program folder.

2. Make a note of the controller numbers that are not used for direct 
control of any device at all.

3. Set up your MIDI remote control so that it only uses these unused 
MIDI Controller numbers.

! Please note that you can only assign a MIDI Controller number for 
remote control of one parameter at a time. If you try to assign a sec-
ond parameter to a MIDI Controller number already used, the previ-
ously assigned parameter is overridden by the new one. 

Enabling MIDI Remote
To enable MIDI Remote, select “Enable MIDI Remote Mapping” from the Op-
tions menu.
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Editing MIDI Remote Mapping
1. To get an overview of which parameters are MIDI remote controlla-

ble select “Edit MIDI Remote Mapping” from the Options menu. 
When done, each device you select will show a green arrow symbol beside 
every parameter that can be assigned a MIDI remote.

A section of a mixer with MIDI Remote enabled.

2. If you click on a assignable parameter, a dialog appears allowing 
you to select a MIDI controller (or a Note number) to control that 
parameter.
Note numbers function exactly like Keyboard remote - they can only control 
on/off or min/max values (see page 57).

The MIDI Remote dialog.

3. Make sure that the “Learn from MIDI Input” box is ticked.

4. Simply turn the knob (or slider etc.) that you wish to use to remote 
control the parameter.
The “MIDI Received” field momentarily flickers as you turn the knob, and 
then the dialog shows the controller number and the channel it is transmitted 
on.

5. Click “OK” to exit the dialog.
The selected parameter now has a tag, displaying the controller number, and 
the MIDI channel used.

6. To exit Edit MIDI Remote Mapping mode, deselect it from the Op-
tions menu.
You do not always have to use this method - see below.

About the two Edit MIDI Remote Mapping Modes

If Edit MIDI Remote Mapping is enabled (ticked) on the Options menu, assigned 
parameters are “tagged”, and the arrow indicators show the assignable parame-
ters. In this mode, however, you cannot operate Reason normally, as every pa-
rameter you click on will open the MIDI Remote dialog. The Edit mode is 
primarily for overview of available parameters and the current assignments.

D Another way to assign keyboard remote commands is to have “Edit 
MIDI Remote Mapping” deselected on the Options menu, and to 
simply [Ctrl]-click (Mac) / right-click (PC) the parameter you wish to 
remote control.
This opens a pop-up menu, where one of the options will be “Edit MIDI Re-
mote Mapping”. Selecting this opens the MIDI Remote dialog. Thus, you do 
not have to select Edit mode from the Options menu if you already know that 
a parameter is free and assignable.
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Keyboard Remote
Assigning keyboard remote commands is very similar to MIDI remote mapping. 
However, as there is no MIDI involved, there is no special setting up required. 
Keyboard commands can be assigned the same parameters as when using MIDI 
remote mapping, but the functionality differs in one central aspect:

D Keyboard Remote commands can only be used to toggle on/off or 
min/max values for an assigned parameter.

Hence, if you assign a keyboard remote command for a knob, slider or spin con-
trol, it will only switch between the minimum and maximum values for that param-
eter. The only exception to this are the multi-selector buttons used for various 
parameters such as envelope destination, for example. These will cycle through 
the available options when using keyboard remote.

Enabling Keyboard Remote
To enable Keyboard Remote, select “Enable Keyboard Remote” from the Op-
tions menu, or press [Command]+G (Mac) or [Ctrl]+G (PC).

Editing Keyboard Remote
D To get an overview of which parameters are remote controllable se-

lect “Edit Keyboard Remote” from the Options menu. 
When done, each device you select will show a yellow arrow symbol beside 
every parameter that can be assigned a keyboard remote.

A section of a drum machine with Keyboard Remote enabled.

D If you click on a assignable parameter, a dialog appears allowing 
you to select a key command for that parameter.
You may use any key except the Space bar, Tab, Enter or the Numeric key-
pad (which is reserved for Transport functions) or a combination of [Shift] + 
any key (with the same aforementioned exceptions).

The Keyboard Remote dialog.

D Simply press the key (or key combination) you wish to use to re-
mote control the parameter.
The “Key Received” field momentarily indicates that it is “learning” the key-
stroke(s), and then the dialog displays the name of the key you have 
pressed. If [Shift] was used, the box beside the word Shift in the dialog is 
ticked. 

About the two Edit Keyboard Remote Modes

If Edit Keyboard Remote is enabled (ticked) on the Options menu, assigned pa-
rameters are “tagged”, showing the remote key for that parameter. In this mode, 
however, you cannot operate Reason normally, as every parameter you click on 
will open the Key Remote dialog. This mode is primarily for overview of available 
parameters and the current assignments.

D Another way to assign keyboard remote commands is to have “Edit 
Keyboard Remote” deselected on the Options menu, and to simply 
[Ctrl]-click (Mac)/right-click (PC) the parameter you wish to remote 
control.
This opens a pop-up menu, where one of the options will be “Edit Keyboard 
Remote”. Selecting this opens the Key Remote dialog. Thus, you do not 
have to enable/disable Edit mode from the Options menu if you know that a 
parameter is assignable.

! If you try to assign a Remote Key that is already in use, you will get 
an alert asking if you wish to change the current assignment.
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Saving Remote Setups
MIDI or Keyboard Remote setups are always stored with the song. But perhaps 
you wish to be able to recall this setup for use in a new song, or permanently use 
a specific remote setup. 

D This could be done by saving a song document containing all the 
devices that are affected by the remote setup together with the re-
lated Key or MIDI mapping, but without any sequencer data. 
This song document could then be used as a starting point for any new 
song, by simply loading it, and immediately using “Save As” to save it under 
a new name.
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ReWire users – Read This!
This chapter is about synchronization via MIDI Clock, and does not apply to us-
ers of ReWire. If you are using Reason together with a ReWire compatible appli-
cation, ReWire automatically handles all synchronization issues for you. See 
page 47 for details.

What is Synchronization 
and MIDI Clock?
Synchronization, in this context, is when you make Reason play at the same 
tempo as another device; where both start, stop and can locate to certain posi-
tions, together. This is done by transmitting MIDI Clock signals between Reason 
and the other device. MIDI Clock is a very fast “metronome” that can be trans-
mitted in a MIDI cable. As part of the MIDI Clock concept there are also instruc-
tions for Start, Stop and locating to sixteenth note positions.

You can set up synchronization between Reason and hardware devices (tape 
recorders, drum machines, stand alone sequencers, workstations etc.) and 
other computer programs running on the same or another computer.

Master/Slave
In a synchronized system there is always one master and one or more slaves. In 
our case, the master is the one that controls the tempo. In other words, it is only 
the tempo setting on the master device that is of any relevance, since the slaves 
slavishly follow the master's tempo.

D Reason always acts as a slave. That is, it receives MIDI Clock sig-
nals, it never transmits them.

! Before you create any serious projects that require sync, try out the 
features described below and check out “Synchronization Consid-
erations” on page 117.

Slaving Reason to an 
External Device
This example assumes that you have an external device, such as a drum ma-
chine, hardware sequencer, another computer, tape recorder etc., that transmits 
MIDI Clock signals to which you want to synchronize Reason. 

1. Connect a MIDI Cable from the MIDI Out on the other device to a 
MIDI In on the computer running Reason.

2. Set up the other device so that it transmits MIDI Clock signals to 
the MIDI Out you just connected to the computer running Reason.

3. In Reason, pull down the Edit menu (under Mac OS X, the Reason 
menu) and open the Preferences dialog. Select the Advanced MIDI 
page.

4. Pull down the MIDI Clock Sync pop-up and select the MIDI Input to 
which you connected the MIDI cable from the other device.
Under Mac OS 9, if you do not understand which Input this is, or if that MIDI 
input doesn’t appear in the list, consult your OMS documentation for infor-
mation on MIDI interfaces, MIDI ports and naming.

Reason Mac OS 9 set up to sync to MIDI Clock coming in from a MPC-60 drum machine 
connected to an external MIDI interface.
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Under Windows, if you can’t find the MIDI Input you want to use, there is either 
something wrong with the installation of the interface, or some other program is 
holding on to it. Consult the documentation for the MIDI interface, the other pro-
gram and Windows, for more information.

Reason Windows set up to sync to MIDI Clock coming in via the MIDI interface on a SB PCI 
128 card.

5. Close the dialog.

6. Activate MIDI Clock Sync from the Options menu in Reason.
This can also be set on the Transport panel.

7. Activate playback on the other device.
Reason will start playing ‘in sync’ with it and the Sync LED on the Transport 
will light up.

Slaving Reason to 
Another Program on the 
Same Computer
! The preferred method for synchronizing two applications is by us-

ing ReWire, see page 47. However, if the application you need to 
sync Reason with doesn’t support ReWire, you can try the proce-
dures described below.

This section describes how to use MIDI Clock to synchronize Reason to another 
application running on the same computer. This text is based on the following 
assumptions:

• Under Mac OS 9, that the other program has full support for OMS and that 
you have read and understood the instructions on MIDI via OMS in general, 
described in the chapter “Routing MIDI to Reason”.

• Under Windows, that you have access to a MIDI routing utility, as described 
on page 45.

! Note that synchronization via MIDI Clock makes the two programs 
play at the same time, that is, they both “run” when you “hit play”. It 
does not mean they can both play audio at the same time. See page 
281 for details about “sharing audio”.

! A note for users of Mac OS X: As of this writing, there was no prac-
tical way of synchronizing two applications without ReWire.

Proceed as follows:

1. Set up the other program, so that it transmits MIDI Clock to Reason:
• Under Mac OS 9 this is done by selecting the OMS IAC port.
• Under Windows this is done by selecting one of the MIDI routing utility 

ports.

2. In Reason, pull down the Edit menu and open the Preferences dia-
log. Select the Advanced MIDI page.
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3. Pull down the MIDI Clock pop-up and select the corresponding 
MIDI routing utility port.

Windows: Reason set up to sync to MIDI Clock coming in via “Power MIDI” port 1.

Mac OS 9: Reason set up to sync to MIDI Clock coming in via OMS IAC.

4. Close the dialog.

5. Activate MIDI Clock Sync from the Options menu in Reason.

6. Activate playback on the other device.
Reason will start playing ‘in sync’ with it and the Sync LED on the Transport 
will light up.

Synchronization 
Considerations
Adjusting for Latency

Latency compensation.

Because of the latency problem described on page 282, you might need to ad-
just Reason’s playback in relation to the sync master, so that they are in perfect 
time. The tempo will not differ between the two, but Reason might play ahead or 
behind the other application. You might need to adjust this. However, this is 
something you only need to do once. The setting is stored with your other pref-
erences, so you don’t need to adjust it again.

Proceed as follows:

1. Set up the other application so that it generates a solid click, on for 
example quarter or eighth notes, preferably with a special sound on 
the downbeat.
This click can either come from an internal metronome or from a MIDI 
source. If you use a MIDI source, make sure you pick one that has solid MIDI 
timing.

2. Set up Reason so that it plays a similar rhythm as the other applica-
tion.
You might for example use the Metronome or Redrum drum computer for 
this.

3. Start the two applications in sync.

4. Make sure you hear both applications at approximately equal level.

5. Open the Preferences dialog in Reason and select the Audio page.

6. Trim the “Latency compensation” setting until the “clicks” from the 
both sources sound at exactly the same time.

7. Close the Preferences dialog in Reason.
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If Latency Compensation isn’t enough
There might be situations where you can’t compensate enough in Reason to 
make two software applications run in sync. This might especially be true if the 
other application is an audio sequencer, that is if it can record and playback both 
audio and MIDI.

This problem is an indication of the fact that the other application has not been 
set up properly and that its audio playback is not in sync with its own MIDI play-
back.

! This is not something that you can or should compensate for in 
Reason. Instead, follow the instruction included with the other ap-
plication to make sure its MIDI playback and audio playback are 
correctly locked to each other.

About the beginning of the Song
Due to the latency phenomenon, described on page 282, Reason needs some 
time to correct it’s playback speed when it first receives the Start command. 
This can be noted as a small glitch in the audio playback, when the program 
starts. If this is a problem, you need to insert a couple of empty measures at the 
beginning of the Song. Proceed as follows: 

1. Set the Left Locator to “1 1 1” and the right Locator to “3 1 1“.

2. Click somewhere in the main sequencer area to move the menu fo-
cus to the sequencer.

3. Select “Insert Bars Between Locators” from the Edit menu.

4. Set up the other device/application, so that it also plays two empty 
bars at the beginning.

About MIDI Song Position Pointers
MIDI Clock actually consists of five type of messages: The actual clock (the met-
ronome that establishes the tempo), Start, Stop and Continue commands and 
Song Position Pointers. This last type of message contains information about 
positions, so that a program for example “knows” where in a Song to start play-
back from.

Normally, this ensures that you can locate to any position and activate playback 
from there. In older devices, Song Position Pointers might not be implemented. 
This means that you will be able to synchronize properly only if you start both de-
vices from the absolute beginning of the song.

About Tempo Changes
Again, due to the latency phenomenon, Reason needs a bit of time to adjust to 
changes in tempo. If there are abrupt changes in the MIDI Clock, due to drastic 
tempo changes in the master, you will note that Reason will require up to one 
measure to adjust itself to the change. How long this actually takes also de-
pends on the precision of the incoming MIDI Clock. The more precise it is, the 
faster Reason can adjust to it. 

If this adjustment is a problem, try to use gradual tempo changes rather than im-
mediate ones.

! When Reason is synchronized to MIDI Clock, there is no Tempo 
readout.
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7 D Optimizing Performance
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Introduction
Reason is a program of infinite possibilities. You can create as complex songs 
as you like, using endless racks of devices. While this is one of the most exciting 
properties of the program it does have a drawback – it means that you must be 
careful with how you manage your computer processing power.

Each device you add to the rack uses up a bit of computer processing power – 
the more devices the faster the computer has to be. However, you can set up 
your devices to require more or less processing power. For example a sound on 
the Subtractor synthesizer that only uses one oscillator and one filter requires 
much less processing power than one using both dual oscillators and dual fil-
ters.

Samples used in your songs also require RAM - memory - to load properly. The 
use of RAM can also be managed, as described at the end of this chapter.

When creating songs for other people, for example for publishing in the Reason 
song archive (see www.propellerheads.se for more information), you should do 
what you can to reduce the requirements for playing back a certain song, both in 
terms of processing power and in terms of RAM requirements. Other users may 
not have as powerful a computer as you do!

Checking Processing Power
On the transport you will find a meter labelled CPU. This indicates how much 
processing power is used at any given moment.

The CPU meter.

The higher this meter goes, the higher the strain on your computer processor. 
You will note when your processor is heavily loaded that graphics will update 
slower. Finally, when there’s too little power left to create the audio properly, the 
sound will start breaking up.

Optimization and Output 
Latency
As described on page 282, you generally want the lowest possible latency, to 
get the best response when you play Reason in real time. However, selecting 
too low a latency is likely to result in playback problems (clicks, pops, dropouts, 
etc.). There are several technical reasons for this, the main one being that with 
smaller buffers (lower latency), the average strain on the CPU will be higher. This 
also means that the more CPU-intensive your Reason song (i.e. the more de-
vices you use), the higher the minimum latency required for avoiding playback 
difficulties.

Therefore, you may need to adjust the latency. This is done differently depending 
on which audio cards, drivers and operating system you are using:

Making adjustments in the ASIO Control Panel

If you are using an ASIO driver specifically written for the audio hardware, you 
can in most cases make settings for the hardware in its ASIO Control Panel. 
This panel (opened by clicking the ASIO Control Panel button in the Prefer-
ences-Audio dialog) may or may not contain parameters for adjusting the la-
tency. Usually this is done by changing the number and/or size of the audio 
buffers - the fewer and smaller the audio buffers, the lower the latency. Please 
consult the documentation of your audio hardware and its ASIO drivers for de-
tails!

! Raising the buffer size to eliminate audio artefacts on playback is 
mainly effective if you are currently using very small buffers, 64 to 
256 samples. If the buffers are already big (1024 or 2048 samples) 
you will not notice much difference.

Making adjustments in the Reason Preferences dialog

If you are running Reason under Windows and using an MME or DirectX driver, 
or if you are running Reason under Mac OS X and using a CoreAudio driver, you 
can adjust the output latency in the Preferences – Audio dialog.

D Under Windows and Mac OS X, this is done by dragging the Buffer 
Size slider.

D If you are running Reason under Mac OS 9.x using the Sound Man-
ager Default Output driver, you cannot change the latency.

General procedure

The basic procedure for optimizing the latency is the following:
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1. Open a song and start playback.
You want to choose a song that is reasonably demanding, i.e. with more 
than just a few tracks and devices. 

2. Open the Preferences dialog.
Under Mac OS X, this is found on the Reason menu; under all other operat-
ing systems it’s found on the Edit menu.

3. Select the Audio page and locate the buffer settings.
If you are using an ASIO driver, you need to click the ASIO Control Panel 
button, for Mac OS X/CoreAudio, Windows/MME or DirectX you should use 
the Buffer Size slider.

! If you are making adjustments in the ASIO Control Panel for hard-
ware with an ASIO driver, you should make a note of the current 
buffer settings before changing them.

4. While the song is playing, listen closely for pops and clicks and try 
lowering the latency (buffer size/number).

5. When you get pops and clicks, raise the latency value a bit.

6. Close the Preferences dialog (and ASIO Control Panel, if open).

About Latency Compensation

In the lower right corner of the Preferences-Audio dialog, you will find a setting 
called Latency Compensation. This value is used internally in Reason to com-
pensate for the latency when synchronizing Reason to another MIDI sequencer 
or similar. Usually, Latency Compensation is set to the same value as the Output 
Latency, but it is possible to increase it (see page 62). Normally however, you 
shouldn’t need to touch this parameter.

Optimizing Your 
Computer System
In this manual we do not have the possibility to give you detailed procedures for 
optimizing your computer for maximum power. This is a subject that we could 
write complete books on! However, we’d like to share a couple of important tips:

D Quit other programs that are running at the same time as Reason.

D Remove background tasks on your computer.
This might be any background utilities you have installed as well as network-
ing, background internet activities etc.

D Under Windows, make sure you use the latest and most efficient 
driver for your audio card.
Generally, ASIO drivers are the most efficient, followed by DirectX and last 
MME.

D Only work on one Reason document at a time.
Songs that are open in the background do consume some processing 
power even though they’re not playing.

D Lower the sample rate setting on the Preferences dialog.
While this also reduces sound quality, it is a very quick and convenient way 
to try to play a song that your computer otherwise can’t handle.

D Make sure your computer display is set to 16-bit colors.
Under Windows, this mode is called “High Color”; under Mac OS it is called 
“Thousands of colors”.
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Optimizing Songs
Below follows things you can check and change to make sure your song uses as 
little computer processing power as possible:

Global
D Delete unused devices.

If a device isn’t actually doing anything, delete it from the rack.

D Use fewer devices.
For example, instead of using several reverbs as insert effects, replace them 
all with one, set up as a send effect. By the same token, try to use one sam-
pler playing several different samples instead of numerous samplers playing 
one sample each.

D Don’t use stereo unless it is required.
For example, if a sampler or Dr. Rex player is playing mono material, only 
connect the Left output and leave the Right output unconnected.

Sample Players – NN19, NNXT, Dr. Rex and 
Redrum
D Only activate High Quality Interpolation when it is required.

Listen to the sound in a context and determine whether you think this setting 
makes any difference. However, note that on a Macintosh G4, High Quality 
Interpolation does not require any more processing power.

D If you are playing back a sample at a much higher pitch than it was 
recorded at, consider sample rate converting the actual sample file 
to a lower sample rate.
This will require an external sample editor with good sample rate conversion 
facilities.

D Try to refrain from using stereo samples.

Filters – Subtractor, Malström, NN19, NNXT and 
Dr. Rex
D Deactivate filters that are not used.

Observe that if the Cutoff is all the way up or the envelope is set to open the 
filter fully, then the filter doesn’t affect the sound. Conserve processing 
power by disabling the filter altogether.

D Where applicable, use the 12dB lowpass filter instead of the 24dB 
lowpass filter. 
See if you can get the same sonic result by using the 12dB filter, since it 
uses up less processing power.

Polyphonic Devices – Subtractor, Malström, 
NN19, NNXT, Dr. Rex and Redrum
D Try making the device play fewer voices.

This can be done for example by lowering the release and setting the Po-
lyphony setting to exactly the maximum number of notes played simulta-
neously by this device.

✪ Please note that just lowering the polyphony setting has no effect. 
Unused voices do not consume processing power.

D Where applicable, try the Low Bandwidth (Low BW) setting.
This will remove some high frequency content from the sound of this partic-
ular device, but often this is not noticeable (this is especially true for bass 
sounds).

Subtractor
D Try avoiding using Oscillator 2 altogether.

If you can create the sound you need with only one oscillator, this saves con-
siderable amounts of processing power.

D Do not use the oscillator Phase mode if you don’t need it.
In other words, set the Oscillator Mode switches to “o”, not “*” or “–”.

D Do no activate Noise unless required.

D Do not activate Filter 2 unless required.

D Do not use FM unless required.
In other words, set the oscillator FM knob to “0” and make sure no modula-
tion source is routed to FM.

Malström
D If it isn’t necessary, refrain from using Osc B at all.

If you can produce the desired sound by using Osc A only, this will save a lot 
of processing power.

D If one or both Oscillators are routed to one Filter only, and/or the 
Spread parameter is set to “0”, only connect one of the outputs (the 
one to which the filter is connected) to the mixer, and leave the 
other one unconnected.

D Try to see if you can achieve the desired effect by using only one of 
the filters, and without using the shaper.
Using both of the filters and the shaper in conjunction requires considerably 
more processing power than using just one of the filters and/or the shaper.
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Redrum
D Do not use the Tone feature available on channel 1, 2 and 9.
In other words, make sure the Tone controls and their accompanying Vel knobs 
are set to “0” (“twelve o’ clock”).

Mixer
D Avoid using stereo inputs when not required.

For example, if your sampler or Dr. Rex player is playing mono material, only 
connect it to the Left input on a mixer channel. Leave the Right input uncon-
nected.

D Do not activate EQ unless required.
If a channel doesn’t make use of EQ, make sure it’s EQ button is deacti-
vated.

Distortion
D The D-11 Foldback Distortion will use up less CPU power than the 

Scream 4 Distortion device.

Reverb
D The RV-7 uses much less power than the RV7000.

For some applications the RV-7 might do just fine, and will use up much less 
power.

D If you are running out of processing power, try the Low Density al-
gorithm for the RV-7.
This uses up much less power than other algorithms.

Send Effects
D When you are using mono effects as send effects, you can connect 

the effect returns in mono as well (disconnect the cable to Aux Re-
turn Right on the Mixer).
This is true for the following effects:

• D-11 Distortion.
• ECF-42 Envelope Controlled Filter.
• COMP-01 Compressor.
• PEQ-2 Parametric EQ.
• DDL-1 Delay (provided the Pan parameter is set to center position).

Songs and Memory 
Requirements
Songs not only use up system resources in terms of processing power, they also 
require RAM (memory) to load at all.

The amount of RAM required for loading a song, is directly proportional to the 
amount of samples used in the song. For example, a song only using Subtrac-
tors and effects requires very little RAM.

If you are running out of RAM try the following:

D Close other song documents.
All open songs compete for RAM

D Under Mac OS 9; raise the memory setting for Reason.
This is done in the Finder by selecting the Reason application and opening 
the Get Info window.

D Under Windows or Mac OS X, terminate other applications.
All running applications compete for the RAM available in the computer.

D Use mono samples instead of stereo.
Mono samples require half the amount of RAM.

D Try sample rate converting sample files to a lower sample rate.
Note that this will affect sound quality negatively. Also note that it will require 
an external sample editor with good sample rate conversion facilities.
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Overview
The transport panel has standard controls for the sequencer transport, but also features controls for setting tempo, metronome click, locator points etc. The main con-
trols in the central area of the transport panel are as follows:

Main Transport Controls
The main transport controls function just like standard controls on tape recorders etc. There are also fixed computer keyboard combinations for the most important 
transport functions:

You can also use the following transport related key commands:

| Function | Key command | Comments

Stop [0] on the numeric keypad or [Return] Pressing Stop during playback stops the sequencer. Pressing stop again, sets the position 
to the left locator (if this is located before the current position). Pressing stop a third time sets 
the position to the start of Bar 1. The Stop button also sends out a “Reset” message, in case 
of stuck notes or other related problems.

Play [Enter] on the numeric keypad Starts playback of the sequencer.

Rewind [7] on the numeric keypad Clicking once moves the position backward one Bar. If you press and hold this button on the 
transport (not using key command) it will start scrolling faster after about 2 seconds. 

Fast Forward [8] on the numeric keypad Clicking once moves the position forward one Bar. If you press and hold this button on the 
transport (not using key command) it will start scrolling faster after about 2 seconds.

Record [*] on the numeric keypad, or 
[Command]/[Ctrl]-[Return]

Activates “Record ready” mode if sequencer is stopped. If activated during playback it will 
start recording immediately (“punch in”).

| Function | Key command | Comments

Toggle Stop/Play Space bar Switches between stop and play mode.

Go to Left Locator (Loop Start) [1] on the numeric keypad Sets the position to the left locator.

Go to Right Locator (Loop End) [2] on the numeric keypad Sets the position to the right locator.

Stop

Play

Rewind

Fast Forward

Song Position Overdub/Replace switch

Loop on/off

Left and Right Locator positions

Record

Time Signature

TempoFold/Unfold transport
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Tempo and Time Signature

The tempo and time signature settings can be adjusted on the transport panel. 
The left tempo field sets the tempo in bpm, and the tempo field to the right al-
lows you to fine tune the tempo, in steps of 1/1000 bpm.

D You can specify any tempo between 1 and 999.999 bpm (beats per 
minute).

D You can also adjust the tempo (in bpm steps) by using the [+] and 
[–] keys on the numeric keypad.

D You set the time signature by specifying a numerator (left value 
field) and a denominator (right value field).
The numerator is the number of beats per bar, and the denominator governs 
the length of a beat.

Song Position

The song position in Bars, Beats and 16th notes is shown (in that order) in the 
three fields below the transport controls. You can set the positions by using the 
spin controls.

D You can also set the position by double clicking on a Pos value box, 
typing in a new position (in the format “Bars.Beats.16th notes”) and 
pressing [Return].
If you only type one or two numbers, the remaining numbers will be set to 
their lowest values (e.g. type “5” to set the position to “5.1.1”)

Left and Right Locator Positions

The left and right locators are used for several things, like setting the boundaries 
of a loop or inserting/removing bars. You can set the positions for both locators 
by using the spin controls on the transport panel or by double clicking and typ-
ing a position value.

Loop On/Off

In loop mode, the sequencer will repeat a section over and over again, during 
playback or recording. You specify the section to be looped by setting the left 
and right locator.

Overdub/Replace Switch

When recording over a previously recorded section, this switch governs the fol-
lowing:

D In Overdub mode, the new recording is added to whatever was on 
the Track before. 

D In Replace mode, the new recording replaces any previously re-
corded notes.

! Note that controllers and pattern changes aren’t affected by this - 
recording controllers will always replace any previously recorded 
controller values. However, you may still want to set the switch to 
Overdub mode, to avoid accidentally removing some recorded 
notes in the area.
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Additional Transport Panel Items

Click

When this is activated, you will hear a click on each beat, with an accent on the 
downbeat of each bar. The click is played back during recording and playback. 
You can adjust the volume of the click by using the Level knob.

MIDI Sync and Focus

This section of the Transport Panel contains items relating to MIDI sync. 

D The “Enable” button puts Reason into MIDI sync mode. 
The transport controls will be disabled, and Reason will not run unless MIDI 
sync data is provided from an external device. 

The MIDI and Play Focus buttons relate to how incoming MIDI and MIDI sync 
should be handled if there are several open Song documents. If you have two or 
more Songs opened, and no MIDI sync is used, the currently selected Song (the 
document “on top”) always has MIDI focus. If MIDI Sync is enabled (which is 
global for all currently open Song documents), this functionality changes in the 
following way:

D If both “Play” and “MIDI” are activated for a Song, incoming MIDI 
data and MIDI sync will be sent to this Song, regardless of whether 
another Song is currently in focus.

D If only “MIDI” is activated for Song, and another Song has “Play” 
focus, incoming MIDI will be sent to the former and MIDI sync to the 
latter (i.e this Song will play back), regardless of which Song is cur-
rently in focus.

Automation Override

Automation override is activated when you manually “grab” a parameter that is 
being automated. If you change the setting of an automated parameter, the 
“Punched In” indicator lights up, and the automation data is temporarily overrid-
den, until you either click the “Reset” button or press stop on the transport. As 
soon as you click Reset, the automation regains control.

See also page 9.

Audio Out Clipping Indicator

All signals that are being fed into the Hardware Interface (to your audio hard-
ware’s physical outputs) are monitored for clipping (signal overload) at the out-
put stage. 

If clipping occurs this indicator will light up, and stay lit for several seconds. If 
this happens, you should reduce the output level, in one of the following ways:

D If the signals are being sent to your Hardware Interface via a Mixer, 
you should reduce the Master output level from the Mixer.
This will ensure that the relative levels of the mix are kept intact. Alternatively, 
if the current mix doesn’t represent a “final balance”, and the clipping seems 
to be caused by individual channels in the mixer, you could also try reducing 
the output of the connected device(s), or pulling down the channel faders a 
bit for the “offending” channels.

! Clipping can only occur in the output stage of the Hardware Inter-
face, not in the Reason mixer or in any other Reason device. How-
ever, it is good practice to keep all mixer channel and master levels 
as high as possible within the normal range, for best results. For ex-
ample, having to compensate channel levels by drastically reducing 
the Master output to avoid clipping is indicative of the mixer chan-
nel levels being set too high.
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D If the Audio Out Clipping indicator lights up, and the signals are be-
ing sent directly (not via a Mixer) to your Hardware Interface, you 
can check the meters in the Hardware Interface. If the red segment 
of any of these meters are momentarily lit, this indicates at which 
output(s) the clipping is occurring.
Reduce the output level of all devices connected to outputs whose meters 
show red.

CPU Meter

This bar graph shows the current CPU (processor) load. Note that this mea-
sures how much of the total processor power the Reason “audio engine” cur-
rently is using up. Graphics, MIDI and the “rest” of the Reason program is 
allotted the CPU power not used by the audio engine, so audio always has pri-
ority. See “Optimizing Performance” for more information.



TRANSPORT PANEL76



9 D Reason Hardware Interface



REASON HARDWARE INTERFACE78

Introduction

The Hardware Interface is where you connect Reason with the “outside world”. 
This is where MIDI is received, and where audio signals are routed to ReWire 
channels or to the physical outputs of your audio hardware. The Hardware Inter-
face is always present at the top of the rack, and cannot be deleted. This chap-
ter is meant to serve as a panel reference, describing the various sections of the 
device. How to set up your MIDI interface and audio hardware is described in 
the Getting Started book and in “About Audio on Computers”. 

The Hardware interface is divided into two sections: MIDI In Device and Audio 
Out.

MIDI In Device
Reason’s Hardware Interface can accommodate up to 64 channels of MIDI, di-
vided into 4 buses, each with 16 MIDI channels. There are two basic ways you 
can route incoming MIDI to Reason devices, which is set in the Preferences - 
MIDI and Advanced MIDI dialogs:

D Via the Sequencer.
If you choose this option, the selected track’s destination device automati-
cally receives incoming MIDI data. This means that you only have to send 
MIDI over the same port and channel as the sequencer is set to use (in the 
MIDI Preferences), to access any audio device in Reason. This is the easiest 
way of routing MIDI if you are using the built in sequencer. There are no set-
tings you need to make in the Hardware Interface if you use the Sequencer 
input.

D By using the MIDI “External Control” inputs.
This is set in the Advanced MIDI Preferences. You can select up to four 
buses (if your MIDI interface supports it), each with 16 MIDI channels. If this 
mode is used, you use the pop-up menu for each MIDI channel in the MIDI In 
device to select the destination device you would like to route the MIDI to. If 
you want to send MIDI to Reason over several channels simultaneously, you 
have to use the external control inputs.

Using External MIDI Control 
For each MIDI channel, the MIDI In Device contains the following items:

D The Device Pop-Up menu is used to select which device the channel 
should send MIDI to.
Only existing devices are available on the menu.

D The Name field displays the name of the device connected to the 
channel.
This is blank if no device is selected.

D A note on indicator shows if MIDI is received on this channel.

Bus Select Buttons

These four buttons labeled A, B, C and D are used to select which of the four 
buses is currently displayed in the MIDI In device. If you have a multiple port in-
terface you can use up to four buses (or ports), each with 16 MIDI channels. The 
Bus Select buttons determine which of the buses is currently in view in the MIDI 
In device.
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Audio Out
Reason supports up to 64 audio output channels.

D Each output features a meter and a green indicator which will be lit 
for each channel that is available.

! Remember that the Hardware Interface is where any possible audio 
clipping will occur in Reason. Keep an eye on the clipping indicator 
on the transport panel, and also on the individual meters in the Au-
dio Out panel. If a channel pushes the meter into the red, the output 
level of the device should be reduced.

Using ReWire
If you are running Reason together with a ReWire compatible host application, 
you can route any Reason device output to a ReWire channel by connecting the 
device to any of the audio inputs at the back of the Hardware Interface. In Re-
Wire mode, all 64 channels are available and any device output routed to a Re-
Wire channel will appear in the ReWire host application on it’s own channel. 
See “Using Reason as a ReWire Slave”.
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Introduction

The Mixer 14:2 allows you to control the level, stereo placement (Pan), tone 
(EQ) and effect mix (AUX Sends) of each connected audio device.

If you have ever used a conventional hardware audio mixer, you will most likely 
find the Mixer very straightforward to use. It is configured with 14 (stereo) input 
channels, which are combined and routed to the Left and Right Master outputs. 
The vertical channel “strips” are identical and contain - from the top down - four 
Auxiliary Sends, an EQ section, Mute and Solo buttons, Pan control, and a Level 
fader.

Every mixer parameter can of course be automated, and should the need arise 
for more mixer channels, you can simply create another mixer! 

! Note that if you haven’t created a mixer prior to creating an audio 
device, the audio device output will be auto-routed to your audio 
hardware outputs via the Reason Hardware Interface (Audio Out 
device). 

The Channel Strip

Each channel strip in the Mixer 14:2 contains the items listed on the next page:

AUX Sends 1-4

EQ Treble and Bass controls

EQ On/Off button

Mute (M) and Solo (S) buttons

Pan control

Channel fader

Channel meter

Channel label

Pre-fader switch for AUX Send 4
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Channel Strip Controls:

| Item | Description |Value Range

Channel Fader The channel fader is used to control the output level of each corresponding channel. 
By adjusting the faders, you can set the desired mix (balance) between different devices connected to the Mixer. 

0 - 127 

Channel Label Each channel in the mixer that has a device connected to it, displays a read-only label with the name of the device 
to the left of the fader.

N/A

Channel Meter The meter is a graphical representation of the channel output level. If the signal level pushes the meter into the 
range of the red area, try lowering either the output level of the device connected to the channel, or the channel 
fader itself, to avoid distortion.

N/A

Pan Control Use this control to set the left/right position of the channel in the stereo field. [Command]/[Ctrl]-click the Pan 
knob to set Pan to the default “0” (center position).

-64 – 0 – 63

Mute (M) and 
Solo (S) Buttons

Clicking a channel’s Mute button silences the output of that channel. Click the button again to unmute the chan-
nel.
Clicking a channel’s Solo button silences all other mixer channels, so that you only hear the soloed channel. Sev-
eral channels can be soloed at the same time, but if this is the case, note that soloed channels can’t be muted 
with the Mute button. To mute one of several channels in solo mode you simply “unsolo” it.

On/Off

EQ Treble and Bass 
controls

The EQ Treble and Bass controls is used to cut or boost the higher and lower frequencies of the signal, respec-
tively. Click on the EQ button to activate the EQ.
If you need more advanced EQ, you can always use a PEQ2 parametric EQ as an insert effect for a device.
Note also the two EQ modes - see page 84.

Treble: +/- 24 dB 
at 12 kHz.

Bass: +/- 24 dB at 
80 Hz.

Auxiliary (AUX) 
Effect Send 1-4

The four independent AUX Sends control the amount of channel signal that is to be sent to other devices - typi-
cally effect processors. The effect output is then normally returned to the Mixer via the AUX Return inputs (see 
page 84) where it is mixed with the dry (non-processed) signal. If you create an effect device when the Mixer is 
selected, the effect is auto-routed to the first available Send/Return connectors. You can then control the amount 
of effect that is to be applied to any device connected to a Mixer channel via the corresponding AUX Send knob. 
The AUX Send outputs are taken post channel fader, but you have the option of selecting Pre-fader mode for 
AUX Send 4 (by clicking the “P” button next to the send so that it lights up). In that mode, the send level is inde-
pendent of the channel fader.
The sends are in stereo but can be used in mono as well. 

0 - 127
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The Mixer signal flow
The basic signal flow for a channel in the Mixer is as follows:

Note that the Solo function is true “in-place” solo, meaning that if the channel 
uses Auxiliary sends routed to effect devices, the soloed output signal will also 
include the Aux Return signals (from the soloed channel(s) only). Hence, you will 
hear the soloed channel(s) including any Aux Send effects. 

Note also that if the pre-fader send mode is activated for Aux 4 the send is 
tapped after the EQ and Pan controls but before the channel fader.

About the EQ modes

With Reason 2.5, the EQ modules in the Mixer were improved to get an even 
better sound and character. However, if you want to play back songs made in 
previous Reason versions, you may want to use the “old” EQ mode to ensure 
that the songs sound exactly the same.

On the back of the Mixer you will find a switch for this - select “Improved EQ” for 
the new EQ types or “Compatible EQ” for the old-style EQ. The parameters are 
exactly the same in both cases.

The Auxiliary Return 
Section

The Auxiliary Returns provide an “extra” four stereo inputs in addition to the 
Mixer’s 14 stereo channels. The main function of Return channels is to provide 
inputs for connected Send effects devices. Each Aux Return channel has a level 
control, and a read-only tape label that display the name of the device con-
nected to the Return channel.

The Master Fader

The Master L/R fader controls the summed output level of all channels in the 
Mixer. Use this to change the relative level of all channels, to make fade-outs etc.

FaderEQ Mute AUX Sends

Solo Master L/R Output

Effects DevicesAUX Returns 

Input

Aux 4 pre-fader 
mode

Pan
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Connections
All input and output connectors are as usual located on the back panel of the 
Mixer 14:2. Special connectors are used for “chaining” two or more Mixers to-
gether. This is described on page 86.

Mixer Channel Connections

D Each mixer channel features stereo left/right inputs for connecting 
audio devices. 
Use the left input when manually connecting a mono signal source.

D In addition, there are two Control Voltage (CV) inputs (with associ-
ated voltage trim pots), for voltage controlling channel Level and 
Pan from other devices.

Auxiliary (AUX) Send Out

D There are four stereo Send Out connectors, which normally are 
used to connect to the inputs of effect devices.
To connect a send to a mono-input device, use the Left (Mono) output.

When a Send is connected to an effects device, the corresponding AUX Send 
knob determines the level of the signal sent to the effect device for each chan-
nel. The Send Output is taken post-channel fader but you have the option of se-
lecting pre-fader mode for AUX Send 4. 

D Note that some effects (for example the Comp-01 compressor or 
the PEQ2 parametric EQ) are effect types which are not designed to 
be used as AUX Send effects, but rather as insert effects, where the 
whole signal is passed through the effect. 
Alternatively, you could use AUX Send 4 in pre-fader mode and lower the 
channel fader completely.

Auxiliary (AUX) Returns

D There are four stereo Return input connectors.
These are normally connected to the left and right outputs of effect devices. 

Master Left/Right Outputs

D The Master outputs are auto-routed to the first available input pair 
on the Audio Hardware interface. 
This in turn sends the audio to the outputs of your audio hardware.

✪ Note that the Master outputs don’t have to be routed directly to the 
Audio Hardware Interface. You could for example route the Master 
outputs to an effect, and then route the effect outputs to the Hard-
ware Interface instead.

D In addition, there is a Control Voltage (CV) input (and an associated 
trim pot), for voltage controlling the Master Level from another de-
vice.



THE MIXER86

Chaining Mixers

Two chained Mixers are connected like this, the top Mixer being the “Master” Mixer.

If you need more Mixer channels, you can simply create a new Mixer. If you do 
this, the Mixers are automatically connected via the “Chaining Master” and 
“Chaining Aux” connectors.

D The newly created Mixer’s Master Output is connected to the origi-
nal Mixer’s Chaining Master input.
The Master Out Level for the new Mixer is now controllable from the original 
Mixer’s Master fader - so that this fader now controls the Master output level 
of both mixers.

D The newly created Mixer’s four stereo Aux Send outputs is con-
nected to the original Mixer’s Chaining Aux connectors.
The new Mixer will now have access to any Aux Send effects connected to 
the original Mixer, via the same corresponding Aux Send(s).

This way, the two Mixers operate as “one”. 

! One exception is the Mute/Solo function, which is not chained. 
Thus, soloing a channel in one of the Mixers, will not mute the chan-
nels in the other Mixer.

You can create as many Mixers as you like, they will be chained in the same way, 
with one Mixer remaining the “master” (i.e. it controls the Master level of all 
chained Mixers and supplies the Aux Send effect sources).

Partially or Non-Chained Mixers

You can also have several Mixers that are only partially or not chained at all. 

D You may for example wish to have different Aux Send effects for 
one Mixer. 
Then simply disconnect one or more of the Send Out to Chaining Aux con-
nectors, and assign new Send effects.

D You could for example send the Master output of one Mixer to an-
other Input pair on the Audio In Hardware interface, instead of the 
Chaining Master inputs.
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Introduction

At first glance, Redrum looks styled after pattern-based drum machines, like the 
legendary Roland 808/909 units. Indeed, it does have a row of 16 step buttons 
that are used for step programming patterns, just like the aforementioned clas-
sics. There are significant differences, however. Redrum features ten drum 
“channels” that can each be loaded with an audio file, allowing for completely 
open-ended sound possibilities. Don’t like the snare - just change it. Complete 
drum kits can be saved as Redrum Patches, allowing you to mix and match drum 
sounds and make up custom kits with ease.

About File Formats
Redrum reads two basic types of files:

Redrum Patches

A Redrum patch (Windows extension “.drp”) contains all settings for all ten 
drum sound channels, including file references to the used drum samples (but 
not the actual drum samples themselves). Switching patches is the same as se-
lecting a new drum kit.

Drum Samples

Redrum can read and play back sample files of the following formats:

• Wave (.wav)
• AIFF (.aif)
• SoundFonts (.sf2)
• REX file slices (.rex2, .rex, .rcy)
• Any bit depth
• Any sample rate
• Stereo or Mono

! All samples are stored internally in 16-bit format, regardless of their 
original bit depth or sample rate.

Wave and AIFF are the standard audio file formats for the PC and Mac plat-
forms, respectively. Any audio or sample editor, regardless of platform, can read 
and create audio files in at least one of these formats, and some of them in both 
formats.

SoundFonts are an open standard for wavetable synthesized audio, developed 
by E-mu systems and Creative Technologies.

SoundFont banks store wavetable synthesized sounds, allowing users to create 
and edit multi-sampled sounds in special Soundfont editing programs. The 
sounds can then be played back in wavetable synthesizers, typically on audio 
cards. The samples in a SoundFont are stored hierarchically in different catego-
ries: User Samples, Instruments, Presets etc. The Redrum allows you to browse 
and load single SoundFont samples, not entire soundfonts.

REX files are files created in ReCycle – a program designed for working with 
sampled loops. It works by “slicing” up a loop and making separate samples of 
each beat, which makes it possible to change the tempo of loops without affect-
ing the pitch and to edit the loop as if it was built up of individual sounds. The 
Redrum lets you browse REX files and load separate slices from it as individual 
samples.
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Using Patches
When you create a new Redrum device it is empty. Before it can play back any 
audio you must first load a Redrum patch (or create one from scratch, by loading 
individual drum samples). A Redrum patch contains settings for the ten drum 
sound channels, complete with file references to the drum samples used.

! Redrum patterns are not part of the patch! 

Loading a Patch
To load a patch, use one of the following methods:

D Use the browser to locate and open the desired patch.
To open the browser, select “Browse Redrum Patches” from the Edit menu 
or device context menu, or click the folder button in the patch section on the 
device panel.

D Once you have selected a patch, you can step between all the 
patches in the same folder by using the arrow buttons next to the 
patch name display.

D If you click on the patch name display on the device panel, a pop-up 
menu will appear, listing all patches in the current folder.
This allows you to quickly select another patch in the same folder, without 
having to step through each one in turn.

Checking the Sounds in a Patch
There are two ways you can listen to the sounds in a patch without programming 
a pattern:

D By clicking the Trigger (arrow) button at the top of each drum sound 
channel.

D By playing the keys C1 to A1 on your MIDI keyboard.
C1 plays drum sound channel 1 and so on. See also page 97.

Both these methods play back the drum sample for the corresponding drum 
sound channel, with all settings for the sound applied.

Creating a new Patch
To create a patch of your own (or modify an existing patch), you use the follow-
ing basic steps:

1. Click the folder button for a drum sound channel.
The Redrum sample browser opens.

2. Locate and open a drum sample.
You will find a large number of drum samples in the Factory Sound Bank (in 
the folder Redrum Drum Kits/xclusive drums-sorted). You can also use any 
AIFF, Wave, SoundFont sample or REX file slice for this.

3. Make the desired settings for the drum sound channel.
The parameters are described on page 93.

4. Repeat steps 1 and 3 for the other drum sound channels.

5. When you’re satisfied with the drum kit, you can save the patch by 
clicking the Floppy Disk button in the patch section on the device 
panel.
Note however, that you don’t necessarily need to save the patch - all settings 
are included when you save the song.

Loading REX file slices

Loading slices from within a REX file is done much in the same way as loading 
“regular” samples:

1. Open the sample browser as described above.

2. Browse to a REX file.
Possible extensions are “.rex2”, “.rex” and “.rcy”.

3. Select the file and click “Open”.
The browser will now display a list of all the separate slices within the REX 
file.

4. Select the desired slice and click open.
The slice is loaded into the Redrum.



REDRUM90

Creating an Empty Patch
To “initialize” the settings in the Redrum, select “Initialize Patch” from the Edit 
menu or the device context menu. This removes all samples for all drum sound 
channels, and sets all parameters to their default values.

Programming Patterns
About Pattern Selection
As described in the Getting Started book, each pattern device (such as the Re-
drum) has 32 pattern memories, divided into four banks. To select a pattern, 
click a Pattern button (or, if the desired pattern is in another bank, first click the 
Bank button and then click the Pattern button).

D If you select a new pattern during playback, the change will take ef-
fect on the next downbeat (according to the time signature set in 
the transport panel).
If you automate pattern changes in the main sequencer, you can make them 
happen at any position - see page 29.

D Note that you cannot load or save patterns - they are only stored as 
part of a song.
However, you can move patterns from one location to another (even be-
tween songs) by using the Cut, Copy and Paste Pattern commands. This is 
explained in the chapter “Using Pattern Devices” in the Getting Started 
book.

Pattern Programming Basics
If you are unfamiliar with step programming patterns, the basic principle is very 
intuitive and easy to learn. Proceed as follows:

1. Load a Redrum patch, if one isn’t already loaded.

2. Make sure an empty pattern is selected.
If you like, use the Clear Pattern command on the Edit menu or device con-
text menu to make sure.

3. Make sure that the “Enable Pattern Section” and the “Pattern” but-
tons are activated (lit).

4. Press the “Run” button.
There will be no sound, as no pattern steps have been recorded yet. But as 
you can see, the LEDs over the Step button light up consecutively, moving 
from left to right, and then starts over. Each Step button represents one 
“step” in the Pattern. 



REDRUM 91

5. Select a Redrum channel, by clicking the “Select” button at the bot-
tom of the channel.
The button lights up, indicating that this channel and the drum sound it con-
tains is selected.

6. While in Run mode, press Step button 1, so that it lights up.
The selected sound will now play every time Step 1 is “passed over”.

7. Clicking other Step buttons so they light up will play back the se-
lected sound as the sequencer passes those steps.
Clicking on a selected (lit) step button a second time removes the sound 
from that step and the button goes dark again. You can click and drag to 
add or remove steps quickly.

8. Select another Redrum channel to program steps for that sound.
Selecting a new sound or channel also removes the visual indications (static 
lit buttons) of step entries for the previously selected sound. The step but-
tons always show step entries for the currently selected sound.

9. Continue switching between sounds, and programming steps to 
build your pattern.
Note that you can erase or add step entries even if Run mode isn’t activated.

Setting Pattern Length
You may want to make settings for Pattern length, i.e the number of steps the 
pattern should play before repeating:

D Use the “Steps” spin controls to set the number of steps you wish 
the pattern to play.
The range is 1 to 64. You can always extend the number of steps at a later 
stage, as this will merely add empty steps at the end of the original pattern. 
You could also make it shorter, but that would (obviously) mean that the 
steps “outside” the new length won’t be heard. These steps aren’t erased 
though; if you raise the Steps value again, the steps will be played back 
again.

About the “Edit Steps” Switch

If you set the pattern length to more than 16 steps, the pattern steps following 
after the 16th won’t be visible, although they will play back. To view and be able 
to edit the next 16 steps, you have to set the Edit Steps switch to 17-32. To see 
and edit steps beyond 32 you set the switch to 33-48, and so on.

Setting Pattern Resolution

Redrum always follows the tempo setting on the transport panel, but you can 
also make Redrum play in different “resolutions” in relation to the tempo setting. 
Changing the Resolution setting changes the length of each step, and thereby 
the “speed” of the pattern.

This is explained in the chapter “Using Pattern Devices” in the Getting Started 
book.

Step Dynamics 
When you enter step notes for a drum sound, you can set the velocity value for 
each step to one of three values: Hard, Medium or Soft. This is done by setting 
the Dynamic switch before entering the note.

The color of the step buttons reflect the dynamics for each step. Soft notes are light yellow, 
Medium notes are orange and Hard are red.

D When the Medium value is selected, you can enter Hard notes by 
holding down [Shift] and clicking.
In the same way, you can enter Soft notes by holding down [Option] (Mac) 
or [Alt] (Windows) and clicking. Note that this doesn’t change the Dynamic 
setting on the device panel - it only affects the notes you enter.
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D When you use different dynamics, the resulting difference in the 
sound (loudness, pitch, etc.), is governed by the “VEL” knob set-
tings for each drum channel (see page 93). 
If no velocity amount is set for a drum channel, it will play back the same, re-
gardless of the Dynamic setting.

D To change the dynamics for an already programmed step, set the 
switch to the dynamic value you wish to change it to and click on 
the step.

! Note that if you are triggering Redrum via MIDI or from the main se-
quencer, the sounds will react to velocity like any other audio de-
vice. The Dynamic values are there to offer velocity control when 
using the built-in pattern sequencer.

Pattern Shuffle
Shuffle is a rhythmic feature, that gives the music a more or less pronounced 
swing feel. It works by delaying all sixteenth notes that fall in between the eighth 
notes.

You can activate or deactivate shuffle individually for each Redrum pattern by 
clicking the Shuffle button on the device panel.

However, the amount of shuffle is set globally with the Pattern Shuffle control on 
the transport panel.

Flam

A flam is when you double-strike a drum, to create a rhythmic or dynamic effect. 
Applying flam to a step entry will add a second “hit” to a drum sound. The flam 
amount knob determines the delay between the two hits.

To add a flam drum note, proceed as follows:

1. Activate flam by clicking the Flam button.

2. Click on a step to add a note (taking the Dynamic setting into ac-
count as usual).
A red LED is lit above the step to indicate that flam will be applied to that 
step.

3. Use the Flam knob to set the desired amount of flam.
The flam amount is global for all patterns in the device.

D To add or remove flam to or from an existing step note, click directly 
on the corresponding flam LED.
You can also click and drag on the LEDs to add or remove several flam 
steps quickly.

D Applying flam to several consecutive step entries is a quick way to 
produce drum rolls.
By adjusting the Flam knob you can create 1/32 notes even if the step reso-
lution is 1/16, for example.

The Pattern Enable switch

If you deactivate the “Pattern” button, the pattern playback will be muted, start-
ing at the next downbeat (exactly as if you had selected an empty (silent) pat-
tern). For example, this can be used for bringing different pattern devices in and 
out of the mix during playback.

The Enable Pattern Section switch
If this is deactivated, Redrum will function as a pure “sound module”, i.e. the in-
ternal Pattern sequencer is disengaged. Use this mode if you wish to control Re-
drum exclusively from the main sequencer or via MIDI (see page 97).
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Pattern Functions
When a Redrum device is selected, you will find some specific pattern functions 
on the Edit menu (and on the device context menu):

Chaining Patterns
When you have created several patterns that belong together, you most proba-
bly want to make these play back in a certain order. This is done by recording or 
inserting pattern changes into the main sequencer. See page 29.

Converting Pattern Data to Notes
You can convert Redrum Patterns to notes in the main sequencer. This allows 
you to edit the notes freely, create variations or use Groove quantizing. This is 
described on page 12.

Redrum Parameters
Drum Sound Settings
Redrum features ten drum sound channels that can each be loaded with a Wave 
or AIFF sample or a sample from a SoundFont bank. Although they are basically 
similar, there are three “types” of drum sound channels, with slightly different 
features. This makes some channels more suitable for certain types of drum 
sounds, but you are of course free to configure your drum kits as you like.

On the following pages, all parameters will be listed. If a parameter is available 
for certain drum sound channels only, this will be stated.

Mute & Solo

At the top of each drum sound channel, you will find a Mute (M) and a Solo (S) 
button. Muting a channel silences its output, while Soloing a channel mutes all 
other channels. Several channels can be muted or soloed at the same time.

You can also use keys on your MIDI keyboard to mute or solo individual drum 
sounds in real time. 

D The keys C2 to E3 (white keys only) will mute individual drum chan-
nels starting with channel 1.
The sounds are muted for as long as you hold the key(s) down.

D The keys C4 to E5 (white keys only) will solo individual drum chan-
nel, starting with channel 1.
The sounds are soloed for as long as you hold the key(s) down.

This is a great way to bring drum sounds in and out of the mix when playing Rea-
son live. You can also record the drum channel Mutes in the main sequencer, 
just like any other controller (see page 22).

| Function | Description

Shift Pattern Left/Right These functions move all notes in the pattern one 
step to the left or right.

Shift Drum Left/Right The Shift Drum functions move all notes for the se-
lected drum channel (the channel for which the Se-
lect button is lit) one step to the left or right. 

Randomize Pattern Creates a random pattern. Random patterns can be 
great starting points and help you get new ideas.

Randomize Drum Creates a random pattern for the selected drum 
sound only - the notes for the other drum sound 
channels are unaffected.

Alter Pattern The Alter Pattern function modifies the selected 
pattern by “shuffling” the current pattern notes and 
redistributing them among the drum sounds at ran-
dom. This creates a less chaotic pattern than the 
“Randomize Pattern” function.
Note that there must be something in the pattern 
for the function to work on - using an Alter function 
on an empty pattern will not do anything.

Alter Drum Works like the “Alter Pattern” function, but affects 
the selected drum sound only.

C2 C3 C4 C5

1 2 3 4 5 6 7 8 9 10 1 2 3 4 5 6 7 8 9 10

Mute Solo
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The Effect Sends (S1 & S2)

On the back panel of Redrum you will note two audio connections labeled 
“Send Out” 1 and 2. When you create a Redrum device, these will by default be 
auto-routed to the first two “Chaining Aux” inputs on the Mixer device (provided 
that these inputs aren’t already in use).

This feature allows you to add effects to independent drum sounds in the Re-
drum.

D Raising the S1 knob for a drum sound channel will send the sound 
to the first send effect connected to the mixer.
Similarly, the S2 knob governs the send level to the second send effect in 
the mixer.

D Note that there must be send effects connected to the AUX Sends 
and Returns in the mixer for this to work.

D Also note that if Redrum is soloed in the Mixer the effect sends will 
be muted.

D Another way to add independent effects to drum sounds is to use 
the independent drum outputs.
See page 97.

Pan

Sets the Pan (stereo position) for the channel.

D If the LED above the Pan control is lit, the drum sound uses a stereo 
sample.
In that case, the Pan control serves as a stereo balance control.

Level and Velocity

The Level knob sets the volume for the channel. However, the volume can also 
be affected by velocity (as set with the Dynamic value, or as played via MIDI). 
How much the volume should be affected by velocity is set with the “Vel” knob.

D If the Vel knob is set to a positive value, the volume will become 
louder with increasing velocity values.
The higher the Vel value, the larger the difference in volume between low 
and high velocity values.

D A negative value inverts this relationship, so that the volume de-
creases with higher velocity values.

D If the Vel knob is set to zero (middle position), the sound will play at 
a constant volume, regardless of the velocity.
When Vel is set to zero, the LED above the knob goes dark.

Length and the Decay/Gate switch

The Length knob determines the length of the drum sound, but the result de-
pends on the setting of the Decay/Gate switch:

D In Decay mode (switch down), the sound will decay (gradually fade 
out) after being triggered. The decay time is determined by the 
Length setting.
In this mode, it doesn’t matter for how long a drum note is held (if played 
back from the main sequencer or via MIDI) - the sound will play the same 
length for short notes as for long notes. This is the traditional “drum ma-
chine” mode.
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D In Gate mode (switch up), the sound will play for the set Length, and 
then be cut off.
Furthermore, if a sound set to Gate mode is played from the main se-
quencer, from a CV/Gate device or via MIDI, the sound will be cut off when 
the note ends or after the set Length, depending on which comes first. Or in 
other words, the sound plays for as long as you hold the note, but the Length 
setting serves as the maximum length for the sound.
There are several uses for the Gate mode:
• For “gated” drum sounds, when the tail of the sound is abruptly cut off as 

an effect.
• For when you want to use very short sounds, and don’t want them to “lose 

power” by being faded out.
• For when you play the Redrum from the sequencer or via MIDI, with sounds 

for which the length is important (e.g. when using the Redrum as a sound 
effects module).

! Audio samples sometimes contain a “loop”, which is set by editing 
the audio in a sample editor. This loop repeats a part of the sample 
to produce sustain as long as you hold down a note. Drum samples 
usually don’t contain loops, but who is to say that Redrum should 
only play drum samples? 
Note that if a sample contains a loop, and Length is set to maxi-
mum, the sound will have infinite sustain, in other words it will 
never become silent, even if you stop playback. Decreasing the 
Length setting solves this problem. 

Pitch

Sets the pitch of the sound. The range is +/- 1 octave.

D When the pitch is set to any other value than 0, the LED above the 
knob lights up to indicate that the sample isn’t played back at its 
original pitch.

Pitch Bend

By setting the Bend knob to a positive or negative value, you specify the start 
pitch of the sound (relative to the Pitch setting). The pitch of the sound will then 
be bent to the main Pitch value. Thus, selecting a positive Bend value will cause 
the pitch to start higher and bend down to the original Pitch, and vice versa.

D The Rate knob determines the bend time - the higher the value, the 
slower the bend.

D The Vel knob determines how the Bend amount should be affected 
by velocity.
With a positive Vel value, higher velocity results in wider pitch bends.

D The Bend and Vel knobs have LEDs that light up when the functions 
are activated (i.e. when a value other than zero is selected).

! Pitch bend is available for drum sound channels 6 and 7 only.

Tone

The Tone knob determines the brightness of the drum sound. Raising this pa-
rameter results in a brighter sound. The Vel knob determines whether the sound 
should become brighter (positive Vel value) or darker (negative Vel value) with 
higher velocity.

D The Tone and Vel knobs have LEDs that light up when the functions 
are activated (i.e. when a value other than zero is selected).

! The Tone controls are available for drum sound channels 1, 2 and 10 
only.

Sample Start

The Start parameter allows you to adjust the start point of the sample. The 
higher the Start value, the further the start point is moved “into” the sample. If 
you set the Start Velocity knob to a positive amount, the sample start point is 
moved forward with higher velocities. A negative Start Velocity amount inverts 
this relationship.
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D When Start Velocity is set to any other value than zero, the LED 
above the knob lights up.

D A negative Start Velocity amount is only useful if you have set the 
Start parameter to a value higher than 0.
By raising the Start value a bit and setting Start Velocity to a negative value, 
you can create rather realistic velocity control over some drum sounds. This 
is because the very first transients in the drum sound will only be heard when 
you play hard notes.

! The Sample Start settings are available for drum sound channels 3-
5, 8 and 9.

Global Settings

Channel 8 & 9 Exclusive

If this button is activated, the sounds loaded into drum channels 8 and 9 will be 
exclusive. In other words, if a sound is played in channel 8 it will be silenced the 
moment a sound is triggered in channel 9, and vice versa. 

The most obvious application for this feature is to “cut off” an open hi-hat with a 
closed hi-hat, just like a real one does.

High Quality Interpolation

When this is activated, the sample playback is calculated using a more ad-
vanced interpolation algorithm. This results in better audio quality, especially for 
drum samples with a lot of high frequency content.

D High Quality Interpolation uses more computer power - if you don’t 
need it, it’s a good idea to turn it off!
Listen to the drum sounds in a context and determine whether you think this 
setting makes any difference.

! If you are using a Macintosh with a G4 (Altivec) processor, turning 
High Quality Interpolation off makes no difference.

Master Level

The Master Level knob in the top left corner of the device panel governs the 
overall volume from Redrum.
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Using Redrum as a Sound 
Module
The drum sounds in Redrum can be played via MIDI notes. Each drum sound is 
triggered by a specific note number, starting at C1 (MIDI note number 36):

This allows you to play Redrum live from a MIDI keyboard or a MIDI percussion 
controller, or to record or draw drum notes in the main sequencer. If you like, you 
can combine pattern playback with additional drum notes, such as fills and vari-
ations. However:

! If you want to use Redrum purely as a sound module (i.e. without 
pattern playback) you should make sure that the “Enable Pattern 
Section” button is deactivated.
Otherwise, the Redrum pattern sequencer will start as soon as you 
start the main sequencer.

Connections

On the back of the Redrum you will find the following connections:

For each drum sound channel:

C1 C2

1

2

3

4

5 6

7

8

9

10
| Connection | Description

Audio Outputs There are individual audio outputs for each drum sound 
channel, allowing you to route a drum sound to a separate 
channel in the mixer, possibly via insert effects, etc. 
For mono sounds, use the “Left (Mono)” output (and pan 
the sound using the Pan control in the mixer).
When you use an individual output for a sound, the sound is 
automatically excluded from the master stereo output.

Gate Out This sends out a gate signal when the drum sound is played 
(from a pattern, via MIDI or by using the Trigger button on 
the device panel). This lets you use the Redrum as a “trig 
sequencer”, controlling other devices.
The length of the gate signal depends on the Decay/Gate 
setting for the sound: In Decay mode, a short “trig pulse” is 
sent out, while in Gate mode, the gate signal will have the 
same length as the drum note (see page 94).

Gate In Allows you to trigger the sound from another CV/Gate de-
vice. All settings apply, just as when playing the drum sound 
conventionally.

Pitch CV In Lets you control the pitch of the drum sound from another 
CV device.
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Others

| Connection | Description

Send Out 1-2 Outputs for the send signals controlled with the S1 and S2 
knobs, as described on page 94.

Stereo Out This is the master stereo output, outputting a mix of all 
drum sounds (except those for which you use individual 
outputs).
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Introduction
Subtractor is an analog-type polyphonic synthesizer based on subtractive syn-
thesis, the method used in analog synthesizers. This chapter will go through all 
parameters of each section of Subtractor. In addition to the parameter descrip-
tions, the chapter also includes a few tips and tricks to help you get the most out 
of the Subtractor synthesizer.

! It is recommended that you start with default settings (an “Init 
Patch”) if you intend to follow the examples in this chapter, unless 
otherwise is stated. An Init Patch is created by selecting “Initialize 
Patch” from the Edit menu. If you wish to keep the current settings, 
save them before initializing.

The Subtractor has the following basic features:

D Up to 99 Voice Polyphony.
You can set the number of voices for each Patch.

D Dual Filters.
A combination of a multimode filter and a second, linkable, lowpass filter al-
lows for complex filtering effects. See page 105.

D Two Oscillators, each with 32 waveforms.
See page 100.

D Frequency Modulation (FM). 
See page 104.

D Oscillator Phase Offset Modulation.
This is an unique Subtractor feature that generates waveform variations. See 
page 103.

D Two Low Frequency Oscillators (LFO:s)
See page 111.

D Three Envelope Generators.
See page 109.

D Extensive Velocity Control.
See page 113.

D Extensive CV/Gate Modulation possibilities.
See page 116.

! Loading and saving Patches is described in the chapter “Working 
with Patches” in the Getting Started book.

The Oscillator Section

Subtractor provides two oscillators. Oscillators are the main sound generators 
in Subtractor, the other features are used to shape the sound of the oscillators. 
Oscillators generate two basic properties, waveform and pitch (frequency). The 
type of waveform the oscillator produces determines the harmonic content of 
the sound, which in turn affects the resultant sound quality (timbre). Selecting a 
oscillator waveform is usually the starting point when creating a new Subtractor 
Patch from scratch.

Oscillator 1 Waveform

Oscillator 1 provides 32 waveforms. The first four are standard waveforms, and 
the rest are “special” waveforms, some of which are suitable for emulating vari-
ous musical instrument sounds.

✪ It is worth noting here that all waveforms can be radically trans-
formed using Phase offset modulation (see page 103). 

D To select a waveform, click the spin controls to the right of the 
“Waveform” LED display. 
The first 4 basic waveforms are shown as standard symbols, and the special 
waveforms are numbered 5 - 32. 

Here follows a brief description of the Subtractor waveforms:
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! Please note that the descriptions of the waveforms sound or timbre 
is merely meant to provide a basic guideline, and shouldn’t be 
taken too literally. Given the myriad ways you can modulate and 
distort a waveform in Subtractor, you can produce extremely differ-
ent results from any given waveform.

Setting Oscillator 1 Frequency - Octave/
Semitone/Cent

By clicking the corresponding up/down buttons you can tune, i.e. change the 
frequency of Oscillator 1 in three ways:

| Waveform | Description

Sawtooth This waveform contains all harmonics and produces a bright and 
rich sound. The Sawtooth is perhaps the most “general purpose” 
of all the available waveforms.

Square A square wave only contains odd number harmonics, which pro-
duces a distinct, hollow sound.

Triangle The Triangle waveform generates only a few harmonics, spaced 
at odd harmonic numbers. This produces a flute-like sound, with a 
slightly hollow character.

Sine The sine wave is the simplest possible waveform, with no harmon-
ics (overtones). The sine wave produces a neutral, soft timbre.

5 This waveform emphasizes the higher harmonics, a bit like a saw-
tooth wave, only slightly less bright-sounding.

6 This waveform features a rich, complex harmonic structure, suit-
able for emulating the sound of an acoustic piano.

7 This waveform generates a glassy, smooth timbre. Good for elec-
tric piano-type sounds.

8 This waveform is suitable for keyboard-type sounds such as harp-
sichord or clavinet.

9 This waveform is suitable for electric bass-type sounds.

10 This is a good waveform for deep, sub-bass sounds.

11 This produces a waveform with strong formants, suitable for 
voice-like sounds.

12 This waveform produces a metallic timbre, suitable for a variety of 
sounds.

13 This produces a waveform suitable for organ-type sounds.

14 This waveform is also good for organ-type sounds. Has a brighter 
sound compared to waveform 13.

15 This waveform is suitable for bowed string sounds, like violin or 
cello.

16 Similar to 15, but with a slightly different character.

17 Another waveform suitable for string-type sounds.

18 This waveform is rich in harmonics and suitable for steel string 
guitar-type sounds.

19 This waveform is suitable for brass-type sounds.

20 This waveform is suitable for muted brass-type sounds.

21 This waveform is suitable for saxophone-like sounds.

22 A waveform suitable for brass and trumpet-type sounds.

23 This waveform is good for emulating mallet instruments such as 
marimba.

24 Similar to 23, but with a slightly different character.

25 This waveform is suitable for guitar-type sounds.

26 This is a good waveform for plucked string sounds, like harp.

27 Another waveform suitable for mallet-type sounds (see 23-24), 
but has a brighter quality, good for vibraphone-type sounds.

28 Similar to 27, but with a slightly different character.

29 This waveform has complex, enharmonic overtones, suitable for 
metallic bell-type sounds.

30 Similar to 29, but with a slightly different character. By using FM 
(see page 104) and setting the Osc Mix to Osc 1, this and the fol-
lowing two waveforms can produce noise.

31 Similar to 30, but with a slightly different character.

32 Similar to 30, but with a slightly different character.

| Waveform | Description
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D In Octave steps 
The range is 0 - 9. The default setting is 4 (where “A” above middle “C” on 
your keyboard generates 440 Hz). 

D In Semitone steps 
Allows you to raise the frequency in 12 semitone steps (1 octave).

D In Cent steps (100th of a semitone) 
The range is -50 to 50 (down or up half a semitone).

Oscillator Keyboard Tracking

Oscillator 1 has a button named “Kbd. Track”. If this is switched off, the oscilla-
tor pitch will remain constant, regardless of any incoming note pitch messages, 
although the oscillator still reacts to note on/off messages. This can be useful for 
certain applications:

D When Frequency Modulation (FM - see page 104) or Ring Modula-
tion (see page 105) is used.
This produces enharmonic sounds with very varying timbre across the key-
board.

D For special effects and non-pitched sounds (like drums or percus-
sion) that should sound the same across the keyboard.

Using Oscillator 2

You activate Osc 2 by clicking the button next to the text “Osc 2“. Setting oscil-
lator frequency and keyboard tracking is identical to Oscillator 1.

Adding a second oscillator enables many new modulation possibilities which 
can produce richer timbres. A basic example is to slightly detune (+/– a few 
cents) one of the oscillators. This slight frequency offset causes the oscillators 
to “beat” against each other, producing a wider and richer sound. Also, by com-
bining two different waveforms, and adding frequency or ring modulation, many 
new timbres can be created.

Oscillator Mix 

The Osc Mix knob determines the output balance between Osc 1 and Osc 2. To 
be able to clearly hear both oscillators, the “Osc Mix” knob should be set some-
where around the center position. If you turn the Mix knob fully to the left, only 
Osc 1 will be heard, and vice versa. [Command]/[Ctrl]-clicking the knob sets the 
Mix parameter to center position.

Oscillator 2 Waveform
The waveform alternatives for Oscillator 2 are identical to those of Oscillator 1.

However, the Noise Generator provides a third sound generating source (in ad-
dition to the two oscillators) in Subtractor, and could be regarded as an “extra” 
waveform for Oscillator 2, as it is internally routed to the Oscillator 2 output. See 
below for a description of the Noise Generator.
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Noise Generator

The Noise Generator could be viewed as an oscillator that produces noise in-
stead of a pitched waveform. Noise can be used to produce a variety of sounds, 
the classic example being “wind” or “rolling wave” sounds, where noise is 
passed through a filter while modulating the filter frequency. Other common ap-
plications include non-pitched sounds like drums and percussion, or simulating 
breath noises for wind instruments. To use the Noise Generator, select an Init 
Patch and proceed as follows:

1. Turn Osc 2 off.

2. Click the button (in the Noise Generator section) to activate the 
Noise Generator.
If you play a few notes on your MIDI instrument you should now hear Osc1 
mixed with the sound of the Noise Generator.

3. Turn the Mix knob fully to the right, and play a few more notes.
Now just the Noise Generator will be heard. 

D Thus, the output of the Noise Generator is internally routed to Osc 
2.
If you switch Osc 2 on, the noise will be mixed with the Osc 2 waveform.

There are three Noise Generator parameters. These are as follows:

Phase Offset Modulation
A unique feature of the Subtractor oscillators is the ability to create an extra 
waveform within one oscillator, to offset the phase of that extra waveform, and to 
modulate this phase offset. By subtracting or multiplying a waveform with a 
phase offset copy of itself, very complex waveforms can be created. Sounds 
complicated? Well, the theory behind it might be, but from a user perspective it 
is just a method of generating new waveforms from existing waveforms.

A seasoned synth programmer using Subtractor for the first time may wonder 
why the Subtractor oscillators (seemingly) cannot provide the commonly used 
pulse waveform and the associated pulse width modulation (PWM). Or oscilla-
tor sync, another common feature in analog synthesizers. The simple answer is 
that Subtractor can easily create pulse waveforms (with PWM) and oscillator 
sync-sounds, and a lot more besides, partly by the use of phase offset modula-
tion.

Each oscillator has it's own Phase knob and a selector button. The Phase knob 
is used to set the amount of phase offset, and the selector switches between 
three modes:

• Waveform multiplication (x) 
• Waveform subtraction (–) 
• No phase offset modulation (o).

| Parameter | Description

Noise Decay This controls how long it takes for the noise to fade out when 
you play a note. Note that this is independent from the Amp 
Envelope Decay parameter (see page 110), allowing you to 
mix a short “burst” of noise at the very beginning of a sound, 
i.e. a pitched sound that uses oscillators together with noise.

Noise Color This parameter allows you to vary the character of the noise. If 
the knob is turned fully clockwise, pure or “white” noise 
(where all frequencies are represented with equal energy) is 
generated. Turning the knob anti-clockwise produces a grad-
ually less bright sounding noise. Fully anti-clockwise the noise 
produced is an earthquake-like low frequency rumble.

Level Controls the level of the Noise Generator.
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When phase offset modulation is activated, the oscillator creates a second 
waveform of the same shape and offsets it by the amount set with the Phase 
knob. Depending on the selected mode, Subtractor then either subtracts or mul-
tiplies the two waveforms with each other. The resulting waveforms can be seen 
in the illustration below.

• In example 1, we see two sawtooth waves with a slight offset. 
• Example 2 shows that subtracting one slightly offset sawtooth wave from the 

other, produces a pulse wave. If you modulate the Phase offset parameter 
(with for example an LFO), the result will be pulse width modulation (PWM).

• Example 3 shows the resulting waveform when multiplying the offset waves 
with each other. As you can see (and hear if you try it), multiplying waveforms 
can produce very dramatic and sometimes unexpected results.

Using phase offset modulation can create very rich and varied timbres, espe-
cially when used along with LFO or Envelopes to modulate the phase offset.

✪ To get a “feel” for this concept, you could study Patches that use 
phase offset modulation, and maybe tweak some of the Phase Off-
set parameters to find out what happens. Try “SyncedUp” in the 
Polysynth category in the Factory Soundbank for an example of osc 
sync or “Sweeping Strings” (in the Pads category) for an example 
of PWM.

! Note that if you activate waveform subtraction with a Phase offset 
set to “0” for an oscillator, the second waveform will cancel out the 
original waveform completely, and the oscillator output will be si-
lent. If you set the Phase Offset knob to any other value than zero, 
the sound returns.

Frequency Modulation (FM)

In synthesizer-speak, Frequency Modulation, or FM, is when the frequency of 
one oscillator (called the “carrier”) is modulated by the frequency of another os-
cillator (called the “modulator”). Using FM can produce a wide range of har-
monic and non harmonic sounds. In Subtractor, Osc 1 is the carrier and Osc 2 
the modulator. To try out some of the effects FM can produce, proceed as fol-
lows:

1. Select an Init Patch by selecting “Initialize Patch” from the Edit 
menu.

2. Activate Osc 2.
As you need both a carrier and a modulator to produce FM, turning the FM 
knob will not produce any effect unless you first activate Osc 2. For classic 
FM sounds, use sine wave on oscillator 1 and triangle wave on oscillator 2.

3. Use the FM knob to set the FM amount to a value of about 50.
As you can hear, the timbre changes, but the effect isn’t very pronounced 
yet.

4. Turn the Osc Mix knob fully to the left, so that only the sound of Osc 
1 is heard.
The modulator (Osc 2) still affects Osc 1, even though the Osc 2 output is 
muted.

5. Now, hold down a note on your MIDI keyboard and tune Osc 2 a 
fifth up from the original pitch by setting the Osc 2 frequency 
“Semi” parameter to a value of 7.
As you can hear, for each semitone step you vary the Osc 2 frequency, the 
timbre changes dramatically. Setting Osc 2 frequency to certain musical in-
tervals (i.e. fourth, fifth or octave semitone steps) produces harmonic, rich 
timbres, almost like tube distortion. Setting Osc 2 to non-musical intervals 
usually results in complex, enharmonic timbres.

✪ Experiment with different oscillator parameters such as phase off-
set modulation, changing the waveforms etc. and listen to how they 
affect the sound of frequency modulation.

Using the Noise Generator as the Modulator source

As explained earlier, the Noise Generator is internally routed to the Osc 2 out-
put. Hence, if you deactivate Osc 2, and activate the Noise Generator while us-
ing FM, the noise will be used to frequency modulate Osc 1. 

1. The two offset 
waveforms:
1. The two offset 
waveforms:

2. The result of 
subtraction:

3. The result of 
multiplication:

Ampl.

Ampl.

Ampl.

t.

t.

t.
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✪ With the Noise Generators default settings, this will sound much 
like colored noise. But by changing (lowering) the Noise Generator 
Decay parameter, so that the noise modulates only the attack por-
tion of the sound can produce more interesting results. You could 
also use a combination of noise and Osc 2.

Ring Modulation

Ring Modulators basically multiply two audio signals together. The ring modu-
lated output contains added frequencies generated by the sum of, and the differ-
ence between, the frequencies of the two signals. In the Subtractor Ring 
Modulator, Osc 1 is multiplied with Osc 2 to produce sum and difference fre-
quencies. Ring modulation can be used to create complex and enharmonic, bell-
like sounds.

1. Select an Init Patch by selecting “Initialize Patch” from the Edit 
menu.
Save any current settings you wish to keep before initializing.

2. Activate Ring Modulation with the button in the lower right corner 
of the oscillator section.

3. Activate Osc 2.
You need to activate Osc 2 before any ring modulation can happen.

4. Turn the Osc Mix knob fully to the right, so that only the sound of 
Osc 2 is heard.
Osc 2 provides the ring modulated output.

5. If you play a few notes while varying the frequency of either oscilla-
tor, by using the Semitone spin controls, you can hear that the tim-
bre changes dramatically.
If the oscillators are tuned to the same frequency, and no modulation is ap-
plied to either the Osc 1 or 2 frequency, the Ring Modulator won’t do much. 
It is when the frequencies of Osc 1 and Osc 2 differ, that you get the “true” 
sound of ring modulation.

The Filter Section

In subtractive synthesis, a filter is the most important tool for shaping the overall 
timbre of the sound. The filter section in Subtractor contains two filters, the first 
being a multimode filter with five filter types, and the second being a low-pass fil-
ter. The combination of a multimode filter and a lowpass filter can be used to 
create very complex filter effects.

Filter 1 Type
With this multi-selector you can set Filter 1 to operate as one of five different 
types of filter. The five types are illustrated and explained on the following pages:
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D 24 dB Lowpass (LP 24)
Lowpass filters lets low frequencies pass and cuts out the high frequencies. 
This filter type has a fairly steep roll-off curve (24dB/Octave). Many classic 
synthesizers (Minimoog/Prophet 5 etc.) use this filter type.

The darker curve illustrates the roll-off curve of the 24dB Lowpass Filter. The lighter 
curve in the middle represents the filter characteristic when the Resonance parameter is 
raised.

D 12 dB Lowpass (LP 12)
This type of lowpass filter is also widely used in analog synthesizers (Ober-
heim, early Korg synths etc.). It has a gentler slope (12 dB/Octave), leaving 
more of the harmonics in the filtered sound compared to the LP 24 filter.

The darker curve illustrates the roll-off curve of the 12dB Lowpass Filter. The lighter 
curve in the middle represents the filter characteristic when the Resonance parameter is 
raised.
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D Bandpass (BP 12)
A bandpass filter cuts both high and low frequencies, while midrange fre-
quencies are not affected. Each slope in this filter type has a 12 dB/Octave 
roll-off.

The darker curve illustrates the roll-off curve of the Bandpass Filter. The lighter curve in 
the middle represents the filter characteristic when the Resonance parameter is raised.

D Highpass (HP12)
A highpass filter is the opposite of a lowpass filter, cutting out the lower fre-
quencies and letting the high frequencies pass. The HP filter slope has a 12 
dB/Octave roll-off.

The darker curve illustrates the roll-off curve of the Highpass Filter. The lighter curve in 
the middle represents the filter characteristic when the Resonance parameter is raised.
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D Notch
A notch filter (or band reject filter) could be described as the opposite of a 
bandpass filter. It cuts off frequencies in a narrow midrange band, letting the 
frequencies below and above through. On it’s own, a notch filter doesn’t re-
ally alter the timbre in any dramatic way, simply because most frequencies 
are let through. However, by combining a notch filter with a lowpass filter 
(using Filter 2 - see page 109 in this chapter), more musically useful filter 
characteristics can be created. Such a filter combination can produce soft 
timbres that still sound “clear”. The effect is especially noticeable with low 
resonance (see page 108) settings.

The darker curve illustrates the roll-off curve of the Notch Filter. The lighter curve in the 
middle represents the filter characteristic when the Resonance parameter is raised.

Filter 1 Frequency 
The Filter Frequency parameter (often referred to as “cutoff”) determines which 
area of the frequency spectrum the filter will operate in. For a lowpass filter, the 
frequency parameter could be described as governing the “opening” and “clos-
ing” of the filter. If the Filter Freq is set to zero, none or only the very lowest fre-
quencies are heard, if set to maximum, all frequencies in the waveform are heard. 
Gradually changing the Filter Frequency produces the classic synthesizer filter 
“sweep” sound.

! Note that the Filter Frequency parameter is usually controlled by 
the Filter Envelope (see page 110) as well. Changing the Filter Fre-
quency with the Freq slider may therefore not produce the expected 
result.

Resonance 
The filter resonance parameter is used to set the Filter characteristic, or quality. 
For lowpass filters, raising the filter Res value will emphasize the frequencies 
around the set filter frequency. This produces a generally thinner sound, but with 
a sharper, more pronounced filter frequency “sweep”. The higher the filter Res 
value, the more resonant the sound becomes until it produces a whistling or 
ringing sound. If you set a high value for the Res parameter and then vary the fil-
ter frequency, this will produce a very distinct sweep, with the ringing sound be-
ing very evident at certain frequencies.

• For the highpass filter, the Res parameter operates just like for the lowpass 
filters.

• When you use the Bandpass or Notch filter, the Resonance setting adjusts 
the width of the band. When you raise the Resonance, the band where fre-
quencies are let through (Bandpass), or cut (Notch) will become narrower. 
Generally, the Notch filter produces more musical results using low reso-
nance settings.

Filter Keyboard Track (Kbd)
If Filter Keyboard Track is activated, the filter frequency will increase the further 
up on the keyboard you play. If a lowpass filter frequency is constant (a Kbd set-
ting of “0”) this can introduce a certain loss of “sparkle” in a sound the higher up 
the keyboard you play, because the harmonics in the sound are progressively 
being cut. By using a degree of Filter Keyboard Tracking, this can be compen-
sated for.
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Filter 2 
A very useful and unusual feature of the Subtractor Synthesizer is the presence 
of an additional 12dB/Oct lowpass filter. Using two filters together can produce 
many interesting filter characteristics, that would be impossible to create using a 
single filter, for example formant effects. 

The parameters are identical to Filter 1, except in that the filter type is fixed, and 
it does not have filter keyboard tracking.

D To activate Filter 2, click the button at the top of the Filter 2 section. 
Filter 1 and Filter 2 are connected in series. This means that the output of Fil-
ter 1 is routed to Filter 2, but both filters function independently. For exam-
ple, if Filter 1 was filtering out most of the frequencies, this would leave Filter 
2 very little to “work with”. Similarly, if Filter 2 had a filter frequency setting of 
“0”, all frequencies would be filtered out regardless of the settings of Filter 1.

✪ Try the “Singing Synth” patch (in the Monosynth category of the 
Factory Sound Bank) for an example of how dual filters can be 
used.

Filter Link

When Link (and Filter 2) is activated, the Filter 1 frequency controls the fre-
quency offset of Filter 2. That is, if you have set different filter frequency values 
for Filter 1 and 2, changing the Filter 1 frequency will also change the frequency 
for Filter 2, but keeping the relative offset. 

✪ Try the “Fozzy Fonk” patch (in the Polysynth category of the Fac-
tory Sound Bank) for an example how linked filters can be used.

! Caution! If no filter modulation is used, and the filters are linked, 
pulling down the frequency of Filter 2 to zero will cause both filters 
to be set to the same frequency. If combined with high Res settings, 
this can produce very loud volume levels that cause distortion!

Envelopes - General
Envelope generators are used to control several important sound parameters in 
analog synthesizers, such as pitch, volume, filter frequency etc. Envelopes gov-
ern how these parameters should respond over time - from the moment a note is 
struck to the moment it is released. 

Standard synthesizer envelope generators have four parameters; Attack, Decay, 
Sustain and Release (ADSR). 

There are three envelope generators in the Subtractor, one for volume, one for 
the Filter 1 frequency, and one modulation envelope which has selectable mod-
ulation destinations. 

The ADSR envelope parameters.

Attack

When you play a note on your keyboard, the envelope is triggered. This means it 
starts rising from zero to the maximum value. How long this should take, de-
pends on the Attack setting. If the Attack is set to “0”, the maximum value is 
reached instantly. If this value is raised, it will take time before the maximum 
value is reached.

For example, if the Attack value is raised and the envelope is controlling the filter 
frequency, the filter frequency will gradually rise up to a point each time a key is 
pressed, like an “auto-wha” effect. 

Attack
(time)

Decay
(time)

Sustain
(level)

Release
(time)

Key Down Key Up

Level

Time
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Decay

After the maximum value has been reached, the value starts to drop. How long 
this should take is governed by the Decay parameter. 

If you wanted to emulate the volume envelope of a note played on a piano for ex-
ample, the Attack should be set to “0” and the Decay parameter should be set to 
a medium value, so that the volume gradually decreases down to silence, even if 
you keep holding the key down. Should you want the decay to drop to some 
other value than zero, you use the Sustain parameter.

Sustain

The Sustain parameter determines the level the envelope should rest at, after the 
Decay. If you set Sustain to full level, the Decay setting is of no importance since 
the volume of the sound is never lowered.

If you wanted to emulate the volume envelope of an organ, you theoretically only 
really need to use the Sustain parameter set to full level, as a basic organ volume 
envelope instantly goes to the maximum level (Attack “0”) and stays there (De-
cay “0”), until the key is released and the sound instantly stops (Release “0”). 

But often a combination of Decay and Sustain is used to generate envelopes 
that rise up to the maximum value, then gradually decreases to finally land to rest 
on a level somewhere in-between zero and maximum. Note that Sustain repre-
sents a level, whereas the other envelope parameters represent times.

Release

Finally, we have the Release parameter. This works just like the Decay parame-
ter, except it determines the time it takes for the value to fall back to zero after re-
leasing the key.

Amplitude Envelope

The Amplitude Envelope is used to adjust how the volume of the sound should 
change from the time you press a key until the key is released. By setting up a 
volume envelope you sculpt the sound’s basic shape with the four Amplitude En-
velope parameters, Attack, Decay, Sustain and Release. This determines the ba-
sic character of the sound (soft, long, short etc.).

Filter Envelope

The Filter Envelope affects the Filter 1 Frequency parameter. By setting up a fil-
ter envelope you control the how the filter frequency should change over time 
with the four Filter Envelope parameters, Attack, Decay, Sustain and Release. 

Filter Envelope Amount

This parameter determines to what degree the filter will be affected by the Filter 
Envelope. Raising this knob’s value creates more drastic results. The Envelope 
Amount parameter and the set Filter Frequency are related. If the Filter Freq 
slider is set to around the middle, this means that the moment you press a key 
the filter is already halfway open. The set Filter Envelope will then open the filter 
further from this point. The Filter Envelope Amount setting affects how much fur-
ther the filter will open.

Filter Envelope Invert

If this button is activated, the envelope will be inverted. For example, normally the 
Decay parameter lowers the filter frequency, but after activating Invert it will in-
stead raise it, by the same amount. 
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Mod Envelope

The Mod Envelope allows you to select one of a number of parameters, or Des-
tinations, to control with the envelope. By setting up a modulation envelope you 
control the how the selected Destination parameter should change over time 
with the four Mod Envelope parameters, Attack, Decay, Sustain and Release. 

The available Mod Envelope Destinations are as follows:

LFO Section

LFO stands for Low Frequency Oscillator. LFOs are oscillators, just like Osc 1 & 
2, in that they also generate a waveform and a frequency. However, there are 
two significant differences:

• LFOs only generate waveforms with low frequencies.
• The output of the two LFOs are never actually heard. Instead they are used 

for modulating various parameters.

The most typical application of an LFO is to modulate the pitch of a (sound gen-
erating) oscillator, to produce vibrato. Subtractor is equipped with two LFO’s. 
The parameters and the possible modulation destinations vary somewhat be-
tween LFO 1 and LFO 2.

LFO 1 Parameters
Waveform

LFO 1 allows you to select different waveforms for modulating parameters. 
These are (from top to bottom):

| Destination | Description

Osc 1 Selecting this makes the Mod Envelope control the pitch (fre-
quency) of Osc 1.

Osc 2 Same as above, but for Osc 2.

Osc Mix Selecting this makes the Mod Envelope control the oscillator 
Mix parameter. Both oscillators must be activated for this to 
have any effect.

FM Selecting this makes the Mod Envelope control the FM Amount 
parameter. Both oscillators must be activated for this to have 
any effect.

Phase Selecting this makes the Mod Envelope control the Phase Off-
set parameter for both Osc 1 and 2. Note that Phase Offset 
Modulation (Subtraction or Multiplication) must be activated for 
this to have any effect (see page 103).

Freq 2 Selecting this makes the Mod Envelope control the Frequency 
parameter for Filter 2.

| Waveform | Description

Triangle This is a smooth waveform, suitable for normal vibrato.

Inverted Saw-
tooth

This produces a “ramp up” cycle. If applied to an oscillator’s 
frequency, the pitch would sweep up to a set point (governed 
by the Amount setting), after which the cycle immediately starts 
over.

Sawtooth This produces a “ramp down” cycle, the same as above but in-
verted.

Square This produces cycles that abruptly changes between two val-
ues, usable for trills etc.

Random Produces random stepped modulation to the destination. On 
some vintage synths, this is called “sample & hold”.

Soft Random The same as above, but with smooth modulation.
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Destination

The available LFO 1 Destinations are as follows:

Sync

By clicking this button you activate/deactivate LFO sync. The frequency of the 
LFO will then be synchronized to the song tempo, in one of 16 possible timedi-
visions. When sync is activated, the Rate knob (see below) is used for setting 
the desired timedivision.

Turn the knob and check the tooltip for an indication of the time division.

Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster modu-
lation rate.

Amount

This parameter determines to what degree the selected parameter destination 
will be affected by LFO 1. Raising this knob’s value creates more drastic results.

LFO 2 Parameters
LFO 2 is polyphonic. This means that for every note you play, an independent 
LFO cycle is generated, whereas LFO 1 always modulates the destination pa-
rameter using the same “cycle”. This can be used to produce subtle cross-mod-
ulation effects, with several LFO cycles that “beat” against each other. This also 
enables LFO 2 to produce modulation rates that vary across the keyboard (see 
the “Keyboard Tracking” parameter below). 

Destination

The available LFO 2 Destinations are as follows:

LFO 2 Delay

This parameter is used to set a delay between when a note is played and when 
the LFO modulation “kicks in”. For example, if Osc 1 & 2 is selected as the des-
tination parameter and Delay was set to a moderate value, the sound would start 
out unmodulated, with the vibrato only setting in if you hold the note(s) long 
enough. Delayed LFO modulation can be very useful, especially if you are play-
ing musical instrument-like sounds like violin or flute. Naturally it could also be 
used to control more extreme modulation effects and still retain the “playability” 
of the sound.

LFO 2 Keyboard Tracking

If LFO keyboard tracking is activated, the LFO rate will progressively increase 
the higher up on the keyboard you play. Raising this knob’s value creates more 
drastic results.

✪ If the LFO is set to modulate the phase offset, LFO keyboard track-
ing can produce good results. For example, synth string pads and 
other sounds that use PWM (see page 103) can benefit from this.

| Destination | Description

Osc 1&2 Selecting this makes LFO 1 control the pitch (frequency) of 
Osc 1 and Osc 2.

Osc 2 Same as above, but for Osc 2.

Filter Freq Selecting this makes the LFO 1 control the filter frequency for 
Filter 1 (and Filter 2 if linked). 

FM Selecting this makes the LFO 1 control the FM Amount pa-
rameter. Both oscillators must be activated for this to have 
any effect.

Phase Selecting this makes the LFO 1 control the Phase Offset pa-
rameter for both Osc 1 and 2. Note that Phase Offset Modu-
lation (Subtraction or Multiplication) must be activated for this 
to have any effect (see page 103).

Osc Mix Selecting this makes the LFO 1 control the oscillator Mix pa-
rameter. 

| Destination | Description

Osc 1&2 Selecting this makes LFO 2 modulate the pitch (frequency) of 
Osc 1 and Osc 2.

Phase Selecting this makes the LFO 2 modulate the Phase Offset pa-
rameter for both Osc 1 and 2. Note that Phase Offset Modula-
tion (Subtraction or Multiplication) must be activated for this to 
have any effect (see page 103). 

Filter Freq 2 Selecting this makes the LFO 2 modulate the filter frequency for 
Filter 2. 

Amp Selecting this makes the LFO 2 modulate the overall volume., to 
create tremolo-effects.
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Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster modu-
lation rate.

Amount

This parameter determines to what degree the selected parameter destination 
will be affected by LFO 2. Raising this knob’s value creates more drastic results.

Play Parameters
This section deals with two things: Parameters that are affected by how you 
play, and modulation that can be applied manually with standard MIDI keyboard 
controls. 

These are:

• Velocity Control
• Pitch Bend and Modulation Wheel
• Legato
• Portamento
• Polyphony

Velocity Control

Velocity is used to control various parameters according to how hard or soft you 
play notes on your keyboard. A common application of velocity is to make 
sounds brighter and louder if you strike the key harder. Subtractor features very 
comprehensive velocity modulation capabilities. By using the knobs in this sec-
tion, you can control how much the various parameters will be affected by veloc-
ity. The velocity sensitivity amount can be set to either positive or negative 
values, with the center position representing no velocity control. 
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The following parameters can be velocity controlled: Pitch Bend and Modulation Wheels

The Pitch Bend wheel is used for “bending” notes, like bending the strings on a 
guitar. The Modulation wheel can be used to apply various modulation while you 
are playing. Virtually all MIDI keyboards have Pitch Bend and Modulation con-
trols. Subtractor features not only the settings for how incoming MIDI Pitch 
Bend and Modulation wheel messages should affect the sound. Subtractor also 
has two functional wheels that could be used to apply real time modulation and 
pitch bend should you not have these controllers on your keyboard, or if you 
aren’t using a keyboard at all. The Subtractor wheels mirror the movements of 
the MIDI keyboard controllers.

Pitch Bend Range

The Range parameter sets the amount of pitch bend when the wheel is turned 
fully up or down. The maximum range is “24” (=up/down 2 Octaves).

| Destination | Description

Amp This let’s you velocity control the overall volume of the sound. If a 
positive value is set, the volume will increase the harder you 
strike a key. A negative value inverts this relationship, so that the 
volume decreases if you play harder, and increases if you play 
softer. If set to zero, the sound will play at a constant volume, re-
gardless of how hard or soft you play. 

FM This sets velocity control for the FM Amount parameter. A posi-
tive value will increase the FM amount the harder you play. Neg-
ative values invert this relationship.

M. Env This sets velocity control for the Mod Envelope Amount parame-
ter. A positive value will increase the envelope amount the harder 
you play. Negative values invert this relationship.

Phase This sets velocity control for the Phase Offset parameter. This 
applies to both Osc 1 & 2, but the relative offset values are re-
tained. A positive value will increase the phase offset the harder 
you play. Negative values invert this relationship.

Freq 2 This sets velocity control for the Filter 2 Frequency parameter. A 
positive value will increase the filter frequency the harder you 
play. Negative values invert this relationship.

F. Env This sets velocity control for the Filter Envelope Amount parame-
ter. A positive value will increase the envelope amount the harder 
you play. Negative values invert this relationship.

F. Dec This sets velocity control for the Filter Envelope Decay parame-
ter. A positive value will increase the Decay time the harder you 
play. Negative values invert this relationship.

Osc Mix This sets velocity control for the Osc Mix parameter. A positive 
value will increase the Osc 2 Mix amount the harder you play. 
Negative values invert this relationship.

A. Attack This sets velocity control for the Amp Envelope Attack parame-
ter. A positive value will increase the Attack time the harder you 
play. Negative values invert this relationship.
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Modulation Wheel

The Modulation wheel can be set to simultaneously control a number of param-
eters. You can set positive or negative values, just like in the Velocity Control 
section. The following parameters can be affected by the modulation wheel:

Legato
Legato works best with monophonic sounds. Set Polyphony (see below) to 1 
and try the following:

D Hold down a key and then press another key without releasing the 
previous.
Notice that the pitch changes, but the envelopes do not start over. That is, 
there will be no new “attack”. 

D If polyphony is set to more voices than 1, Legato will only be ap-
plied when all the assigned voices are “used up”.
For example, if you had a polyphony setting of “4” and you held down a 4 
note chord, the next note you played would be Legato. Note, however, that 
this Legato voice will “steal” one of the voices in the 4 note chord, as all the 
assigned voices were already used up!

Retrig
This is the “normal” setting for playing polyphonic patches. That is, when you 
press a key without releasing the previous, the envelopes are retriggered, like 
when you release all keys and then press a new one. In monophonic mode, Re-
trig has an additional function; if you press a key, hold it, press a new key and 
then release that, the first note is also retriggered.

Portamento (Time)
Portamento is when the pitch “glides” between the notes you play, instead of in-
stantly changing the pitch. The Portamento knob is used to set how long it takes 
for the pitch to glide from one pitch to the next. If you don’t want any Portamento 
at all, set this knob to zero.

Setting Number of Voices - Polyphony

This determines the polyphony, i.e. the number of voices a Subtractor Patch can 
play simultaneously. This can be used to make a patch monophonic (=a setting 
of “1”), or to extend the number of voices available for a patch. The maximum 
number of voices you can set a Subtractor Patch to use is 99. In the (unlikely) 
event you should need more voices, you can always create another Subtractor!

! Note that the Polyphony setting does not “hog” voices. For exam-
ple, if you have a patch that has a polyphony setting of ten voices, 
but the part the patch plays only uses four voices, this won’t mean 
that you are “wasting” six voices. In other words, the polyphony set-
ting is not something you need to consider much if you want to con-
serve CPU power - it is the number of voices actually used that 
counts.

About the Low Bandwidth button
This can be used to conserve CPU power. When activated, this function will re-
move some high frequency content from the sound of this particular device, but 
often this is not noticeable (this is especially true for bass sounds).

| Parameter | Description

F. Freq This sets modulation wheel control of the Filter 1 Frequency pa-
rameter. A positive value will increase the frequency if the wheel 
is pushed forward. Negative values invert this relationship.

F. Res This sets modulation wheel control of the Filter 1 Resonance 
parameter. A positive value will increase the resonance if the 
wheel is pushed forward. Negative values invert this relation-
ship.

LFO 1 This sets modulation wheel control of the LFO 1 Amount pa-
rameter. A positive value will increase the Amount if the wheel is 
pushed forward. Negative values invert this relationship.

Phase This sets modulation wheel control of the Phase Offset param-
eter for both Osc 1 and 2. Note that Phase Offset Modulation 
(Subtraction or Multiplication) must be activated for this to have 
any effect (see page 103). 

FM This sets modulation wheel control of the FM Amount parame-
ter. A positive value will increase the FM amount if the wheel is 
pushed forward. Negative values invert this relationship. Both 
oscillators must be activated for this to have any effect.
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External Modulation

Subtractor can receive common MIDI controller messages, and route these to 
various parameters. The following MIDI messages can be received:

• Aftertouch (Channel Pressure)
• Expression Pedal
• Breath Control

If your MIDI keyboard is capable of sending Aftertouch messages, or if you have 
access to an Expression Pedal or a Breath controller, you can use these to mod-
ulate parameters. The “Ext. Mod” selector switch sets which of these message-
types should be received.

These messages can then be assigned to control the following parameters:

Connections

Flipping the Subtractor around reveals a plethora of connection possibilities, 
most of which are CV/Gate related. Using CV/Gate is described in the chapter 
“Routing Audio and CV”.

Audio Output
This is Subtractor’s main audio output. When you create a new Subtractor de-
vice, this is auto-routed to the first available channel on the audio mixer.

Sequencer Control
The Sequencer Control CV and Gate inputs allow you to play the Subtractor 
from another CV/Gate device (typically a Matrix or a Redrum). The signal to the 
CV input controls the note pitch, while the signal to the Gate input delivers note 
on/off along with velocity.

! For best results, you should use the Sequencer Control inputs with 
monophonic sounds.

| Destination | Description

F. Freq This sets External modulation control of the Filter 1 Frequency 
parameter. A positive value will increase the frequency with 
higher external modulation values. Negative values invert this 
relationship.

LFO 1 This sets External modulation control of the LFO 1 Amount pa-
rameter. A positive value will increase the LFO 1 amount with 
higher external modulation values. Negative values invert this 
relationship.

Amp This let’s you control the overall volume of the sound with exter-
nal modulation. If a positive value is set, the volume will increase 
with higher external modulation values. A negative value inverts 
this relationship.

FM This sets External modulation control of the FM Amount param-
eter. If a positive value is set, the FM amount will increase with 
higher external modulation values. A negative value inverts this 
relationship. Both oscillators must be activated for this to have 
any effect.
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Modulation Inputs
! Remember that CV connections will not be stored in the Subtractor 

patch, even if the connections are to/from the same Subtractor de-
vice! 

These control voltage (CV) inputs (with associated voltage trim pots), can mod-
ulate various Subtractor parameters from other devices, or from the modulation 
outputs of the same Subtractor device. These inputs can control the following 
parameters:

• Oscillator Pitch (both Osc 1 & 2).
• Oscillator Phase Offset (both Osc 1 & 2).
• FM Amount
• Filter 1 Cutoff
• Filter 1 Res
• Filter 2 Cutoff
• Amp Level 
• Mod Wheel

Modulation Outputs
The Modulation outputs can be used to voltage control other devices, or other 
parameters in the same Subtractor device. The Modulation Outputs are:

• Mod Envelope
• Filter Envelope 
• LFO 1

Gate Inputs
These inputs can receive a CV signal to trigger the following envelopes. Note 
that connecting to these inputs will override the normal triggering of the enve-
lopes. For example, if you connected an LFO output to the Gate Amp input, you 
would not trigger the amp envelope by playing notes, as this is now controlled 
by the LFO. In addition you would only hear the LFO triggering the envelope for 
the notes that you hold down. The following Gate Inputs can be selected:

• Amp Envelope
• Filter Envelope
• Mod Envelope
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13 D Malström Synthesizer
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Introduction
The Malström is a polyphonic synthesizer with a great number of different rout-
ing possibilities. It is based on the concept of what we call “Graintable Synthe-
sis” (see below), and is ideally suited for producing swirling, sharp, distorted, 
abstract special effect types of synthesizer sounds. In fact, you could go so far 
as to say that the Malström can produce sounds quite unlike anything you’ve 
ever heard from a synthesizer. 

For a complete run-down of the principles behind it and thorough explanations 
of the controls, read on...

Features
The following are the basic features of the Malström:

D Two Oscillators, based on Graintable Synthesis.
See page 121 for details.

D Two Modulators, featuring tempo sync and one-shot options.
See page 123.

D Two Filters and one Shaper.
A number of different filter modes in combination with several routing op-
tions and a Waveshaper makes it possible to create truly astounding filter ef-
fects.

D Three Envelope generators.
There is one amplitude envelope for each oscillator and a common envelope 
for both filters. See page 122 and page 126 for details.

D Polyphony of up to 16 voices.

D Velocity and Modulation control.
See page 131.

D A number of CV/Gate Modulation possibilities.
See page 133.

D A variety of Audio Input/Output options.
You can for instance connect external audio sources for input to the 
Malström, and you can also control its output. See page 132 for more de-
tails.

Theory of operation
There are a number of different synthesis methods for generating sound. There 
is e.g. Subtractive Synthesis (which is used in Reason’s other synth - the Sub-
tractor), FM Synthesis and Physical Modelling Synthesis to mention but a few.

To give you a clear understanding of the inner workings of the Malström, it might 
be in order with a brief explanation of what we call Graintable Synthesis.

What we refer to as Graintable Synthesis is actually a combination of two syn-
thesis methods; Granular Synthesis and Wavetable Synthesis.

• In granular synthesis, sound is generated by a number of short, contiguous 
segments (grains) of sound, each typically between 5 to 100 milliseconds 
long. The sound is varied by changing the properties of each grain and/or 
the order in which they are spliced together. Grains can be produced either 
by a mathematical formula or by a sampled sound. This is a very dynamic 
synthesis method with a lot of variation possibilities, although somewhat 
hard to master and control.

• Wavetable synthesis on the other hand, is basically the playback of a sam-
pled waveform. An oscillator in a wavetable synth plays back a single period 
of a waveform, and some wavetable synths also allow the possibility of 
sweeping through a set of periodic waveforms. This is a very straightforward 
synthesis method that is easily controlled, but somewhat limited in variation 
possibilities.

The Malström combines these two into a synthesis method that provides a very 
flexible way of synthesizing sounds with incredible flux and mutability.

It works like this:

• The oscillators in the Malström play back sampled sounds that are subject to 
some very complex processing and cut up into a number of grains. From 
here on, these sounds will be referred to as Graintables

• This results in a set of periodic waveforms (a graintable) that, when spliced 
together, play back the original sampled sound.

• This can then be treated just like a wavetable. I.e. It is possible to sweep 
through it. Move through it at any speed without affecting pitch. Play any 
section of it repeatedly. Use it to pick static waveforms. Jump between posi-
tions. Etc. etc.

• It is also possible to perform a number of other tricks, all of which are de-
scribed further on in this chapter.

Loading and Saving Patches
Loading and saving patches is done in the same way as with any other Reason 
device. This is described in the chapter “Working with Patches” in the Getting 
Started book.
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The Oscillator section

The two oscillators (osc:A and osc:B) of the Malström are the actual sound gen-
erators, and the rest of the controls are used for modulating and shaping the 
sound. The oscillators actually do two things; they play a graintable and gener-
ate the pitch:

• A graintable is several short, contiguous segments of audio (see above).
• Pitch is the frequency at which the segments are played back.

When creating a Malström patch, the fundamental first building block is usually 
to select a graintable for one or both of the oscillators.

D To activate/deactivate an oscillator, click the On/Off button in the 
top left corner.
When an oscillator is activated, the button is lit.

An activated oscillator

D To select a graintable, either use the spin controls or click directly in 
the display to bring up a pop-up menu with the available grainta-
bles.
The graintables are sorted alphabetically into a number of descriptive cate-
gories, giving a hint as to the general character of the sound. Note that the 
categories are only visible in the pop-up menu, not in the display.

Setting oscillator frequency
You can change the frequency - i.e. the tuning - of each oscillator by using the 
three knobs marked “Octave”, “Semi” and “Cent”.

D The Octave knob changes the frequency in steps of one full octave 
(12 semitones).
The range is -4 – 0 – +4 where 0 corresponds to middle “A” on your key-
board at 440 Hz.

D The Semi knob changes the frequency in steps of one semitone.
The range is 0 to +12 (one full octave up).

D The Cent knob changes the frequency in steps of cents, which are 
100ths of a semitone.
The range is -50 – 0 – +50, i.e. down or up by up to half a semitone.
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Controlling playback of the graintable
Each oscillator features three controls that determine how the loaded grainta-
bles are played back. These are: The “Index” slider, the “Motion” knob and the 
“Shift” knob.

D The Index slider sets the playback starting point in the graintable.
By dragging the slider, you set which index point in the graintable should be 
played first when the Malström receives a Note On message. Playback will 
then continue to the next index point according to the active graintable. With 
the slider all the way to the left, the first segment in the graintable is also the 
one that will be played back first.

! Note that the Malström’s Graintables are not all of the same length, 
and that the range for the Index slider (0-127) does not reflect the 
actual length of the graintables. I.e. regardless of whether a graint-
able contains 3 or 333 grains, the Index slider will always span the 
entire graintable even though the slider range says 0-127.

D The Motion knob controls how fast the Malström should move for-
ward to play the next segment in the graintable, according to its 
motion pattern (see below).
If the knob is kept in the middle position the speed of motion is the normal 
default. Turning the knob to the left slows it down and turning it to the right 
results in higher speed. If the knob is set all the way to the left, there will be 
no motion at all, which means that the initial segment, as set with the Index 
slider, will play over and over as a static waveform. 

D The Shift knob changes the timbre of the sound (the formant spec-
trum).
What it actually does is change the pitch of a segment up or down by re
sampling. However, since the pitch you hear is independent of the actual 
pitch of the graintable (see above), pitch-shifting a segment instead means 
that more or less of the segment waveform will be played back, resulting in a 
change of harmonic content and timbre.

About motion patterns

Each graintable has a predefined motion pattern and a default motion speed. 

When a graintable is looped (i.e. if the Motion knob is not set all the way to the 
left), it follows one of two possible motion patterns:

D Forward
This motion pattern plays the graintable from the beginning to the end, and 
then repeats it.

D Forward - Backward
This motion pattern plays the graintable from the beginning to the end, then 
from the end to the beginning and then repeats it.

The motion speed can be changed with the Motion knob, as described above, 
but it is not possible to alter the motion pattern of a graintable.

The amplitude envelopes

Each oscillator features a standard ADSR (Attack, Decay, Sustain, Release) en-
velope generator, and a Level control. These are used for controlling the volume 
of the oscillator. One thing that makes the Malström different from many other 
synths though, is the fact that the amplitude envelopes are placed before the fil-
ter and routing sections in the signal path.

The amplitude envelopes control how the volume of a sound should change 
from the moment you strike a key on your keyboard to the moment that you re-
lease it again.

Vol

The Volume knobs set the volume level out from each oscillator.

! For an overall description of the general envelope parameters (At-
tack, Decay, Sustain, Release), please refer to the Subtractor chap-
ter.
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The Modulator section

The Malström features two Modulators (mod:A and mod:B) These are in fact an-
other type of oscillators, called LFOs (Low Frequency Oscillators). They each 
generate a waveform and a frequency, much like osc:A and osc:B. However, 
there are a couple of important differences:

• Mod:A and mod:B do not generate sound. They are instead used for modu-
lating various parameters to change the character of the sound.

• They only generate waveforms of low frequency.

Furthermore, both modulators are tempo syncable and possible to use in one 
shot mode, in which case they will actually work like envelopes.

Modulator parameters
The two Modulators have a few controls in common, but there are also some dif-
ferences. Both the common parameters and the ones that are unique for each 
Modulator (the destinations) are described below.

D To activate/deactivate a Modulator, click the On/Off button in the 
top left corner.
When a Modulator is activated, the button is lit.

An activated Modulator

Curve

This lets you select a waveform for modulating parameters. Use the spin con-
trols to the right of the display to cycle through the available waveforms. Some of 
these waveforms are especially suited for use with the Modulator in one shot 
mode (see below).

Rate

This knob controls the frequency of the Modulator. For a faster modulation rate, 
turn the knob to the right.

The Rate knob is also used for setting the time division when synchronizing the 
Modulator to the song tempo (see below). 

One Shot

To put the Modulator into one shot mode, click this button so that it is lit. 

Normally, the Modulators will repeat the selected waveforms over and over 
again, at the set rate. However, when one shot mode is activated and you play a 
note, the Modulator will play the selected waveform only once (at the set rate) 
and then stop. In other words, it will effectively be turned into an envelope gen-
erator!

Note that even though all waveforms can be used with interesting results, some 
waveforms are explicitly well suited for use in one shot mode. For example, try 
using the waveform with just one long, gently sloping curve.

Sync

Clicking this button so that it is lit synchronizes the Modulator to the song 
tempo, in one of 16 possible time divisions. 

! When sync is activated, the Rate knob is used for selecting the de-
sired timedivision. Turn the Rate knob and observe the tool tip for 
an indication of the timedivision.

A/B selector

This switch is used for deciding which oscillator and/or filter the Modulator 
should modulate - A, B or both. With the switch in the middle position, both A 
and B will be modulated.

Destinations
The following knobs are used for determining what each of the two modulators 
should modulate.
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D Note that these knobs are bi-polar, which means that if a knob is in 
the middle position, no modulation is applied. If you turn a knob ei-
ther to the left or to the right, an increasing amount of modulation 
is applied to the parameter. The difference is that if you turn a knob 
to the left, the waveform of the modulator is inverted.

Mod:A

Mod:A can modulate the following parameters of either oscillator:

D Pitch
Use this if you want Mod:A to offset the pitch of osc:A, osc:B, or both (see 
page 121).

D Index
Use this if you want Mod:A to offset the index start position of osc:A, osc:B, 
or both (see page 122).

D Shift
Use this if you want Mod:A to affect the harmonic content of osc:A, osc:B, or 
both (see page 122).

Mod:B

Mod:B can modulate the following parameters of either oscillator:

D Motion
Use this if you want Mod:B to affect the motion speed of osc:A, osc:B, or 
both (see page 122).

D Level
Use this if you want Mod:B to change the output level of osc:A, osc:B, or 
both (see page 122).

D Filter
Use this if you want Mod:B to offset the cutoff frequency of filter:A, filter:B, 
or both (see page 126).

D Mod:A
Use this if you want Mod:B to change the total amount of modulation from 
Mod:A.

The Filter section

The filter section lets you further shape the overall character of the sound. Con-
tained herein are two multimode filters, a filter envelope and a waveshaper.

The Filters

Both filter:A and filter:B have the exact same parameters, all of which are de-
scribed below
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D To activate/deactivate a filter, click the On/Off button in the top left 
corner.
When a filter is activated, the button is lit.

An activated filter

Filter types

To select a filter type, either click the Mode button in the bottom left corner or 
click directly on the desired filter name so that it lights up in yellow:

D LP 12 (12 dB lowpass)
Lowpass filters let low frequencies through and cut off high frequencies. 
This filter type has a roll-off curve of 12dB/Octave.

D BP 12 (12 dB bandpass)
Bandpass filters cut both high and low frequencies, leaving the frequency 
band in between unaffected. Each slope in this filter type has a 12 dB/Oc-
tave roll-off.

D Comb + & Comb –
Comb filters are basically delays with very short delay times with adjustable 
feedback (in Reason controlled with the Resonance knob). A comb filter 
causes resonating peaks at certain frequencies. 

The difference between “+” and “–” is in the position of the peaks, in the 
spectrum. The main audible difference is that the “–”-version causes a bass 
cut.

The Resonance parameter in both cases controls the shape and size of the 
peaks.

D AM
AM (Amplitude Modulation) is often referred to as Ring Modulation. A Ring 
Modulator works by multiplying two signals together. In the case of the Mal-
ström, the filter produces a sine wave which is multiplied with the signal from 
osc:A or osc:B. Resonance controls the mix between the clean and modu-
lated signals. The Ring Modulated output will then contain added frequen-
cies which are generated by the sum of, and the difference between the two 
signals. This can be used for creating complex, non-harmonic sounds.

Comb + Low Resonance Comb + High Resonance

Comb – Low Resonance Comb – High resonance
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Filter controls

Each filter contains the following four controls:

D Kbd (keyboard tracking)
By clicking this button so that it is lit, you activate keyboard tracking. If key-
board tracking is activated, the frequency of the filter will change according 
to the notes you play on your keyboard. That is, if you play notes higher up on 
the keyboard, the filter frequency will increase and vice versa. If keyboard 
tracking is deactivated, the filter frequency will remain at a fixed value regard-
less of where on the keyboard you play.

D Env (envelope)
If you click on this button so that it is lit, the cutoff frequency (see below) will 
be modulated by the filter envelope. If you leave this deactivated, the Filter 
Envelope will have no effect.

D Freq (frequency)
The function of this parameter depends on which filter type you have se-
lected:

With all filter types except AM, it is used for setting the cutoff frequency of 
the filter. In the case of the lowpass filter for example, the cutoff frequency 
determines the limit above which high frequencies will be cut off. Frequen-
cies below the cutoff frequency will be allowed to pass through. The farther 
to the right you turn the knob, the higher the cutoff frequency will be.

If you have selected AM as filter type, this will instead control the frequency 
of the signal generated by the filter. The same control range applies though; 
the farther to the right you turn the knob the higher the frequency will be.

D Res (resonance)
Again, the function of this parameter depends upon which filter type is se-
lected:

If the selected filter is any other type than AM, it sets the filter characteristic, 
or quality. For the lowpass filter for example, raising the filter Res value will 
emphasize the frequencies around the set filter frequency. This generally 
produces a thinner sound, but with a sharper, more pronounced filter fre-
quency “sweep”. The higher the filter Res value, the more resonant the 
sound becomes until it produces a whistling or ringing sound. If you set a 
high value for the Res parameter and then vary the filter frequency, this will 
produce a very distinct sweep, with the ringing sound being very evident at 
certain frequencies.

In the case of the AM filter type though, this control instead regulates the 
balance between the original signal and the signal resulting from amplitude 
modulation. The farther to the right you turn the knob, the more dominant the 
AM signal will be.

The Filter Envelope

This is a standard ADSR envelope with two additional controls; inv and amt. 

The filter envelope is common for both filter:A and filter:B, and controls how the 
filter frequency should change over time.

Inv (inverse)

This button toggles inversion of the envelope on and off. The Decay segment of 
the envelope will for instance normally lower the frequency, but if the envelope is 
inverted it will instead raise the frequency.

Amt (amount)

This controls to which extent the filter envelope affects the filters, or rather - the 
set filter cutoff frequencies. For example; if the cutoff frequency is set to a cer-
tain value, the filter will already be opened by this amount when you hit a key on 
your keyboard. The amount setting then controls how much more the filter will 
open from that point. Turn the knob to the right to increase the value.

! For an overall description of the general envelope parameters (At-
tack, Decay, Sustain, Release), please refer to the Subtractor chap-
ter.
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The Shaper

Before filter:A is an optional waveshaper. Waveshaping is a synthesis method 
for transforming sounds by altering the waveform shape, thereby creating a com-
plex, rich sound. Or, if that’s more to your taste, truncating and distorting the 
sound to lo-fi heaven!

A guitar distortion box could be viewed as a type of waveshaper for example. An 
unamplified electric guitar produces a sound with fairly pure harmonic content, 
which is then amplified and transformed by the distortion box.

D To activate/deactivate the Shaper, click the On/Off button in the 
top left corner.
When the Shaper is activated, the button is lit.

The Shaper activated

Mode

You can select one of five different modes for shaping the sound, each with its 
own characteristics. 

To select a mode, either click the Mode button in the bottom left corner or click 
directly on the desired mode name so that it lights up in yellow.

D Sine
This produces a round, smooth sound.

D Saturate
This gives a lush, rich character to the sound.

D Clip
This introduces clipping - digital distortion - to the signal.

D Quant
This lets you truncate the signal by bit-reduction, thus making it possible to 
achieve that noisy, characteristic 8 bit sound for example.

D Noise
This is actually not strictly a shaper function. Instead it multiplies the sound 
with noise.

Amt (amount)

This controls the amount of shaping applied. By turning the knob to the right you 
increase the effect.

Input Signal

Sine

O
utput S

ignal

Saturate
Clip
Quant
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Routing
The Malström puts you in total control of how the signal should be routed from 
the oscillators, through the filters and on to the outputs. Below is first a general 
description of the routing options, followed by examples of how to route the sig-
nal in order to achieve a certain result.

D Click on a button so that it is lit, to route the signal correspondingly.
See below for descriptions.

! Note that the result depends both on the routing buttons and on 
whether the filters and shaper are activated or not! 

Routing examples

One or both oscillators without filters

With this configuration, the signals from the oscillators will bypass the filters and 
the shaper and go directly to the respective output. Using both oscillators allows 
you to use the Spread parameter to create a true stereo sound.

One or both oscillators to one filter only

Both oscillators routed to filter:B only. Both oscillators routed to filter:A only.

With these configurations, the signal from osc:A and/or osc:B will go to either 
filter:A or filter:B and then to the outputs. This is essentially a mono configuration 
and hence Spread should probably be set to “0”.

If this button is lit, the signal from osc:B 
is routed to filter:B. If this is not lit, the 
signal from osc:B will go straight to the 
outputs.

If this button is lit, the signal from filter:B is routed to filter:A via the shaper. 
The signal from filter:B can originate from either osc:A, osc:B or both. If this 
is not lit, the signal from filter:B will go straight to the outputs.

If this button is lit, the signal from osc:A 
is routed to filter:B. If neither this nor the 
other routing button from osc:A (to 
filter:A/shaper) is lit, the signal from 
osc:A will go straight to the outputs.

If this button is lit, the signal from osc:A is routed to filter:A via the shaper. If neither this nor 
the other routing button from osc:A (to filter:B) is lit, the signal will go straight to the outputs.
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Both oscillators with one filter each

With this configuration, the signals from osc:A and osc:B will go to filter:A and 
filter:B respectively, and then to the outputs.

Again, this configuration allows you to work in true stereo.

One oscillator with both filters in parallel

With this configuration, the signal from osc:A will go to both filter:A and filter:B, 
with the filters in parallel.

! This configuration is only possible with osc:A. Osc:B can be routed 
to both filters as well, but only in series (see below).

One or both oscillators with both filters in series

Osc:A routed through both filters in series. Osc:B routed through both filters in series.

With these configurations, the signal from osc:A and/or osc:B will go to both fil-
ter:A and filter:B, with the filters in series (one after the other).

Adding the shaper

The signal from one or both oscillators can also be routed to the shaper. The sig-
nal will then pass through the shaper to the outputs, with or without also passing 
through the filters.

In the left figure, the signal from osc:A is routed to the shaper and then directly to the outputs. 
In the right figure, the signal from osc:B is routed to filter:B, then to the shaper and then to 
filter:A.
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The output controls

These two parameters control the output from the Malström in the following way:

Volume

This knob controls the master volume out from the Malström.

Spread

This controls the stereo pan-width of the outputs from Osc:A/B and Filter:A/B 
respectively. The farther to the right you turn the knob, the wider the stereo im-
age will be. In other words, the signals will be panned further apart to the left and 
right.

! If you are only using one output (A or B), it is strongly recom-
mended that you set Spread to “0”.

The play controls

To the far left on the Malström’s “control panel” are various parameters that are 
affected by how you play, and lets you apply modulation by MIDI controls. The 
following is a description of these controls.

Polyphony - setting the number of voices

This lets you set the polyphony for the Malström. Polyphony is the number of 
voices it can play simultaneously. The maximum number is 16 and the minimum 
is 1, in which case the Malström will be monophonic.

! The number of voices you can play depends of course on the capac-
ity of your computer. Even though the maximum number is 16 it 
doesn’t necessarily mean that your system is capable of using that 
many voices. Also note that voices do not consume CPU capacity 
unless they are really “used”. That is, if you are using a patch that 
plays two voices but have polyphony set to four, the two “unused” 
voices do not consume any of your system resources.

Porta (portamento)

This is used for controlling portamento. This is a parameter that makes the pitch 
glide between the notes you play, rather than changing the pitch instantly as 
soon as you hit a key on your keyboard. By turning this knob you set how long it 
should take for the pitch to glide from one note to the next as you play them. 

With the knob turned all the way to the left, portamento is disabled.

Legato

By clicking this button you activate/deactivate Legato. Legato in Malström is 
unique in that it allows you to control whether the sound is monophonic or poly-
phonic by using your playing style:

D If you play legato (hold down a key and then press another key 
without releasing the previous), the sound is monophonic.
Also note that the pitch changes, but the envelopes do not start over. That 
is, there will be no new “attack”.

D If you play non-legato (separated notes), with polyphony set to 
more voices than 1, each note will decay separately (polyphonic).
This will be most apparent with longer release times.
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The Pitch Bend and Modulation wheels

• The Pitch Bend wheel is used for bending the pitch of notes, much like 
bending the strings on a guitar or other string instrument. 

• The Modulation wheel can be used for applying modulation while you are 
playing.

Virtually all MIDI keyboards have Pitch Bend and Modulation controls. The Mal-
ström does not only feature the settings for how incoming MIDI Pitch Bend and 
Modulation wheel messages should affect the sound, but also two functional 
wheels that can be used for applying real time modulation and pitch bend if you 
don’t have these controllers on your keyboard, or if you aren’t using a keyboard 
at all. The wheels on the Malström also mirror the movements of the wheels on 
your MIDI keyboard.

Pitch Bend Range

The Range parameter sets the maximum amount of pitch bend, i.e. how much it 
is possible to change the pitch by turning the wheel fully up or down. The maxi-
mum range is 24 semitones (2 Octaves). You change the value by clicking the 
spin controls to the right of the display.

The Velocity controls

Velocity is used for controlling various parameters according to how hard or soft 
you play notes on your keyboard. A typical use of velocity control is to make 
sounds brighter and louder if you strike a key harder. By using the knobs in this 
section, you can control how much the various parameters will be affected by 
velocity. 

! All of the velocity control knobs are bi-polar, which means that the 
amount can be set to either positive or negative values, while keep-
ing the knobs in the center position means that no velocity control 
is applied.

The following parameters can be velocity controlled:

D Lvl:A
This lets you velocity control the output level of osc:A.

D Lvl:B
This lets you velocity control the output level of osc:B.

D F.env
This sets velocity control for the Filter Envelope Amount parameter. Positive 
values will increase the envelope amount the harder you play, and negative 
values will decrease the amount.

D Atk (attack)
This sets velocity control for the Amp Envelope Attack parameter of osc:A 
and/or osc:B. Positive values will increase the Attack time the harder you 
play, and negative values will decrease it.

D Shift
This lets you velocity control the Shift parameter of osc:A and/or osc:B.

D Mod
This lets you velocity control all modulation amounts of mod:A and/or 
mod:B.

! Note that you can set the last three parameters (Atk, Shift and Mod) 
to be velocity controlled for either or both of oscillator/modulator A 
and B. This is done with the A/B selector switch.
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The Modulation wheel controls

The Modulation wheel can be set to control a number of parameters. You can 
set positive or negative values, just like in the Velocity Control section (see 
above).

The following parameters can be affected by the modulation wheel:

D Index
This sets modulation wheel control of the currently active graintable’s index 
(see page 122) for osc:A and/or osc:B. Positive values will move the index 
position forwards if the modulation wheel is pushed forward. Negative val-
ues will move it backwards.

D Shift
This sets modulation wheel control of the Shift parameter of osc:A and/or 
osc:B (see page 122).

D Filter
This sets modulation wheel control of the Filter Frequency
parameter (see page 126). Positive values will raise the frequency if the
wheel is pushed forward and negative values will lower the frequency.

D Mod
This sets modulation wheel control of the total amount of modulation from 
mod:A and/or mod:B. Positive values will increase the settings if the wheel is 
pushed forward and negative values will decrease the settings.

! You can set whether these parameters on either or both oscillator/
modulator/filter A and B will be affected by the modulation wheel. 
This is done with the A/B selector switch.

Connections

Flipping the Malström around reveals a wide array of connection possibilities. 
Most of these are CV/Gate related. Using CV/Gate is described in the chapter 
“Routing Audio and CV”.

Audio Output
These are the Malström’s audio outputs. When you create a new Malström de-
vice, they are auto-routed to the first available channel on the audio mixer:

D Shaper/Filter:A (left) & Filter:B (right)
These are the main stereo outputs. Each of the two filters are connected to 
a separate output, and by connecting both, you can have stereo output. 
Whether the output really will be in stereo however, is determined by the 
routing and the Spread parameter. See page 128 for details about this.

D Osc:A & osc:B
These make it possible to output the sound directly after the Amp Envelope 
of each oscillator, bypassing the filter section. Connecting one or both of 
these to a channel on the audio mixer will break the Malström’s internal sig-
nal chain. That is, it is not possible to process the sound by using the filters 
and the shaper of the Malström. the sound instead goes directly to the mixer.

✪ Note also that you can connect the outputs Osc:A & Osc:B to the 
Audio Inputs on the Malström for some interesting effects - see 
page 133.

Audio Input
• Shaper/Filter:A
• Filter:B

These inputs let you connect either other audio sources, or the Malström’s own 
internal signal directly to the filters and the shaper - see page 133.
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Sequencer Control
The Sequencer Control CV and Gate inputs allow you to play the Malström from 
another CV/Gate device (typically a Matrix or a Redrum). The signal to the CV in-
put controls the note pitch, while the signal to the Gate input delivers note on/off 
along with velocity.

! For best results, you should use the Sequencer Control inputs with 
monophonic sounds.

Gate Input
These inputs can receive a CV signal to trigger the following envelopes:

• Amp Envelope
• Filter Envelope 

! Note that connecting to these inputs will override the normal trig-
gering of the envelopes. For example, if you connected a Modula-
tion output to the Gate Amp in-put, you would not trigger the amp 
envelope by playing notes, as this is now controlled by the Modula-
tor. In addition you would only hear the Modulator triggering the 
envelope for the notes that you hold down.

Modulation Input
These control voltage (CV) inputs (with associated voltage trim pots and A/B se-
lector switches), can modulate various Malström parameters from other devices, 
or from the modulation outputs of the same Malström device. These inputs can 
control the following parameters:

• Oscillator Pitch
• Filter Frequency
• Oscillator Index offset
• Oscillator Shift
• Amp Level
• Mod Amount
• Mod Wheel

Modulation Output
The Modulation outputs can be used to voltage control other devices, or other 
parameters in the same Malström device. 

The Modulation Outputs are:

• Mod:A 
• Mod:B
• Filter Envelope

Routing external audio to 
the filters

The audio inputs on the back of the Malström allows you to connect any audio 
signal to the filters and Shaper. 

To use this feature, it’s important to understand the following background:

Normally the Malström behaves like any regular polyphonic synthesizer, in that 
each voice has its own filter. The filter settings are the same, but each filter enve-
lope is triggered individually when you play a note.

However, when you connect a signal to the audio inputs, it is routed to an “extra” 
filter. The envelope for this filter is triggered each time any of the other filter en-
velopes is triggered. In other words, the “extra” filter envelope is triggered each 
time you play a note on the Malström.

There are two different uses for the audio inputs:

Connecting an external signal source

Connecting an audio signal from another device in the rack to the audio input al-
lows you to process the signal through the filters and/or Shaper of the Malström. 
The processed signal will then be mixed with the Malström’s “own” voices (if ac-
tivated) and sent to the outputs.

The result depends on the following:

• To which jack you connect the signal.
• Whether the filters and/or Shaper are activated on the front panel.
• The routing button for filter:B.

If this is activated and you connect a signal to the Filter:B input, the signal 
will be processed in filter:B and then sent to the Shaper and filter:A (just as 
when routing Malströms own oscillators on the front panel).

Note again that the filter envelope is triggered by all voices. To make use of the 
filter envelope, you either need to play the Malström or use gate signals to trig-
ger it or the filter envelope, separately.



MALSTRÖM SYNTHESIZER134

Connecting the signal from the Malström itself

If you connect one or both oscillator outputs to the audio input(s), the internal 
signal path from the oscillators to the filters is broken. In other words, no signals 
will pass internally from the oscillators to the filters, and the three routing buttons 
for the oscillators are ignored.

This may seem pointless at first, but there are several uses for this:

D When you play the Malström in this mode, the filter envelope will be 
triggered for each note you play, affecting all sounding notes.
This is due to the monophonic “extra” filter described above. On older syn-
thesizers, this feature is called “Multiple triggering”.

D Since all notes you play are mixed before being sent into the filter, 
the result of using the Shaper will be totally different (if you play 
more than one note at a time).
This is similar to playing a guitar chord through a distortion effect, for exam-
ple.

D You can patch in external effects between the oscillators and the 
filters.
Just connect an oscillator output to the input of the effect device, and the ef-
fect output to the Malströms’s audio input.

✪ You can use combinations of connections and routing. You could 
for instance connect an external audio signal to one of the inputs, 
one of the Malström’s oscillators to the other input and then use 
the routing options on the front panel for the other oscillator. All of 
these signals will then be mixed and sent to the Malström’s main 
outputs.
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Introduction
A sampler could be described as a device capable of recording and reproduc-
ing audio material, like a tape recorder. Unlike a tape or hard disk based re-
corder, samplers allows you to “play” the recorded sound via MIDI, using a 
keyboard for example. This way, any reproducible sound can be integrated into 
the MIDI environment, and be controlled from sequencers etc. like synthesizers. 

The NN-19 is a sample player, capable of reproducing, but not recording or ed-
iting sound files. 

The program comes with more than a hundred ready-made sample patches, 
covering all kinds of instrument types. In addition to this there are plenty of single 
samples that can be used for creating your own patches.

If you want to record or edit your own samples, there are plenty of relatively inex-
pensive (and even free) audio editing software for both the Windows and the 
Mac OS platforms, that will allow you to both record audio (via your computers 
or audio cards audio inputs), and to edit the resulting audio file. Virtually every 
product that is capable of this, can create sound files which can be loaded di-
rectly into the NN-19.

Also, there are thousands of high quality sample CD:s available, covering every 
conceivable musical style or direction ranging from professionally recorded or-
chestral samples to esoteric electronic noises.

General Sampling 
Principles 
Background
Before a sound can be used by a sampler, it must be converted to a digital sig-
nal. Hardware samplers provide audio inputs that can convert the analog signal 
to digital, by the use of an “A/D Converter” (analog to digital). This “samples” the 
signal at very short time intervals and converts it to a digital representation of the 
analog signal’s waveform. The sample rate and the bit depth of this conversion 
determines the resulting sound quality. Finally the signal is passed through a dig-
ital to analog converter (D/A) which reconstructs the digital signal back to ana-
log, which can be played back. 

Multisampling vs. Single Samples
Most of the included NN-19 patches are made up of a collection of several sam-
ples. This is because a single sampled sound only sounds natural within a fairly 
narrow frequency range. If a single sample is loaded into an empty NN-19, the 
sample will be playable across the whole keyboard. The pitch (frequency) of the 
original sample (called root-key) will be automatically placed on the middle C key 
(C3). 

Note that this has nothing to do with the actual pitch the sample itself produces! 
It may not even have a pitch as such, it could be the sound of someone talking 
for example. 

If you play any single sample about two octaves above or below its root key, it 
will most likely sound very “unnatural”. In the case of it actually being a sample of 
someone talking, playing two octaves up will make the talking voice sample 
sound squeaky, short and most likely unintelligible. Two octaves down the voice 
will sound something like a drawn-out gargle.

Thus, the range that most samples can be transposed without sounding unnatu-
ral is limited. To make a sampled piano, for example, sound good across the 
whole keyboard, you need to first have made many samples at close intervals 
across the keyboard, and then define an upper and lower range for each sample, 
called a Key Zone. All the keyzones in the piano sample patch then make up a 
Key Map. 

How to create key zones is described on page 138.

To sample real instruments accurately requires a lot of hard work. Firstly, you 
need the original instrument, which should be in perfect working order. For 
acoustic instruments you need a couple of good microphones, a mixer or other 
device with high quality microphone preamps, and a room with good acoustics. 
You need to be meticulous when recording the different samples, so that levels 
are smooth and even across the range etc. 

Fortunately Reason provides a wide range of high quality multisampled instru-
ments, so much of this hard work has already been done for you.

In our experience, most people don’t use samplers only for playing sampled ver-
sions of “real” instruments. Very often, single “stand alone” or single samples are 
used. Maybe you wish to use different sounds for every key zone. Or you could 
have complete chorus and verse vocals plus variations assigned to several “one 
note” key zones. Or use samples of different chords that play rhythmic figures to 
the same tempo, and use these to build song structures etc. The possibilities are 
endless. When you use samples in this way, the keys on your keyboard that play 
the samples do not necessarily correspond to pitch at all, the keys are simply 
used to trigger the samples.
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About Audio File Formats
The NN-19 can read audio files in the following formats:

• Wave (.wav)
• AIFF (.aif)
• SoundFonts (.sf2)
• REX file slices (.rex2, .rex, .rcy) 
• Any sample rate and practically any bit depth.

! If you want the files to play back with their original bit depth - if 
higher than 16-bits - make sure to activate “Use High Resolution 
Samples” on the General page in the Preferences dialog. Other-
wise, samples will be played back as 16-bit files in NN-19 regard-
less of their original bit depth. See the Getting Started book for 
more details.

Wave and AIFF are the standard audio file formats for the PC and Mac plat-
forms, respectively. Any audio or sample editor, regardless of platform, can read 
and create audio files in at least one of these formats.

SoundFonts are an open standard for wavetable synthesized audio, developed 
by E-mu systems and Creative Technologies.

REX files are music loops created in the ReCycle program (see below). The NN-
19 lets you either load REX files as patches or separate slices from REX files as 
individual samples.

About the Sample Patch format

Reason’s Sample Patch format (.smp), is based on either Wave or AIFF files, but 
includes all the NN-19 associated parameter settings as well.

D The audio files may be stereo or mono. Stereo audio files are 
shown with a “S” symbol beside its name in the display.

Loading a Sample Patch
When you create a new NN-19 device, it is empty. That is, the “Init patch” in the 
NN-19 does not contain any samples. For NN-19 to produce sound, you need to 
load either a sample patch, or a sample. 

A patch contains “everything”. All the samples, assigned key zones, and associ-
ated panel settings will be loaded. Loading a sample patch is done using the 
patch browser, just like in all other devices that use Patches.

Open the folder that contains the NN-19 patch you wish to load, select it and 
click open.

Loading REX Files as Patches
REX Files are files created in the ReCycle program. This is an application cre-
ated by Propellerhead Software, used for slicing up music loops and enabling 
them to be played back in any tempo. In Reason, REX files are primarily used in 
the Dr. Rex loop player, but they can be used in the NN-19 as well. Possible ex-
tensions are “.rx2”, “.rcy” and “.rex”.

When loading a REX file, each slice in the file is assigned to one key, chromati-
cally. All parameters are set to default settings.

When using REX files in the DR. Rex loop player, it is possible to make a track 
play the slices in order to recreate the original loop. To do the same in the NN-
19 requires a few extra steps.

1. Use the patch browser to load the REX file into an NN-19 sampler.

2. Create a Dr. Rex loop player and load the same REX file in to this 
device.

3. Use the To Track feature on the Dr. Rex to create playback data (a 
group) on the track assigned to the Dr. Rex.

4. Move that group to the track that plays the NN-19 and play it back 
from there.

5. Delete the Dr. Rex loop player.
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About Key Zones and 
Samples
Loading a Sample into an empty NN-19
1. Create a new sampler device.

2. Click on the sample browser button.
This is located above the keyboard display to the left.

✪ When you browse samples, you can preview them before loading 
using the browser Play button. If you select the Preview “Autoplay” 
function, the samples play back once automatically when selected.

3. Use the browser to select a sample and open it.

When you load the first sample into an empty NN-19, this will be assigned a key 
zone that spans the entire range of the keyboard, and the default Init Patch set-
tings will be used.

Below the keyboard, the range, sample name, root key, tuning, level and loop 
status of the current key zone is displayed, each with a corresponding knob.

The light blue strip above the keyboard indicates the currently selected key zone, which is in 
this case the full range of the keyboard. 

The inverted note on the keyboard indicates the “root key” of the sample. All 
samples contain a root key, tuning and level setting. If NN-19 is empty, a sample 
will have its root key placed on the middle “C” (C3) key.

4. If desired, click on the keyboard to change the root key. 

! You can audition a loaded sample patch or sample by holding down 
[Option] (Mac)/[Alt] (Windows) and clicking on a key in the Key-
board display. The mouse will take on the shape of a speaker sym-
bol to indicate this.

Loading SoundFont samples
The SoundFont format was developed by E-mu systems in collaboration with 
Creative Technologies. It is a standardized data format containing wavetable 
synthesized audio and information on how it should be played back in wavetable 
synthesizers - typically on audio cards. The SoundFont format is an open stan-
dard so there is a vast amount of SoundFont banks and SoundFont compatible 
banks developed by third parties.
The samples in a SoundFont are stored hierarchically in different categories: 
User Samples, Instruments, Presets etc. The NN-19 allows you to browse for 
and load single SoundFont samples, but not entire soundfonts.

1. Use the sample browser to select a SoundFont file (.sf2) and open 
it.
The browser opens the SoundFont and displays the folders within it.

2. Select the folder “Samples” and open it.
This folder contains a number of samples which can be loaded like any other 
sample.

3. Select the desired sample and open it.
The sample is loaded and assigned a key zone range that spans the entire 
keyboard. You can now make settings for it as with any other sample.

Loading REX slices as samples
A slice is a snippet of sound in a REX File. To import a REX slice, click the sam-
ple browser button (see above), browse to a REX file and open it as if it was a 
folder. The browser will then display the slices as files inside that “folder”.

In the rest of this manual, when we refer to importing samples, all that is said ap-
plies to REX slices as well.
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Creating Key Zones
A “key zone” is a range of keys, that plays a sample. All key zones together make 
up a “key map”.

To create a new key zone, the following methods can be used:

D Select “Split Key Zone” from the Edit or context menus.
This splits the currently selected key zone in the middle. The new zone is the 
upper half of the split, and is empty. The dividing point has a “handle” above 
it, see “Setting the Key Zone Range” below for a description.

D By [Alt]/[Option]-clicking at a point just above the key zone strip, a 
new empty key zone is created. 
The point where you click becomes the lower limit (or boundary) for the orig-
inal key zone, and the upper limit for the new key zone. 

The new empty key zone gets selected upon creation.

Selecting Key Zones
Only one key zone can be selected at a time. A selected key zone is indicated by 
a light blue (as opposed to dark blue) strip above the keyboard in the display. 
There are two ways you can select key zones:

D By clicking on an unselected key zone in the display.

D By activating the “Select Key Zone via MIDI” button.
Playing a note belonging to an unselected key zone from your MIDI key-
board, will select the key zone it belongs to.

Setting the Key Zone Range 
! Key zones cannot overlap.

When you adjust the boundaries of a key zone, the surrounding boundaries are 
automatically adjusted accordingly. 

You can change the key zone range in the following ways:

D By dragging the “handle(s)” which divides the key zones, you can 
change the range of the selected key zone.
In the case of having two key zones split in the middle, you could thus 
change the lower limit for the upper (new) key zone and the upper limit for 
the original key zone. 

D By using the “Lowkey” and “Highkey” knobs to set a lower and up-
per range, respectively.

Deleting a Key Zone
D To delete a key zone, select it and then select “Delete Key Zone” 

from the Edit menu. 
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About Key zones, Assigned and Unassigned 
Samples
When you load samples and rearrange your key mapping, you will often end up 
with samples that are not assigned to any key zone. In the following texts we re-
fer to the samples as follows:

• Assigned samples are samples that are currently assigned to one ore more 
key zones.

• Unassigned samples are samples that reside in the sample memory, but that 
are currently not assigned to any key zone.

Adding Sample(s) to a Key Map

If the sample hasn’t been loaded yet

1. Select a key zone.
This can be empty, or contain a sample - it doesn’t matter for now.

2. Use the Sample Browser to add one, or several (see below), sam-
ple(s).

The following will happen:

D If the zone contained a sample prior to loading, this will be re-
placed, both in the zone and in the sample memory, unless the 
sample was also used by another key zone, in which case it will be 
kept.

D If you loaded several samples, one of the samples will be assigned 
to the key zone, and the other samples will be loaded but remain 
unassigned.

If the sample is already loaded but unassigned

1. Select a key zone.
This can be empty, or contain a sample - it doesn’t matter for now.

2. Use the Sample knob to dial in the sample you want the key zone to 
play.

The Sample knob.

Setting the Root Key
Once you have defined a key zone, and added a sample, you should set the root 
key for the sample. 

D Select the key zone the sample belongs to, and click on the key you 
wish to set the root key to.
Which key to select is normally determined by the pitch of the sample. For 
example if the sample plays a F#2 guitar note, click on F#2.

✪ Note that it is possible to select a root key outside the key zone, if 
required.

Removing Sample(s) from a Key Map
D To remove a sample, select the zone it belongs to, and then select 

“Delete Sample” from the Edit or context menus.
The sample is removed from the zone and from sample memory.

D To remove a sample from a key zone/map, without removing it from 
memory, you can either select “No Sample” with the Sample knob 
for that zone, or simply replace it with another sample in the same 
way.

Removing All Unassigned Samples
D To remove all samples that are not assigned to any key zone, select 

Delete Unused Samples from the Edit menu.

Rearranging Samples in a Key Map
There is no specific function for rearranging or trading places between samples 
and key zones. Simply select a key zone and change the current sample assign-
ment with the Sample knob.

Setting Sample Level
For each key zone you can set a volume level, using the Level button below the 
display. If the transition between two key zones causes a noticeable level differ-
ence, this parameter can be used to balance the levels.

Tuning Samples
Sometimes you might find that the samples you wish to use in a key map are 
slightly out of tune with each other. This parameter allows you to tune each sam-
ple in a map by +/– half a semitone. 

D Select the key zone(s) that contains the out of tune sample(s), and 
use the Tune knob below the keyboard display. 
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✪ If all samples originate from different sources, and all or most of 
them are pitched slightly different (a not uncommon sampling sce-
nario), you could first tune them so that they all match each other, 
and then, if necessary, use the Sample Pitch controls in the Osc 
section to tune them globally to the “song” you wish to use the 
samples in.

D Note that if all the samples were slightly out of tune by the same 
amount in relation to the song you intend to use the samples in, it 
would be much simpler to use the Sample Pitch controls in the Osc 
section directly.

Looping Samples

A sample, unlike the cycles of an oscillator for example, is a finite quantity. There 
is a sample start and end. To get samples to play for as long as you press down 
the keys on your keyboard, they need to be looped. 
For this to work properly, you have to first set up two loop points which deter-
mine the part of the sample that will be looped, and make this a part of the audio 
file. You cannot set loop points in the NN-19, this has to be done in a sample ed-
itor. 

All included samples already have set loop points (if needed).

For each sample (or key zone), you can select the following Loop modes by us-
ing the Loop knob below the keyboard display:

D OFF
No looping is applied to the sample.

D FWD
The part between the loop points plays from start to end, then the cycle is re-
peated. This is the most common loop mode.

D FWD - BW
The part between the loop points plays from start to end, then from end to 
start (backwards), and then repeats the cycle. 

! For samples without any loop points, the whole sample will be 
looped.

About the Solo Sample Function
The Solo Sample button will allow you to listen to a selected sample over the en-
tire keyboard range.

D Select the key zone the sample is assigned to, and then activate 
Solo Sample.
This can be useful for checking if the root key is set correctly or if the current 
range is possible to extend etc.

! For Solo Sample to work, “Select Key Zone via MIDI” must be dis-
abled!
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Automap Samples
If you have a number of samples that belong together, but haven’t mapped them 
to key zones you can use the “Automap Samples” function on the Edit menu. 
This is used in the following way:

1. Select all samples that belong together and load them in one go, 
using the sample browser.
One of the samples will be assigned to a key zone spanning the whole 
range, and the rest will be loaded in to memory but remain unassigned.

2. Select Automap Samples from the Edit menu.

Now all samples currently in memory (assigned or unassigned) will be arranged 
automatically so that:

D Each sample will be placed correctly according to its root note, and 
will be tuned according to the information in the sample file.
Most audio editing programs can save root key information as part of the file.

D Each sample will occupy half the note range to the next sample’s 
root note.
The root key will always be in the middle of each zone, with the zone extend-
ing both down and up in relation to the root position.

Mapping Samples Without Root Key or Tuning 
Information
Some samples may not have any information about root key or tuning stored in 
the file. If the file names indicate the root key you can manually set it for each 
sample using the method described below. In a worst case scenario, i.e. no tun-
ing or root key information whatsoever, you can still make use of the Automap 
function:

1. Select all samples that belong together and load them in one go, 
using the sample browser.
One of the samples will be assigned to a key zone spanning the whole 
range, and the rest will be loaded in to memory but remain unassigned.

2. Manually set the root key, and adjust the tune knob if the sample 
needs fine-tuning.
Without any information stored in the file, or if the file name doesn’t indicate 
the root key, you will have to use your ears for this step. Play the sample and 
use another instrument or a tuner to determine its pitch.

3. Select the next sample using the Sample knob, and repeat the pre-
vious step.
Proceed like this until you have set a root key for all the samples in memory.

4. Select “Automap Samples” from the edit menu.
The samples will be automatically mapped according to their set root key po-
sitions!

How Mapping Information is Saved
All information about key zones, high and low range, root key etc. is stored as 
part of the Sampler Patch. The original sample files are never altered!
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NN-19 Synth Parameters
The NN-19 synth parameters are used to shape and modulate samples. These 
are mostly similar to the parameters used to shape the oscillators in Subtractor - 
you have envelope generators, a filter, velocity control etc. Again, it is important 
to remember that these parameters do not alter the audio files in any way, only 
the way they will play back.

! These parameters are global, in the sense that they will affect all 
samples in a sample patch.

The Oscillator Section

For a sample patch, the actual samples are what oscillators are for a synthesizer, 
the main sound source. The following settings can be made in the Osc section 
of the NN-19:

Sample Start

This changes the start position of samples in a sample patch. Turning the knob 
clockwise gradually offsets the samples’ start position, so that they will play 
back from a position further “into” the samples’ waveform. This is useful mainly 
for two things:

D Removing “air” or other unwanted artefacts from the start of less 
than perfect samples.
Occasionally (although not in any samples supplied with Reason) you may 
come across samples where the start point of the sample is slightly ahead of 
the start of the actual sound. There may be noise or silence in the beginning 
which was not intended to be part of the sample. By adjusting the sample 
start position, this can be removed.

D Changing the start point as an effect.
For example, if you had a sample of someone saying “one, two, three”, you 
could change the start position so that when you played the sample it would 
start on “three”. 

✪ You can also assign velocity sample start allowing to use your play-
ing to determine the exact sample start. See later in this chapter.

Setting Sample Pitch - Octave/Semitone/Fine

By adjusting the corresponding knobs you can change the pitch of all samples 
belonging to a patch, in three ways:

D Octave steps 
The range is 0 - 8. The default setting is 4. 

D Semitone steps 
Allows you to raise the frequency in 12 semitone steps (1 octave).

D Fine steps (100th of a semitone) 
The range is -50 to 50 (down or up half a semitone).

! Note that the controls in this section cannot be used to tune sam-
ples against each other, as all samples will be affected equally. To 
tune individual samples, you use the Tune parameter below the 
keyboard display (see page 140).

Keyboard Tracking

The Osc section has a button named “Kbd. Track”. If this is switched off, the 
sample’s pitch will remain constant, regardless of any incoming note pitch mes-
sages, although the oscillator still reacts to note on/off messages. This could be 
useful if you are using non-pitched samples, like drums for example. You could 
then play a sample in a zone using several keys, allowing for faster note trigger-
ing if you wanted to play a drum roll, for example.

Osc Envelope Amount

This parameter determines to what degree the overall pitch of the samples will 
be affected by the Filter Envelope (see page 145). You can set negative or pos-
itive values here, which determines whether an envelope parameter should raise 
or lower the pitch.
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The Filter Section

Filters are used for shaping the overall timbre of the sound. The filter in NN-19 is 
a multimode filter with five filter types.

Filter Mode

With this selector you can set the filter to operate as one of five different types of 
filter. These are as follows:

D 24 dB Lowpass (LP 24)
Lowpass filters lets low frequencies pass and cuts out the high frequencies. 
This filter type has a fairly steep roll-off curve (24dB/Octave). Many classic 
synthesizers (Minimoog/Prophet 5 etc.) used this filter type.

D 12 dB Lowpass (LP 12)
This type of lowpass filter is also widely used in classic analog synthesizers 
(Oberheim, TB-303 etc.). It has a gentler slope (12 dB/Octave), leaving 
more of the harmonics in the filtered sound compared to the LP 24 filter.

D Bandpass (BP 12)
A bandpass filter cuts both high and low frequencies, while midrange fre-
quencies are not affected. Each slope in this filter type has a 12 dB/Octave 
roll-off.

D High-Pass (HP12)
A highpass filter is the opposite of a lowpass filter, cutting out the lower fre-
quencies and letting the high frequencies pass. The HP filter slope has a 12 
dB/Octave roll-off.

D Notch
A notch filter (or band reject filter) could be described as the opposite of a 
bandpass filter. It cuts off frequencies in a narrow midrange band, letting the 
frequencies below and above through. 

Filter Frequency 

The Filter Frequency parameter (often referred to as “cutoff”) determines which 
area of the frequency spectrum the filter will operate in. For a lowpass filter, the 
frequency parameter could be described as governing the “opening” and “clos-
ing” of the filter. If the Filter Freq is set to zero, none or only the very lowest fre-
quencies are heard, if set to maximum, all frequencies in the waveform are heard. 
Gradually changing the Filter Frequency produces the classic synthesizer filter 
“sweep” sound.

! Note that the Filter Frequency parameter is usually controlled by 
the Filter Envelope (see “Envelope Section” below) as well. Chang-
ing the Filter Frequency with the Freq slider may therefore not pro-
duce the expected result.

Resonance

The filter resonance parameter (sometimes called Q) is used to set the Filter 
characteristic, or quality. For lowpass filters, raising the filter Res value will em-
phasize the frequencies around the set filter frequency. This produces a gener-
ally thinner sound, but with a sharper, more pronounced filter frequency 
“sweep”. The higher the resonance value, the more resonant the sound be-
comes until it produces a whistling or ringing sound. If you set a high value for 
the Res parameter and then vary the filter frequency, this will produce a very dis-
tinct sweep, with the ringing sound being very evident at certain frequencies.

• For the highpass filter, the Res parameter operates just like for the lowpass 
filters.

• When you use the Bandpass or Notch filter, the Resonance setting adjusts 
the width of the band. When you raise the Resonance, the band where fre-
quencies are let through (Bandpass), or cut (Notch) will become narrower. 
Generally, the Notch filter produces more musical results using low reso-
nance settings.
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Envelope Section
Envelope generators are used to control several important sound parameters in 
analog synthesizers, such as pitch, volume, filter frequency etc. Envelopes gov-
ern how these parameters should respond over time - from the moment a note is 
struck to the moment it is released. 

Standard synthesizer envelope generators have four parameters; Attack, Decay, 
Sustain and Release (ADSR). 

There are two envelope generators in the NN-19, one for volume, and one for 
the filter frequency.

! Please refer to the Subtractor chapter for a description of the basic 
envelope parameters.

Amplitude Envelope

The Amp Envelope is used to adjust how the volume of the sound should 
change from the time you press a key until the key is released. By setting up a 
volume envelope you sculpt the sound’s basic shape with the four Amplitude En-
velope parameters, Attack, Decay, Sustain and Release. This determines the ba-
sic character of the sound (soft, long, short etc.). The Level parameter acts as a 
general volume control for the sample patch.

Filter Envelope

The Filter Envelope can be used to control two parameters; filter frequency and 
sample pitch. By setting up a filter envelope you control the how the filter fre-
quency and/or the sample pitch should change over time with the four Filter En-
velope parameters, Attack, Decay, Sustain and Release. 

Filter Envelope Amount

This parameter determines to what degree the filter will be affected by the Filter 
Envelope. Raising this knob’s value creates more drastic results. The Envelope 
Amount parameter and the set filter frequency are related. If the Filter Freq slider 
is set to around the middle, this means that the moment you press a key the filter 
is already halfway open. The set Filter Envelope will then open the filter further 
from this point. The Filter Envelope Amount setting affects how much further the 
filter will open.

Filter Envelope Invert

If this button is activated, the envelope will be inverted. For example, normally the 
Decay parameter lowers the filter frequency, but after activating Invert it will in-
stead raise it, by the same amount. Note that Invert does not affect the Osc pitch 
parameter (this can be inverted by setting positive or negative values).

LFO Section

LFO stands for Low Frequency Oscillator. LFOs are oscillators in the sense that 
they generate a waveform and a frequency. However, there are two significant 
differences compared to normal sound generating oscillators:

• LFOs only generate waveforms with low frequencies.
• The output of the two LFOs are never actually heard. Instead they are used 

for modulating various parameters.

The most typical application of an LFO is to modulate the pitch of a (sound gen-
erating) oscillator or sample, to produce vibrato. 

The LFO section has the following parameters:
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Waveform

LFO 1 allows you to select different waveforms for modulating parameters. 
These are (from the top down):

Destination

The available LFO Destinations are as follows:

Sync

By clicking this button you activate/deactivate LFO sync. The frequency of the 
LFO will then be synchronized to the song tempo, in one of 16 possible time-
divisions. When sync is activated, the Rate knob (see below) is used for setting 
the desired timedivision.

Turn the knob and check the tooltip for an indication of the timedivision.

Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster modu-
lation rate.

Amount

This parameter determines to what degree the selected parameter destination 
will be affected by the LFO. Raising this knob’s value creates more drastic re-
sults.

Play Parameters
This section deals with two things: Parameters that are affected by how you 
play, and modulation that can be applied manually with standard MIDI keyboard 
controls. 

These are:

• Velocity Control
• Pitch Bend and Modulation Wheel
• Legato
• Portamento
• Polyphony
• Voice Spread
• External Controllers

| Waveform | Description

Triangle This is a smooth waveform, suitable for normal vibrato.

Inverted
Sawtooth

This produces a “ramp up” cycle. If applied to an oscillator’s 
frequency, the pitch would sweep up to a set point (governed 
by the Amount setting), after which the cycle immediately 
starts over.

Sawtooth This produces a “ramp down” cycle, the same as above but in-
verted.

Square This produces cycles that abruptly changes between two val-
ues, usable for trills etc.

Random Produces random stepped modulation to the destination. 
Some vintage analog synths called this feature “sample & 
hold”.

Soft Random The same as above, but with smooth modulation.

| Destination | Description

Osc Selecting this makes LFO control the pitch (frequency) of the 
sample patch.

Filter Selecting this makes the LFO control the filter frequency. 

Pan Selecting this makes the LFO modulate the pan position of sam-
ples, i.e. it will move the sound from left to right in the stereo 
field.
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Velocity Control

Velocity is used to control various parameters according to how hard or soft you 
play notes on your keyboard. A common application of velocity is to make 
sounds brighter and louder if you strike the key harder. By using the knobs in this 
section, you can control how much the various parameters will be affected by 
velocity. The velocity sensitivity amount can be set to either positive or negative 
values, with the center position representing no velocity control. 

The following parameters can be velocity controlled:

Pitch Bend and Modulation Wheels
The Pitch Bend wheel is used for “bending” notes, like bending the strings on a 
guitar. The Modulation wheel can be used to apply various modulation while you 
are playing. Virtually all MIDI keyboards have Pitch Bend and Modulation con-
trols. NN-19 also has two functional wheels that could be used to apply real time 
modulation and pitch bend should you not have these controllers on your key-
board, or if you aren’t using a keyboard at all. The wheels mirror the movements 
of the MIDI keyboard controllers.

Pitch Bend Range

The Range parameter sets the amount of pitch bend when the wheel is turned 
fully up or down. The maximum range is “24” (=up/down 2 Octaves).

Modulation Wheel

The Modulation wheel can be set to simultaneously control a number of param-
eters. You can set positive or negative values, just like in the Velocity Control 
section. The following parameters can be affected by the modulation wheel:

Legato
Legato works best with monophonic sounds. Set Polyphony (see below) to 1 
and try the following:

D Hold down a key and then press another key without releasing the 
previous.
Notice that the pitch changes, but the envelopes do not start over. That is, 
there will be no new “attack”. 

D If polyphony is set to more voices than 1, Legato will only be ap-
plied when all the assigned voices are “used up”.
For example, if you had a polyphony setting of “4” and you held down a 4 
note chord, the next note you played would be Legato. Note, however, that 
this Legato voice will “steal” one of the voices in the 4 note chord, as all the 
assigned voices were already used up!

| Destination | Description

Amp This let’s you velocity control the overall volume of the sound. If 
a positive value is set, the volume will increase the harder you 
strike a key. A negative value inverts this relationship, so that 
the volume decreases if you play harder, and increases if you 
play softer. If set to zero, the sound will play at a constant vol-
ume, regardless of how hard or soft you play.

F. Env This sets velocity control for the Filter Envelope Amount param-
eter. A positive value will increase the envelope amount the 
harder you play. Negative values invert this relationship.

F. Dec This sets velocity control for the Filter Envelope Decay parame-
ter. A positive value will increase the Decay time the harder you 
play. Negative values invert this relationship.

S.Start This sets velocity control for the Sample Start parameter. A 
positive value will increase the Start Time amount the harder 
you play. Negative values invert this relationship.

A. Attack This sets velocity control for the Amp Envelope Attack parame-
ter. A positive value will increase the Attack time the harder you 
play. Negative values invert this relationship.

| Destination | Description

F. Freq This sets modulation wheel control of the Filter Frequency pa-
rameter. A positive value will increase the frequency if the wheel 
is pushed forward. Negative values invert this relationship.

F. Res This sets modulation wheel control of the Filter Resonance pa-
rameter. A positive value will increase the resonance if the 
wheel is pushed forward. Negative values invert this relation-
ship.

F. Dec This sets modulation wheel control for the Filter Envelope De-
cay parameter. A positive value will increase the decay if the 
wheel is pushed forward. Negative values invert this relation-
ship.

LFO This sets modulation wheel control of the LFO Amount parame-
ter. A positive value will increase the Amount if the wheel is 
pushed forward. Negative values invert this relationship.

Amp This sets modulation wheel control for the Amp level parameter. 
A positive value will increase the level if the wheel is pushed for-
ward. Negative values invert this relationship.
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Retrig
This is the “normal” setting for playing polyphonic patches. That is, when you 
press a key without releasing the previous, the envelopes are retriggered, like 
when you release all keys and then press a new one. In monophonic mode, Re-
trig has an additional function; if you press a key, hold it, press a new key and 
then release that, the first note is also retriggered.

Portamento (Time)
Portamento is when the pitch “glides” between the notes you play, instead of in-
stantly changing the pitch. The Portamento knob is used to set how long it takes 
for the pitch to glide from one pitch to the next. If you don’t want any Portamento 
at all, set this knob to zero.

Setting Number of Voices - Polyphony
This determines the polyphony, i.e. the number of voices a patch can play simul-
taneously. This can be used to make a patch monophonic (=a setting of “1”), or 
to extend the number of voices available for a patch. The maximum number of 
voices you can set a patch to use is 99. 

! Note that the Polyphony setting does not “hog” voices. For exam-
ple, if you have a patch that has a polyphony setting of ten voices, 
but the part the patch plays only uses four voices, this won’t mean 
that you are “wasting” six voices. In other words, the polyphony set-
ting is not something you need to consider if you want to conserve 
CPU power - it is only the number of voices actually used that 
counts.

Voice Spread
This parameter can be used to control the stereo (pan) position of voices. The 
Spread knob determines the intensity of the panning. If this is set to “0”, no pan-
ning will take place. The following pan modes can be selected:

Low Bandwidth
This will remove some high frequency content from the sound, but often this is 
not noticeable (this is especially true if you have “filtered down” samples). Acti-
vating this mode will save you some extra computer power, if needed.

Controller Section
NN-19 can receive common MIDI controller messages, and route these to vari-
ous parameters. The following MIDI messages can be received:

• Aftertouch (Channel Pressure)
• Expression Pedal
• Breath Control

If your MIDI keyboard is capable of sending Aftertouch messages, or if you have 
access to an Expression Pedal or a Breath controller, you can use these to mod-
ulate NN-19 parameters. The “Source” selector switch determines which of 
these message-types should be received.

These messages can then be assigned to control the following parameters:

| Mode | Description

Key This will shift the pan position gradually from left to right the higher up 
on the keyboard you play.

Key 2 This will shift the pan position from left to right in 8 steps (1/2 octave) 
for each consecutive higher note you play, and then repeat the cycle.

Jump This will alternate the pan position from left to right for each note 
played.

F. Freq This sets external modulation control of the filter frequency parame-
ter. A positive value will increase the frequency with higher external 
modulation values. Negative values invert this relationship.

LFO 1 This sets external modulation control of the LFO Amount parameter. 
A positive value will increase the LFO amount with higher external 
modulation values. Negative values invert this relationship.

Amp This let’s you control the overall volume of the sound with external 
modulation. If a positive value is set, the volume will increase with 
higher external modulation values. A negative value inverts this rela-
tionship.
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Connections
On the back panel of the NN-19 you will find the connectors, which are mostly 
CV/Gate related. 

Audio Outputs
These are the main left and right audio outputs. When you create a new NN-19 
device, these are auto-routed to the first available channel on the audio mixer.

Mono Sequencer Control
These are the main CV/Gate inputs. CV controls the note pitch. Gate inputs trig-
ger note on/off values plus a level, which can be likened to a velocity value. If you 
want to control the NN-19 from a Matrix Pattern Sequencer for example, you 
would normally use these inputs. The inputs are “mono”, i.e. they control one 
voice in the sampler.

Modulation Inputs
! Remember that CV connections will not be stored in the sample 

patch, even if the connections are to/from the same NN-19 device! 

These control voltage (CV) inputs (with associated voltage trim pots), can mod-
ulate various NN-19 parameters from other devices, or from the modulation out-
puts of the same NN-19 device. These inputs can control the following 
parameters:

• Osc (sample) Pitch
• Filter Cutoff
• Filter Resonance
• Amp Level 
• Mod Wheel

Modulation Outputs
The Modulation outputs can be used to voltage control other devices, or other 
parameters in the same NN-19 device. The Modulation Outputs are:

• Filter Envelope 
• LFO 

Gate Inputs
These inputs can receive a CV signal to trigger the envelopes. Note that con-
necting to these inputs will override the “normal” triggering of the envelopes. For 
example, if you connected a LFO output to the Gate Amp input, you would not 
trigger the amp envelope by playing notes, as this is now controlled by the LFO. 
In addition you would only hear the LFO triggering the envelope for the notes 
that you hold down.

• Amp Envelope
• Filter Envelope
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Introduction
Features
The basic functions of the NN-XT are very similar to those of its sampler com-
panion in the Reason rack - the NN-19. Just like the NN-19, NN-XT lets you load 
samples and create multi-sample patches by mapping samples across the key-
board. The sound can then be modified by a comprehensive set of synth-type 
parameters. There are however some major differences between the two. The 
NN-XT has:

D Support for SoundFonts.
Presets and samples from SoundFont banks can be loaded and used in the 
NN-XT (see page 153).

D 8 stereo output pairs.
This makes it possible to route different samples to different mixer channels 
for individual effect processing (see page 174).

D The possibility to create layered sounds. 
This is done by mapping several samples across the same keyboard range 
(see page 169).

D The possibility to create sounds that only play over certain velocity 
ranges, velocity switched key maps and velocity crossfading.
See page 170.

D Key maps with individual synth parameter settings for each sample.
See page 175.

Even though the NN-XT is a more advanced sample player than NN-19, it should 
not be considered as a successor to the NN-19, but rather as a complement to 
it. The NN-19 will for example probably still be the sampler of choice for those of 
you who want to be able to quickly load a couple of samples and start playing, 
since that particular aspect takes a little more doing with the NN-XT.

Panel Overview
The Main Panel
When the NN-XT is added to the rack, you will initially only see the main panel.

The NN-XT main panel.
The main panel is where you load complete sample patches. It also contains the 
“global controls”. These are controls that affect and modify the sound of entire 
patches rather than the individual key zones.

The Remote Editor panel
To show/hide the remote editor panel, use the fold/unfold arrow at the bottom 
left.

The remote editor panel is where you load individual samples, create key maps, 
modify the sound of the samples with synth parameters etc.

! The main panel of the NN-XT can be folded like any other Reason 
device. Note that folding the main panel will also fold the remote 
editor regardless of its current state.

Click this arrow...

...to make the remote editor panel visible.
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Loading Complete 
Patches and REX Files
As previously alluded, you can load complete sample patches as well as individ-
ual samples into the NN-XT.

• A patch is a complete “sound package”. It contains information about all the 
samples used, assigned key zones, associated panel settings etc. Loading a 
sample patch is done by using the patch browser on the main panel, and 
works in the same way as with any other Reason device.

The patch browser button on the main panel.

For general instructions on how to load and save patches, please consult the 
chapter “Working with Patches” in the Getting Started book.

• Loading separate samples is done in a similar way, but via the sample 
browser on the remote editor panel. If you load samples, map them across 
keyboard ranges and set up the sound the way you want it, you can save 
your settings as a Patch for easy access later.

The sample browser button on the remote editor.

More about loading samples later in this chapter.

Loading NN-XT Patches
NN-XT Patches are patches made specifically for the NN-XT. Reason ships with 
a large number of NN-XT Patches, some in the Factory Sound Bank but most in 
the Orkester Sound Bank. NN-XT Patches have the extension “.sxt”.

Loading NN-19 Patches
NN-19 Patches have the extension “.smp”. Note that when loading NN-19 
patches into the NN-XT, some parameters will not be applicable since the NN-
19 and the NN-XT to some extent differ from each other in terms of controls. In 
these cases, the concerned parameters will either be ignored by the NN-XT or 
mapped to the most equivalent control.

Loading SoundFonts
The SoundFont format was developed by E-mu systems in collaboration with 
Creative Technologies. It is a standardized data format containing wavetable 
synthesized audio and information on how it should be played back in wavetable 
synthesizers - typically on audio cards. The SoundFont format is an open stan-
dard so there is a vast amount of SoundFont banks and SoundFont compatible 
banks developed by third parties.

Loading SoundFonts is no different from loading NN-XT Patches. As with NN-
19 Patches, the NN-XT does its best to map all the SoundFont settings to NN-
XT parameters.

You can load SoundFont presets by using the patch browser, and single Sound-
Font samples by using the sample browser.

Loading Complete REX Files as Patches
REX Files are files created in the ReCycle program. This is an application cre-
ated by Propellerhead Software, used for slicing up music loops and enabling 
them to be played back in any tempo. In Reason, REX files are primarily used in 
the Dr. Rex loop player, but they can be used in the NN-XT as well. Possible ex-
tensions are “.rx2”, “.rcy” and “.rex”.

When loading a REX file, each slice in the file is assigned to one key, chromati-
cally. All parameters are set to default settings.

When using REX files in the DR. Rex loop player, it is possible to make a track 
play the slices in order to recreate the original loop. To do the same in the NN-
XT requires a few extra steps.

1. Use the patch browser to load the REX file into an NN-XT sampler.

2. Create a Dr. Rex loop player and load the same REX file in to this 
device.

3. Use the To Track feature on the Dr. Rex to create playback data (a 
group) on the track assigned to the Dr. Rex.

4. Move that group to the track that plays the NN-XT and play it back 
from there.

5. Delete the Dr. Rex loop player.
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Using the Main Panel
All of the controls on the main panel are used for globally modifying certain pa-
rameters for all of the samples in a patch, by the same amount.

! Movements of the parameters on the main panel can be recorded 
as automation. However, controls on the remote editor panel (de-
scribed later) can not!

The following is a description of the controls and parameters on the main panel.

The Pitch Bend and Modulation wheels

Most MIDI keyboards come equipped with Pitch Bend and Modulation wheels. 
The NN-XT features settings for how incoming MIDI Pitch Bend and Modulation 
wheel messages should affect the sound. The wheels on the NN-XT will also 
mirror the movements of the wheels on your MIDI keyboard.

If you don’t have Pitch Bend or Modulation controls on your keyboard, or if you 
aren’t using a keyboard at all, you can use the two fully functional wheels on the 
NN-XT to apply real time modulation and pitch bend.

• The Pitch Bend wheel is used for “bending” the played notes up and down 
to change their pitch - much like bending the strings on a guitar or other 
string instrument. The Pitch Bend Range is set on the remote editor panel 
(see page 178).

• The Modulation wheel can be used for applying modulation to the sound 
while you’re playing. It can also be used for controlling a number of other pa-
rameters, as described on page 175.

External control

This section can be used in three ways:

Receiving MIDI controller messages from external sources

NN-XT can receive common MIDI controller messages, and route these to vari-
ous parameters. You use the “Source” selector switch to determine which type 
of message should be received:

• Aftertouch (Channel Pressure)
• Expression Pedal
• Breath Control

If your MIDI keyboard is capable of sending aftertouch messages, and/or if you 
have connected an expression pedal or a breath controller to it, you can use 
these to modulate NN-XT parameters. Which parameters should be modulated 
is set in the remote editor panel (see page 175).

Recording MIDI controller messages with the wheel

The wheel in the external control section can be used for recording any or all of 
the three MIDI controller message types into the Reason sequencer. If your MIDI 
keyboard isn’t capable of sending aftertouch messages or you don’t have ac-
cess to an expression pedal or a breath controller, you can use the wheel in-
stead. 

This is done just as with any other automation recording, see page 8.
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High Quality Interpolation

This switch turns High Quality Interpolation on and off. When it is activated, the 
sample pitch is calculated using a more advanced interpolation algorithm. This 
results in better audio quality, especially for samples with a lot of high frequency 
content.

• High Quality Interpolation uses more computer power however - so if you 
don’t need it, it’s a good idea to turn it off! Listen to the sounds in a context 
and determine whether you think this setting makes any difference.

• If you are using a Macintosh with a G4 (Altivec) processor, High Quality In-
terpolation is always activated, regardless of the state of this button.

Global Controls

All of these knobs change the values of various parameters in the remote editor 
panel and affect all loaded samples. Thus they can be used for quickly adjusting 
the overall sound.

The knobs are bi-polar, which means that when they are centered, no parameter 
change is applied. By turning them to the right you increase the corresponding 
value, and by turning them to the left, you decrease the value.

Again, the movements of these parameters can be recorded as automation. This 
is done just as with any other automation recording, see page 8.

The controls are, from left to right:

Filter

These two knobs each control a parameter of the filter (see page 179). Note that 
the filter must be on for these to have any effect.

D Frequency
This changes the cutoff frequency of the filter. 

D Resonance
This changes the resonance parameter of the filter, meaning - the filter char-
acteristic, or quality.

Amp Envelope

These three knobs control the Amplitude Envelope (see page 181) in the follow-
ing way:

D Attack
This changes the Attack value of the Amplitude Envelope. That is, how long 
it should take for the sound to reach full level after you press a key on your 
keyboard.

D Decay
This changes the Decay value of the Amplitude Envelope. Decay determines 
how long it should take for the sound to go back to the sustain level after it 
has reached full value (see page 181) and the key that triggered the sound 
is still being pressed.

D Release
This changes the Release value of the Amplitude Envelope. Release works 
just like Decay with the exception that it determines how long it should take 
for the sound to become silent after the key has been released.

Mod Envelope

This knob controls the Decay value of the Modulation Envelope (see page 
180). Also see above for a brief description of Decay.

Master Volume

This controls the main volume out from the NN-XT. Turn the knob to the right to 
increase the volume.
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Overview of the Remote 
Editor panel
It is in the Remote Editor Panel that the main NN-XT action is going on, espe-
cially if you’re creating your own patches. The remote editor is dominated by the 
key map display, and this is also the part on which we will concentrate to begin 
with.

The Key Map display
The key map display consists of a number of separate areas that let you do dif-
ferent things. To help you navigate the key map display, these areas are de-
scribed below.

The Info area

This displays the following information about the currently selected sample: 
Sample rate, mono/stereo information, bit resolution and file size.

The Sample area

This area displays the names of the samples in each zone. It also allows you to 
change the order of the zones by clicking and dragging them up and down.

The Group area

This area does not show any information. However, by clicking in it, you can in-
stantly select all the zones that belong to a certain group. See page 163 for in-
formation on how to create groups.

The Keyboard area

Aside from the fact that is a guideline for setting up key ranges, it is also used for 
setting the root keys of, and auditioning loaded samples. See page 167 and 
page 162 respectively for more information.

The Tab Bar area

This area gives you a visual indication of the key range of a selected zone. By 
clicking and dragging the “handles” at the key range boundaries, you can resize 
the key ranges, and by clicking in between the handles, you can move the key 
ranges without changing their length.

The Key Range area

This area in the middle of the key map display is where you keep track of all the 
zones and the relationship between them. You can also move and resize the 
zones just like in the Tab Bar area, as described above.

The Scrollbars

There are both horizontal and vertical scrollbars that work just like regular scroll-
bars. Whenever there is more information in the key map display than what fits 
on a “single screen”, you can use the scrollbars to reveal it. Either click on the ar-
rows or click and drag the scrollbar handles.

The Info area.

The Sample area.

The Group
area.

The Keyboard area. The Tab Bar area.

The Key Range area.

The Scrollbars.
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Sample Parameters

This area shows the current values of basic parameters you can set for each 
separate zone, such as root key, play mode, output etc. The parameters are 
changed by using the knobs directly below the key map display.

Group Parameters

These parameters are adjusted on a per group basis (see page 174 for more in-
formation on groups). Most of them relate to performance or playing style.

Synth Parameters

The bulk of the parameters on the remote editor are used for adjusting the sound 
of the samples by applying filtering, envelope shaping, modulation (like vibrato 
and tremolo) and so on. We call these the synth parameters, since they are to a 
large extent identical to those on a regular synthesizer.

About Samples and Zones
For a clear understanding of the terminology used when describing the various 
operations that can be performed in the key map display, it is important to clarify 
the distinction between a sample and a zone:

• A Sample is a piece of audio that can be loaded into the NN-XT and played 
back.

• A Zone could be viewed as a “container” for a loaded sample.

All loaded samples are placed in “Zones” in the key map display. You can then 
organize the zones as you please, and make various settings such as key- and 
velocity ranges separately for each zone.

In other words, the settings you make are actually performed on the zones, but 
affect the samples in them. Hence, when we talk about making settings for a 
zone, it is synonymous with making settings for a sample - the sample that the 
zone contains.

• Two or more zones can play the same sample, but with different parameter 
settings, making them sound completely different.

• A zone can be empty, playing no sample at all.
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Selections and Edit Focus
Almost all operations in the remote editor are performed on one or more se-
lected zones or on the zone with edit focus. Several zones can be selected at 
once, but only one zone at a time can have edit focus.

This is important since:

D Editing operations that can be performed on several zones (like de-
leting), always apply to the selected zones.

D Editing operations that can be performed on one zone only (like ad-
justing the “Lo key”), always apply to the zone with edit focus.

D The front panel always shows the settings for the zone with edit fo-
cus.

Here no zone is selected.

Here the middle zone is selected but does not have edit focus.

Here the middle zone has edit focus but is not selected. Notice the thicker border and the 
additional handles in the key range area.

Here the middle zone is selected and has edit focus.

Here, all three zones are selected, but the middle one has edit focus.

Selecting Zones
D To select a zone, click on it.

Clicking on a zone will also automatically give it edit focus.

You can also select multiple zones in several ways:

D By holding down [Shift] or [Command] (Mac)/[Ctrl] (Windows) and 
clicking on the zones you wish to select.
This way you can select several non-contiguous zones. You can also dese-
lect a selected zone by clicking on it again.

D By using the keyboard command [Command]-[A] (Mac)/[Ctrl]-[A] 
(Windows). 
This will select all of the zones in the key map display. To deselect all zones, 
click in an unoccupied area in the Sample column or the key map area.

D By clicking and dragging a selection box in the key map area.

Note that the zones don’t have to be completely encompassed by the selection 
box. The selection box only have to intersect parts of the zones to include them 
in the selection.

Making a selection box like this....

...will select these zones:



NN-XT SAMPLER 159

Selecting zones via MIDI

You can also select zones via your MIDI keyboard. By clicking the button marked 
“Select zones via MIDI” above the key map display so that it lights up, you en-
able selection via MIDI.

This way, you can select a zone and give it edit focus by pressing a key that lies 
within the zone’s key range (see later in this chapter for information about setting 
up key ranges).

In this case, this zone can be selected by pressing any key between C2 - C3 on your MIDI 
keyboard.

Note also, that selection via MIDI is velocity sensitive. Zones may have specific 
velocity ranges. This means that they won’t be played unless the key that trig-
gers the zone is played with a certain velocity. The same rules apply when se-
lecting via MIDI, only zones that meet the velocity criteria will be selected. Read 
more about setting up velocity ranges on page 170.

Selecting All Zones in a Group

The concept of zone groups is fully introduced on page 163. For now we will 
only describe how to select all samples that belong to the same group:

Moving Edit Focus

Moving Edit Focus

A zone can be given edit focus independently of selection:

D When you click on an unselected zone, it both gets selected and 
gets edit focus.

D When you select several zones using [Shift] or [Command]/[Ctrl], 
the one you select last always gets edit focus.

D To set edit focus to a zone when several zones are already selected, 
click on it without holding down any modifier keys.
This way, you can move edit focus between the selected zones freely with-
out deselecting any of them.

Clicking in the 
Group column...

...selects all zones 
in the group
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Adjusting Parameters
Adjusting Synth Parameters
The synth parameters are the ones that occupy the bulk of the remote editor 
panel (see page 157). Changes you make to synth parameters always apply to 
all selected zones.

D The panel “only” shows the settings for the zone with edit focus.
More about this below.

D To make adjustments to one zone, select it (which also gives it edit 
focus) and adjust the parameter on the front panel.

D To set several zones to the same value, select them and adjust the 
parameter.
All zones will be set to the same value for the parameter you adjusted. 

Adjusting Group Parameters
Group parameters apply to a group. That is, they are settings that are shared by 
all zones in a group.

D To make adjustments to one group, select one or more zones that 
belong to the group, and adjust the parameter on the front panel.

D To set several groups to the same value, select at least one zone in 
each group you want to adjust, and adjust the parameter.
All groups will be set to the same value. More about this below.

Sample Parameters

About Single and Multiple Parameters

The Sample parameters are divided into two groups: single and multiple, differ-
entiated by color on the front panel:

D Single adjustment parameters can only be applied to one zone at a 
time. Adjustments made to these parameters always only apply to 
the zone with edit focus.

D Multiple adjustment parameters apply to all selected zones, just 
like the synth parameters, as described above.

About “Conflicting” Parameters

Often you will find yourself in a situation where you select multiple zones and pa-
rameter settings differ between them. This is quite normal. For example, you will 
often find yourself making adjustments to for example level and filtering to bal-
ance the sound between several samples across the keyboard. However, if you 
have multiple selections this can sometimes lead to confusion: Enter the NN-
XT’s “conflicting parameters” indication:
Whenever two or more selected zones have conflicting parameter settings, NN-
XT will notify you about this by showing a small “M” (for multiple) symbol, next to 
the parameter.

In this example, Level and Spread have conflicting settings.

D The controls on the panel always show the setting for the zone with 
edit focus.

D By clicking your way through the zones within the selection, you 
can see the settings for each zone.

D If you adjust a parameter, all selected zones will be set to the same 
value for this parameter.

You can put this functionality to good use when checking how a patch has been 
created and when checking that your own settings are consistent through the 
various zones.

Copying parameters between zones

You can easily copy parameter settings from one zone to any number of other 
zones. Proceed as follows:

1. Select all the zones you want to involve in the operation.
By this we mean the zone with the settings you wish to copy, and the zone(s) 
to which you want to copy the settings.

2. Make sure the zone that contains the settings you want to copy has 
edit focus.

3. Pull down the Edit menu or the NN-XT context menu and select 
“Copy Parameters to Selected Zones”.
All the selected zones will now get the exact same parameter settings.

! Observe that this only applies to the synth parameters (see page 
175). Sample parameters (root key, velocity range etc.) can not be 
copied.

Single adjustment parameters Multiple adjustment parameters:
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Managing Zones and 
Samples
Creating a Key Map
When you add an NN-XT sampler to the rack, its key map display is always 
empty. That is, it contains no samples.

To create a new key map, proceed as follows:

1. Either click the Browse Samples button, select Browse Samples 
from the Edit menu or select Browse Samples from the NN-XT’s 
context menu.
This will bring up the regular Reason file browser.

The Browse Samples button.

2. Select the sample or samples that you want to load in the browser 
and click “OK”.
The selected sample(s) are loaded into the NN-XT.

When new samples are loaded into the NN-XT they have the following proper-
ties:

• Each sample is placed in its own zone.
• Each zone spans a key range of five octaves on the keyboard - C1 to C6.
• All the newly added sample(s)/zones are automatically selected.
• The first added zone gets edit focus.

A key map with four newly added samples.

Setting Root Notes and Key Ranges

The next step after loading the samples is most likely to adjust the key range, 
root note and tuning of the samples, so that they play sensibly across the key 
range. There are many ways of doing this, described on page 164 and onwards. 
However, we will here briefly describe a procedure for quickly creating a com-
plete key map out of a set of loaded samples.

This example assumes that the samples you load is a set of multisamples for a 
pitched instrument (like guitar, piano, flute etc.).

1. Load the samples.

2. Use “Select All” on the Edit menu to select all the loaded samples.

3. Use “Set Root Notes from Pitch Detection” to automatically set up 
the root notes (pitches) for the samples.

4. Select “Automap Zones” from the Edit menu.

All the selected zones will now be arranged automatically into a basic key map. 
You can now proceed with adjusting the synth parameters on the front panel to 
shape the sound!

About File Formats and REX Slices
The NN-XT can import various types of samples:

D Standard Wave files 
These have the extension “.wav”. This is the standard audio file format for the 
PC platform. Any audio or sample editor, regardless of platform, can read 
and create audio files in Wave format. Any sample rate and practically any 
bit resolution is supported.

D Standard AIFF files 
These have the extension “.aif” and this is the standard audio file format for 
the Mac platform. Again, any audio editor can read and create audio files in 
this format. Any sample rate and practically any bit resolution is supported.

D SoundFont samples
This is a standardized data format containing wavetable synthesized audio 
and information on how it should be played back in wavetable synthesizers - 
typically on audio cards. SoundFont banks are hierarchically organized into 
different categories: User Samples, Instruments, Presets etc. The NN-XT 
lets you load single samples from within a Soundfont bank.

D REX file slices
A slice is a snippet of sound in a REX File (see page 153). To import a REX 
slice, browse to a REX file and open it as if it was a folder. The browser will 
then display the slices as files inside that “folder”. In the rest of this manual, 
when we refer to importing samples, all that is said applies to REX slices as 
well.

! If you want files to play back with their original bit depth - if higher 
than 16-bits - make sure to activate “Use High Resolution Samples” 
on the General page in the Preferences dialog. Otherwise, samples 
will be played back as 16-bit files in NN-XT regardless of their origi-
nal bit depth. See the Getting Started book for more details.
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Adding More Samples to the Key Map
You can add additional samples to an existing key map in the same way as de-
scribed above.

1. Make sure that no already loaded sample has edit focus.
If you don’t, there’s a risk that the selected sample will be replaced, see be-
low. To remove the edit focus, click in an unoccupied area in the Sample col-
umn or the key map area. 

2. Open the Sample Browser.

3. Select the sample(s) you want to load in the browser and click 
“OK”.
The new sample(s) are added to the key map.

Replacing a Sample
To replace the sample in a zone, proceed as follows:

1. Make sure the zone has edit focus and do one of the following:

D Click the Browse Samples button.

D Select Browse Samples from the Edit menu or the NN-XT context 
menu.

D Double click in the zone.
Any of these methods will open the standard file browser in which you can 
select a new sample for the zone.

2. Select one and only one sample in the Sample Browser.
If you select more than one sample in the browser the samples you load will 
not replace the one with edit focus. They will instead be added below it.

Quick Browsing through Samples
If you want to quickly browse through a number of samples, for example to see 
which one of them would fit best in a certain context, proceed as follows:

1. Set up the zone as desired and make sure it has edit focus:

2. Use the arrow buttons in the Browse Samples section to select the 
next/previous sample in the same directory.

Removing Samples
D To remove a sample from a zone, select it by clicking on it and then 

select “Remove Samples” from the Edit menu or the NN-XT context 
menu.
This will remove the sample from the zone, leaving it empty. Note that you 
can remove the samples from several selected zones at the same time.

Auditioning samples
You can audition the loaded samples in two ways:

D By pressing [Option] (Mac)/[Alt] (Windows) and clicking a sample 
in the sample column.
The mouse pointer will take on the shape of a speaker symbol when you 
move it over the sample column.
Clicking a sample will play it back at its root pitch (see page 167). Further-
more, the sample will play back in its unprocessed state. That is, without any 
synth-parameters applied (see page 175).

D By pressing [Option] (Mac)/[Alt] (Windows) and clicking a sample 
in the keyboard column.
The difference here is that you will hear the sample at the pitch correspond-
ing to the key you clicked and with any and all processing applied. The click 
mimics a key played with velocity 100. Also note that this may trigger several 
samples, depending on whether they are mapped across the same or over-
lapping key ranges, and the velocity range settings (see page 164 and page 
170 respectively).

Adding Empty Zones
You can add empty zones to a key map. Empty zones are treated just like zones 
containing samples, in that they are automatically selected, gets edit focus and 
are assigned a five octave key range when they are first created. However, you 
can only add one zone at a time. It is also possible to resize, move and edit 
empty zones in the same way as zones containing samples.

D To add an empty zone, pull down the Edit menu or the NN-XT con-
text menu and select “Add Zone”.
An empty zone is added below any existing zones in the key map. An empty 
zone is indicated with the text “**No Sample**”.

A newly added empty zone.

After you have added an empty zone, you can assign a sample to it, just as when 
Replacing a Sample, or when Quick Browsing, as described above.
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Duplicating Zones
You can duplicate any number of already existing zones (containing samples or 
empty). 

1. Select the zone(s) you want to copy.

2. Pull down the edit menu or the NN-XT context menu and select “Du-
plicate Zones”.
The selected zones will now be copied and automatically inserted below the 
last one in the key map display. 

The duplicated zones will contain references to the same samples as the original 
zones. They will also have the exact same key ranges and parameter settings.

Using Copy and Paste

The Copy Zones function on the Edit menu allows you to copy all selected zones 
to the clipboard. Selecting Paste Zones from the Edit menu will paste the zones 
into the selected NN-XT device, below the existing zones.

This is a handy way to transfer zones (complete with all settings) from one NN-
XT device to another.

Removing Zones
To remove one or several zones, select them and do one of the following:

D Press [Delete] or [Backspace] on the computer keyboard.

D Select “Delete Zones” from the Edit menu or the NN-XT context 
menu.

When removing zones, you will remove any samples in them as well.

Rearranging Zones in the List
D To move a zone to another position in the list, click on it in the sam-

ples column and drag up or down.
An outline shows you where the zone will appear when you release the 
mouse button.

Working with Grouping
About Groups
Grouping has two purposes:

D To allow you to quickly select a number of zones that “belong to-
gether.”
For example if you have created a layered sound consisting of piano and 
strings, you could put all string samples in one group and all piano samples 
in one group. Then you can quickly select all piano samples and make an ad-
justment to them by trimming a parameter.

D To group zones that need to share group settings together.
For example, you may want to set a group to legato and monophonic mode 
and add some portamento so that you can play a part where you slide be-
tween notes.

Note that there is always at least one group, since the zones you create are al-
ways grouped together by default.

Creating a Group
1. Select the zones you want to group together.

The zones don’t have to be contiguous in order to be grouped. Regardless 
of their original positions in the samples column, they will all be put together 
in succession.

2. Select “Group Selected Zones” from the Edit menu or the NN-XT 
context menu.
The zones are grouped.
Selecting these zones and grouping them...

...will create these two groups instead of 
the original one large group.
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Moving a Group to another Position in the List
D Click on the group in the Groups column and drag up or down with 

the mouse button pressed.
An outline of the group you move is superimposed upon the display to help 
you navigate to the desired position.

Dragging a group to a new position.

3. Release the mouse button at the desired position.
The group and all its zones appear at the new position.

Moving a Zone from one Group to another
This is done just as when rearranging samples in the list, as described on the 
previous page. The only difference is that you drag the zone from one group to 
another.

Selecting a Group and/or Zones in a Group
D Clicking on a group in the groups column selects the group and all 

the zones in the group.

D Clicking on a zone in the samples column selects the group (and 
that zone).

The Group Parameters
There are a few parameters on the front panel that apply specifically to groups. 
see page 174 for details.

Working with Key Ranges
About Key Ranges
Each zone can have its own separate key range, the lowest and the highest key 
that will trigger the sample. 
A good example of use for this is when sampling a certain instrument. Sampling 
of a piano for example is usually performed by making several recordings of dif-
ferent notes at close intervals, and then mapping these samples to separate, 
contiguous, fairly narrow key ranges. This concept is called multi-sampling.
The reason for this is that if one single sample is played across the entire key-
board, it will most likely sound very unnatural when played too far from its original 
pitch, since the amount you can transpose a sound without negatively affecting 
its timbre is very limited.

Setting up Key Ranges
You can adjust the key range of zones in a number of ways:

By Dragging the Zone Boundary Handles

1. Select the zone in the Key Range area.

2. Point and click on one of the handles that appear at each end.

3. Drag the handle left/right.
Dotted lines extend from the edges of the zones up to the keyboard area. 
These lines give you a visual indication of which keys the key range will en-
compass. There is also an alphanumerical indication at the bottom left of the 
display.

Clicking and dragging the high key boundary handle 
of a zone with the default key range of C1 - C6...

...to change the key range to C1 - C2.
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4. Repeat the procedure with as many zones as you wish, to create a 
complete key map.

By using the Lo Key and Hi Key controls

Directly below the key map area is a row of knobs. These are the sample param-
eters. As the name implies, they are used for changing various parameters that 
affect how the zones are played back. In the middle of the sample parameters 
area are two knobs called “Lo Key” and Hi Key”.

These can be used for setting the low key and the high key of a zone’s key 
range, just like dragging the boundary handles as described above:

1. Make sure the zone for which you want to set the key range has edit 
focus.

2. Use the knobs to change the corresponding key - low or high.
Check the display right above the knobs for an indication of the key. You can 
also keep an eye on the lines extending from the zone edges to the keyboard 
area.

By Dragging the Zone Boundary Handles on the Tab Bar

As previously described, the area directly below the keyboard area is called the 
tab bar. This shows the key range for the currently selected zone, and also con-
tains boundary handles. 

Dragging a boundary handle on the tab bar.

These handles can be used much to the same effect as when dragging the 
boundary handles in the key map display. However, the handles on the tab bar 
can change the key range of multiple zones at the same time.

The following applies:

• The tab bar shows the key range for the zone with edit focus.
• Dragging the boundary handles for that zone will also simultaneously change 

the key range for a number of surrounding zones if:

D The high key or low key (depending on which handle you drag) of 
the other zones are the same as the zone with edit focus.

D The other zones are adjacent to the zone with edit focus.

! Note that it doesn’t matter whether the other zones are selected or 
not. They will be affected anyway.

In the example in the picture above, the zone within the middle has edit focus. Its 
left handle (the low key) is placed differently from any of the other zones, but all 
of the zones have the same high key setting. This means that...

• Dragging the left handle will only move the low key position of the zone with 
edit focus (the pictures show before and after dragging).

• Dragging the right handle will move the high key position for all of the zones 
at the same time, since they all have the same high key position (again, the 
picture shows before and after dragging).
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Moving Zones by Dragging the Zone Boxes

You can also move entire zones horizontally, thereby changing their key ranges.

1. Select all the zones you want to move.
You can move several zones simultaneously.

2. Point on any of the selected zones, and press the mouse button.

3. Drag left/right and release the mouse button.

Dragging multiple zones.

Moving Zones by Dragging in the Tab Bar

You can also move a zone by dragging anywhere between the zone boundary 
handles on the tab bar. When you do, the surrounding zones will be affected just 
as when dragging the boundary handles in the tab bar (see above).

This can be used to “slide” a zone in relation to its surrounding zones, as the pic-
ture example below shows (before and after dragging).

About the Lock Root Keys function

Normally, when you move zones (as described above), the root note of the 
zone(s) you move will change accordingly. In other words, the zone(s) will be 
transposed. If this is not desired, you can activate the Lock Root Keys function 
prior to moving the zone(s) by clicking on the button above the key map display.

Moving zones without changing their root notes can be used for some interest-
ing effects, since it will completely change the timbre of the sample(s) as they 
are played back.

About the Solo Sample function

The Solo Sample function lets you play a selected sample over the entire key-
board and disregarding any velocity range assigned to the sample. All other 
loaded samples are temporarily muted.

This is useful if you for example want to check how far up and down from its root 
key a sample can be played on the keyboard before starting to sound “unnatu-
ral”. The solo sample function can therefore be useful as a guide for setting up 
key ranges, as described on page 164.

1. Select one and only one zone, or - if you have a selection of multi-
ple zones - make sure the one you want to hear has edit focus.

2. Activate Solo Sample by clicking on the button so that it lights up.

3. Play the MIDI keyboard
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Sorting Zones by Note
The Edit menu and the NN-XT context menu contains an item called “Sort Zones 
by Note”. This option lets you automatically sort the selected zones in descend-
ing order according to their key ranges.

When you invoke this option, the selected zones will be sorted from top to bot-
tom in the display starting with the one with the lowest range.

Note however, that the sorting is done strictly on a group basis. That is, only 
zones that belong to the same group can be sorted in relation to each other.

Before sorting and after.

If two zones have the same key range, they are sorted by velocity range.

Setting Root Notes and 
Tuning
About the Root Key
All instrument sounds have an inherent pitch. When playing a sample of such a 
sound on the keyboard, the keys you play must correspond to that pitch. For ex-
ample, you may have recorded a piano playing the key “C3”. When you map this 
onto the NN-XT key map, you must set things up so that the sampler plays back 
the sample at original pitch when you press the key C3.

This is done by adjusting the root note.

D Many samples files from different sources already have a set root 
key in the file. If they do, the root key will be correctly set automati-
cally when you load the sample into a zone.

D However if the sample doesn’t have a root note stored in the file, (if 
you for example have recorded it yourself) you will need to adjust it

Setting the Root Note Manually
To set the root key for a zone, proceed as follows:

D Make sure the zone has edit focus (for example by clicking on it), 
and do one of the following:

D Use the knob marked “Root” in the sample parameter area below 
the display.
Turning it to the right will raise the pitch of the root key. The selected key is 
displayed alphanumerically directly above the knob, and you can also look at 
the keyboard area for a visual indication (see below).

D Press [Ctrl] (Windows)/[Command] (Mac) and click on the desired 
root key in the keyboard area.
The set root key is shaded so you can easily distinguish it.
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Tuning Samples Manually 
In addition to setting the root note, you may need to fine tune your samples, in or-
der for them to match other instruments and/or each other:

D Make sure the zone has edit focus (for example by clicking on it).

D Use the knob marked “Tune” in the sample parameter area.
This allows you to tune each sample in a key map by +/– half a semitone 
(-50 – 0 – 50).

Setting the Root Note and Tuning Using Pitch 
Detection
The NN-XT features a pitch detection function to help you set the root keys. This 
is useful if you for example load a sample that you haven’t recorded yourself, and 
you don’t have any information about its original pitch.

Proceed as follows:

1. Select all the zones you want to be subject to pitch detection.

2. Pull down the Edit menu or the NN-XT context menu and select “Set 
Root Notes from Pitch Detection”.
The samples in all the selected zones will now be analyzed, and the detected 
root keys will automatically be set for you.

! Note that for this to work properly, the samples must have some 
form of perceivable pitch. If it is sampled speech, or a snare drum 
for example, it probably doesn’t have any discernible pitch.

About Changing the Pitch of Samples
The procedures above should be used to make sure the samples are consis-
tently pitched across the keyboard, and that they all match an absolute refer-
ence (for example A 440 tuning).

If you need to tune the samples to match other material, or to get a certain effect 
(for example detuning two sounds against each other for a chorus effect) you 
should use the Pitch section among the synth parameters, not the sample tuning 
parameters.

Using Automap
The automap function can be used as a quick way of creating a key map, or as a 
good starting point for further adjustments of a key map.

Automap works under the assumption that you intend to create a key map for a 
complete instrument, for example a number of samples of a piano, all at different 
pitches.

1. Load the samples you want to Automap.
Now you have three options:

D Trust that the root note information in the files is already correct.

D Manually adjust the root notes (and tuning) for all the samples.

D Use “Set Root Notes from Pitch Detection” to automatically set up 
the root notes.

2. Select all zones you want to automap.

3. Select Automap Zones from the Edit menu or the NN-XT context 
menu.

All the selected zones will now be arranged automatically in the following way:

D The zones will be sorted in the display (from top to bottom - lowest 
key first) according to the root keys.

D The zones will be assigned key ranges according to the root keys.
The key ranges are set up so that the split between two zones is exactly in 
the middle between the zones’ root notes. If two zones have the same root 
key they will be assigned the same key range.
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Layered, Crossfaded and 
Velocity Switched Sounds
Creating Layered Sounds
You can set things up so that two or more zones have overlapping key ranges - 
either completely or partially. This way you can create layered sounds, i.e. differ-
ent samples that are played simultaneously when you press a key on your key-
board.

In the picture above, you can see a set of piano samples at the top, mapped 
across the key range.

Below these are a set of string samples that also span the entire key range.

Whenever you play a key within this keyboard range, the sound produced will be 
a combination of the piano and the string sample.

In addition, in the example above, the user has arranged the piano samples into 
one group and the string samples in another. This is convenient since it allows 
for quick selection of the entire piano map, for example for balancing its level 
against the strings.

About Velocity Ranges
When zones are set up so that their key ranges overlap – completely or partially 
– you can use velocity switching and crossfading to determine which zones 
should be played back depending on how hard or soft you play on your MIDI 
keyboard.

This is done by setting up velocity ranges, with or without crossfading.

Each time you press a key on your MIDI keyboard, a velocity value between 1-
127 is sent to Reason. If you press the key softly, a low velocity value is sent and 
if you press it hard, a high velocity value is sent.

This velocity value determines which samples will be played and which will not.

Let’s say for example that you’ve mapped three different zones across the same 
key range:

D Zone 1 has a velocity range from 1-40.
This means that the sample in it will be triggered by velocity values between 
1-40.

D Zone 2 has a velocity range of 41-80.
The sample in this zone will be played back by velocity values between 41-
80.

D Zone 3 has a velocity range of 81-127.
The sample in this zone will be triggered by all velocity values above 80.
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Overlapping Velocity Ranges

Let’s change the values above slightly:

D Zone 1 has a velocity range from 1-60.

D Zone 2 has a velocity range of 41-100.

D Zone 3 has a velocity range of 81-127.

Now, velocity values between 41 and 60 will trigger samples from both Zone 1 
and Zone 2. Likewise, velocity values between 81 and 100 will trigger sounds 
from Zone 2 and Zone 3.

About Full and Partial Velocity Ranges

You can see which zones have modified velocity ranges in the key map display:

• Zones with a full velocity range (0 - 127) are only shown with an outline.
• Zones with any other velocity range are shown as striped.

The top zone has a full velocity range (1-127), and the lower zone has a partial velocity range 
(any other range), which is indicated by stripes

Sorting Zones by Velocity Values

The Edit menu and the NN-XT context menu contain an item called “Sort Zones 
by Velocity”. This option lets you automatically sort the selected zones in the dis-
play in descending order according to their set low or high velocity values.

When you invoke this option, the selected zones will be sorted from top to bot-
tom starting with the one with the highest “Lo Vel “value.

Note however, that the sorting is done strictly on a group basis. That is, only 
zones that belong to the same group can be sorted in relation to each other.

If two zones have the same velocity range, they are sorted by key range.

Setting Velocity Range for a Zone
To set up a velocity range for a zone, proceed as follows:

1. Select one or more zones that you want to adjust.

2. Use the knobs marked “Lo Vel” and “High Vel” in the sample pa-
rameter area to set the desired low- and high velocity values.

Adjusting the “Lo Vel” value for a zone.

“Lo vel” is the lowest velocity value that should trigger the sample in the zone - 
i.e. if a key is pressed so softly that the velocity is lower than this value, the sam-
ple will not be played. 

“Hi vel” is the highest velocity value that should trigger the sample, which means 
that if a key is pressed so hard that the velocity is higher than this value, the sam-
ple will not be played.
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About Crossfading Between Zones
At the bottom right in the sample parameter area are two knobs marked “Fade 
In” and “Fade Out”. These are primarily used for setting up velocity crossfades 
for smooth transitions between overlapping zones. In order to set up crossfades 
you adjust the fade out and fade in values for the overlapping zones.

Crossfading Between two Sounds

An example:

D Two zones are both set to play in the full velocity range of 1-127.

D Zone 1 has a fade out value of 40.
This means that this zone will play at full level with velocity values below 40, 
With higher velocity values, it will gradually fade out.

D Zone 2 has a fade in value of 80.
This has the effect that as you play velocity values up to 80, this zone will 
gradually fade in. With velocity values above 80, it will play at full level.

Another example:

Crossfading can be used to only fade in or fade out a certain sound. One com-
mon example is to set things up so that one sound plays the entire velocity range 
and another is faded in only at high velocity values.

D Zone 1 is set to play the entire velocity range with no crossfade.

D Zone 2 is set to play the velocity range 80 to 127, with a fade in 
value of 110.
This means that this zone will start fading in from velocity values 80 and will 
play at full level in the velocity range 110 to 127.

This can be used for example to add a rimshot to a regular snare sound or a 
harder attack to a softer violin sample.
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Setting Crossfading for a Zone

Manually

To set up a crossfade for a zone, proceed as follows:

1. Select one or more zones that you want to adjust.

2. Use the knobs marked “Fade In” and “Fade Out” in the sample pa-
rameter area, to set the desired values.

✪ You can change the values with finer precision by pressing [Shift] 
while turning the knobs, and you can reset the standard values by 
pressing [Command] (Mac)/[Ctrl] (Windows) and clicking on the 
knobs.

Automatically

If you find it tedious to manually set up crossfades between zones, NN-XT can 
do it for you! The Edit menu and the NN-XT context menu contain an item called 
“Create Velocity Crossfades”.

1. Set up the zones so that their velocity ranges overlap, as desired.

2. Select the zones.
You can select as many zones as you wish, not just one pair of overlapping 
zones.

3. Select “Create Velocity Crossfades” from the Edit menu.
NN-XT will analyze the overlapping zones and automatically set up what it 
deems to be appropriate fade in and fade out values for the zones.

Note the following important points:

D This operation will not work if both zones have full velocity ranges.
At least one of the zones must have a partial velocity range (see page 170).

D This operation will not work if the zones are completely overlap-
ping.

Using Alternate
About the Alternate function

At the bottom right in the sample parameters area is a knob marked “Alt”. It only 
has two states - On and Off. This is used for semi-randomly alternating between 
zones during playback.

There are several practical uses for this. Here follows two examples:

• Layering several recordings of the same snare drum. By alternating between 
them you get a more natural repetition.

• Layering string up- and down strokes. By alternating you get the realistic ef-
fect of switching between the two directions of the stroke.

You can layer as many sounds as you will and the algorithm switches between 
them in a way that provides as little repetition as possible.

To set up an alternating set of zones, proceed as follows:

1. Set up the zones so that they overlap completely or partially.

2. Select them all.

3. Set “Alt” to On for all the zones.
Now, the program will automatically detect how to alternate between the 
zones, depending on their overlap.
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Sample Parameters

The Sample parameter area is found below the screen. For details on how to ad-
just them (depending on whether one or more zones are selected) see page 
160. Below follows a run-down of the various parameters:

Root Note and Tune
These parameters are described on page 167.

Sample Start and End
By turning the knobs you offset the start and end positions, so that they will play 
back more or less of a samples’ waveform. Typical examples of use for this 
would be:

D Removing unwanted portions from samples.
This could be anything from noise to “dead air” at the beginning or end of a 
sample.

D To create variations out of a single sample.
These controls can be used to pick out any section of a recording for use as 
a sample.

D Together with velocity sample start control.
You can for example increase Sample Start and then apply negative velocity 
modulation to Sample Start. Then, the harder you play the more you will hear 
of the attack portion of the sound.

✪ If you hold down [Shift] when adjusting these parameters, the ad-
justment is always in single frames (samples).

Loop Start and End
A sample, unlike the cycles of an oscillator for example, is a finite quantity. There 
is a sample start and end. To get samples to play for as long as you press down 
the keys on your keyboard, they need to be looped. 

For this to work properly, you have to first set up two loop points which deter-
mine the part of the sample that will be looped.

The instrument samples in the sound banks included with Reason are already 
looped. The same will be true for most commercial sample libraries. However, if 
you need to, you can use these controls to adjust the looping.

• The size and position of the loop – in the sample – is determined by two pa-
rameters, Loop Start (the beginning of the loop) and Loop End (the end 
point of the loop).

• The NN-XT then keeps repeating the section between the Loop Start and 
Loop end until the sound has decayed to silence.

Play Mode
By using this knob you can select one of the following loop modes for each 
zone:

D FW
The sample in the zone will play only once, without looping.

D FW-LOOP
The sample will play from the sample start point to the loop end point, jump 
back to the loop start point and then loop infinitely between the start and 
end loop points. This is the most common loop mode.

D FW - BW
The sample will play from the sample start point to the loop end point, then 
from the loop end point to the loop start point (backwards), and then loop in-
finitely forwards-backwards between the start and end loop points.

D FW-SUS
This works like FW-LOOP with the exception that it will only loop as long as 
the key is held down. As you release the key, the sample will play to the ab-
solute end of the sample, that is beyond the boundaries of the loop.

This means that the sound may have a short natural release even if the re-
lease parameter is raised to a high value (which is not true for “FW-LOOP”, 
where the release parameter always controls the length of the sound after 
the key is released).

D BW
The sample will play only once - from the end to the beginning - without loop-
ing.

Lo Key and Hi Key
These parameters are described on page 164.

Lo Vel and Hi Vel
These parameters are described on page 169.

Fade In and Fade Out
These parameters are described on page 171.
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Alt
This parameter is described on page 172.

Out
The NN-XT features eight separate stereo output pairs (see page 184). For each 
zone, you can decide which of these output pairs to use. Thus, if you have cre-
ated a key map consisting of eight zones, each of these can have a separate ste-
reo output from NN-XT, and can then be routed to a separate mixer channel if 
you so wish.

D To select which output a selected zone should be directed to, use 
the knob marked “Out” in the sample parameter area.
The output pairs are indicated above the button.

! Note that you still have to route the outputs the way you want them 
on NN-XT’s back panel. If you assign a zone to an output pair other 
than 1-2 (which is the default) no connections or auto routing are 
made. You have to do that manually.

A Stereo Example

One possible way of utilizing this would be to create a drum kit. In this case you 
could load up to eight different stereo drum samples, assign them to separate 
outputs, route each to a separate mixer channel and then use the mixer to set 
levels and pan, add send effects etc.

Using a Stereo Output as Two Mono Outputs

If, on the other hand, you are using mono samples, you can use one stereo pair 
as a two separate outputs, effectively giving you a total of 16 separate outputs.

1. Assign two zones to the same output.

2. Us the Pan control to pan one of the zones hard left and the other 
hard right.

3. Connect each of the two outputs in the stereo pair to a separate 
mixer channel.

Group Parameters

The group parameters are located at the top left on the remote editor panel. 
These are parameters that in various ways are directly related to playing style.

Group parameters apply to a group, that is they are settings that are shared by 
all zones in a group.

D To make adjustments to one group, select one or more zones that 
belong to the group, and adjust the parameter on the front panel.

D To set several groups to the same value, select at least one zone in 
each group you want to adjust, and adjust the parameter on the 
front panel.

Key Poly
This setting determines the number of keys that you can play simultaneously (the 
polyphony). The maximum number is 99 and the minimum is 1, in which case the 
group will be monophonic.

Users of other samplers may want to note that the polyphony often means set-
ting the number of voices that should be able to play. The NN-XT is different in 
this aspect, since the polyphony setting instead determines the number of keys, 
regardless of how many voices each key plays.
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Legato and Retrig

Legato

Legato works best with monophonic sounds. Set Key Poly (see above) to 1 and 
try the following:

D Hold down a key and then press another key without releasing the 
previous.
Notice that the pitch changes, but the envelopes do not start over. That is, 
there will be no new “attack”. 

D If Key Poly is set to more voices than 1, Legato will only be applied 
when all the assigned keys are “used up”.
For example, if you had a polyphony setting of “4” and you held down a 4 
note chord, the next note you played would be Legato. Note, however, that 
this Legato key will “steal” one of the keys in the 4 note chord, as all the as-
signed keys were already used up!

Retrig

Retrig is the “normal” setting for playing polyphonic patches. That is, when you 
press a key without releasing the previous, the envelopes are triggered, like 
when you release all keys and then press a new one. In monophonic mode, Re-
trig has an additional function; if you press a key, hold it, press a new key and 
then release that, the first note is also retriggered.

LFO 1 Rate
This is used for controlling the rate of LFO 1 if it is used in “Group Rate” mode. 
In that case, this knob will take precedence over the rate parameter in the LFO 1 
section. See page 182 for detailed information about this.

Portamento
This is used for controlling portamento - a parameter that makes the pitch glide 
between the notes you play, rather than changing the pitch instantly as soon as 
you hit a key on your keyboard. By turning this knob you set how long it should 
take for the pitch to glide from one note to the next as you play them. 

In legato mode, there will only be any portamento when actually playing legato 
(tied) notes.

With the knob turned all the way to the left, portamento is disabled.

Synth parameters
The Modulation controls

As previously described, the Modulation wheel (and the External Control wheel) 
can be used for controlling various parameters. These controls allow you to de-
fine which parameters the wheels should modulate and to what extent.

D Below each of the knobs are the letters “W” and “X”.
These are used for selecting the source that should control the parameter, 
and represent the “Modulation Wheel” and the “External Control wheel” re-
spectively.

D By clicking on any of the letters, you decide which source should 
control the parameter. 
You can select either, both or none. When a letter is “lit”, the corresponding 
source is set to control the parameter.

D By turning the knobs, you decide how much the modulation and/or 
external control wheel should modulate the corresponding parame-
ter.

Note that all of the control knobs are bi-polar, which means that they can be set 
to both positive and negative values. Positive values are set by turning the knobs 
to the right, and negative values are thus set by turning the knobs to the left:

• Setting them to positive values means that the value of the controlled param-
eter will be raised if the source wheel is pushed forward.

• Setting them to negative values means that the value will be lowered when a 
wheel is pushed forward.

• Keeping the knobs in the center position means that no modulation control 
is applied. 

There is one exception to these rules, and that is the LFO 1 Amt control, which 
works in a slightly different way. See below for more information about this.
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The following parameters can be modulated:

F.Freq

This sets modulation control of the Filter’s cutoff frequency (see page 179).

Mod Dec

This sets modulation control of the Decay parameter in the Modulation Envelope 
(see page 180).

LFO 1 Amt

This determines how much the amount of modulation from LFO 1 is affected by 
the Modulation wheel and/or the External Controller wheel. It does this by “scal-
ing” the amounts set with the three destination knobs in the LFO 1 section 
(Pitch, Filter and Level, see page 182). We’ll explain this with an example:

To use the Modulation Wheel to increase pitch modulation (vibrato), proceed as 
follows:

1. Turn the Mod Wheel all the way down, so that no modulation is ap-
plied.

2. Activate the “W” button for LFO 1 Amt in the Modulation section.

3. Set the corresponding knob to “12 o’clock” (zero).

4. Set up LFO 1 so that as much vibrato is applied as you want it to be 
when the Modulation wheel is turned all the way up.

5. Increase LFO 1 Amt until you hear as much vibrato as you want it to 
be when the wheel is turned all the way down.
If you turn LFO 1 Amt all the way up, there will be no vibrato at all when the 
wheel is all the way down.

To instead use the Modulation wheel to decrease vibrato, process as follows:

1. Turn the Mod Wheel all the way down, so that no modulation is ap-
plied.

2. Activate the “W” button for LFO 1 Amt in the Modulation section.

3. Set the corresponding knob to “12 o’clock” (zero).

4. Set up LFO 1 so that as much vibrato is applied as you want it to be 
when the Modulation wheel is turned all the way down.

5. Turn the Modulation wheel all the way up.

6. Decrease LFO 1 Amt until you hear as much vibrato as you want it 
to be when the wheel is turned all the way up.
If you turn LFO 1 Amt all the way down, there will be no vibrato at all when 
the wheel is all the way up.

F.Res

This sets modulation control of the Resonance parameter in the Filter (see page 
179).

Level

This sets the amount of amplitude envelope modulation of each zone’s level. The 
level set here will be the level of the highest point of the Amp Envelope.

LFO 1 Rate

This sets modulation control of the Rate parameter in LFO 1 (see page 182).
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The Velocity controls

Velocity is used for controlling various parameters according to how hard or soft 
you play notes on your keyboard. A typical use of velocity control is to make 
sounds brighter and louder if you strike a key harder. By using the knobs in this 
section, you can control if and how much the various parameters will be affected 
by velocity. 

Just like the modulation controls, all of the velocity control knobs are bi-polar, 
and can be set to both positive and negative values.

• Setting them to positive values means that the value of the controlled param-
eter will be raised the harder you play.

• Setting them to negative values means that the value will be lowered the 
harder you play.

• Keeping the knobs in the center position means that no velocity control is 
applied. 

The following parameters can be velocity controlled:

F.Freq

This sets velocity control of the Filter’s cutoff frequency (see page 179).

Mod Dec

This sets velocity control of the Decay parameter in the Modulation Envelope 
(see page 180).

Level

This sets velocity control of the Amp Envelope.

Amp Env Attack

This sets velocity control of the Attack parameter in the Amplitude Envelope (see 
page 181).

S. Start

This sets velocity control of the Sample Start parameter (see page 173), so that 
it will be offset forwards or backwards, according to how hard or soft you play.

This allows you to control how much of the attack portion of the sample you hear 
when playing harder or softer.

To be able to make use of negative values for this parameter, you must increase 
the sample parameter Sample Start.
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The Pitch section

This section contains various parameters related to controlling the pitch, or fre-
quency, of the zones. 

Pitch Bend Range

This lets you set the amount of pitch bend, i.e. how much the pitch changes 
when your turn the pitch bend wheel fully up or down. The maximum range is +/
- 24 semitones (2 Octaves).

Setting the pitch

Use the three knobs marked “Octave”, “Semi” and “Fine” to change the pitch of 
the sample(s):

D Octave
This changes the pitch in steps of one full octave. The range is -5 – 0 – 5.

D Semi
This lets you change the pitch in semitone steps. The range is -12 – 0 – 12 
(2 octaves).

D Fine 
This changes the pitch in cents (hundredths of a semitone). The range is -50 
– 0 – 50 (down or up half a semitone).

K. Track

This knob controls Keyboard Tracking of the pitch.

• In the center position, each key represents a semitone This is the normal set-
ting.

• When turned all the way down, all keys play the same pitch. This can be use-
ful for percussion like timpani where you might want to play the same pitch 
from a range of keys.

• When turned all the way up, each key on the keyboard shifts the pitch one 
octave.



NN-XT SAMPLER 179

The Filter Section

Filters can be used for shaping the character of the sound. The filter in NN-XT is 
a multimode filter with six different filter types.

D To activate/deactivate the filter, click the On/Off button in the top 
right corner.
When the filter is activated, the button is lit.

Filter mode

To select a filter mode, either click the Mode button in the bottom right corner or 
click directly on the desired filter name so that it lights up:

D Notch
The notch filter is used for cutting off frequencies in a narrow frequency 
range around the set cutoff frequency, while letting the frequencies below 
and above through.

D HP 12
This is a highpass filter with a 12 dB/Octave roll-off slope. A highpass filter 
cuts off low frequencies and lets high frequencies pass. That is, frequencies 
below the cutoff frequency are cut off and frequencies above it pass 
through.

D BP 12
This is a bandpass filter with a 12 dB/Octave roll-off slope. A bandpass filter 
could be viewed as the opposite of a notch filter. It cuts off both the high and 
the low frequencies, while frequencies in the band range pass through.

D LP 6 
This is a lowpass filter with a gentle, 6 dB/Octave slope. A lowpass filter is 
the opposite of a highpass filter. It lets the low frequencies through and fil-
ters out the high frequencies. This filter has no Resonance.

D LP 12
This is a lowpass filter with a 12 dB/Octave roll-off slope.

D LP 24
This is a lowpass filter with a fairly steep roll-off slope of 24 dB/Octave.

Filter controls

The following filter controls are available:

D Freq
This is used for setting the filter cutoff frequency. The cutoff frequency deter-
mines the limit above or below which frequencies will be cut off depending 
on the selected filter type. In the case of a lowpass filter for example, fre-
quencies below the cutoff frequency will be allowed to pass through, while 
frequencies above it will be cut off. The farther to the right you turn the knob, 
the higher the cutoff frequency will be.

✪ It is very common to modulate filter frequency with the modulation 
envelope, as described on page 180.

D Res
Technically, this knob controls feedback of the output signal from the filter, 
back to its input. Acoustically it emphasizes frequencies around the cutoff 
frequency. For a lowpass filter for example, increasing Res will make the 
sound increasingly more hollow until the sound starts “ringing”. If you set a 
high value for the Res parameter and then vary the filter frequency, this will 
produce a classic synthesizer filter sweep.

For the notch and bandpass filter types, the Resonance setting instead ad-
justs the width of the band. That is, the higher the resonance setting, the nar-
rower the band will be where frequencies are cut off (notch) or let through 
(Bandpass).

D K. Track
This lets you activate and control keyboard tracking of the filter frequency. If 
keyboard tracking is activated, the set cutoff frequency of the filter will 
change according to the notes you play on your keyboard. That is, if you play 
notes higher up on the keyboard, the filter frequency will be raised and vice 
versa.

When the knob is set to its center position, filter frequency is adjusted so 
that the harmonic content remains constant across the keyboard.

Keyboard tracking is deactivated by default (the knob all the way to the left). 
This means that the filter frequency will remain unchanged regardless of 
where on the keyboard you play.
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The Modulation Envelope

The Modulation Envelope parameters let you control how certain parameters, or 
destinations, should change over time - from the moment a note is struck to the 
moment it is released again. 

The destinations you can use are: 

• Pitch
• Filter frequency

Parameters

The following are the available controlling parameters:

D Attack
When you press a key on your keyboard, the envelope is triggered. The at-
tack parameter then controls how long it should take before the controlled 
parameter (pitch or filter) reaches the maximum value, when you press a key. 
By setting attack to a value of “0”, the destination parameter would reach the 
maximum value instantly. By raising the attack parameter, the value will in-
stead slowly “slide” up to its maximum.

D Hold
This is used for deciding how long the controlled parameter should stay at 
its maximum value before starting to decrease again. This can be used in 
combination with the Attack and Decay parameters to make a value reach its 
maximum level, stay there for a while (hold) and then start dropping gradually 
down to the sustain level.

D Decay
After the maximum value for a destination has been reached and the Hold 
time has expired, the controlled parameter will start to gradually drop down 
to the sustain level. How long it should take before it reaches the sustain 
level is controlled with the Decay parameter. If Decay is set to “0”, the value 
will immediately drop down to the sustain level.

D Sustain
The Sustain parameter determines the value the envelope should drop back 
to after the Decay. If you set Sustain to full level however, the Decay setting 
doesn’t matter since the value will never decrease.
A combination of Decay and Sustain can be used for creating envelopes 
that rise up to the maximum value, then gradually decrease to, and stay on a 
level somewhere in-between zero and maximum. 

D Release
This works just like the Decay parameter, with the exception that it deter-
mines the time it takes for the value to fall back to zero after the key is re-
leased.

D Delay
This is used for setting a delay between when a note is played and when the 
effect of the envelope starts. That is, the sound will start unmodulated, and 
the envelope will kick in after you have kept the key(s) pressed down for a 
while. Turn the knob to the right to increase the delay time. If the knob is set 
all the way to the left, there will be no delay.

D Key To Decay
By using this, you can cause the value of the Decay parameter (see above) 
to be offset depending on where on your keyboard you play. If you turn the 
knob to the right the decay value will be raised the higher up you play, and 
turning the knob to the left will lower the decay value the higher up you play. 
With the knob in the center position, this parameter is deactivated.

Destinations

The following are the available Mod Envelope destinations:

D Pitch
This will make the envelope modulate the pitch, as set in the Pitch section 
(see page 178). Turn the knob to the right to raise the pitch and to the left to 
lower the pitch. In the middle position, pitch will not be affected by the enve-
lope.

D Filter
This will make the envelope modulate the cutoff frequency of the Filter (see 
page 179). Turn the knob to the right to increase the frequency and to the 
left to lower the frequency. In the middle position, the envelope will have no 
effect on the cutoff frequency.
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The Amplitude Envelope

The Amplitude Envelope parameters let you control how the volume of a sound 
should change over time - from the moment a note is struck to the moment it is 
released again.

Parameters

Most of the Amplitude Envelope parameters are identical to those of the Modu-
lation Envelope. So for a detailed description of the following parameters, please 
refer to the modulation envelope section on page 180:

• Attack
• Hold
• Decay
• Sustain
• Release
• Delay
• Key To Decay

The following are the parameters that are unique for the Amp Envelope section:

D Level
This knob sets the level of the zone. Turn it to the right to raise the level.

D Spread and Pan modes
These two parameters are used for controlling the stereo (pan) position of 
the sound. The Spread knob determines the sound’s width in the stereo im-
age (how far left – right the notes will be spread out). If this is set to “0”, no 
spread will take place. The Mode selector switch is used for choosing which 
type of spread you want to apply:

D Pan
This controls the stereo balance of the output pair to which a zone is routed. 
In the middle position, the signal appears equally strong on the left and right 
channel in a stereo pair. By turning the knob to the left or right, you can 
change the stereo balance.

Note that if you for instance turn the Pan knob all the way to the left, you cause 
the signal to be output from the left channel of the stereo pair only.

You can use this to treat a stereo output as two independent mono outputs, if re-
quired.

See page 174 for information on routing zones to output pairs.

|Mode |Description

Key This will make the pan position shift gradually from left to right, the 
higher up on the keyboard you play.

Key 2 This will make the pan position shift from left to right and then back 
again from right to left in a sequence of eight keys. Playing 4 adja-
cent semitones thus makes the pan position gradually go from left to 
right. The next 4 higher semitone notes will then change the pan po-
sition from right to left in the same way, and this cycle will then be 
repeated.

Jump This will make the pan position jump between left and right each 
time a note is played.
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The LFOs

NN-XT features two Low Frequency Oscillators - LFO 1 and LFO 2. “Normal” 
oscillators generate a waveform and a frequency, and produce sound. Low fre-
quency Oscillators on the other hand, also generate a waveform and a fre-
quency, but there are two major differences: 

• LFOs only generate sounds of a low frequency.
• LFOs don’t produce sound, but are instead used for modulating various pa-

rameters.

The most typical use of an LFO is to modulate the pitch of a sound (generated 
by an oscillator or - in the case of NN-XT - a sample), to produce vibrato.

About the Difference between LFO 1 and LFO 2

There are two fundamental differences between LFO 1 and LFO 2:

D LFO 2 is always key synced, that is, each time you press a key, the 
LFO waveform starts over from scratch. LFO 1 can be switched be-
tween key synced and non-key synced modes.

D LFO 2 only has one waveform, triangle.

The following parameters are available for the LFOs:

Rate (LFO 1 and 2)

This knob controls the frequency of the LFO. For a faster modulation rate, turn 
the knob to the right.

The Rate knob of LFO 1 is also used for setting the timedivision when synchro-
nizing the LFO to the song tempo (see below).

Delay (LFO 1 and 2)

This can be used for setting a delay between when a note is played and when 
the LFO modulation starts kicking in (gradually). This way, you can make the 
sound start unmodulated, and then have the LFO modulation start after you have 
kept the key(s) pressed down for a while. 

Turn the knob to the right to increase the delay time.

Mode (LFO 1 only)

This lets you set the “operation mode” for the LFO. Click the button to switch 
between the available modes:

D Group Rate
In this mode, the LFO will run at the rate set for it’s group in the group sec-
tion, rather than at the rate set here (see page 174). This way, all zones in 
the group will have the exact same modulation rate.

D Tempo Sync
In this mode, the LFO will be synchronized to the song tempo, in one of 16 
possible time divisions.

! When tempo sync is activated, the Rate knob is used for selecting 
the desired timedivision. Turn the Rate knob and observe the tool 
tip for an indication of the timedivision.

D Free Run
In free run mode, the LFO simply runs at the rate set with the Rate parame-
ter. Furthermore, if Key Sync is deactivated, the modulation cycle will not be 
retriggered each time you press a key - it will run continuously.
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Waveform (LFO 1 only)

Here, you select which type of waveform should be used for modulating the des-
tination parameters.

Click the button to switch between the following waveforms:

! LFO 2 always uses a triangle waveform.

Key Sync (LFO 1 only)

By activating key sync, you “force” the LFO to restart its modulation cycle each 
time a key is pressed.

! Note that LFO 2 always uses Key Sync.

Destinations for LFO 1

The following parameters can be modulated by LFO 1: 

D Pitch
This will make the LFO modulate the pitch, for vibrato, trills, etc. It can be set 
to -2400 – 0 – 2400 cents which equals 4 octaves. The set pitch will 
change up and down by this amount, with each modulation cycle. Turning 
the knob to the right will make the modulation cycle start above the set pitch, 
while turning it to the left will invert the cycle. Keeping this in the middle po-
sition means that the pitch will not be affected by the LFO.

D Filter
This will make the LFO modulate the cutoff frequency of the Filter, for auto-
wah effects, etc. The positive/negative effect is the same as for pitch.

D Level
This will make the LFO modulate NN-XT’s output level, for tremolo effects, 
etc. The positive/negative effect is the same as for pitch.

Destinations for LFO 2

The following parameters can be modulated by LFO 2:

D Pan
This makes the LFO modulate the pan position of a zone. The sound will 
move back and forth in the stereo field. Turning the knob to the left makes 
the sound move from left to right, and turning it to the right thus makes it 
move from right to left. The middle position provides no modulation at all.

D Pitch
Just like for LFO 1 (see above), this makes LFO 2 modulate the pitch. The 
range is also the same as for LFO 1.

| Waveform | Description

Triangle This is a smooth waveform, suitable for normal vibrato.

Inverted Sawtooth This produces a “ramp up” cycle. If applied to an oscilla-
tor’s frequency, the pitch would sweep up, after which the 
cycle immediately starts over.

Sawtooth This produces a “ramp down” cycle, the same as above 
but inverted.

Square This produces cycles that abruptly change between two 
values, usable for trills etc.

Random Produces random stepped modulation to the destination. 
Some vintage analog synths called this feature “sample & 
hold”.

Soft Random The same as above, but with smooth modulation.
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Connections
On the back panel of NN-XT are a number of connectors. Many of these are CV/
Gate related. Using CV/Gate is described in the chapter “Routing Audio and 
CV”.

Sequencer Control
The Sequencer Control CV and Gate inputs allow you to play the NN-XT from 
another CV/Gate device (typically a Matrix or a Redrum). The signal to the CV in-
put controls the note pitch, while the signal to the Gate input delivers note on/off 
along with velocity.

Modulation Input
These control voltage (CV) inputs (with associated voltage trim pots), can mod-
ulate various NN-XT parameters from other devices. These inputs can control 
the following parameters:

• Oscillator Pitch
• Filter Cutoff Frequency
• Filter Resonance
• LFO 1 Rate
• Master Volume
• Pan
• Modulation Wheel

Gate Input
These inputs can receive a CV signal to trigger the following envelopes:

• Amplitude Envelope
• Modulation Envelope 

Note that connecting to these inputs will override the normal triggering 
of the envelopes. For example, if you connect a Matrix Gate Out to the 
Gate In Amp Envelope, you would not trigger the amp envelope by 
playing notes, as this is now controlled by the Matrix Gate Out. In addi-
tion you would only hear the Gate Out triggering the envelope for the 
notes that you hold down.

Audio Output
There are 16 audio output jacks on the NN-XT’s back panel - eight separate ste-
reo pairs. When you create a new NN-XT device, the first output pair (1L & 2R) 
is auto-routed to the first available channel on the audio mixer. 

The other output pairs are never automatically routed. If you wish to use any of 
the other output pairs, you have to manually connect them to the desired device 
- typically a mixer channel. The basics on Routing is described in the chapter 
“Managing the Rack” in the Getting Started book.

! Note that when you use any other output pair than the first, you also 
have to route one or more zones to it if you want it to actually out-
put sound, since all zones by default are routed to outputs 1 & 2. 
How to route zones to other outputs is described on page 174.
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Introduction

The Dr.Rex Loop Player is capable of playing back and editing files created in 
ReCycle, another product created by Propellerhead Software. ReCycle is a pro-
gram designed especially for working with sampled loops. By “slicing” a loop 
and making separate samples of each beat, ReCycle makes it possible to 
change the tempo of loops without affecting the pitch and to edit the loop as if it 
was built up of individual sounds.

ReCycled Loops
To fully understand Dr.Rex you need to understand what it means to ReCycle a 
drum loop. Imagine that you have a sample of a drum loop that you want to use 
in a track you are working on. The loop is 144 bpm and your track is 118 bpm. 
What do you do? You can of course lower the pitch of the loop, but that will 
make the loop sound very different, and if the loop contains pitched elements 
they will no longer match your song. You can also time stretch it. This won’t alter 
the pitch, but will make the loop sound different. Usually it means that you loose 
some “punch” in the loop. 

Instead of stretching the sample, ReCycle slices the loop into little pieces so 
that each drum hit (or whatever sound you are working with) gets it's own slice. 
These slices can be exported to an external hardware sampler or saved as a 
REX file to be used in Reason. When the loop has been sliced you are free to 
change the tempo any way you want. You can also create fills and variations 
since the slices can be moved around in the sequencer.

About File Formats
Dr.Rex can read files in the following formats:

D REX (.rex) 
This is the file format generated by previous versions of ReCycle (Mac plat-
form).

D RCY (.rcy) 
This is the file format generated by previous versions of ReCycle (PC plat-
form).

D REX 2 (.rex2) 
This is the ReCycle file format for both Mac and PC platforms generated by 
ReCycle version 2.0. One of the differences between the original REX for-
mat and REX2, is that the REX2 format supports stereo files. 

! Unlike the other audio devices, Dr.Rex does not load or save file in-
formation in a “Patch” format. The REX file and the associated 
panel settings is instead saved in the Song (.rns) file. 

✪ If you have made adjustments (pitch, level etc.) to a REX loop that 
you wish to use in another Song, you can simply copy the whole 
Dr.Rex device from one song to another.
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Adding a Loop
To add a loop into the Dr.Rex Loop Player, proceed as follows:

1. Open the browser by selecting “Browse ReCycle/REX Files” from 
the Edit menu or the device context menu, or click on the folder but-
ton beside the Loop name display.

2. In the browser, locate and open the desired loop.
You can listen to the loops before loading by using the Preview function in 
the browser.

! Loading a new REX file will replace any currently loaded file.

Auditioning the Loop in Dr.Rex
D Once loaded, you can check out the loop by using the Preview but-

ton.
It will play back repeatedly in the tempo set on the transport panel. If you 
change the tempo, the loop tempo follows.

D You can also play the loop once via MIDI, by using the D0 key.

D To check out the loop together with other device sequencer data 
and patterns already recorded, activate both the Preview function 
and the sequencer Play button.
This does not have to be done in any particular order, they will play back in 
perfect sync anyway.

Loading Loops “On the Fly”
Another practical method for checking out loops, is to load them “on the fly”, i.e. 
during playback. This is especially useful if you want to check out a number of 
loops against other sequencer data and patterns previously recorded. Proceed 
as follows:

1. Activate Preview on the Dr.Rex and start sequencer playback.
The REX loop and the sequencer are synced.

2. Now load a new REX file by using the Browser in one of the usual 
ways.
After a brief silence, the new file is loaded, and sync is maintained.

3. Repeat step 2 as necessary until you have found a suitable loop.

D If you are trying out loops within the same folder, the quickest ways 
to select a new loop is to use the arrow keys next to the loop name 
display.
Or, you can click in the loop name display and select a new loop from the 
pop-up menu that appears.

! Note that the Preview function is not the “real” way of playing back 
REX loops. If you want to use the loop in a context with other de-
vices, you should transfer the REX slices to notes in the sequencer, 
as described on page 188.
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Creating Sequencer Notes
To be able to make your REX loop start at the same time as other sequencer or 
pattern data, you first have to create sequencer notes from the slices:

1. Select a sequencer track connected to the Dr.Rex device.

2. Set the left and right locators to encompass the section you want to 
fill with REX notes.
You may want to make sure that this area doesn’t contain any notes already, 
to avoid confusion.

3. Click the To Track button on the Dr.Rex panel.

Now, the program will create a note for each slice, positioned according to the 
timing of the slices. The notes will be pitched in semitone steps, with the first 
note on C1, the second on C#1 and so on, with one pitch for each slice. If the 
area between the locators is longer than the loop length, the loop notes will be 
repeated to fill out the loop.

The loop notes in the Arrange View...

...and in the Edit View.

Activating playback in the sequencer will now play back the notes on the se-
quencer track. These in turn will play back the slices in the Dr.Rex device, in the 
correct order and with the original timing maintained. Now the fun begins!

• You can change the groove in the loop by quantizing or moving notes.
• You can transpose notes to change the order of the slices on playback.
• You can use the Alter Notes function in the Change Events dialog (see page 

32) to scramble the loop notes - without destroying the original loop timing.
• You can remove and draw new notes, creating any kind of variation.
• You can use the User Groove function to apply the rhythmic feel of the loop 

to notes on other sequencer tracks.

For details about editing in the sequencer, see page 22.

! Note that if you have created sequencer notes from a REX file, you 
cannot load a new REX file into Dr.Rex and play it from the existing 
track. Well, you can, but it will not play back properly. If you have 
created notes in this way, and want to change the REX file, first de-
lete the notes, then use the “To Track” command again after having 
loaded the new REX file. 

You can also export the REX file as a MIDI file, as described on page 258.
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Slice Handling
Selecting Slices

A selected slice is indicated by being highlighted in the waveform display. To se-
lect a slice, use one of the following methods:

D By clicking in the waveform display.
If you hold down [Option] (Mac) or [Alt] (Windows) and click on a slice in 
the waveform display, it will be played back. The pointer takes on the shape 
of a speaker symbol to indicate this.

D By using the “Slice” knob below the waveform display.

D Via MIDI.
If you activate “Select Slice Via MIDI”, you can select and “play” slices using 
your MIDI keyboard. Slices are always mapped to consecutive semitone 
steps, with the first slice always being on the “C1” key.

D If you play back a loop with “Select via MIDI” option activated, each 
consecutive slice is selected as it is played back.
You can edit parameters during playback.

Editing Individual Slices
There are two basic methods you can use to edit individual slices in Reason:

D In the Waveform display of the Dr.Rex device.
This is used for making playback settings for a slice.

D In the Sequencer.
Here you can edit the notes that play the slices. There is a special REX lane 
for editing REX slice notes, with the notes indicated by the slice numbers in-
stead of by pitches. Editing in the sequencer is described in the Sequencer 
chapter.

Editing in the Waveform Display

Here you are able to edit several parameters for each slice, by first selecting it, 
and then using the knobs below the waveform display. The following slice pa-
rameters can be set:

! If you have made settings to any of the parameters listed above, 
these will be lost if you load a new REX file. All Dr.Rex panel set-
tings are stored in the Song. You cannot directly apply panel set-
tings to another REX file!

| Parameter | Description

Pitch Allows you to transpose each individual slice in semitone 
steps, over a range of more than eight octaves.

Pan The stereo position of each slice.

Level The volume of each slice. The default level is 100.

Decay Allows you to shorten individual slices.
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Dr.Rex Synth Parameters
The Dr.Rex synth parameters are used for shaping and modulating the sound of 
the REX loops. These parameters are familiar synth parameters, similar to the 
ones in the synthesizers; The Subtractor and the Malström, and in the samplers; 
the NN-19 and the NN-XT. It is important to remember that these parameters do 
not alter the REX files in any way, only the way they will play back. 

! These parameters are global, in the sense that they will affect all 
slices in a REX file.

Oscillator Section

For a REX file, the audio contained in the slices are what oscillators are for a syn-
thesizer, the main sound source. The following settings can be made in the Osc 
section of the Dr.Rex:

Setting the overall Pitch

You can change the pitch of a REX file in three ways:

D In octave steps.
This is done using the Oct knob. The range is 0 - 8, with “4” the default.

D In semitone steps.
This is done by using the Transpose knob below the waveform display, or by 
clicking on the keyboard above the knob. You can raise or lower the fre-
quency in 12 semitone steps (+/– 1 octave). The transpose value can also 
be changed via MIDI, by pressing a key between C-2 and C0 (with C1 reset-
ting the transpose value to zero).

D In cents (hundredths of a semitone).
The range is -50 to 50 (down or up half a semitone).

! To tune an individual slice, you select it and use the Pitch parameter 
below the waveform display.

Osc Envelope Amount

This parameter determines to what degree the overall pitch of the REX file will 
be affected by the Filter Envelope (see page 191). You can set negative or pos-
itive values here, which determines whether the envelope curve should raise or 
lower the pitch.

The Filter Section

Filters are used for shaping the overall timbre of the sound. The filter in Dr.Rex is 
a multimode filter with five filter modes.

D You activate or deactivate the filter completely by clicking the Filter 
button.
The filter is active when the button is lit.

Filter Mode

With this selector you can set the filter to operate as one of five different types of 
filter. These are as follows:

D 24 dB Lowpass (LP 24)
Lowpass filters lets low frequencies pass and cuts out the high frequencies. 
This filter type has a fairly steep roll-off curve (24dB/Octave). Many classic 
synthesizers (Minimoog/Prophet 5 etc.) used this filter type.

D 12 dB Lowpass (LP 12)
This type of lowpass filter is also widely used in classic analog synthesizers 
(Oberheim, early Korg synths, etc.). It has a gentler slope (12 dB/Octave), 
leaving more of the harmonics in the filtered sound compared to the LP 24 
filter.

D Bandpass (BP 12)
A bandpass filter cuts both high and low frequencies, while midrange fre-
quencies are not affected. Each slope in this filter type has a 12 dB/Octave 
roll-off.

D High-Pass (HP12)
A highpass filter is the opposite of a lowpass filter, cutting out the lower fre-
quencies and letting the high frequencies pass. The HP filter slope has a 12 
dB/Octave roll-off.

D Notch
A notch filter (or band reject filter) could be described as the opposite of a 
bandpass filter. It cuts off frequencies in a narrow midrange band, letting the 
frequencies below and above through. 
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Filter Frequency 

The Filter Frequency parameter (often referred to as “cutoff”) determines which 
area of the frequency spectrum the filter will operate in. For a lowpass filter, the 
frequency parameter could be described as governing the “opening” and “clos-
ing” of the filter. If the Filter Freq is set to zero, none or only the very lowest fre-
quencies are heard, if set to maximum, all frequencies in the waveform are heard. 
Gradually changing the Filter Frequency produces the classic synthesizer filter 
“sweep” sound.

! Note that the Filter Frequency parameter is usually controlled by 
the Filter Envelope (see page 191) as well. Changing the Filter Fre-
quency with the Freq slider may therefore not produce the expected 
result.

Resonance

The filter resonance parameter affects the character of the filter sound. For low-
pass filters, raising the resonance will emphasize the frequencies around the set 
filter frequency. This produces a generally thinner sound, but with a sharper, 
more pronounced filter frequency “sweep”. The higher the resonance value, the 
more resonant the sound becomes until it produces a whistling or ringing sound. 
If you set a high value for the resonance parameter and then vary the filter fre-
quency, this will produce a very distinct sweep, with the ringing sound being 
very evident at certain frequencies.

• For the highpass filter, the resonance parameter operates just like for the 
lowpass filters.

• When you use the Bandpass or Notch filter, the resonance setting adjusts 
the width of the band. 
When you raise the resonance, the band where frequencies are let through 
(Bandpass), or cut (Notch) will become narrower. Generally, the Notch filter 
produces more musical results using low resonance settings.

Envelope Section
Envelope generators are used to control several important sound parameters in 
analog synthesizers, such as pitch, volume, filter frequency etc. In a conventional 
synthesizer, envelopes govern how these parameters should respond over time 
- from the moment a note is struck to the moment it is released. In the Dr.Rex de-
vice however, the envelopes are triggered each time a slice is played back.

There are two envelope generators in the Dr.Rex, one for volume, and one for the 
filter frequency (and/or pitch). Both have the standard four parameters; Attack, 
Decay, Sustain and Release 

! Please refer to the Subtractor chapter for a description of the basic 
envelope parameters.

Amplitude Envelope

The Amp Envelope governs how the volume of a slice should change over time, 
from the time it is triggered (the slice note starts) until the slice note ends. This 
can be used to make a loop more distinct (by having a snappy attack and a short 
decay time) or more spaced-out (by raising the attack time).

The Level parameter acts as a general volume control for the loop.

Filter Envelope

The Filter Envelope can be used to control two parameters; filter frequency and 
overall loop pitch. By setting up a filter envelope you control how the filter fre-
quency and/or the pitch should change over time for each slice.

The Amount parameter determines to what degree the filter frequency will be af-
fected by the Filter Envelope. The higher the Amount setting, the more pro-
nounced the effect of the envelope on the filter.

✪ Try lowering the Frequency slider and raising Resonance and Enve-
lope Amount to get the most effect of the filter envelope!
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LFO Section

LFO stands for Low Frequency Oscillator. LFOs are oscillators in the sense that 
they generate a waveform and a frequency. However, there are two significant 
differences compared to normal sound generating oscillators:

• LFOs only generate waveforms with low frequencies.
• The output of the two LFOs are never actually heard. Instead they are used 

for modulating various parameters.

The most typical application of an LFO is to modulate the pitch of a (sound gen-
erating) oscillator or sample, to produce vibrato. In the Dr.Rex device, you can 
also use the LFO to modulate the filter frequency or panning.

Waveform

LFO 1 allows you to select different waveforms for modulating parameters. 
These are, from top to bottom:

Destination

The available LFO Destinations are as follows:

Sync

By clicking this button you activate/deactivate LFO sync. The frequency of the 
LFO will then be synchronized to the song tempo, in one of 16 possible time di-
visions. When sync is activated, the Rate knob (see below) is used for setting 
the desired time division.

Turn the knob and check the tooltip for an indication of the time division.

Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster modu-
lation rate.

Amount

This parameter determines to what degree the selected parameter destination 
will be affected by the LFO 1, i.e. the amount of vibrato, filter wah or auto-pan-
ning.

| Waveform | Description

Triangle This is a smooth waveform, suitable for normal vibrato.

Inverted
Sawtooth

This produces a “ramp up” cycle. If set to control pitch (fre-
quency), the pitch would sweep up to a set point (governed 
by the Amount setting), after which the cycle immediately 
starts over.

Sawtooth This produces a “ramp down” cycle, the same as above but 
inverted.

Square This produces cycles that abruptly changes between two val-
ues, usable for trills etc.

Random Produces random stepped modulation to the destination. 
Some vintage analog synths called this feature “sample & 
hold”.

Soft Random The same as above, but with smooth modulation.

| Destination | Description

Osc Selecting this makes LFO control the pitch (frequency) of the 
REX file.

Filter Selecting this makes the LFO control the filter frequency. 

Pan Selecting this makes the LFO modulate the pan position of 
the REX file, i.e. it will move the sound from left to right in the 
stereo field.
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Velocity Control

Velocity is usually used to control various parameters according to how hard or 
soft you play notes on your keyboard. A REX file does not contain velocity values 
on its own. And when you create sequencer track data by applying the “To 
Track” function, all velocities are set to a default value of “64”. As velocity infor-
mation is meant to reflect variation, having them all set to the same value is not 
meaningful if you wish to velocity control Dr.Rex parameters.

There are basically two ways you can apply “meaningful” velocity values to REX 
files:

• After creating track data, you can edit velocity values in the Velocity Lane in 
the sequencer.

• You can play slices in real time on your keyboard. The resulting data will 
have velocity values reflecting how the notes were struck when you played.

When velocity values have been adjusted, you can control how much the various 
parameters will be affected by velocity. The velocity sensitivity amount can be 
set to either positive or negative values, with the center position representing no 
velocity control. 

The following parameters can be velocity controlled:

Pitch Bend and Modulation Wheels

The Pitch Bend wheel is used for “bending” the pitch up or down. The Modula-
tion wheel can be used to apply various modulation while you are playing the 
loop. Virtually all MIDI keyboards have Pitch Bend and Modulation controls. 
Dr.Rex also has two functional wheels that could be used to apply real time 
modulation and pitch bend should you not have these controllers on your key-
board, or if you aren’t using a keyboard at all. The wheels mirror the movements 
of the corresponding MIDI keyboard controllers.

Pitch Bend Range

The Range parameter sets the amount of pitch bend when the wheel is turned 
fully up or down. The maximum range is “24” (=up/down 2 Octaves).

Modulation Wheel

The Modulation wheel can be set to simultaneously control a number of param-
eters. You can set positive or negative values, just like in the Velocity Control 
section. The following parameters can be affected by the modulation wheel:

|  Parameter | Description

Amp This let’s you velocity control the overall volume of the file. If a 
positive value is set, the volume will increase with higher veloc-
ity values. 

F. Env This sets velocity control for the Filter Envelope Amount param-
eter. A positive value will increase the envelope amount with 
higher velocity values. Negative values invert this relationship.

F. Decay This sets velocity control for the Filter Envelope Decay parame-
ter. A positive value will increase the Decay time with higher ve-
locity values. Negative values invert this relationship.

| Parameter | Description

F. Freq This sets modulation wheel control of the filter frequency pa-
rameter. A positive value will raise the frequency if the wheel is 
pushed forward. Negative values invert this relationship.

F. Res This sets modulation wheel control of the filter resonance pa-
rameter. A positive value will increase the resonance if the 
wheel is pushed forward. Negative values invert this relation-
ship.

F. Decay This sets modulation wheel control for the Filter Envelope De-
cay parameter. A positive value will increase the decay if the 
wheel is pushed forward. Negative values invert this relation-
ship.
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Setting Number of Voices - Polyphony

This determines the polyphony, i.e. the number of voices, or slices, Dr.Rex can 
play simultaneously. For normal loop playback, it is worth noting that slices 
sometimes “overlap”. Therefore, it is recommended that you use a polyphony 
setting of about 3-4 voices when playing REX files. If you are “playing” slices via 
MIDI, the polyphony setting should be set according to how many overlapping 
slices you want to have.

! Note that the Polyphony setting does not “hog” voices. For exam-
ple, if you are playing a file that has a polyphony setting of ten 
voices, but the file only uses four voices, this won’t mean that you 
are “wasting” six voices. In other words, the polyphony setting is 
not something you need to consider if you want to conserve CPU 
power - it is only the number of voices actually used that counts.

Audio Quality Settings

These two parameters provide ways of balancing audio quality vs. conservation 
of computer power.

High Quality Interpolation

When this is activated, the loop file playback is calculated using a more ad-
vanced interpolation algorithm. This results in better audio quality, especially for 
loops with a lot of high frequency content.

D High Quality Interpolation uses more computer power - if you don’t 
need it, it’s a good idea to turn it off!
Listen to the loop in a context and determine whether you think this setting 
makes any difference.

! If you are using a Macintosh with a G4 (Altivec) processor, turning 
High Quality Interpolation off makes no difference.

Low Bandwidth (BW)

This will remove some high frequency content from the sound, but often this is 
not noticeable (this is especially true if you have “filtered down” your loop). Acti-
vating this mode will save you some extra computer power, if needed.
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Connections
On the back panel of Dr.Rex you will find the connectors, which are mostly CV/
Gate related. Using CV/Gate is described in the chapter “Routing Audio and 
CV”.

Audio Outputs
These are the main left and right audio outputs. When you create a new Dr.Rex 
device, these are auto-routed to the first available channel on the audio mixer.

Slice Gate Output
This outputs a gate signal for each triggered slice in the loop.

Modulation Inputs
These control voltage (CV) inputs (with associated voltage trim pots), allow you 
to modulate various Dr.Rex parameters from other devices (or from the modula-
tion outputs of the Dr.Rex device itself). The following CV inputs are available:

• Osc Pitch.
• Filter Cutoff.
• Filter Resonance.
• Amp Level.
• Mod Wheel.

Modulation Outputs
The Modulation outputs can be used to voltage control other devices, or other 
parameters in the Dr.Rex device itself. The Modulation Outputs are:

• Filter Envelope.
• LFO.

Gate Inputs
These inputs can receive a CV/gate signal to trigger the two envelopes. Note 
that connecting to these inputs will override the “normal” triggering of the enve-
lopes. For example, if you connected an LFO CV output on another device to the 
Gate Amp input on the Dr.Rex, the amplitude envelope would not be triggered 
by the incoming MIDI notes to the Dr.Rex device, but by the LFO CV signal. In 
addition you would only hear the LFO triggering the envelope for the slices that 
were playing at the moment of the trigger.

• Amp Envelope
• Filter Envelope
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17 D Matrix Pattern Sequencer
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Introduction

The Matrix is a pattern-based device. Matrix doesn’t generate sound on its own, 
but has to be connected to another instrument device. It basically works by 
sending pattern data in the form of Note CV (pitch) and Gate CV (note on/off 
plus velocity) or Curve CV (for general CV parameter control) signals to a device 
or device parameter. The patterns can be up to 32 steps, and there are 32 mem-
ory locations for storing pattern data. The Matrix is monophonic and can control 
one voice in an instrument device.

Unlike most other devices in Reason, the user interface of the Matrix is not mod-
eled on any existing hardware equivalent. The hardware devices that could be 
said to have similar functionality are analog step sequencers, which usually had 
rows of knobs that controlled the note pitch and gate values for each step.

About the Three Output Types

Note and Gate CV values.

The Matrix can produce three types of output: Curve CV, Note (Key) CV and 
Gate CV. 

D Note CV normally controls note pitch. 
When connected to an instrument device Sequencer Control input, the val-
ues correspond to semitone steps.

D Gate CV represents a note-on/off value, plus a level value (that 
could be likened to velocity).

Both of these two outputs are typically connected to the Sequencer Control 
Gate and CV inputs on a compatible instrument device. For example, if you cre-
ate a Matrix with either a synthesizer (Subtractor, Malström) or a sampler (NN-
19, NN-XT) selected, they will be auto-routed in this way, and will control one 
voice in the device.

D Curve CV is a separate pattern, programmed separately from the 
Note/Key and Gate CV.

Curve CV values (upper window).

This is useful for programming CV curves that control other parameters other 
than note pitch (although you could do this too). This way you could control the 
note pitch and triggering from the Key and Gate outputs for a device, then add a 
second independent pattern using the Curve CV output that could control filter 
cutoff for example.

It should be stressed that all three outputs can be used in any number of ways. 
For example, you could use the Gate CV to trigger a drum in Redrum, or let the 
Curve CV control the feedback parameter of a delay, etc.

Gate values are 
entered here

Note values are 
entered here
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Programming Patterns
! Pattern programming basics is covered in “Programming Pattern 

Devices”.

Tutorial
The programming procedure of the Matrix is to input note and gate values into 
the upper and lower fields of the pattern window respectively. You can input val-
ues by clicking or dragging in the pattern window. Proceed as follows:

1. Create a Subtractor synth.
You don’t have to use the Subtractor device to use the Matrix, in fact you 
don’t have to use an instrument device at all, but for this basic tutorial we will 
use a “standard” setup.

2. With the Subtractor selected, create a Matrix Pattern Sequencer.
The Matrix Note and Gate CV outputs will now be auto-routed to Subtrac-
tors Sequencer Control Gate and CV inputs, as you can see if you flip the 
rack around.

3. Make sure that the switch to the left of the pattern window is set to 
“Keys” position.
As you can see, there is a horizontal row of red rectangles at the bottom of 
the upper field in the pattern window. These rectangles represent note pitch, 
for each step in a pattern. At the moment they are all set to the same note 
pitch.

4. Click inside the upper grid section of the Matrix pattern window.
An orientation line is displayed in the grid to make it easier for you to find the 
desired note, and the red rectangles are placed according to where you 
click. You can drag to input continuous note values.

5. Click in the lower area of the pattern window.
Vertical strips of varying heights can be created. These represent Gate ve-
locity values. The higher the strip, the higher the velocity value. You can drag 
to input continuous gate values.

6. Press the Play button on the Matrix.
The pattern you “programmed” in the previous steps is now repeated. At the 
top of the pattern window, a red rectangle indicates every step of the pat-
tern.
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D If you now click or drag in the upper grid section with the pattern 
playing, you can hear how the note pitches change.
The note pitch corresponds to the keyboard printed to the left of the pattern 
window, in a one octave range, and as previously mentioned, an orientation 
line is visible when clicking or dragging, making it easy to find the note pitch 
on the keyboard.

D If you now click or drag in the lower gate section while the pattern 
is playing, you can hear how the timbre and volume changes. 

D If you drag some of the vertical rectangles down so that they disap-
pear from view, the corresponding steps of the pattern are com-
pletely silenced.

D By using the 5-way switch below the “Keys/Curve” switch you can 
input notes in other octave ranges (over five octaves).
Note that there can only be one note for each step in the pattern.

7. By using a combination of the methods described in the above 
steps, you can program suitable note values for each step, decide 
which steps should be played and set their velocity with the gate 
values.

Using Curve Patterns
Curve patterns are independent patterns that can be applied separately to the 
note pattern programmed in “Keys” mode. If you switch the Keys/Curve switch 
to “Curve”, the note, but not the gate steps, disappear from view, and leaves the 
upper area of the pattern window empty. You can now start programming a 
curve pattern. Proceed as follows:

1. Draw a curve, using the same method as for notes or gates.
As you can see, the Curve pattern looks like large vertical gate steps. 

D If you play the pattern, nothing has changed, i.e. the pattern sounds 
exactly like it did before the Curve pattern was drawn.
This is because the Curve CV output hasn’t been connected to any parame-
ter yet.

2. Flip the rack around so you can see the back panel of the Matrix.

3. Connect the Curve CV output to the Filter Cutoff Modulation Input 
on the Subtractor.
Now the curve pattern controls the filter frequency of the Subtractor.

✪ If the effect isn’t very noticeable, try raising the filter Q parameter, 
and lowering the filter frequency.

D The Curve CV output can be connected to any device CV or Modula-
tion input.
Actually, Curve CV signals can also produce Gate triggers (used for trigger-
ing samples or envelopes for example). 

D A Gate trigger is produced for each curve pattern step that follows a 
value of “0”. 
If you look at the picture below, steps 2,4 and 6 will produce a trigger, be-
cause steps 1, 3 and 5 are set to zero, but the rest of the pattern would not.
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About Unipolar and Bipolar Curves

On the back panel of the Matrix you will find a switch, allowing you to select be-
tween “Unipolar” or “Bipolar” Curves. The difference is as follows:

D A unipolar curve has values starting from “0” and up. 
“0” is the value produced by all steps when they are “empty” (not visible). 
Unipolar is the default setting of this switch when a new Matrix is created.

Unipolar curve.

D A bipolar curve is divided in the “middle”, with the middle repre-
senting a value of “0”.
The curve reflects this. If no curve has been drawn and you switch to bipolar 
mode, all steps go from the bottom up to the middle of the scale printed to 
the left of the pattern window. Thus, all steps are at “0”, and the curve can 
be drawn both up and down from the middle.

Bipolar curve.

Bipolar curves are essential in some instances. If you want to use the Matrix to 
CV control the Pan parameter for a mixer channel for example, a unipolar curve 
would start at zero - which for Pan equals center position. This means that you 
would only be able to use the curve to pan in one direction from this center po-
sition. A bipolar curve however, will have the zero value in the middle, allowing 
you to draw pan curves in both directions. Bipolar curves can also be used for 
controlling parameters with positive and negative values.

Setting Pattern Length

You may want to make settings for Pattern length, i.e. the number of steps the 
pattern should play before repeating:

D The “Steps” spin controls are used to set the number of steps you 
wish the pattern to play.
The range is 1 to 32. You can always extend the number of steps at a later 
stage, as this will merely add empty steps at the end of the original pattern. 
You could also make it shorter, but that would (obviously) mean that the 
steps you remove won’t play back. The steps you remove aren’t erased 
though, if you set the step number back again, anything recorded in the pre-
viously removed step locations will be played back.

Using Tied Notes
If you activate “Tie” to the left of the Gate pattern window, you can create longer 
notes (eighth notes, quarter notes etc.). A quick way to draw tied gates is to hold 
down [Shift] when you input the gate values.

Entering tied gate values.

D Each step that has one tied gate value will be twice the length com-
pared to a normal step.
Tied gate steps are indicated by being twice as wide in the pattern window.

D If two or more notes of the same pitch are tied together, the result 
will be even longer notes. 

Tied notes are also essential if you want to create typical TB-303 “Acid”-type 
lead lines - see page 204.

Selecting Patterns and Pattern Banks
This is described in the chapter “Programming Pattern Devices” in the Getting 
Started book.



MATRIX PATTERN SEQUENCER202

Setting Pattern Resolution
Matrix always follows the tempo setting on the transport panel, but you can also 
make Matrix play in different tempo “resolutions” in relation to the tempo setting. 
This is explained in the chapter “Programming Pattern Devices”.

Pattern Shuffle
Shuffle is a rhythmic feature, that gives the music a more or less pronounced 
swing feel. It works by delaying all sixteenth notes that fall in between the eighth 
notes.

Straight sixteenth note pattern (viewed in the sequencer).

The same sixteenth note pattern with shuffle applied.

In Reason, you can activate or deactivate shuffle individually for each pattern in a 
pattern device. However, the amount of shuffle is set globally with the Pattern 
Shuffle control on the transport panel.

The Shuffle on/off switch in Matrix and the Pattern Shuffle control on the transport panel.

Pattern Mute
If you deactivate the “Pattern” button above the Pattern select buttons, the pat-
tern playback will be muted, starting at the next downbeat (exactly as if you had 
selected an empty (silent) pattern). For example, this can be used for bringing 
different pattern devices in and out of the mix during playback.

Pattern Functions
When a pattern device is selected, you will find some specific pattern functions 
on the Edit menu (and on the device context menu).

Shift Pattern Left/Right

The Shift Pattern functions move the notes and corresponding gate values in a 
pattern one step to the left or right.

Shift Pattern Up/Down

! This function does not alter the Curve CV. This is because the val-
ues produced by the Curve CV do not necessarily correspond to 
semitone note steps at all.

The Shift Pattern functions will transpose all the notes in a pattern one semitone 
up or down. 

Randomize Pattern

The Randomize Pattern function create random patterns. These can often be 
great starting points and help you get new ideas. Both Note, Gate and Curve 
CV values will be created.

Alter Pattern

The Alter Pattern function modifies existing patterns. Note that there must be 
something in the pattern for the function to work on - using an Alter function on 
an empty pattern will not do anything.

! Note that Randomize and Alter affects both the Gate, Note and 
Curve CV!

Chaining Patterns
! Selecting Patterns and Banks and using Cut, Copy and Paste with 

Patterns is described in the chapter “Programming Pattern De-
vices”. 

When you have created several patterns that belong together, you will most 
probably want to make these play back in a certain order. 

D Simply activate record for the track with the Matrix as the destina-
tion in the sequencer and use the Pattern and Bank buttons to de-
termine the playback order as the Song is playing. 
The Patterns play to the end before changing, so you won’t have worry too 
much over the “timing” of the pattern changes you input manually. When you 
are done, the sequencer track will contain pattern change data, and the pat-
terns will automatically switch according to the order set while recording. 
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4. More on recording pattern changes on page 10.

D An alternative way to do this is editing directly in the Pattern Edit 
lane in the sequencer.
Editing in the Pattern lane is described in the Sequencer chapter.

Converting Pattern Data to Notes
! Curve patterns cannot be converted to sequencer data! Only the 

note pattern and the gate values will be converted.

You can convert Matrix Pattern data to note data, that can be edited and played 
back from the main sequencer. Proceed as follows:

1. Select the sequencer track connected to the Matrix.

2. Set the left and right locators to the desired range or length.
If the range set is longer than the pattern(s), the data will be repeated to fit 
the range.

3. Select the Matrix device you wish to copy the pattern(s) from.

4. Select “Copy Pattern to Track” from the Edit menu or the device 
context menu.
Notes will be created between the left and right locators, according to the 
selected pattern (Gate and Key values only).

However, at this point the track with the notes is connected to the Matrix itself. 
This is pointless, since the Matrix doesn’t produce any sound. Therefore:

5. Re-route the sequencer track to the device which was controlled by 
the Matrix (or to another instrument device if you like).
This is done by clicking in the Out column for the track in the track list, and 
selecting another device from the pop-up menu that appears.

If you now activate playback from the transport you will send note data to the 
connected device from both the sequencer and the Matrix at the same time, 
which is probably not what you want. To avoid this happening, you have to do 
one of the following:

D Delete the Matrix device.

Or...

D Disconnect CV and Gate cables between the Matrix and the instru-
ment device on the back panel.

✪ The procedure above copies a single pattern to notes in the se-
quencer. If you have automated pattern changes, you can copy a 
complete pattern track to notes, taking all pattern changes into ac-
count. This is described on page 13.
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Example Usage
As mentioned previously, the Matrix is a very flexible device. Here follows a few 
examples of how you can use the Matrix Pattern Sequencer.

Using the Matrix for Modulation
You can effectively use the Matrix as a modulation source, much like an LFO. 
Just like the LFOs in Reason’s instrument devices, the Matrix can generate mod-
ulation that is synchronized to tempo, which has many advantages. Proceed as 
follows:

1. Create a Synthesizer (Subtractor or Malström).

2. Create a Matrix Pattern Sequencer, or if one already exists, set it to 
an empty pattern.
These two devices may or may not be connected (by autorouting) via the 
synthesizers Sequencer Control inputs - it doesn’t matter for this example.

3. Flip the rack around and connect the Curve CV output on the Matrix 
back panel to the “Amp Level” Modulation input on the synthesizer.
This parameter is used for modulating the output level (volume) of the syn-
thesizer. Volume modulation is often referred to as Tremolo. You can use a 
unipolar curve (see page 201) for this example.

4. Flip the rack back again, and switch the Matrix to display the Curve 
pattern window.
You should now see an empty pattern window, with no Gate or Curve 
events visible.

5. Draw a curve like the one shown in the illustration below.
If you use fewer or more steps than16 (as shown in the picture), just draw 
the curve so that it roughly matches the shape in the picture.

6. Activate Click on the transport panel.

7. Select the track that is routed to the synthesizer, so that you can 
play it from your MIDI keyboard.

8. Activate Play on the transport panel, and hold a chord down on your 
keyboard.
You should now hear the volume being modulated by the Curve pattern.

9. While still in play mode, you can use the Resolution knob to change 
the modulation “rate” in relation to the tempo.
For each clockwise resolution step the modulation speed is doubled and 
vice versa, but it will always stay in sync with the tempo.

Programming “Acid Style” lead lines
By “acid style” lead lines we mean patterns that use a combination of Legato 
and slide (or portamento) effects to produce the widely used hypnotic “wavy” 
sound produced by the original Roland TB-303, and recreated in the Propeller-
head Software product ReBirth. To approximate this typical sound using Rea-
son, proceed as follows:

1. Create a Synthesizer (Subtractor or Malström).

2. Create a Matrix Pattern Sequencer, or if one already exists, set it to 
an empty pattern.

3. Make sure that the Note and Gate CV outputs are connected to the 
synthesizers Sequencer Control CV and Gate inputs, respectively.

4. For Subtractor, select either a Init Patch, or use the “TB Synth” 
patch in the Monosynth category of the Factory Sound Bank. 

D If you use an Init patch, it is important that you make the following 
settings:

• Set Polyphony to “1”.
• Switch Trigger Mode to “Legato”.
• Set Portamento to a value around “50”.

5. Create a pattern in Matrix, and keep it playing back.

D If “Tie” (see page 201) now is activated for a step, the note will be 
tied to the next and the pitch will continuously “glide” to the pitch 
of the following step.
Please note that Tie should be activated on the note you wish to slide from, 
and not the note you slide to.

D If you have several tied notes, one after the other, they will play as 
one long legato phrase. This can be used to create “wavy” lead 
lines with pitch bend effects.

6. Experiment with different Note, Tie and Gate values.
If you have ever used a TB-303 or ReBirth, you should now begin to get the 
hang of how you can create patterns in that particular style by using the Ma-
trix together with a synthesizer.

✪ Adding a DDL-1 (delay), and a D-11 (distortion) effect device will 
make it sound even more “ReBirth”-like, but of course you are also 
able to get a much wider range of timbres by utilizing Reason’s 
other sound and modulation capabilities.
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Triggering Samples
The Gate CV output can be used to trigger samples, either in Redrum or in the 
NN-19 or NN-XT Sampler.

D Connect the Matrix Gate CV out to the Gate (Sequencer Control) in 
on the NN-19/NN-XT or to one of the individual Gate Channel in-
puts of Redrum.
The Matrix gate values will now trigger the sample on each step that has a 
Gate value above “0”.
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Introduction

The ReBirth Input Machine is a device dedicated to receiving audio from the 
Propellerhead program “ReBirth RB-338” (version 2.01 and later). This is 
achieved by using ReWire technology (see page 48), where Reason will act as 
master and ReBirth as a slave device. If you don’t have ReBirth installed, you 
cannot use this device. If you are a ReBirth user, you can use the ReBirth Input 
Machine for the following:

D Receive up to eighteen channels of streaming ReBirth channels in 
Reason.
You can create more ReBirth Input Machines, but only one can be active at 
a time.

D Sample accurate synchronization between the audio in the two pro-
grams.

D The two programs can share the same audio card and take advan-
tage of multiple outputs on that card.

Preparations
For the ReBirth Input Machine to correctly operate together with ReBirth, the 
launch and quit order is very important. Proceed as follows:

Launching
1. Launch Reason.

2. Create a ReBirth Input Machine.
You may want create a Mixer prior to this step, otherwise the L/R Mix chan-
nels will be routed directly to the Audio Hardware Interface. If you have a 
Mixer, the L/R Mix output from the ReBirth Input Machine will be automati-
cally connected to the mixer’s first available audio inputs.

3. Launch ReBirth.

4. When ReBirth is launched, select Reason as the application in fo-
cus.
If both the “Reason is Rewire Master” and the “Active” indicator on the Re-
Birth Input Machine are lit, this indicates that the launch procedure was cor-
rect and that Reason and ReBirth are now locked and in sync.

D If only the “Active” indicator is lit, either the launch order was 
wrong, or ReBirth is not installed properly.

5. Activate playback on Reason’s transport panel.
ReBirth and Reason are locked in perfect sync, and will follow any transport 
commands in either of the programs.

! Note that there is no master/slave relationship for the transport 
controls when using ReWire, as either device will control the other 
device’s transport. The audio, however, is streamed from ReBirth to 
Reason, so in this aspect Reason is the master device.

Quitting
1. First quit ReBirth.

2. Then quit Reason.

Routing
When the two programs are synced, you can route any of the eighteen available 
outputs in ReBirth, to separate channels in a Reason Mixer, or to the Hardware 
Interface for direct connection to a physical output on your audio card.

If you flip the rack around, a row of 18 audio outputs is shown, with the L/R Mix 
outputs auto-routed to your mixer or to the hardware interface.

What Signals are on the Outputs?

Mix-L and Mix-R

This is the regular master output in ReBirth RB-338. These are the only stereo 
channels, all other channels are in mono.

D If none of the other channels are used, then this carries all the 
sound from ReBirth.

D Signals that are activated separately are removed from this mix.
If for example the 909-Mix channel is activated, then Mix-L and Mix-R carries 
all the sound from ReBirth RB-338 except the 909, which will appear on its 
own channel.

The individual outputs are described more closely in the ReWire chapter of the 
ReBirth manual.



19 D BV512 Vocoder



BV512 VOCODER210

Introduction

The BV512 is an advanced vocoder device with a variable number of filter 
bands. It also has a unique 1024-point FFT vocoding mode (equivalent of 512-
band vocoding) for very precise and high quality vocoded speech. By connect-
ing the BV512 to two instrument devices, you can produce anything from vo-
coded speech, singing or drums to weird special effects.

Even if you have worked with a vocoder before, please read the following sec-
tion. Knowing the basic terms and processes will make it much easier to get 
started with the BV512!

How does a vocoder work?

Carrier and modulator

A vocoder accepts two different input signals, a “carrier” and a “modulator”. It 
analyzes the modulator signal, applies its frequency characteristics to the carrier 
signal and outputs the resulting “modulated” carrier signal. 

In the most typical case, the carrier signal is a string or pad sound and the mod-
ulator signal is speech or vocals - the result will be a talking or singing synth 
sound. The modulator could also be drums or percussion (for rhythmically mod-
ulated sounds and effects) or any sound with changing frequency content.

Filter bands

Technically, a vocoder works in the following way: The modulator signal is di-
vided into a number of frequency bands by means of bandpass filters (called the 
“modulator filters” or “analyzing filters”). The signal in each of these bands is 
sent to a separate envelope follower (which continuously analyzes the level of 
the signal). The carrier signal is sent through the same number of bandpass fil-
ters (the “carrier filters”), with the same frequency ranges as the filters for the 
modulator signal. The gain of each bandpass filter is controlled by the level from 
the corresponding envelope follower, and the filtered signals are combined and 
sent to the vocoder’s output.

In this way, the carrier is filtered to have roughly the same frequency characteris-
tics as the modulator. If the modulator signal has a lot of energy in one of the fre-
quency bands, the gain of the corresponding filter band for the carrier signal will 
be high as well, emphasizing those frequencies in the output signal. If there is no 
signal at all within a frequency band in the modulator signal, the corresponding 
band in the output signal will be silent (as the gain will be zero for that filter).

There are several factors determining the quality of the vocoder sound, but the 
most important is the number of filter bands. The larger the number of filter 
bands, the closer will the output signal follow the modulator’s frequency charac-
teristics. The BV512 offers 4, 8, 16 or 32-band vocoding.

✪ Even if a high number of bands will make the sound more precise 
and intelligible, this isn’t always what’s desired! Vocoding with a 
lower number of bands can give results that sound different, fit bet-
ter in a musical context, etc.

FFT vocoding

The BV512 has an additional FFT mode, in which the vocoding process isn’t 
based on bandpass filters as described above. Instead, FFT (Fast Fourier Trans-
form) analysis and processing is used. This equals 512 “conventional” fre-
quency bands and results in a very precise and detailed vocoder sound. Note:

• The FFT mode is best suited for vocoding speech or vocals, giving crystal 
clear and highly intelligible results. It is not so well suited for vocoding drums 
and percussion, since the FFT process is inherently “slower” than the regu-
lar filtering and doesn’t respond as quickly to transients, and also there will 
be a slight delay added to the signal (in the region of 20ms). A workaround 
solution to this would be to move the modulator signal slightly ahead to com-
pensate for the delay.

• Where the conventional filter bands are distributed logarithmically (i.e. the 
same number of filter bands per octave), the 512 bands in the FFT mode are 
distributed linearly. This means a lot of the bands will be in the high fre-
quency range - this is one of the reasons for the clear sound but it is also 
something to keep in mind when making settings for the vocoder in FFT 
mode.
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Setting up for basic 
vocoding
This tutorial describes how to connect and use a typical vocoder setup. We as-
sume here that you have a MIDI keyboard connected. For details on the param-
eters, see page 214.

1. Make sure there’s a MIxer device in the rack (with at least one free 
channel).

2. Create the instrument device you want to use for the carrier signal.
This could typically be a synth or a sampler. In this example we choose a 
Subtractor synthesizer.

3. Set up the carrier device for a sustaining, bright sound.
It’s important to have high frequencies in the carrier. On the Subtractor, a 
simple but effective carrier sound would be based on a sawtooth wave, with 
the filter fairly open. For more about choosing carrier sounds, see page 216.

4. Select the carrier device and create a BV512 Vocoder.
If you flip the rack around you will see that the Vocoder is automatically 
routed as an insert effect for the carrier device (using the Carrier Input 
jacks).

5. Press [Shift] and create the instrument device you want to use for 
the modulator signal.
Pressing [Shift] will add the device without auto-routing it to a mixer - this 
makes sense since we want to route it to the Vocoder in this case. 
For a modulator device you would typically either want a sampler (with vo-
cals or speech samples), a drum machine or a Dr.Rex device (with vocal or 
rhythmic loops). For simplicity we use a Dr.Rex device in this example.

6. Flip the rack around and route the output of the Dr.Rex to the Mod-
ulator Input jack on the BV512.

7. On the BV512 Vocoder, turn the Dry/Wet knob fully to the left 
(“dry”).

This will let you hear the unprocessed sound of the modulator device only - useful for the 
next step:

8. Load a loop into the Dr.Rex device and click the Preview button to 
start playback.
For example, you could simply choose one of the Dr.Rex Drum Loops in the 
Factory Sound Bank.

9. Turn the Dry/Wet knob on the vocoder fully to the right (“wet”).
Now you won’t hear anything - since there is no carrier signal.

Carrier

Vocoder

Modulator
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10. Route MIDI to the carrier device by clicking in the MIDI symbol col-
umn for its track in the sequencer.

11. Play a chord or a note on your MIDI keyboard.
What you hear now is the vocoded sound, e.g. the carrier sound processed 
to have the same tonal characteristics as the modulator.

12. Try the different filter band options and note the difference in 
sound.

13. You can also adjust the vocoder sound by clicking and dragging the 
bars in the lower display.
Each bar corresponds to a frequency band, with low frequencies to the left 
and high frequencies to the right. You adjust the level of a band by dragging 
its bar up or down. Clicking and dragging across the bars allow you to 
change the levels of several bars, much like drawing an eq curve.

The upper display shows the spectrum of the modulator signal, for display only.

D To reset a band to ±0 dB, press [Command] (Mac) or [Ctrl] (Win) 
and click on it.
You can also reset all bands to zero by bringing up the context menu for the 
Vocoder device and selecting “Reset Band Levels”.

14. If the vocoder sound is “muddy” or indistinct, try raising the “HF 
Emph” knob on the Vocoder.
This parameter (High Frequency Emphasis) boosts the high frequencies in 
the carrier signal.

15. Try out the other parameters if you like.
See page 214 for details.

That’s it - a basic vocoder setup!

Vocoded vocals
The most common usage for a vocoder is probably the typical “singing” or “talk-
ing synth” sound, using vocals or speech as modulator. Since Reason doesn’t 
support live audio input you cannot sing and play in real time - instead you need 
to use sampled speech or vocals (with e.g. an NN-19 or NN-XT as the modulator 
device). The procedure for this is roughly the same as in the tutorial above, but 
this time you need to record or enter some notes in the sequencer for the mod-
ulator device (since the samplers don’t have pattern or Preview playback). 
Here’s a quick guideline:

1. Create the carrier device.

2. Select the carrier device and create a BV512 vocoder.

3. Select the BV512 and create the modulator device (typically an NN-
19 or NN-XT sampler device).

4. Load the vocals or speech samples into the sampler device and as-
sign them to keyzones as desired.
For details about using sampler devices, see the respective device chapter.

5. Record or enter some notes on the sequencer track for the sampler 
device, so that the vocal samples are played back where you want 
them in the song.
To hear the unprocessed sound of the sampler device, set the Dry/Wet con-
trol on the BV512 to “Dry”, as above. When you’re done, turn the control 
back to “Wet” to get the vocoded sound.

6. Route MIDI to the carrier device.

7. Start sequencer playback and play notes or chords on your MIDI 
keyboard.
The result will be the classic vocoded vocal sound.

8. At this point you may want to record the notes or chords you play 
for the carrier device.
As MIDI is already routed to the carrier device track, all you need to do is 
start recording and play along.
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Using the BV512 as an 
equalizer
The BV512 has a unique equalizer mode, in which the device works purely as an 
insert effect (the modulator input isn’t used). This allows you to use the process-
ing filters of the vocoder as a kind of graphic equalizer.

Setting up
1. Select the device that you want to process through the BV512.

2. Create a BV512 device.
It is automatically connected as an insert effect, using the Carrier Input jacks.

3. Set the switch to the left of the displays to “Equalizer”.

In use

In equalizer mode, you cut or boost frequencies by clicking and dragging in the 
lower display - just as with a regular graphic equalizer. The usage and results dif-
fer depending on which mode is selected:

4 - 32 band mode

As in vocoder mode, the number of bars in the display conforms to the number 
of bands selected (4, 8, 16 or 32). With a higher number of bands you get a 
more detailed control over the frequency response. However:

D In these modes, the equalizer will “color” the sound even if all 
bands are set to ±0 dB!
This is due to phase interaction and overlap between the bandpass filters.

Therefore you probably want to use the 4 - 32 band mode for coloring and mu-
tating sounds - not for subtle, “clean” equalizing.

FFT (512) mode

In FFT (512) mode you still get 32 bars in the display, but the each bar may con-
trol several frequency bands (remember that there are 512 bands in FFT mode). 
Since the frequency bands are distributed linearly in FFT mode, bars to the left in 
the display control few frequency bands while bars to the right control many fre-
quency bands.

D In FFT (512) mode, setting all bands to ±0 dB is the same as bypass-
ing the equalizer - the sound will not be affected.
This makes FFT mode suitable for “clean” equalizing, where you want to 
boost or cut some frequencies without changing the basic sound character.

D However, FFT mode equalizing is not suited for very drastic fre-
quency cuts or boosts, as this may give audio artefacts due to the 
workings of FFT processing.
Still: as always, there are no hard and fast rules. Let your ears judge!

D Keep in mind that FFT mode also introduces a slight delay to the 
signal.
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BV512 parameters
On the front panel of the BV512 Vocoder, you will find the following parameters 
and displays:

| Parameter | Description

Bypass/On/Off 
switch

In Bypass mode, the carrier signal passes through the de-
vice unaffected and the modulator signal is disregarded. In 
On mode, the device outputs the vocoded or equalized sig-
nal. Off mode cuts the output, silencing the device.

Level meters Show the signal level of the carrier and modulator signals, 
respectively.

Band switch Selects the number of filter bands (4, 8, 16 or 32) or FFT 
(512) mode.

Equalizer/Vocoder 
switch

Determines whether the BV512 should work as a vocoder 
or an equalizer. In Equalizer mode, the Modulator input is 
disregarded (see page 213).

Modulation level 
display

The upper display shows the spectrum of the modulator 
signal.

Frequency band 
level adjust

The lower display allows you to adjust the level of each fil-
ter frequency band, by clicking and dragging the corre-
sponding bar. In vocoder mode this affects the vocoded 
sound. In equalizer mode, this is where you cut or boost 
frequencies. To reset a band to ±0 dB, press [Command] 
(Mac) or [Ctrl] (Win) and click on its bar in the display. To 
reset all bands, select “Reset Band Levels” from the device 
context menu.
Note: when FFT (512) mode is selected, each of the 32 
bars in the display corresponds to several frequency 
bands, with bars to the right in the display controlling pro-
gressively more bands (due to the FFT bands being linearly 
distributed over the frequency range).

Hold button Clicking this button “freezes” the current filter settings. 
While the button is lit, the modulator signal doesn’t affect 
the sound - the carrier signal is filtered with the settings as 
they were the moment you activated Hold. Click the button 
again to turn off Hold. Hold is also automatically reset 
(turned off) when you stop sequencer playback - just like 
the pitch bend and modulation wheels on synth devices.
This function can be controlled via CV or MIDI, for sample 
and hold-like effects.
The Hold button is not available in Equalizer mode.

Attack This is a global attack time control, affecting all envelope 
followers (see page 210). Normally you probably want this 
set to zero, to make the vocoder react as quick as possible. 
Raising the Attack time can be useful for “smearing” 
sounds, creating pads, etc. 
Not available in Equalizer mode.

Decay Similarly, this controls the decay time for all envelope fol-
lowers, i.e. how quick the filter band levels drop. Adjust this 
according to taste and context. 
Not available in Equalizer mode.

Shift Shifts the carrier filters up or down in frequency, drastically 
changing the character of the vocoded (or equalized) 
sound. This parameter can be controlled via CV, for 
phaser-like sweeps and special effects.

HF Emph 
(High Frequency 
Emphasis)

Boosts the high frequencies in the carrier signal. This is 
sometimes desired to get a clearer vocoded sound. The 
reason is that a carrier signal should theoretically contain 
roughly equal energies in all frequency ranges for best re-
sults - in a typical synth sound the high frequencies are of-
ten weaker than the low frequencies. Raising the HF Emph 
control will rectify this.
Not available in Equalizer mode.

Dry/Wet Determines the balance between modulator sound (dry) 
and vocoded sound (wet). To get the pure vocoder sound, 
set this to wet (turned fully right).
Not available in Equalizer mode.

| Parameter | Description
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Connections

The back panel of the BV512 offers the following connections:

Individual band levels

These are CV outputs and inputs. 

• The upper row outputs CV signals generated by the envelope followers for 
each frequency band. 

• The lower row are CV level inputs to the individual bandpass filters through 
which the signal is processed (the “vocoder filters”).
Connecting a CV signal to one of the inputs breaks the internal signal path 
from the corresponding envelope follower (in other words, that frequency 
band is now controlled by the CV signal you’ve connected - not by the cor-
responding frequency band in the modulator signal).

• If 16 band mode is selected, each output/input pair corresponds to a sepa-
rate frequency band. In 8 band or 4 band mode, only the 8 first or 4 first out-
put/input pairs are used. In 32 band mode, each output is a mix of two 
adjacent frequency bands and each input controls two bands. Finally, in FFT 
(512) mode each output/input pair corresponds to several frequency bands.

There are several interesting uses for the Individual band levels connectors: you 
can cross-patch frequency bands so that e.g. low frequencies in the modulator 
signal controls high frequency bands in the vocoder, you can extract CV signals 
for controlling synth parameters in other devices, you can base the vocoding on 
CV signals from other devices rather than on a modulator signal, etc. See page 
218 for details.

Other CV connections

Audio connections

| Connection | Description

Shift (CV in) This allows you to control the Shift parameter from an 
external CV source. A sensitivity knob determines how 
much the Shift setting is affected by the CV signal.

Hold (Gate in) When a gate signal is sent to this input, the Hold func-
tion is activated (see page 214). Hold remains on until 
the gate signal “goes low” (falls to zero). By connecting 
e.g. a Matrix to this input, you can create “stepped” vo-
coder sounds, sample and hold-like effects, etc.

| Connection | Description

Carrier input This is where you connect the instrument device that 
provides the carrier signal (or the device to be pro-
cessed in Equalizer mode) - typically a synth or sampler 
device. The vocoder can handle mono or stereo carrier 
signals.

Modulator input This is where you connect the instrument device that 
provides the modulator signal, in mono. This connec-
tion is not used in Equalizer mode.

Output In Vocoder mode, the outputs carry a mix between the 
vocoded signal and the modulator signal (as set with 
the Dry/Wet control on the front panel). In Equalizer 
mode the output is the carrier signal, processed 
through the equalizer filter.
Note that the output will be in mono if the Carrier input 
is in mono, and vice versa - the BV512 does not pro-
cess mono into stereo.
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Automation

All parameters on the front panel can be automated in the standard manner. The 
individual band levels (the bars in the lower display) will be edited on separate 
lanes in the sequencer. Note:

D As with the other effect devices, you have to manually create a se-
quencer track for the BV512.

D Although the band level adjustments can be edited individually, 
they are treated as one automatable parameter on the device panel.
This means that if any single band level control is automated, there will be a 
frame around the whole lower display on the device panel. [Ctrl]-clicking 
(Mac) or right-clicking (Win) in the lower display and selecting “Clear Auto-
mation” will remove the automation for all bands. Similarly, selecting “Edit 
Automation” will open the sequencer with lanes for all band levels shown.

The frame indicates that one or more band level controls are automated.

Tips and tricks
Choosing a carrier sound
As always, which carrier sound to choose is a matter of taste and musical con-
text. However, here are a few guidelines to help you get a good result:

• The carrier sound should preferably have a lot of harmonic content (bright-
ness) - dark or muffled sounds will not “give the vocoder much to work with”.

• Often, you want the carrier sound to sustain at an even level (i.e. it shouldn’t 
“die out” when you hold a chord). Similarly, you most often want a reason-
ably fast attack (although not with a distinct, sharp click or edge).

• You may want a sound that is rather static over time, without drastic enve-
lope control of filter cutoff for example.

• If you want to play vocoded chords, the carrier sound must of course be 
polyphonic.

Here are some hands-on suggestions for carrier sounds:

D A simple Subtractor pad based on a sawtooth waveform.
You could simply start with the initial patch (as set up when you create a 
new Subtractor device). Open the filter, turn off envelope modulation of the 
cutoff frequency and raise the Amp Envelope Sustain. 
If you want a classic, rich chorus-like sound, use two detuned oscillators - or 
better still, add a UN-16 Unison device as an insert effect between the Sub-
tractor and the vocoder!

A simple but effective carrier sound setup.

D A similar fat carrier sound can be obtained using a Malström device 
with a patch based on the “Sawtooth*16” graintable.
With the Malström you can get a stereo carrier signal with no extra devices: 
simply select the “Sawtooth*16” graintable for both oscillators, detune the 
oscillators slightly with the Cent controls and raise the Spread parameter to 
the desired stereo width. No filter routings are necessary.
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D For a more distinct and precise sound, try using a narrow pulse 
waveform.
You get this by selecting e.g. a sawtooth wave on the Subtractor, setting the 
Phase Mode selector to “–” and turning the Phase knob to the left until you 
get the desired sound. This type of carrier sound lends itself well to mono-
phonic vocoder lines in the lower registers.

D Use noise as a carrier.
Try using pure noise (possibly filtered down a bit) for robotic voices, whis-
pering and special effects. It’s also very useful to add a bit of noise to a saw-
tooth or pulse sound - this makes vocoded speech clearer and more 
intelligible.

D Use sampled strings or choir sounds.
A rich drawbar organ sample can also be a cool carrier sound.

D For unusual vocoder sounds, try using the Malström as carrier de-
vice, e.g. with a glassy, digital pad sound selected.
Try turning up the Attack and Decay controls on the BV512, for smeared, 
rhythmic or pseudo-random modulation of a pad.

Choosing a modulator sound
The modulator sound should typically have varying level and harmonic content. 
As we’ve already mentioned, the most typical modulator sounds are vocals or 
speech and drums or percussion.

D The quickest way to get a modulator sound is to use a rhythmic loop 
in the Dr.Rex device (as in the tutorial on page 211).
This way you don’t have to program a rhythm pattern. On the other hand, us-
ing a Redrum as modulator allows you to create exactly the rhythm you want 
and fine-tune the sounds and the groove.

D To use your “own” vocals as modulator sounds, you need to record 
them as WAV or AIFF files (using any audio recording utility on your 
computer) and load the files as samples into an NN-19 or NN-XT de-
vice.

D Instead of using a sampler device as modulator for speech or vo-
cals, you could slice the vocal samples in Propellerheads’ ReCycle 
application, and play them back with a Dr.Rex device.
This would make it easier to work with vocoded vocals, especially if you are 
experimenting with different tempo settings or grooves. Tip: You can copy 
the MIDI notes played by Dr.Rex to the carrier track so that the original 
rhythm of the speech/vocal is preserved.

Using the modulator as carrier
You can get cool special effects by using the same device both as carrier and as 
modulator. For example, try processing a Redrum device in the following way:

1. Create a Redrum device and set up the desired patch and pattern.

2. Create a Spider Audio Merger & Splitter device.

3. Create a BV512 Vocoder.

4. Flip the rack around and connect the devices in the following way:

The output of the Redrum goes into the splitter section of the Spider, and is split into two 
signals. One signal goes into the carrier input of the vocoder, the other goes into the 
modulator input.

This is essentially the required connections, but for best results it’s a good idea 
to add some distortion and/or compression to the carrier signal - this increases 
the amount of high frequencies in the carrier signal:

5. Press [Shift] and create a Scream 4 distortion device.

6. Connect the distortion device as an insert effect between the Spi-
der and the carrier input of the vocoder.
Now, the carrier signal will be processed in the distortion device, but not the 
modulator signal.

7. Play back the pattern and experiment with the settings on the vo-
coder and distortion device.

D This technique can also be used to process vocals and speech.

D Try adjusting the Shift parameter for new effects and sounds.
Remember that you can route CV to the Shift parameter on the back of the 
BV512 - use e.g. a Matrix or an LFO output on a synth device!
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Controlling the Hold function
As described see page 214, pressing the Hold button on the front panel 
“freezes” the current filter spectrum until you deactivate it again. This can be 
used for creating sample & hold-like effects, stuttering or garbled vocoder 
sounds:

• Connect e.g. the Gate output on a Matrix device to the Hold input on the 
back of the BV512. By playing back a gate pattern on the Matrix, the Hold 
function will repeatedly be turned on and off according to the programmed 
rhythm in the pattern. Hold will be active for the length of each gate signal.

• Automate the Hold function with the main sequencer, either by recording it 
or by drawing in its controller lane.

• If you route MIDI to the BV512 you can control the Hold function in two ways 
by default: By pressing a damper pedal connected to your MIDI controller or 
by playing the note C4. In both cases, the Hold function will be momentary - 
Hold is on until you release the pedal or key.

Using the individual band level connections
As described on page 215, the individual band level connectors on the back are 
CV output and input jacks. The upper row sends out the CV signals from the en-
velope followers for the different frequency bands, while the lower jacks are CV 
inputs for controlling the individual bandpass filters (breaking the internal con-
nection from the envelope followers). There are several interesting things you 
can do with these connections:

Crosspatching frequency bands

By connecting outputs to inputs in alternative configurations, you can drastically 
change the result of the vocoding. For example, you could have low frequencies 
in the modulator signal give high frequencies in the vocoded sound and vice 
versa. Note: 

• In 4 band and 8 band mode, only the 4/8 first output/input pairs are used.

• In 32 band mode and FFT (512) mode, each connection corresponds to two 
or several frequency bands.
This means that connecting an output to the input with the same number is 
not the same as using the internal signal path (no CV cable connected). You 
can hear this quite clearly in FFT (512) mode: connect all outputs to the cor-
responding inputs and gradually remove the CV cables while listening to the 
vocoder sound - the sound will progressively get more detailed.

Extracting CV from the vocoder

You can connect an individual band level output to any CV input on any device. 
This means you can use the vocoder as an envelope follower, having elements in 
the modulator sound control a parameter in another device, e.g. an effect. Note:

• The Attack and Decay settings on the BV512 panel affect the envelope fol-
lowers, and thus the rise and fall times of the CV signals from the individual 
band level outputs. 

• If you are using the vocoder in a mode with many bands, but want a broader 
frequency range to generate the CV signal, you can merge several band out-
puts into one CV signal - use a Spider CV Merger & Splitter device.

Controlling vocoder bands from an external source

Connecting a CV source to an individual band input breaks the internal connec-
tion from the corresponding envelope follower. This way you can “manually” con-
trol the vocoder filters. Some applications:

D Connect the CV outputs for one or more envelopes in the carrier de-
vice to individual band inputs.
When you play the carrier instrument, one or more of the bandpass filters in 
the vocoder will automatically open, adding an extra attack to the sound. 
Useful if you really want to “play” the carrier, rather than just hold a chord.
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D Connect the gate outputs on a Redrum device to individual band 
level inputs.
With this connection (and no device connected to the Modulator input), the 
Redrum will serve as a pattern sequencer, opening and closing different fil-
ter bands. To adjust the gate times, set the drum sounds to Gate mode and 
use the Length parameter. The result is totally different from using the audio 
signal of the Redrum as modulator.

The vocoder bands are now solely controlled by the gate signals from the drum channels 
- the modulator input isn’t used. 
Note that you can use a Spider CV Merger & Splitter device to split a gate signal, 
sending it to several bands. Also, note that the velocity of the programmed drum notes 
govern the level of the corresponding filter bands.

“Playing” the vocoder from a MIDI keyboard
If you have routed MIDI to the BV512, playing notes from C1 and up will control 
individual filter bands. For example, in 16 band mode, C1 controls band 1, C#1 
band 2 and so on up to D#2 (which controls band 16).

• The level of the bands is proportional to key velocity (how hard you play).
• A band will be “open” until you release the corresponding key.
• Bands to which you have connected a CV signal (using the individual band 

level inputs on the back panel) will not respond to MIDI keys.

Note that with this function, you “play the modulator”. You still need a carrier sig-
nal to get any sound. Typically, you would first record the notes or chords for the 
carrier device in the sequencer, then route MIDI to the vocoder and “play” it from 
your MIDI keyboard while playing back the recorded carrier notes.

✪ An interesting application of this is to patch the vocoder as an in-
sert effect for the whole mix (the output of the main mixer con-
nected to the carrier input, with no modulator device connected), 
and “play the vocoder”. Only the frequency bands for which you 
press keys will be let through. Use the FFT (512) mode for best re-
sults.
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Using the BV512 as a reverb
This is a very special trick which can be quite cool. Proceed as follows:

1. Create a Redrum device.
The “vocoder-reverb” is best suited for drums, even though nothing stops 
you from using it on other sounds.

2. Create a Subtractor and a vocoder.
The Subtractor will automatically be routed to the carrier input. We don’t 
need a dedicated modulator device in this setup.

3. Flip the rack around and connect Aux send 1 on the Mixer to the 
modulator input on the vocoder.

4. While you’re there, re-route the vocoder output to Aux return 1.
This way, our vocoder-reverb will be connected as a regular send effect.

5. Set the vocoder to FFT (512) mode, turn the Decay knob to between 
6 and 7 and turn the Dry/Wet control to “wet” (fully right)

6. On the Subtractor, set up a noise sound as follows:
Turn the Oscillator Mix knob fully to the right.
Turn on the Noise section (but make sure Osc 2 is off).
In the Noise section, turn Color to around twelve o’clock.
Open the filter fully and make sure resonance is set to 0.
Make sure Filter Envelope Amt is 0 (and turn off velocity modulation.
Raise the Sustain to full in the Amp Envelope section.

Now we want the Subtractor to play a continuous noise. You could just route 
MIDI to it, play a note and keep it pressed, but that will probably wear you out in 
the long run. Better to use a Matrix:

7. Create a Matrix and route it to the Subtractor.
We really only need the Gate connection - the note number isn’t important 
with the noise patch.

8. Set up a one step pattern with a tied gate (press [Shift] and draw 
the gate) and start playback on the Matrix.
Now the vocoder gets a continuous noise signal as carrier.

9. Create a suitable drum pattern on the Redrum and start pattern 
playback.

10. Gradually turn up send 1 for the Redrum channel in the mixer.
This now serves as a balance control between the dry drum sound and the 
reverb, generated by the voccoded noise! Set it to a suitable reverb level.

11. Use the Decay control on the vocoder to adjust the reverb decay 
time.

12. Use the Noise Color control on the Subtractor to make the reverb 
darker or brighter.
You could use the filter cutoff for this as well.

That’s it - a pretty good reverb sound with a lot of control. Although the settings 
above give the most natural sound, you can vary the sound and create special-
FX reverb in the following ways for example:

• Switch the vocoder to a lower band mode.
• Lower the cutoff and add some resonance in the Subtractor filter.
• Modulate the Subtractor filter with a fast LFO.
• Set the Subtractor filter to HighPass mode to remove the bottom end from 

the reverb.
• Turn off the Matrix controlling the Subtractor and “play” the noise patch 

yourself (or from the sequencer). This way you can create gated reverb ef-
fects, etc.
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Creating a stereo reverb

What you’ve got above is a mono reverb. Here’s how to make it stereo:

1. Select the Subtractor and create a Spider Audio Merger & Splitter 
device.

2. Create a DDL-1 delay.

3. Connect the devices in the following way:
The Subtractor output should be routed to a Splitter input on the Spider. 
One split output should be routed to one of the carrier inputs on the vo-
coder, the other split output should be routed to the delay. The delay output 
(mono) should be routed to the other carrier input on the vocoder.

The vocoder will now get a “fake-stereo” noise carrier signal.

4. Make sure the output from the vocoder is connected in stereo to the 
Aux return on the Mixer.

5. Finally turn down the Feedback on the delay, set it to all “wet” and 
set the decay time to a second or so.

When you now start playback on the Redrum, the reverb will be in stereo!
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Common Device Features
While the specific parameters for each device are described below, some fea-
tures and procedures are common to all effect devices:

The Input meter

This shows the level of the incoming audio signal, giving you an indication of 
which devices are active, connected and playing. However, you don’t need to 
worry about clipping in effect devices, even if the meter goes into the red.

The Power/Bypass switch

This is located in the upper left corner of each effect device. The switch has 
three modes, according to the following figure:

About making settings

You adjust effect parameters using the regular editing techniques, as described 
in the Getting Started book. Note:
✪ A quick way to reset the parameters to their default values is to 

[Command]/[Ctrl]–Click the corresponding knob.

About Connections

D All effect devices have stereo inputs and outputs, and can be con-
nected as send effects or as insert effects. 
However, some effects are best used as one of these only. This is stated for 
each effect on the following pages. See also the section about the signal 
flow graphs below.

D Most of the effect devices have one or several CV inputs on the 
back panel.
These allow you to control various effect parameters in real-time, from an-
other device in the rack. See page 36 for details about routing CV.

The Signal Flow graphs

On the back of each effect device, you will find two or three small “graphs”. 
These indicate how the effect device handles mono and stereo signals, depend-
ing on the connections. The selection of graphs for a device tells you how it 
should be used, according to the following rules:

| Mode | Description

Bypass In this mode, the input signal is passed directly to the audio output, 
without being affected by the effect device. This is useful when the 
effect device is connected as an insert effect, and you want to 
compare the effect sound with the dry sound.

On This is the default mode, in which the device processes the incom-
ing signal.

Off In this mode, the effect device is turned off and neither dry nor ef-
fect sound is sent out. This is useful when the device is connected 
as a send effect and you want to turn it off temporarily.

| Graph | Description

Can be connected as a mono-in, mono-out device. 
(Of course, all effect devices can be connected in mono. However, 
if this graph isn’t shown for a device, this means that a mono-in, 
mono-out connection may not give the proper results).

Can be connected as a mono-in, stereo-out device. This means that 
the device creates some sort of stereo effect (e.g. a reverb) or a 
mono effect that can be panned.

If you connect both inputs and outputs in stereo, the two sides will 
be processed independently (dual mono processing).

If you connect both inputs and outputs in stereo, the two sides are 
summed before the effect processing. However, the actual effect is 
in stereo (and the dry signal will remain in stereo, if it is passed 
through the effect).

“True stereo” processing, or “stereo in - stereo out” processing. 
When you connect the inputs in stereo, each channel in the effect 
uses the signal information from both inputs. However, the inputs 
are not summed - the two channels are processed differently.
This mode is available on the RV7000 Advanced Reverb.
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Scream 4 Sound 
Destruction Unit

Scream 4 is a very versatile stereo in/out sound destruction device, capable of 
warping any sound literally beyond recognition, but also capable of producing 
more subtle musical effects. Scream 4 features a wide range of algorithms for 
distortion and sound mangling which can be combined with an EQ and a reso-
nant “Body” section to provide everything you need to add an edge to your 
sounds. This effect is most often used as an insert effect.

About the Patch format

Unlike most of the other effect devices, Scream 4 features programmable effect 
presets. Included are a number of factory Patches which can be used as they 
are or provide you with a good starting point for further tweaking.

Patches use the Windows file extension “*.SM4”. Loading and saving Patches is 
done in the same way as for instrument devices.

Parameters
Scream 4 contains three main sections; Damage (distortion and other types of 
sound destruction), Cut (EQ) and Body (places the sound in a resonant environ-
ment - can serve as anything from a cabinet emulator to a wah-wah to com-
pletely new special effects) which can be switched on or off independently. The 
parameters in each section are as follows:

Damage section controls

The “Damage” section is where you specify the basic sound mangling algorithm 
and make settings to inflict the desired amount of damage to the sound. There 
are ten basic algorithms to chose from, ranging from classic distortion effects to 
digital-sounding warping and modulation effects.

There are five controls in this section, with the following functions:

| Parameter | Description

Damage button This switches the Damage section on or off.

Damage Control knob This controls the input gain which in turn determines 
the amount of damage inflicted. The higher the value, 
the more destruction!
When raising the Damage Control you may need to 
lower the Master level to maintain the same output 
level (and vice versa).

Damage Type knob This selects the type of effect - see the table below for 
a description of the available damage methods.

P1/P2 knobs The functionality of these knobs vary according to the 
selected Damage Type - see the table below for a de-
scription.
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Description of the various Damage Type algorithms

Here follows a basic description of the ten Damage Types available, and what 
parameters the P1/P2 knobs control for each type:

| Type | Description

Overdrive This produces an analog-type overdrive effect. Overdrive is quite 
responsive to varying dynamics. Use lower Damage Control set-
tings for more subtle “crunch” effects. 
- The P1 knob controls the basic tone of the effect. Turn clock-
wise for a brighter sound.
- The P2 knob controls Presence. Presence boosts frequencies 
in the high midrange before the distortion stage which in turn af-
fects the character of the distortion. Turn clockwise for more 
Presence boost.

Distortion Similar to Overdrive, but produces denser, thicker distortion. The 
distortion is also more “even” across the Damage Control range 
compared to Overdrive.
- The P1/P2 knobs control Tone and Presence, respectively - 
see Overdrive for a description.

Fuzz Fuzz produces a bright and distorted sound even at low Damage 
Control settings.
- The P1/P2 knobs control Tone and Presence, respectively - 
see Overdrive for a description.

Tube This emulates tube distortion. 
- The P1 knob controls Contour, which is somewhat like a high 
pass filter, changing the tone and character of the distortion.
- The P2 knob controls Bias, which changes the “symmetry” of 
the tube distortion. Setting this to the minimum or maximum 
value will produce asymmetrical distortion (typical of a real-life 
tube amplifier), while a 12 o’clock setting will produce symmetri-
cal distortion (odd harmonics only).

Tape This emulates the soft clipping distortion produced by magnetic 
tape saturation and also adds compression which adds “punch” 
to the sound.
- The P1 knob controls Speed, which simulates tape running at 
different speeds. The higher the Speed setting the more of the 
original high frequency material in the signal. Turn clockwise for 
a brighter sound.
- The P2 knob controls the amount of Compression. Turning the 
knob clockwise increases the compression ratio.

Feedback This effect combines distortion in a feedback loop which can 
produce many interesting and sometimes unpredictable results. 
Feedback is basically when a sound source is fed back to itself. 
An open microphone picking up sound from a nearby loud-
speaker that is also being used to amplify sound from the micro-
phone will produce a feedback loop with the associated typical 
howling. For this effect the Damage Control knob controls the 
gain of the feedback loop.
- The P1 knob controls Size, which could be described as the 
“length” (i.e. the distance between the microphone and the loud-
speaker in the above example) of the feedback loop. 
- The P2 knob controls Frequency, which for this effect deter-
mines which overtones will “howl”.

Modulate Modulate first multiplies the signal with a filtered and com-
pressed version of itself, and then adds distortion. This can pro-
duce resonant, ringing distortion effects.
- The P1 knob controls Ring, which is the resonance of the filter. 
Turn clockwise for more pronounced ringing effects.
- The P2 knob controls Frequency, which is the filter frequency. 
Turn clockwise to raise the filter frequency which generally pro-
duces a sharper, more piercing effect.

Warp Warp distorts and multiplies the incoming signal with itself.
- The P1 knob controls Sharpness. Lower values will produce a 
soft, compressed distortion, while higher values produces more 
harmonics and a sharper sound.
- An effect of multiplying a signal with itself is that the fundamen-
tal pitch is removed from the signal, leaving overtones only. The 
P2 knob controls Bias - raise this to reintroduce the fundamental 
pitch in the sound.

Digital Lo-fi anyone? This reduces the bit resolution and sample rate for 
raw and dirty sounds or for emulating vintage digital gear.
- The P1 knob controls (bit) Resolution. If the knob is turned fully 
to the right there is no bit reduction, fully the left the resolution is 
1-bit.
- The P2 knob controls the sample rate. If the knob is turned fully 
to the right the sample rate is not reduced; turning it to the left 
gradually reduces the sample rate.

Scream Similar to Fuzz, but with a bandpass filter with high resonance 
and gain settings placed before the distortion stage. 
- The P1 knob controls the basic tone of the effect. Turn clock-
wise for a brighter sound.
- The P2 knob controls the filter frequency. The high resonance 
setting of the filter makes it suitable for wah-wah effects.

| Type | Description
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Cut section (EQ)

The sliders in the Cut section are tone controls, allowing you to cut or boost the 
level by up to 18dB in the low, mid and high frequency areas. The Cut section is 
activated with the Cut button above the sliders.

Move the slider from the middle upwards to boost the level, and from the middle 
downwards to cut the level of the corresponding frequency area.

Body section

The Body section is just what it says - it places the sound in a resonant “body”. 
Depending on the settings, the result can be similar to a speaker cabinet simula-
tor, an auto-wah effect, or effects with no real-world counterpart. The section is 
based on 5 basic body types, which simulate how a sound is affected by differ-
ent physical enclosures. The size and resonance of the Body types can be 
changed, and the section also features an envelope follower.

The Body parameters are as follows:

About the envelope follower

The Body section features an envelope follower for dynamic control of the Scale 
parameter. The envelope follower analyzes the amplitude of the incoming signal 
and changes the Scale setting accordingly - the louder the incoming signal the 
higher the value of the Scale parameter. The operating frequency (or size) range 
is set with the Scale parameter, and the envelope follower amount is set with the 
Auto parameter. A typical use for this is auto-wah effects - try Body Type “B” for 
a pronounced wah effect.

• On the back of the Scream 4 you will find an Auto CV output - this delivers 
the CV signal from the envelope follower, allowing you to dynamically control 
parameters in other devices. See page 229 for an example.

About the Master level control

The Master level control should be used when you need to increase or decrease 
the output level, while retaining the basic character of the effect. It can also be 
used to balance the level between the distorted sound and the “clean” (unproc-
essed) sound if the effect is to be switched in and out in the mix.

If the output level is too high, turning down the Damage Control setting would 
lower the output, but it would also change the character of the distortion, as 
would changing eq or presence settings.

Simply lowering the mixer channel level (for the channel that Scream 4 is con-
nected to) would also work of course, but this would also mean that the level dif-
ference between the unprocessed and processed sound would increase. 

So if the clip indicator lights up on the Transport, or if the distorted sound is too 
loud compared to the normal sound, the solution is to lower the Master output 
level.

As pointed out elsewhere in the manual, audio out clipping (indicated by the red 
clip indicator lighting up on the Transport panel) can only happen in the Reason 
Hardware Interface. In other words, you never have to worry about levels passed 
internally from device to device. However, bear in mind that if you use high Mas-
ter output settings (or a lot of boost in the Cut section) Scream 4 can quite eas-
ily cause audio out clipping - and that is most likely not a distortion effect you 
want! 

| Parameter | Description

Body button This switches the Body section on or off.

Body Type knob This is used to select one of the five available Body types 
(A-E). 

Body Reso knob This simulates the resonance of the selected Body. Turn-
ing the knob clockwise gives a more resonant effect.

Body Scale The Body Scale parameter could be said to control the 
“size” of the Body. Note that this is “inverted” - turning the 
knob clockwise reduces the emulated size.

Auto knob Determines the amount of envelope follower effect on the 
Scale parameter - see below.
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CV inputs and outputs

On the back of the Scream 4 you will find CV inputs for controlling the following 
four parameters:

D Damage Control
Use this for dynamically changing the amount of damage effect.

D P1
The use for this depends on the selected Damage Type. For example, if the 
Feedback effect is selected, this will control the Size parameter - connect it 
to the CV Out on a Matrix or synth LFO for strange, flanger-like sweeps.

D P2
The use for this depends on the selected Damage Type. For example, if the 
Scream effect is selected, this will control the Frequency parameter, produc-
ing a distorted wah wah sound.

D Scale
Lets you control the Scale parameter in the Body section from another CV 
source, for wah wah-like effects, etc.

In addition, you find a CV output from the “Auto” (envelope follower) function in 
the Body section. By connecting this to a CV input for a parameter in another 
device, the level of the signal going into the Scream 4 will affect that parameter. 
See below for an example on how to use this.

Tips and tricks
Don’t restrict yourself to using Scream 4 as a basic distortion stompbox, but try 
it in as many ways as possible - you may be surprised to find how often Scream 
4 can add power, warmth and color to your sounds. Here are some examples:

Creating a heavy drum sound

Scream 4 is ideal for processing drums. Try connecting it as an insert effect to a 
Redrum device and experiment with the Damage Types and settings. 

• For classic distorted drums, try the Tube, Tape or Distortion algorithms.
• The Scream algorithm is excellent for a really raw body or industrial drum 

sound.
• For more weird, synth-like effects, try the Modulation or Warp effects.

Remember that you don’t have to route the whole drum kit through the Scream 
device - sometimes it may be better to route the individual outputs from the bass 
drum, snare and/or toms to a Spider Audio Merger (see page 248), connect the 
merged output of the Spider to the Scream 4 and route this to a separate chan-
nel in the Mixer. That way, hi-hats, cymbals and similar are unprocessed.

Warming up a mix with the Tape effect

If you find your mixes a bit sterile, the Tape algorithm is excellent for providing 
some warmth and gentle distortion:

1. Create a Scream 4 device and connect it between the main outputs 
of the Mixer and the Audio Hardware device.

2. Set the Damage Type to Tape.
Make sure the Cut and Body sections are turned off.

3. Start with a low Damage Control setting and P1 (Speed) and P2 
(Compression) at 12 o’clock.

4. Play back your mix and adjust the settings.
Raise the Damage Control for more tape saturation distortion, adjust P1 to 
get the desired brightness and raise P2 if you want a more controlled, com-
pressed sound. If you like, you could also activate the Cut section and use 
the three-band EQ to further adjust the sound.
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Using the Body section as a sound enhancer/phaser/wah

Nothing stops you from using the Body section on its own, without Damage. Try 
this:

1. Create a sampler device (e.g. an NN-19) and select an electric piano 
patch.

2. Select the sampler and create a Scream 4.
It is added as an insert effect.

3. Turn off the Damage section and instead activate the Body section.

You will find that this adds a resonant character to the sound, which will make it 
more “alive” and help it stand out in a mix. You should experiment with the Body 
settings to find the character that suits you best. You could also activate the Cut 
section- if you e.g. find the sound too bassy, just lower the “Lo” slider a bit.

4. Now flip the rack around and connect the CV out from the sampler’s 
LFO to the Scale CV input on the Scream 4.
As you can hear, the Scale is modulated by the LFO.

5. Adjust the amount of Scale modulation with the pot next to the CV 
input on the back of the Scream 4, and the speed (and waveform) of 
the modulation in the LFO section on the sampler device.
With this type of modulation setup, it’s easy to get lush, dreamy phaser ef-
fects. For a more wah wah-like sound, select Body type B and raise the 
Reso and Scale settings.

Emulating vintage digital gear

The first generations of digital instruments (drum machines, synths and sam-
plers) used 8 or 12 bit sampling and processing, at low sample rates. This “lo-fi” 
sound is still in high demand, e.g. in hip-hop and R’n’B. Try this:

1. Connect a Scream 4 as an insert for a Redrum, with a suitable kit 
selected.

2. Set Damage Type to Digital and turn P1 and P2 fully right.

3. Play back and lower P1 (bit depth) and P2 (sample rate) to get the 
sound you want.
You may also want to use the Cut section to emphasize or cut frequencies in 
the sound.

Creating a real dynamic wah effect with the envelope follower

As we have shown, you can get auto-wah-like effects with the Body section in 
Scream 4 (by using the Auto parameter). You could also use the ECF-42 enve-
lope controlled filter and trigger this with a gate signal - this is after all a “real” fil-
ter and sounds even more like a wah effect. However, to get a “real” auto-wah 
effect that responds to the signal level, you need to combine both these devices:

1. Create an instrument device that you want to process with an auto-
wah.
It should be velocity responsive so that the harder you play, the louder it 
sounds.

2. Create a Scream 4 device and an ECF-42 device.
Both these should now be connected as insert effects to the instrument de-
vice.

3. Turn off all three sections in the Scream 4.
This is of course a matter of taste - but here we will show how to use the en-
velope follower in Scream 4, not its sound destruction capabilities.

4. Flip the rack around and connect the Auto CV Output on the Scream 
to the Freq CV input on the ECF-42.

5. Lower the pot next to the CV input a bit - the envelope follower is 
rather sensitive and you probably don’t want the filter to open too 
much.
You can adjust this later if needed.

6. On the ECF-42, select the BP 12 (bandpass) mode and set the Res 
setting rather high.

7. Play the instrument device and adjust the Freq setting on the ECF-
42 to taste.
As you can hear, the harder (or the more notes) you play, the more the filter 
will open.

✪ If you find the auto-wah too responsive, you could add a compres-
sor between the instrument device and the Scream 4 to even out 
the level differences a bit.

✪ The Spider CV Splitter and Merger (see page 249) can be used to in-
vert and split the Auto CV output for even greater flexibility.
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RV7000 Advanced Reverb

The RV7000 is a high quality reverb processor. It features nine different reverb 
and echo algorithms, ranging from rooms and halls to special effects. Since the 
RV7000 comes with a number of useful reverb presets, you could simply select 
one and tweak the most important parameters on the main panel - or you could 
use the Remote Programmer panel to fine-tune the reverb in great detail.

The RV7000 also contains an equalizer and a gate section. Both of these are for 
processing the actual reverb sound, making it possible to get virtually any kind of 
reverb character, including gated reverb.

About the Patch format

Like the Scream 4 device, the RV7000 features programmable effect presets. In 
the Factory Sound Bank will find a number of preset Patches which can be used 
as they are or provide you with a good starting point for further tweaking.

Patches use the Windows file extension “*.RV7”. Loading and saving Patches is 
done in the same way as for instrument devices.

Connections

Typically you connect the RV7000 as a send effect, as this allows you to use it 
for processing several different mixer channels. However, it’s also possible to 
use it as an insert effect - use the Dry/Wet control on the main panel to adjust 
the balance between the dry, unprocessed sound and the reverb. Note:

D The RV7000 is a true stereo reverb, which means that it will use the 
stereo input information when processing both channels (without 
summing the input channels).
It’s also possible to use it as a mono in - stereo out effect. Which type of 
connection to use (mono or stereo in) depends on the material. If the audio 
sources are in mono (or in stereo but with no important difference between 
the left and right channel) using a mono input is sufficient.

D If you want to use RV7000’s Reverse reverb effect, you should con-
sider connecting it as an insert effect or using Send 4 on the Mixer, 
with Pre-fader mode selected (and the channel fader lowered).
This is because you typically don’t want to hear the dry sound when using 
the Reverse effect. See page 237.

The main panel

The RV7000 main panel.

When you create an RV7000, only the main panel will be shown. This contains a 
section for handling patches, on/off buttons for the EQ and Gate sections, the 
most important reverb parameters and a dry/wet mix control. To select a reverb 
patch and make coarse adjustments, this is all you need.

The remote programmer

Clicking the arrow button next to the “cable slot” on the main panel brings up the 
remote programmer panel.

This is where you make detailed settings for the reverb. Note:

• The Edit Mode button to the left determines which section to make settings 
for, Reverb, EQ or Gate.
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• Settings are made with the eight dials around the graphic display. The func-
tions of the dials differ depending on the selected Edit Mode and the se-
lected reverb algorithm. Next to each dial, the display shows the name and 
value of the corresponding parameter.

• Not all modes and algorithms use all eight dials. If a dial isn’t used in the se-
lected mode, nothing will be shown next to it in the display.

• You cannot make settings in the graphic display itself - this is for showing a 
graphic representation of the selected reverb.

Reverb algorithms and parameters

About the main panel parameters

On the main panel you find three reverb parameters that are available for all algo-
rithms:

| Parameter | Description

Decay This governs the length of the reverb or the feedback if an 
echo algorithm is selected.

HF Damp Controls how quickly the high frequencies should decay in 
the reverb. Raise it to gradually remove high frequencies, 
making the reverb sound warmer and less bright.

HI EQ This is a high-shelving EQ that works much like a typical tre-
ble control on a mixer or amplifier. Lower the setting for a 
softer reverb sound or raise it to get more high frequencies.
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Selecting an algorithm

You select a reverb algorithm in the remote programmer panel:

1. Click the remote programmer arrow button on the main panel to 
display the remote programmer panel.

2. Make sure the Edit Mode button is set to Reverb.

3. Use the top left dial to select a reverb algorithm.
The selected algorithm is shown in the display next to the dial.

Here’s a quick overview of the nine algorithms - for details and parameter de-
scriptions, see below.

Small Space

This algorithm places the sound in a small enclosed space, ranging from a tiny 
resonant body to a room. The parameters are:

| Algorithm | Description

Small Space Emulates a small enclosed space (a small room or a reso-
nant body).

Room Emulates a room with adjustable shape and wall character.

Hall Emulates a hall.

Arena Emulates a large arena, with separate pre-delay for the left, 
right and center reverbs.

Plate Emulates a classic plate reverb.

Spring Emulates a spring reverb, as used in e.g. guitar amplifiers.

Echo An echo effect with gradually diffusing echo repeats. Can be 
synced to Reason’s tempo.

Multi Tap A multi-tap delay with four different delay lines and tempo 
sync.

Reverse A reverse reverb effect that “pushes” the dry sound to ap-
pear after the reverb. The result is a backwards reverb lead-
ing up to the direct sound.

| Parameter | Description

Size The size of the emulated space.

Mod Rate The reverb can be randomly modulated for a more even sound 
(or for special effects). This parameter sets the rate of modu-
lation (the amount is set with Mod Amount).

Room Shape Select from four different room shapes, affecting the charac-
ter of the reverb.

LF Damp Controls how quickly the low frequencies should decay in the 
reverb. Raise it to gradually remove low frequencies, making 
the reverb sound “thinner” and less boomy.

Wall Irreg Adjusts the positioning of the emulated walls in the small 
space. The lowest setting emulates two directly opposed 
walls while higher settings emulate more walls and angles, for 
a more complex resonance.

Predelay Sets the predelay time, i.e. the delay between the source sig-
nal and the start of the reverb.

Mod Amount Sets how much the reverb will be modulated. Use fairly low 
settings when emulating real rooms and resonant bodies, and 
higher settings for special effects.
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Room

Emulates a medium-sized room, with the following parameters:

Hall

Emulates a hall.The parameters are the same as for the Room algorithm above 
(but the Hall algorithm offers larger Size settings).

Arena

Emulates the ambience in an arena or concert hall, with long pre-delay times 
(separate for left, right and center):

Plate

A classic plate reverb, excellent for vocals for example. The parameters are:

| Parameter | Description

Size The size of the emulated room.

Diffusion At low Diffusion settings, you will hear the individual reverb 
“bounces” more clearly, while higher settings produce a more 
“smeared”, dense and even reverb.

Room Shape Select from four different room shapes, affecting the charac-
ter of the reverb.

ER->Late The first “answers” in the reverb are called early reflections 
(ER) and are typically more pronounced than the actual reverb 
tail. This parameter sets the time between the early reflections 
and the reverb tail. This is set as a percentage - the actual de-
lay time depends on the Size setting.

ER Level Adjusts the level of the early reflections. “0” is normal level.

Predelay Sets the predelay time, i.e. the delay between the source sig-
nal and the start of the early reflections and reverb.

Mod Amount Sets how much the reverb will be modulated. Moderate mod-
ulation gives a natural, less static sound.

| Parameter | Description

Size The size of the emulated arena or hall.

Diffusion At low Diffusion settings, you will hear the individual reverb 
“bounces” more clearly, while higher settings produce a more 
“smeared”, dense and even reverb.

Left Delay The predelay time for the left side of the reverb.

Right Delay The predelay time for the right side of the reverb.

Stereo Level Adjusts the level of the left and right sides of the reverb. “0” is 
normal level.

Mono Delay The predelay time for the mono (center) reverb signal.

Mono Level Adjusts the level of the mono (center) reverb signal. “0” is nor-
mal level.

| Parameter | Description

LF Damp Controls how quickly the low frequencies should decay in the 
reverb. Raise it to gradually remove low frequencies, making 
the reverb sound “thinner” and less boomy.

Predelay Sets the predelay time, i.e. the delay between the source sig-
nal and the start of the reverb.
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Spring

An emulation of a spring reverb as can be found in guitar amplifiers, organs, etc. 
The spring reverb has the following parameters:

Echo

This is an advanced echo effect, with diffusion controls and tempo sync. When 
Echo is selected, the Decay control on the main panel controls the echo feed-
back (the number of echo repeats). The parameters are:

| Parameter | Description

Length Sets the length of the simulated spring.

Diffusion At low Diffusion settings, you will hear the individual reverb 
“bounces” more clearly, while higher settings produce a more 
“smeared”, dense and even reverb.

Disp Freq When sending a signal to a real-life spring reverb, the initial 
transient will produce a quick, characteristic sweeping tonal 
noise. This is because different frequencies in the sound are 
delayed by different amounts (a phenomenon called disper-
sion). This parameter controls the frequency of that sound.

LF Damp Controls how quickly the low frequencies should decay in the 
reverb. Raise it to gradually remove low frequencies, making 
the reverb sound “thinner” and less boomy.

Stereo (on/off) Determines whether the output of the spring reverb should be 
in mono or stereo.

Predelay Sets the predelay time, i.e. the delay between the source sig-
nal and the start of the early reflections and reverb.

Disp Amount Sets the amount of dispersion effect (see Disp Freq above).

| Parameter | Description

Echo Time Sets the time between each echo. 
When Tempo Sync (see below) is off, the echo time is set in 
milliseconds (10 - 2000 ms); when Tempo Sync is on you set 
the echo time as a number of 1/16 notes or 1/8 triplet notes, 
in relation to the current song tempo.

Diffusion When this is set to 0, the echo will sound as a standard delay 
with clear, precise repeats. Raising the Diffusion setting will in-
troduce additional echoes very close to the “main” echo re-
peats, causing a “smeared” echo sound. This will also expand 
the echo stereo image.

Tempo Sync Determines whether the echo time should be freely set (“off”) 
or synchronized to Reason’s tempo (“on”).

LF Damp Controls how quickly the low frequencies should decay in the 
echoes. Raise it to gradually remove low frequencies.

Spread Adjusts the spacing of the additional echoes added by the Dif-
fusion parameter. For a very smeared echo (sound more like a 
reverb), set both Diffusion and Spread to their maximum val-
ues.

Predelay Sets an additional delay time before the first echo repeat.
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Multi Tap

The Multi Tap delay produces up to four different delays with separate delay 
times, panning and level. The whole set of four delay taps can then be repeated 
at a given rate. Again, the Decay control on the main panel controls the feedback 
(the number of repeats for the whole multi tap set). All delay times can be tempo 
synced.

Note: this algorithm is handled a bit differently since you make separate settings 
for each delay tap:

• The parameters to the left of the display are common for all taps.
• You use the Edit Select parameter in the top right corner to select which tap 

to make settings for - the three parameters below affect the currently se-
lected tap.

Tap 2 selected for editing.

• You can also set Edit Select to “Repeat Tap” - this is where you specify the 
repeat time for the whole multi tap “package”.
With short Repeat times, the first tap may be repeated before the last tap 
has sounded. This can be used to create very complex multiple delay effects.

The common parameters (to the left) are:

When Tap 1 - 4 is selected with the Edit Select parameter, you can make the fol-
lowing settings for the selected delay tap:

When Repeat Tap is selected with the Edit Select parameter, there is only one 
parameter to the right in the display:

Reverse

The Reverse reverb algorithm in RV7000 is special in that it actually “moves” the 
source audio as well. Sounds fed into the Reverse reverb are “sampled”, a re-
verse reverb is created and played back and finally the “sampled” original sound 
is played back. For example, if you feed a snare drum hit into the Reverse reverb, 
you will hear a rising “backwards” reverb, followed by the snare drum hit.

Therefore, you probably don’t want to hear the first, original (dry) sound. There 
are two ways to set this up:

D Connect the RV7000 as an insert effect and make sure the Dry/Wet 
control on the main panel is set fully to “Wet”.

D Connect the RV7000 as a send effect using send 4 on the Mixer, ac-
tivate the Prefader (P) switch for the send and lower the mixer fader 
completely for the source signal.
That way, the signal will be sent to the reverb but the dry sound from the 
Mixer channel isn’t heard. Again, the Dry/Wet control on the reverb should 
be set to “Wet”.

Note:

| Parameter | Description

Tempo Sync Determines whether the delay times and repeat times should 
be freely set (“off”) or synchronized to Reason’s tempo 
(“on”).

Diffusion Raising the Diffusion setting will introduce additional echoes 
very close to the “main” repeats, causing a “smeared” delay 
sound.

LF Damp Controls how quickly the low frequencies should decay in 
the echoes. Raise it to gradually remove low frequencies.

| Parameter | Description

Tap delay Sets the delay - the time from the source signal to the tap. 
When Tempo Sync is off, the delay time is set in millisec-
onds (10 - 2000 ms); when Tempo Sync is on you set the 
delay as a number of 1/16 notes or 1/8 triplet notes, in rela-
tion to the current song tempo.

Tap level Adjusts the level of the selected tap.

Tap pan Adjusts the pan of the selected tap.

| Parameter | Description

Repeat Time Sets the time between each repeat of the whole multi tap 
set. The number of repeats is set with the Decay control on 
the main panel.
When Tempo Sync is off, the repeat time is set in millisec-
onds (10 - 2000 ms); when Tempo Sync is on you set the 
repeat time as a number of 1/16 notes or 1/8 triplet notes, in 
relation to the current song tempo.



THE EFFECT DEVICES236

With this algorithm, raising the Decay setting on the main panel will make the re-
verse reverb start earlier and build up under a longer time. Similarly, the HF 
Damp parameter affects how fast the high frequencies are built up in the reverse 
reverb. In the remote panel, the Reverse algorithm has the following parameters:

| Parameter | Description

Length This sets the time from when the source signal is fed into the 
reverb until it is played back again. It is during this time you 
will hear the reverse reverb, as shown in the display.
The time can be set in milliseconds or as note values, de-
pending on whether Tempo Sync is off or on.
Note: As stated above, the Decay setting determines the 
length of the actual reverse reverb - in essence how soon it 
starts after the source signal. But of course, the reverse re-
verb cannot start before the original source signal! If you set 
Decay to a longer time than the Length setting, the reverse 
reverb will start abruptly, immediately when the source signal 
is fed into the reverb. If this sounds complicated, just take a 
look at the RV7000 display and try the settings - you will 
soon see how it works.
Note also that very high Length settings demand a lot of pro-
cessor power. This can be reduced by adjusting the Density 
parameter, see below.

Density Density governs the “thickness” of the Reverse effect. If this 
parameter is turned down to zero, the effect produces indi-
vidual delays rather than a dense “wash”, which can be used 
as a special effect. Worth noting is that if Density is set to 
around 50%, this can considerably reduce the CPU load 
without altering the sound of the effect too much. Exactly 
how much the Density parameter can be reduced without al-
tering the sound depends on the source material.

Rev Dry/Wet Sets the balance between the “moved” source signal (“dry”, 
low values) and the reverse reverb (“wet”, high values).

Tempo Sync Determines whether the Length setting should be freely set 
(“off”) or synchronized to Reason’s tempo (“on”).
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The EQ section

The equalizer in RV7000 affects the wet reverb sound only and is used for shap-
ing the character of the reverb. There are two EQ bands, one for low frequencies 
(shelving) and one full-range parametric EQ.

D To activate the EQ, click the EQ Enable button on the main panel so 
that the indicator lights up.

D To make EQ settings, select “EQ” with the Edit Mode button to the 
left in the remote programmer panel.

D In this mode, the remote programmer display shows a frequency 
curve, indicating the settings you make with the EQ parameters.

The parameters are:

D Remember that you have a third EQ band at your disposal - the HI 
EQ parameter on the main panel.
The reason why this is on the main panel and not in the EQ section is simply 
that it’s a setting you may want to adjust often, without having to open the re-
mote programmer panel.

The Gate section

The Gate section allows you to create gated reverb effects with a lot of options 
and possibilities. You can either trigger the gate from the source audio signal or 
via MIDI or CV. 

When triggering the gate from the source audio signal, it works like this:

• The gate “listens” to the source (dry) signal and opens whenever the signal 
reaches a certain threshold level.

• The reverb sound is sent through the gate - when the gate is closed you 
won’t hear the reverb.

• When the source signal level drops below the threshold level, the gate 
closes after a time that depends on the Hold parameter and the level of the 
source signal (see the parameter table).

D If you need the gate to be open for an exact duration (time), you 
should trigger it via MIDI or CV.
In audio trigger mode, the actual gate time will vary depending on the source 
signal.

When triggering the gate via MIDI or CV, it works like this:

• The reverb sound is sent through the gate - when the gate is closed you 
won’t hear the reverb.

• Whenever the gate receives any MIDI note (sent to the RV7000) or a gate 
signal (connected to the Gate Trig CV input on the back of the RV7000), the 
gate opens for the duration of the note or gate signal.

Note:

D To activate the Gate, click the Gate Enable button on the main 
panel so that the indicator lights up.

D To make Gate settings, select “Gate” with the Edit Mode button to 
the left in the remote programmer panel.

D In this mode, the remote programmer display shows two meters - 
one showing the signal level (with an indication of the threshold 
level) and one showing the status of the gate.
This is useful for checking what happens, how the gate triggers, etc.

| Parameter | Description

Low Gain The amount of cut or boost of the low-shelving filter.

Low Freq The frequency below which the Low Gain cut or boost is ap-
plied.

Param Gain The amount of cut or boost for the parametric EQ.

Param Freq The center frequency of the parametric EQ, e.g. at which fre-
quency the level should be decreased or increased.

Param Q This governs the width of the affected area around the set 
center frequency. The higher the value, the narrower the af-
fected frequency range.
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The parameters for the Gate section are: CV Inputs

On the back of the RV7000 you find three CV inputs. These are:

| Parameter | Description

Threshold When Trig Source is set to “Audio”, this determines the audio 
signal level at which the gate opens. If you raise this setting, 
only very loud sounds will open the gate.

Decay Mod This modulates the reverb Decay parameter so that the decay 
time is lowered when the gate closes. When this is set to 
zero, no decay modulation happens - this means that if the 
gate is closed and then opened again, you may hear “previ-
ous” reverb tails that are still ringing. If you raise the Decay 
Mod setting, the decay will automatically be lowered when 
the gate is closed, eliminating this effect.

Trig Source Determines whether the gate should be triggered by audio or 
MIDI/CV, as described above.

High Pass A high-pass filter that affects the audio that triggers the gate 
(only active when Trig Source is set to “Audio”). If you raise 
this setting, sounds with low frequencies only will not open 
the gate. Note that this setting doesn’t affect the sound of the 
reverb, only the triggering mechanism.

Attack Determines how long it takes for the gate to open after a trig-
gering signal has been received.

Hold This parameter is only active when Trig Source is set to “Au-
dio”. Hold affects how quickly the gate closes, in the following 
way:
Internally, the gate is controlled by an envelope follower that 
analyzes the source signal level and generates a “level CV 
signal” accordingly. This signal is compared to the Threshold 
level to determine whether the gate should be opened or 
closed. The Hold parameter affects how quickly the envelope 
follower responds when the source signal level drops - you 
could say that this is the decay control for the envelope fol-
lower. The higher the Hold setting, the longer it will take for 
the envelope follower signal to drop below the threshold level 
and close the gate. But the resulting time also depends on 
the source signal level - with a loud signal, it will take longer 
time for the envelope follower to drop to the threshold level. 
Therefore, the actual gate time depends both on the Hold set-
ting and on the character of the source audio.

Release Determines how long it takes for the gate to close after the 
Hold time.

| Parameter | Description

Decay Controls the reverb decay or echo/delay feedback via CV.

HF Damp Controls the HF Damp parameter on the main panel.

Gate Trig Used for triggering the Gate section with a gate signal. The 
length of the gate signal determines the length of the gated re-
verb.
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RV-7 Digital Reverb

Reverb adds ambience and creates a space effect. Normally, reverb simulates 
some kind of acoustic environment such as a room or a hall, but you could also 
use it as a special effect.

D The Reverb device can be used as a send effect or an insert effect.
If several devices uses the same type of reverb, you should connect the re-
verb as a send effect, to conserve computer power.

Parameters

The display to the left on the panel shows the selected reverb algorithm - the 
general type of reverb. By clicking the arrow buttons you can change algorithm, 
with the following options available:

✪ If you need to conserve computer power, try using the Low Density 
algorithm. This uses much less power than the other algorithms.

The selected reverb algorithm can be tweaked using the parameters on the de-
vice panel:

CV Inputs

You can control the Decay parameter via the CV input on the back of the Reverb 
device.

| Algorithm | Description

Hall Emulates a fairly large, smooth hall.

Large Hall Emulates a larger hall, with pronounced pre-delay.

Hall 2 A hall reverb with a brighter attack than “Hall”.

Large Room Emulates a large room with hard early reflections.

Medium Room Emulates a medium-sized room with semi-hard walls.

Small Room A smaller room, suitable for “drum booth”-type reverbs.

Gated A gated reverb, that is abruptly cut off.

Low Density A thinly spaced reverb, where you clearly can here the indi-
vidual echoes. Useful for strings and pads and as a special 
effect.

Stereo Echoes An echo effect with the repeats alternating between stereo 
sides.

Pan Room This is slightly similar to “Stereo Echoes”, but the echo re-
peats have soft attacks.

| Parameter | Description

Size Adjusts the emulated room size. Middle position (value 0) is the 
default size for the selected algorithm. 
Lowering this parameter results in a closer and gradually more 
“canned” sound. Raising this parameter results in a more 
spacey sound, with longer pre-delay.
For the “Stereo Echoes” and “Pan Room” algorithms, the Size 
parameter adjusts the delay time.

Decay This governs the length of the reverb effect. Middle position is 
the default decay time for the selected algorithm.
Note: Decay is not used for the “Gated” algorithm.

Damp Raising the Damp value cuts off the high frequencies of the re-
verb, thereby creating a smoother, warmer effect.

Dry/Wet If you are using the reverb as an insert effect, you use this pa-
rameter to adjust the balance between the unprocessed audio 
signal (dry) and the effect (wet). 
If the reverb is used as a send effect, this should be set all the 
way to wet only, since you can control the balance by using the 
AUX send controls in the Mixer.
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DDL-1 Digital Delay Line

This is a mono delay (where the output can be panned in stereo) that can be 
synchronized to the song tempo. The delay can be used as a send effect or an 
insert effect. 

Parameters

CV Inputs

The following CV inputs are available on the back panel of the device:

D Pan CV.
This allows you to control the panning of the delay signal. Connect an LFO 
to this for moving delay effects, or use a Matrix pattern to simulate random 
delay panning.

D Feedback CV.
This allows you to control the amount of feedback (the number of delay re-
peats) from another device. Useful for dub-type echoes on certain beats or 
notes only.

Switching between Unit modes

When you switch between the two Unit modes (Steps and MS), the following 
rules apply:

D If you switch from Steps mode to MS mode, the delay will be set to 
the same actual delay time as was used in the Steps mode.
This means that you can set up an exact rhythmic delay in Steps mode, and 
then switch to MS mode to adjust it slightly. 

D If you switch from MS mode to Steps mode, the delay is reset to the 
previously used Steps value.

| Parameter | Description

Delay time The display to the left on the device panel shows the delay 
time, either as note value steps (based on the sequencer 
tempo and the Step Length parameter) or in milliseconds, de-
pending on the setting of the Unit switch. 
The maximum delay time is two seconds (2000 ms) while the 
maximum number of steps is 16. 
Note that if the tempo is low, you may reach the maximum de-
lay time at a lower number of steps than 16 (in which case 
raising the steps value will not make any difference).

Unit This is where you select whether you want a tempo-based de-
lay (“Steps” mode) or a free time delay (“MS” mode).
In the Steps mode, you specify the delay time in note value-
based steps. This means that if you change the tempo in the 
transport panel, the delay will maintain its rhythmic relation to 
the music (provided that the resulting delay time doesn’t reach 
the maximum value). This mode is useful for creating rhythmic 
patterns.
If you change the tempo when using the delay in MS mode, 
the delay time will remain the same.
See also the note about switching Unit modes below.

Step length Governs whether each step in Steps mode should be a six-
teenth note (1/16) or an eighth triplet note (1/8T).

Feedback Determines the number of delay repeats.

Pan Pans the delay effect to the left or to the right.

Wet/Dry If you are using the delay as an insert effect, you use this pa-
rameter to adjust the balance between the unprocessed audio 
signal (dry) and the delay effect (wet). 
If the delay is used as a send effect, this should be set all the 
way to wet only, since you can control the balance by using 
the AUX send controls in the Mixer.

| Parameter | Description
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D-11 Foldback Distortion

The D-11 is a simple but effective distortion effect, capable of producing any-
thing from just a whisper soft touch of distortion, to complete thrashing. This ef-
fect is most often used as an insert effect.

Parameters

The distortion has the following parameters:

CV Inputs

On the D-11 you will find a CV input for controlling the Amount parameter. This 
can produce very drastic effects, especially if you control parameters in the in-
strument device (such as filter frequency and resonance) at the same time.

ECF-42 Envelope 
Controlled Filter

The ECF-42 is a multimode filter with a built in envelope generator. It is mainly 
designed to be used together with pattern devices to create pattern controlled 
filter and envelope effects, but it can also be triggered via MIDI, or used as a 
“static” filter for shaping the sound of an instrument device or a whole mix. 

Usage

The Envelope Controlled Filter is best connected as an insert effect. However, 
unlike the other effects it is not a pure “stand-alone” device. To make the most of 
the ECF-42, you need either CV/Gate from an external device or MIDI notes 
from a sequencer track.

D If you connect a device to the ECF-42 using audio inputs/outputs 
only, it will simply act as a filter with no velocity or envelope modu-
lation. 
Hence, all filter parameters are “static”, unless you manually turn the knobs 
or automate them in the sequencer.

D Connecting a gate signal to the Env Gate input on the back panel of 
the device allows you to trigger the envelope generator for the fil-
ter.
Note that the ECF-42 envelope generator is not triggered by the audio itself 
- the envelope parameters won’t do anything unless the device receives gate 
signals.

D By creating a sequencer track connected to the ECF-42, you can 
have the envelope triggered by MIDI notes on the track.
The envelope is affected by the position, length and velocity of the MIDI 
notes (but not by their pitch).

✪ If you are unfamiliar with basic filter and envelope parameters, 
please refer to the Subtractor chapter for a description of these. 

| Parameter | Description

Amount This controls the amount of distortion. The higher the value, 
the more distortion.

Foldback This adjusts the character of the distortion by introducing 
foldback, which makes the waveform more complex. 
The default value is in the middle position. This produces a 
“flat” clipping distortion, which is the most common type. 
Lowering the parameter makes the sound rounder and more 
gentle, raising it makes the sound sharper and more evil.
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The Filter Parameters

The ECF-42 filter section has the following parameters:

The Envelope Parameters

This is a standard envelope generator with Attack, Decay, Sustain and Release 
parameters. It is triggered by a gate signal connected to the Env Gate input on 
the back panel, or by MIDI notes on a sequencer track connected to the ECF-
42. The parameters have the following functionality:

D The Gate indicator lights up when the device receives a signal to the 
Env. Gate input on the back panel or a MIDI note from a sequencer 
track.

CV/Gate Inputs

On the back panel of the ECF-42, you can find the following CV/Gate inputs:

D Freq CV.
Use this for controlling the filter frequency from another device. For smooth 
filter modulation, try connecting an LFO to this input.

D Decay CV.
For controlling the envelope decay parameter from another device.

D Res CV.
Allows you to control the filter resonance from another device. Can be very 
effective in combination with filter frequency sweeps.

D Env. Gate.
This is where you connect a gate signal (e.g. from a Matrix or Redrum de-
vice) for triggering the envelope.

| Parameter | Description

Mode This button sets the desired filter mode. Three modes are avail-
able: 24dB/octave lowpass, 12dB/octave lowpass and 12dB/
octave bandpass.

Freq This is the filter cutoff frequency. 
When using the ECF-42 in “static” mode (without triggering 
the envelope), this parameter adjusts the frequency content of 
the sound.
When using the envelope, the Freq parameter serves as the 
start and end frequency for the filter sweep.

Res This is the filter resonance. Raising this produces a more ex-
treme, “synthy” effect.

Env Amt Determines how much the filter frequency should be affected 
when the envelope is triggered. The higher the value, the more 
drastic the effect.
Note though, that if the Freq parameter is set high, raising the 
Envelope Amount will not make any difference over a certain 
value! This is because the filter is already fully opened - try low-
ering the Freq parameter in that case.

Velocity This parameter determines how much the gate velocity value 
should affect the envelope amount.

| Parameter | Description

A (Attack) When the envelope is triggered, this is the time it takes be-
fore the envelope signal reaches its max value.

D (Decay) After reaching its max value, this is the time it takes for the 
envelope signal to reach the sustain level.

S (Sustain) If the gate remains open (or the MIDI note is held), the enve-
lope signal will remain on this level.

R (Release) When the gate is closed (gate CV goes back to 0) or the 
MIDI note ends, this is the time it takes for the envelope sig-
nal to drop from its current value to the start value (set by the 
Freq parameter).
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Pattern Controlled Filter - An Example

This example shows how to use the ECF-42 and the Matrix to create pattern 
controlled filter effects. Proceed as follows:

1. Start with an empty Song.

2. Create a Mixer.

3. Create a Subtractor Synthesizer.
An Init Patch will work fine for these examples.

4. Create an ECF-42.

5. Create a Matrix Pattern Sequencer.
If you flip the rack around, you can see that the audio out from the Subtractor 
is passed through the ECF-42 and then on to the Mixer. The Matrix Curve 
CV is connected to the ECF-42 Frequency CV parameter, and the Matrix 
Gate CV is connected to the ECF-42 Env Gate input.

6. Select the Track connected to the Subtractor (given that you are 
handling MIDI input via the sequencer) so that you can play it from 
your keyboard.
If you play a few notes and turn the ECF-42 filter freq knob, you should hear 
the sound being filtered.

7. Draw a Gate pattern in the Matrix, using mixed velocity values.
Draw only a Gate pattern, not a Curve pattern.

8. Set both the Env.Amt and Vel knobs on the ECF-42 to about “40”.

9. Click the Run button on the Matrix panel.

10. While in Run mode, hold a chord down on your keyboard.
Now you should hear the envelope (controlling the filter) being triggered 
with every gate step.

D By increasing the Env.Amount, you determine how much the enve-
lope parameters should affect the filter frequency.

D By increasing the Vel. parameter, you determine how much the gate 
velocity should affect the filter frequency.

✪ If the filter effect isn’t very noticeable, try lowering the filter fre-
quency, and raising the Res value.

11. Set both the Env.Amt and Vel knobs on the ECF-42 to “0”.

12. With the Matrix still playing, draw a Curve pattern in the Matrix pat-
tern window.
Now, you should hear the filter frequency being modulated by the curve pat-
tern. By combining the various parameters you can create many new filter ef-
fects. 

D You can also control the ECF-42 from other devices with CV and/or 
Gate outputs.

Triggering the ECF-42 via MIDI

To trigger the envelope in the ECF-42, proceed as follows:

1. Create a sequencer track for the ECF-42.
This is easiest done by bringing up the context menu for the device and se-
lecting “Create Sequencer Track for XX” (where “XX” is the name of this 
particular filter device).

2. Record or draw some notes on the sequencer track.
Remember that the envelope takes the note length and velocity into account. 
The note pitches doesn’t matter.

3. Play back the track.
The actual notes will not be heard (since the track is connected to the ECF-
42, which produces no sound in itself) but the envelope will be triggered ac-
cording to the notes.

D You can even control the envelope “live” via MIDI: just set MIDI in-
put to the sequencer track for the ECF-42 and play your MIDI instru-
ment!
To route MIDI input to a track, click in the In column in the track list, so that 
the MIDI connector symbol appears next to the track name.
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CF-101 Chorus/Flanger

The CF-101 is a combined chorus and flanger effect. It adds depth and move-
ment to the sound by adding a short modulated delay to the audio signal. The 
delayed signal is then mixed with the original (either in the effect device or man-
ually by you - see below). The CF-101 can be used as an insert or send effect.

Parameters

CV Inputs

The following CV inputs are available on the back panel of the device:

D Delay CV.
Allows you to control the delay time from another device. This may give best 
results if you turn off the LFO modulation in the device (turn LFO Mod 
Amount to zero). For example, by controlling the delay parameter from a Ma-
trix, you can create “stepped flanger” effects, in sync with the tempo.

✪ If you use the Delay CV input for “playing” the feedback tone, note 
that a higher delay value gives a lower pitch.

D Rate CV.
Lets you control the rate of the modulating LFO from another device.

About Stereo and Mono connections

The CF-101 can be connected using mono or stereo inputs, as shown by the 
graphs on the back panel. Note the following:

D A “moving” stereo effect is only obtained when you use a mono in-
put and stereo outputs.
With a stereo input, the two sides are processed in parallel, maintaining the 
stereo image of the original sound.

D When you are using a mono input and stereo outputs, there will 
only be a stereo effect if the internal LFO is used.
If you turn LFO Mod Amount to zero, both stereo outputs will carry the same 
signal (mono). This is because the “fake stereo” effect is produced by invert-
ing the modulation for one of the output channels.

Tip: Using the CF-101 as a vibrato effect

The Send mode is intended for when using the CF-101 as a send effect. In this 
mode, the device will only output the modulated delay signal - you get the actual 
“chorusing” by mixing this signal with the dry, unprocessed signal in the Mixer.

However, if you activate Send mode while using the device as an insert effect, 
the result will be a pitch modulated version of the original sound - in short, a vi-
brato effect. Along with a little feedback, this can be used for special effects.

| Parameter | Description

Delay This is a manual control for the delay time used to create the 
chorus/flanger effect. Usually, flanger-type effects use fairly short 
delay times while chorus-type effects use medium long delays.

Feedback This governs the amount of effect signal fed back to the input, 
which in turn affects the intensity and character of the effect. 
Turning this to the extreme left (negative feedback) or right (pos-
itive feedback) produces different flanger effects with a pro-
nounced resonance “tone”, while keeping it in between 
produces a more gentle chorus effect.

LFO Rate This is the frequency of the LFO modulating the delay time. The 
higher the value, the faster the sound will oscillate.

LFO Sync This button lets you activate/deactivate LFO sync. When it is ac-
tivated, the frequency of the LFO is synchronized to the song 
tempo, in one of 16 possible time divisions. The LFO Rate knob 
is then used for setting the desired time division. Turn the knob 
and check the tooltip for an indication of the timedivision.

LFO Mod 
Amount

This determines the depth of the LFO modulation, i.e. by how 
much the delay time should be modulated. If you set this to 0, the 
effect will be “frozen” (most effective if you add some feedback).

Send Mode This determines whether the delayed signal and the dry signal 
should be mixed in the effect device or not. If you use CF-101 as 
an insert effect, you should turn this off - the device will then out-
put a mix of the dry signal and the modulated delay signal.
If you use the device as a send effect, you should activate Send 
mode. Then, the device will only output the modulated delay sig-
nal, allowing you to mix it with the dry signal using the AUX send 
controls in the mixer. See also the note below about using the 
CF-101 as a vibrato effect!
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PH-90 Phaser

The PH-90 Phaser is a classic phaser effect with some special features for fine-
tuning the sound. It can create the classic sweeping phaser sounds suitable for 
pads or guitars, but also more extreme effects if you like. The phaser is best 
used as an insert effect.

Theory

A phaser works by shifting portions of the audio signal out of phase, and then 
adding the processed signal back to the original one. This way, narrow bands of 
the frequency range (“notches”) are filtered out. When these frequencies are ad-
justed, a sweeping phaser sound is created.

The PH-90 is a four-stage phaser, which means that there are four “notches” in 
the frequency response curve (this is a little like using four notch filters with dif-
ferent filter frequencies - see page 108 for an explanation of notch filters). 

When the phaser frequency is adjusted (manually or by the built-in LFO), these 
notches will move in parallel in the frequency spectrum. Furthermore, you can 
adjust the distance between the notches (Split) and their Width. Adding feed-
back raises the filter gain just below each notch in the frequency range, creating 
a more pronounced effect.

Parameters

CV Inputs

The following CV inputs are available on the back panel of the device:

D Freq CV.
Adjusts the frequency parameter. Use this e.g. for creating envelope con-
trolled phasing (preferably with LFO Freq. Mod turned off in the device).

D Rate CV.
Lets you control the speed of the modulating LFO from another device.

About Stereo and Mono connections

The PH-90 can be connected using mono or stereo inputs, as shown by the 
graphs on the back panel. Note the following:

D A “moving” stereo effect is only obtained when you use a mono in-
put and stereo outputs.
With a stereo input, the two sides are processed in parallel, maintaining the 
stereo image of the original sound.

D When you are using a mono input and stereo outputs, there will 
only be a stereo effect if the internal LFO is used.
If you turn LFO Mod Amount to zero, both stereo outputs will carry the same 
signal (mono). This is because the “fake stereo” effect is produced by invert-
ing the modulation for one of the output channels.

| Parameter | Description

Frequency Sets the frequency of the first notch. Adjusting this will move 
the other notches correspondingly. This is the parameter mod-
ulated by the LFO to create phaser sweeps.

Split This adjusts the distance between the notches in the frequency 
range, thereby changing the character of the effect.

Width Determines the width of the notches. Raising the Width deep-
ens the effect and simultaneously makes the sound more hol-
low and thin. This will also have an effect on character of the 
feedback “tone”.

LFO Rate This is the speed of the LFO modulating the frequency param-
eter. The higher the value, the faster the phaser sweeps.

LFO Sync This button lets you activate/deactivate LFO sync. When it is 
activated, the frequency of the LFO is synchronized to the song 
tempo, in one of 16 possible time divisions. The LFO Rate knob 
is then used for setting the desired time division. Turn the knob 
and observe the tooltip that appears for an indication of the ti-
medivision.

LFO Freq. 
Mod

This determines the depth of the LFO modulation, i.e. by how 
much the frequency parameter should be modulated.
If you turn this to zero, the effect will be a static, formant-like 
sound (most effective if you add a little feedback).

Feedback This is similar to the resonance control on a filter. Raising the 
feedback gives a more pronounced “tone” in the effect. For 
“singing” phaser sounds, try raising this to the maximum.

| Parameter | Description
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UN-16 Unison

The UN-16 simulates the sound of several detuned voices playing the same 
notes simultaneously. The voices are individually slightly delayed and also pitch 
modulated by low frequency noise. This produces a rich chorus effect with the 
voices spread across the stereo field (given that stereo outputs are used).

The UN-16 can be used as an insert effect or a send effect.

Parameters

CV Input

One CV input is available on the back panel of the device. This controls the De-
tune parameter.

COMP-01 Auto Make-up 
Gain Compressor

The COMP-01 compressor levels out the audio, by making loud sounds softer. 
To compensate for the volume loss, the device has an automatic make-up gain, 
that raises the overall level by a suitable amount. The result is that the audio lev-
els become more even and individual sounds can get more “power” and longer 
sustain.

The COMP-01 should be used as an insert effect, either for a single instrument 
device or for a whole mix (e.g. inserted between a Mixer device and the Hard-
ware Interface). There are no CV inputs for this device.

Parameters

| Parameter | Description

Voice Count This switch sets the number of voices for the effect; 4. 8 or 
16.

Detune This sets the amount of detuning for the voices. Turn clock-
wise for stronger detuning effects.

Dry/Wet If you are using the UN-16 as an insert effect, you use this pa-
rameter to adjust the balance between the unprocessed au-
dio signal (dry) and the effect (wet). 
If the UN-16 is used as a send effect, this should be set all 
the way to wet only, since you can control the balance by us-
ing the AUX send controls in the Mixer.

| Parameter | Description

Ratio This lets you specify the amount of gain reduction applied to 
the signals above the set threshold. The value is expressed as 
a ratio, from 1:1 (no reduction) to 16:1 (levels above the 
threshold are reduced by a factor 16).

Threshold This is the threshold level above which the compression sets 
in. Signals with levels above the threshold will be affected, sig-
nals below it will not.
In practice, this means that the lower the Threshold setting, the 
more the compressor effect.

Attack This governs how quickly the compressor will apply its effect 
when signals rise above the set threshold. If you raise this 
value, the response will be slower, allowing more of the signal 
to pass through the compressor unaffected. Typically, this is 
used for preserving the attacks of the sounds.

Release When the signal level drops below the set threshold, this de-
termines how long it takes before the compressor lets the 
sound through unaffected. Set this to short values for intense, 
“pumping” compressor effects, or to longer values for a 
smoother change of the dynamics.

Gain meter This shows the amount of gain reduction or increase (in dB), 
caused by the combined compression and make-up gain.
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PEQ-2 Two Band 
Parametric EQ

While there is a simple two-band shelving equalizer available for each channel in 
the mixer, the PEQ-2 gives you much more precise control over the tone color. 
The device consists of two independent, fully parametric equalizers and is most 
often used as an insert effect, in mono or stereo.

About the two EQ modules

The two independent EQs are labeled “A” and “B”. 

D EQ A is always active (provided that the effect device is in “On” 
mode and that you have set the Gain to a value other than 0). 

D To activate EQ B, click the button next to the EQ B parameters, so 
that the LED lights up.
If you only use one EQ, it’s a good idea to turn EQ B off, to conserve com-
puter power.

Parameters

For both EQs (A and B), the following parameters are available:

About the graphic display

The graphic display to the left in the device panel shows the frequency response 
curve as set by the EQ parameters. This gives a visual feedback and helps you 
tailor the EQ settings.

CV Inputs

The following CV inputs are available on the back panel of the device:

D Freq 1 CV.
Allows you to control the frequency of EQ A from another device, creating 
subtle or dramatic EQ sweeps depending on the Q and Gain settings.

D Freq 2 CV.
Allows you to control the frequency of EQ B in the same way.

| Parameter | Description

Frequency This determines the center frequency of the EQ, e.g. at 
which frequency the level should be decreased or increased. 
The range is 31 Hz to 16 kHz.

Q This governs the width of the affected area around the set 
center frequency. The higher the value, the narrower the af-
fected frequency range.

Gain Specifies how much the level of the selected frequency 
range should be boosted (positive values) or lowered (nega-
tive values). The gain range is ±18 dB.
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Spider Audio Merger & 
Splitter

The Spider Audio Merger & Splitter is not an effect device, but a utility. It has two 
basic functions:

D To merge up to four audio input signals into one output.

D To split one audio input signal into four outputs.

There are no controls on the front panel of this device, only signal indicators.

Merging audio

On the back panel of the Spider are several audio connectors. The left half of the 
panel contains four stereo audio input connectors, and to the right of these, one 
merged stereo output. 

D The principle is simple; all audio signals connected to any of the 
four inputs will be merged and output via the output connectors.
If you connect a mono signal (to a L/Mono input, with nothing connected to 
the corresponding R input) it will be output on both merged outputs. This 
way you can merge stereo and mono signals freely.
If you connect a signal to the R input only (with nothing connected to the 
corresponding L/Mono input) it will be output on the R output only.

Practical uses of merging audio

There are many practical uses of merging audio signals together, for example:

D Process several audio signals with the same insert effect(s).
Perhaps you want to process certain channels in a mix with the same com-
pressor, or use one ECF-42 to filter a group of instruments in a mix. You can 
also set up a chain of insert effects and process the merged signals.

D Sub-grouping signals.
It may be practical to control several audio signals using one channel strip in 
the Mixer.

D Use merged signals as either carrier or modulator source for the 
BV512 Vocoder.
You could use several sounds as carrier signal, or modulate the carrier with 
several signal sources.

Splitting audio

The right half of the back panel contains two signal splitters, labeled “A (L)” and 
“B (R)”. The two splitters work independently, in the following way: 

D The signal fed to the input connector will be simultaneously output 
by all four outputs.
For splitting stereo signals you simply use both splitters with “A” for the left 
channel and “B” for the right channel.

Practical uses of splitting audio

There are many practical uses of splitting audio signals - here a few examples:

D Create “pseudo” stereo effects from mono signals.
For example, you could route the mono output of a Subtractor to the Spider 
and then send two split outputs (from the same row) to different effects and 
on to different Mixer channels panned left and right.

D It provides a way to instantly switch between (or mix) different vari-
ations of the same signal.
This is a neat way of applying “spot effects” in a mix. An instrument output is 
split and sent to three different combinations of insert effect processing. The 
outputs from the three effects are routed to separate channels in the Mixer, 
which could in turn have different send effects, eq, etc. You then have three 
different variations of the same signal that can be easily switched in and out 
of the mix for drastic sonic changes - or combined for huge layered sounds.

Four audio input pairs. Merged outputs.

Four split output pairs.Inputs.
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Spider CV Merger & 
Splitter

The Spider CV Merger & Splitter is not an effect device, but a utility. It has two 
basic functions:

D To provide one merged CV output from up to four CV input sources.

D To split CV or Gate inputs into several outputs.
Two inputs, A and B, are provided, each with four outputs, where one of the 
outputs will invert the polarity of the control signal. One reason for having 
two splitable inputs is to make it possible to split Gate and Note CV, to con-
trol several instrument devices with one Matrix for example.

There are no controls on the front panel of this device, only CV signal indicators. 
The four horizontal indicators light up to indicate signals connected to the corre-
sponding merge input. The two indicators to the right indicate signals con-
nected to the corresponding split inputs.

Merging CV

On the back panel of the Spider there are several CV connectors. The left half of 
the panel contains four CV/Gate input connectors with associated trimpots, and 
to the right of these, one merged CV output. 

D The merged CV output will produce a CV signal that represents the 
“sum” of all connected CV inputs.

A few things to note:

• Gate CV signals typically trigger notes or envelope cycles and are normally 
routed to a Gate input. 

• CV signals typically control note pitch or for modulating parameters and are 
typically routed to CV Note or Modulation inputs.

There are no strict rules involved, but the facts mentioned above means that it is 
generally better to stick to using either Gate CV signals or CV signals but not a 
mixture when merging. simply because the CV/Gate signals usually go to differ-
ent input destinations.

For instance, merging Note CV and Gate CV from a Matrix does not make much 
sense if you want to use Matrix to play melodic patterns via the Sequencer Con-
trol inputs of an instrument device. There would only be one merged output 
whereas the instrument device would need a separate Gate and Note CV signal 
to work properly. 

Practical uses of merging CV

The practical applications of merging CV are maybe less obvious compared to 
splitting CV. But there are numerous applications for a merged CV control out-
put, a few of which are listed below:

D You can create interesting modulation effects by merging several 
Modulation outputs from LFO’s and other CV modulation sources.
For example, merging the Modulation outputs from several LFO’s would pro-
duce a “mixed modulation” output. This merged output signal could be lik-
ened to a “super LFO” capable of generating several modulation cycles 
simultaneously, each with a different waveform and modulation rate! In addi-
tion to this, by using the trim control for each CV input, you have full control 
over the amount of modulation applied by each LFO.
The above example could of course also include Curve CV outputs from a 
Matrix or Mod Outs from Malström etc., in short any CV Modulation output.

D Use the ECF-42 Filter to apply envelope controlled filter effects.
This can create the sound of “synthesized” percussion, and other interesting 
effects.

This is done using the following method:

1. Connect the audio outputs of a Redrum to a ECF-42 Envelope con-
trolled filter.

2. Connect the Gate outputs from up to 4 Redrum drum channels to 
the merge inputs of a Spider CV.

3. Route the merged output to the Env Gate input on the ECF-42.
If you add a touch of velocity the connected Gate signals will trigger the 
ECF-42 filter envelope. Again, the trim pots on the Spider allows you to ad-
just the amount of filter envelope applied. 

Four CV inputs with trim 
controls.

The merged CV 
output.



THE EFFECT DEVICES250

D Create an “arpeggiator” using two Matrix devices and the Spider 
CV Merger & Splitter.

By merging the Note CV output from one Matrix with a Curve CV output of an-
other Matrix, you can transpose the Matrix pattern in real-time, a bit like an ar-
peggiator.

1. Create a Subtractor and a Matrix device.
Connect the Matrix Note and Gate CV outputs to the Subtractor Sequencer 
CV and Gate inputs, respectively.

2. Program a pattern for the Matrix.
In the following text this is referred to as “Matrix 1”

3. Now create a Spider CV and a second Matrix device and connect 
them as in the picture below.

Note that the Note CV output from Matrix 1, and the Curve CV output of Matrix 2 should 
be connected to the Spider. The merged output is connected to the Sequencer Control 
Note CV input on the Subtractor.

4. On the Spider CV, turn the trimpot for the input connected to the 
Note CV output fully to the right.
This setting will retain the correct pitch relationship for the notes played by 
the pattern.

5. On the Spider CV, turn the trimpot for the input connected to the 
Curve CV output to “32”.
This will produce a Curve CV output that corresponds to semitone steps.

6. Set the Curve type switch to “Bipolar” on the back of the second 
Matrix (Matrix 2).

7. Flip the rack around so that the front panels are showing, and make 
the following settings for the “Matrix 2”:

• Set the number of steps to “1”.
• Set the Curve/Keys switch to “Curve”. 
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8. Adjust the Matrix 2 curve for step 1 (the only step used) so that it is 
in the middle of the bipolar curve as the picture shows.

9. If you now activate Play from the transport, the pattern you pro-
grammed for Matrix 1 is played back. By carefully adjusting the Ma-
trix 2 Curve step 1 up or down the Matrix 1 pattern is transposed in 
semitone steps.
By programming different values for the “pattern” played by Matrix 2 and 
saving them in different pattern locations, you can use the Pattern selectors 
to transpose the Matrix 1 pattern to different keys!

Splitting CV

On the right half of the back panel you will find two split inputs “A” and “B”, each 
with four output connectors. The signal connected to a Split input will be output 
by all four corresponding outputs, where one is inverted.

Practical uses of splitting CV

There are many practical uses of splitting CV signals - here are a few examples:

D Connecting the CV Note and CV Gate outputs from a Matrix to Split 
Input A and B, allows you to connect the Matrix to several instru-
ment devices.
Simply route the CV and Gate outputs to the corresponding Sequencer 
Control CV/Gate inputs on the instrument devices. Although this could also 
be done by copying the Matrix Pattern data to several sequencer tracks and 
routing the outputs to the desired devices, the advantage by using Split is if 
you are editing Matrix pattern data this will be immediately be reflected in all 
the connected devices, without any copy/paste operations.

D Splitting modulation outputs from LFO’s, Curve CV data etc. allows 
you to apply modulation from one source to several parameters.
By using the inverted output, you can create interesting modulation cross-
fades, where one parameter value rises and another parameter value is low-
ered for example.

Two CV Split Inputs (A & 
B).

Each of the two Split inputs 
provide four Split outputs. The 
lower right Split outputs will 
produce an inverted CV signal.
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Reason Menu (Mac OS X)
About Reason
This menu item opens up a dialog that informs you about the version of the pro-
gram and the people behind it.

Preferences
This menu item opens up the Preferences dialog. See page 268 for detailed de-
scriptions of the options in this dialog.

In addition, the Reason menu contains the standard Mac OS X services and 
Hide/Show options. Please consult the Macintosh help for descriptions of these 
options.

Quit Reason
This allows you to quit the program. If there are any documents open with un-
saved changes you will be asked whether you want to save those changes.

File Menu
New
When you select this, a new, empty song appears. The exact contents of this 
song is determined by your Preferences settings (see page 268).

Open...
To open a Song, proceed as follows:

1. Pull down the File menu and select Open.
The Reason song browser window appears.

2. Use the browser to navigate to the desired folder on disk or within a 
ReFill.

3. When you have located the song file, select it and click Open (or 
double click on the file).
The song appears in its own document window.

✪ You can have several songs open at the same time if you like. This 
allows you to copy and paste patterns and patches between songs. 
However, all open songs consume some memory and performance, 
so you may want to close songs you don’t need.

Close
This closes the active window.

If the window is a song document and it has unsaved changes, you will be asked 
whether you want to save those changes.

Save
This saves the active song document to disk.

• If the song document hasn’t yet been saved, the Save As dialog appears, re-
questing you to enter a file name and specify a location for the file on disk.

• If the document has already been saved at least once, the document will 
simply be saved without any questions.

Save As...
This saves the active song document to disc. A standard Save As dialog ap-
pears requesting you to enter a file name and specify a location for the file on 
disk.

✪ You can set things up so that any samples used in the song are in-
cluded in the song file itself by specifying self-contained settings 
(also on the File menu).
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Song Information...

This brings up a dialog that allows you to add contact information, comments 
about the song, etc. Furthermore, if you save a published version of the song in 
the Reason Song Archive on the Propellerhead web site, vital information can 
automatically be extracted by the web archive engine, and displayed with the 
song file.

The dialog contains the following items:

Text in Window Title

The text you add here will be displayed directly after the file name in the song 
window’s title bar.

More Information

This is where you add notes and comments about the song.

Song Splash

Allows you to add a picture to the song. If the “Show splash on song open” 
checkbox is ticked, the picture will be displayed when the song is opened.

To add a splash picture, click the folder button at the upper right corner, and lo-
cate and open the picture file in the file dialog that appears.

! Splash pictures must be JPEG files (Windows extension “.jpg”) with 
a size of 256 x 256 pixels.

To remove the splash picture from the song, click the cross button.

Author’s Web Page

Allows you to specify your web site. The user can go directly to your site by 
clicking the Browser button to the right (provided there is a working Internet 
connection).

Author’s Email

This is where you specify your E-mail address, if you want other Reason users to 
send you their comments, etc.

Publish Song...
If you want to make your songs available to the public, e.g. for downloading on 
the Internet, there is a special file format for this. A Reason published song (Win-
dows file extension “.rps”) is much like a self-contained song, but has the follow-
ing restrictions:

• The user cannot save any changes to the song.
• Copy, Cut and Paste is disabled.
• It is not possible to use the function Export Song/Loop as Audio File.

In a word, published songs are “locked”. They are meant for playback only - no 
elements can be added, removed or extracted. Furthermore, a published song 
contains information about which ReFills are required (if any).

To create a published song, pull down the File menu and select Publish Song. 
Specify a name and location for the published song in the file dialog that ap-
pears, and click Save.

D Note that you don’t have to make self-contained settings - all files 
(except ReFill components) are automatically included.

About the Reason Song Archive

On the Propellerhead web site (www.propellerheads.se) you will find the Rea-
son Song Archive. This allows you to share your music with other Reason users 
by uploading your songs. 
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Song Self-contain Settings...

A self-contained song contains not only the references to the used files, but also 
the files themselves. You can choose exactly which files should be included in 
the self-contained song, with the following exception:

! Files that are part of a ReFill cannot be included in a self-contained 
song.

If your song contains samples or REX files from a ReFill, other users must have 
the same ReFill to be able to play the song.

To specify which files should be included in the song, proceed as follows:

1. Tick the checkbox in the Sound column for the files you want in-
cluded in the song.

D You can use the Check All button to activate all checkboxes in one 
go.
Similarly, the Uncheck All button deactivates all checkboxes.

D Files that are part of a ReFill are indicated by a lock symbol instead 
of a checkbox (since they cannot be included in the song file).
The rightmost column indicates to which ReFill each such file belongs.

2. When you have selected the desired sounds, click OK.
The dialog is closed. The next time you save, the specified sounds will be in-
cluded in the song file.

! Note that a self-contained song file will be considerably larger than 
the original song file. 
However, samples included in a self-contained song are automati-
cally compressed by approximately 50%, meaning that the self-con-
tained song will still be a lot smaller than the original song and the 
sample files combined.

“Un-self-containing” a Song

If you have opened a song that is more or less self-contained (i.e. contains one 
or several sounds embedded in the song file), you may want to extract these 
sounds and make the song refer to them on disk as usual.

1. Locate the sounds you want to extract from the song file, and deac-
tivate their checkboxes (or click Uncheck All).

2. Click OK to close the dialog.
Now, the program will check for each “extracted” sound file whether it is 
available in your database (at its original, stored location) or not.

D If the program finds the sound file at the location stored in the 
song, it is simply removed from the song file, and the original file 
reference path is used.

D If the program doesn’t find the sound file, a file dialog appears, al-
lowing you to select a folder and name for the sound file.
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Import MIDI File...
Reason can import standard MIDI files (SMF). This allows you to import MIDI 
data to Reason from other applications.

D Under Windows, MIDI files have the extension “.mid”.
On a Macintosh, MIDI files are recognized if they have the file type “Midi”.

D If the imported MIDI file is of “Type 1”, there will be one sequencer 
track for each track in the MIDI file.

D If the imported MIDI file is of “Type 0” (that is, it contains one track 
with MIDI events on multiple channels), there will be one sequencer 
track for each used MIDI channel.

D Any tempo changes in the MIDI file are disregarded.
The tempo in Reason will be set to the first tempo in the MIDI file.

D The new tracks will not be connected to devices in the rack.
You will need to connect the tracks manually to the proper devices, by using 
the Out pop-up menu in the track list.

D All controller data in the MIDI file is included.
This means that pitch bend, volume and modulation wheel data are pre-
served properly. However, some controllers may “mean” different things for 
the original MIDI instruments used when creating the MIDI file and the de-
vices in Reason. When you have connected a sequencer track to a device, 
you may therefore need to remove some unwanted automation from the 
track.

Export MIDI File...
Reason can export standard MIDI files (SMF). This allows you to transfer MIDI 
data from Reason to other applications.

1. Set the End (E) marker at where you want the MIDI file to end.
The MIDI file will contain all events on all tracks from the start of the song to 
the End marker.

2. Select “Export MIDI File” from the File menu. 

3. In the file dialog that appears, specify a name and location for the 
file.
Under Windows, the file will automatically get the extension “.mid”. Under 
Mac OS, this is not required. However, if you want the MIDI file to be recog-
nizable under Windows (and by some hardware sequencers), you may want 
to activate the option “Add Extension to File Name” before saving.

4. Click Save.

MIDI files exported by Reason will have the following properties:

D The MIDI file will be of Type 1, with one MIDI track for each track in 
the Reason sequencer.
The tracks will have the same names as in the Reason sequencer.

D Since the Reason sequencer doesn’t use MIDI channels as such, all 
tracks will be set to MIDI channel 1.

D The sequencer tempo is included in the MIDI file.

Export Device Patch...
This item is valid for all items that can save patches. The menu item name re-
flects the type of device selected (for example “export Redrum Patch”).

Even though the device settings are stored in the song, you may want to save 
any settings you have made for a device as a separate patch file. This allows you 
to use the patch in other songs, and lets you try out other patches in your song 
without risking to lose your sound.

D Under Windows, the different types of patch files have different file 
extensions.
These are “.zyp” (Subtractor patch files), “.smp” (NN-19 patch files) “.drp” 
(Redrum patch files), “.xwv” (Malström patch files) and “.sxt” (NN-XT patch 
files). Under Windows, file extensions are automatically added by Reason 
when you save. Under Mac OS, you can choose to automatically add exten-
sions by activating the “Add Extension to File Name” checkbox in the save 
dialog (this is not required, but may be a good idea if you want the saved 
files to be usable under Windows).

D If you have selected a patch, modified it and want to save it with the 
modifications, you could either save a separate, modified version of 
the patch (with a new name) or simply overwrite the old patch file 
on disk.
As usual, you will be asked whether you really want to replace the existing 
patch file.

✪ You can save a patch under the same name and location (without 
having the save dialog appear) by holding down [Option] (Mac) or 
[Alt] (Windows) and clicking the floppy disk button on the device 
panel. Note that this overwrites the original patch!

Export Song/Loop as Audio File...
When you have created a complete song, you may want to mix it down to an au-
dio file to make it playable for other people (who don’t use Reason). You can ei-
ther export the whole song (from the start to the “E” marker), or only the loop 
(the area between the left and right locator in the sequencer). Proceed as fol-
lows:

1. Make sure only the main stereo outputs are used.
The export function will only include audio routed to the stereo outputs.
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2. Make sure the Loop/End markers are at the correct positions.
If you want to export the loop, you need to set the left and right locators to 
encompass the desired area. If you instead want to export the whole song, 
make sure the End (E) marker is at the desired end position.

✪ If you are using reverb or delay, you may want to adjust the right lo-
cator or End marker so that the reverb/delay “tails” are included in 
the exported file.

3. Check that the song (or loop) plays back properly.
It’s especially important that no clipping occurs during playback (see page 
74).

4. Pull down the file menu and select Export Song as Audio File (or 
Export Loop as Audio File).
A file dialog appears.

5. Specify a name, location and file type (AIFF or Wave) for the audio 
file, and click Save.

6. Specify a sample rate and bit depth (resolution) for the exported 
file in the Settings dialog that appears.

7. Click OK.
The program creates the audio file. Depending on the length of the song/
loop, this may take a while, during which a progress dialog is shown.

Export REX as MIDI File...
If you have imported a REX file into a Dr. Rex device and wish to play back the 
loop via MIDI (typically from another sequencer), proceed as follows:

1. Select the Dr. Rex device in the rack.

2. Select “Export REX as MIDI File...” from the File menu.

3. Save the MIDI File to disk.

4. In the other application, open the MIDI file you just created.

5. Set up the other application to play back the MIDI File on the cor-
rect MIDI Output and MIDI Channel (the output and channel on 
which the Dr. Rex device receives data).

Quit
This allows you to quit the program. If there are any documents open with un-
saved changes you will be asked whether you want to save those changes.

Edit Menu
Undo
Virtually all actions in Reason can be undone. This includes creation, deletion 
and reordering of devices in the Rack, parameter value adjustments, editing in 
the sequencer and tempo/time signature adjustments. You can undo up to 10 
actions.

D To undo the latest action, select “Undo” from the Edit menu or hold 
[Command] (Mac) or [Ctrl] (Windows) and press [Z].
The action to be undone is indicated next to the Undo command on the Edit 
menu. For example, if your latest action was to delete some device(s) from 
the Rack, the Edit menu will say “Undo Delete Devices”.

Redo
To redo an undone action (“undo the undo operation”), select “Redo” from the 
Edit menu or hold [Command] (Mac) or [Ctrl] (Windows) and press [Y].

The action to be redone is indicated next to the Redo command on the Edit 
menu.

You can undo/redo up to 10 actions.

Cut/Cut Device/Cut Pattern
This command takes the selected item(s), removes them and places them on the 
clipboard (an invisible storage location) from where they can later be pasted in.

Cutting applies to tracks, sequencer events and Groups, devices and patterns.

Copy/Copy Device/Copy Patch/Copy Pattern
This command takes the selected item(s), copies them and places the copies on 
the clipboard (an invisible storage location) from where they can later be pasted 
in.

Copying applies to tracks, sequencer events and Groups, devices and patterns.

Paste/Paste Device/Paste Patch/Paste Pattern
This command takes the items you have cut or copied and pastes them back 
into the document.

Sequencer tracks

D If you Paste the track(s) into their original song, this simply dupli-
cates the tracks.
However, the Pasted tracks will not be connected to any devices in the rack.
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D You can also Paste the track(s) into another song.
Note that only the tracks (complete with contents) are copied and pasted - 
not their respective devices. You may want to separately copy and paste the 
devices to the other song.

Sequencer events and groups

D When you Paste sequencer events and groups, they appear at the 
song position, on their original track(s).
If you have deleted the original tracks, or if you Paste into another Reason 
song document, new tracks will be created as needed.

Devices

D When you Paste devices, these are inserted into the rack below the 
currently selected device.
If no device is selected, the pasted devices will appear at the bottom of the 
rack.

D If you Copy and Paste several devices, the connections between 
these are preserved.

D If you hold down [Shift] when you Paste a device, Reason will at-
tempt to automatically route its audio patching. 

Patterns

D Paste Pattern copies the pattern on the clipboard to the selected 
pattern location in the selected device.
This overwrites the selected pattern with the one on the clipboard.

Transferring patterns between Reason songs

If you want to copy patterns between different Reason songs, you use copy and 
paste:

1. Open both songs.

2. Select the pattern you want to copy.

3. Select Copy Pattern from the Edit menu or the device context menu.

4. Make the other song active.
This is done by clicking in the song window or by selecting the song from 
the Windows menu.

5. Select the bank and pattern location to which you want to copy the 
pattern.
Note that any pattern already stored in that location will be overwritten!

6. Select Paste Pattern from the Edit menu or the device context 
menu.

Clear/Delete Device/Clear Pattern
This menu item is used for deleting selected items. It is also used for clearing 
(emptying) the select pattern on a pattern device.

Initialize Patch
Sometimes it is useful to start with a “clean slate” when creating a synth sound, 
a drum kit or a sampler patch. This is done by selecting Initialize Patch from the 
device context menu or Edit menu. This sets all parameters to “standard” values. 
Initializing NN-19, NN-XT, Dr. Rex or Redrum devices will also remove all sample 
file references, allowing you to start from scratch.

Select All
This selects all items of the same type as the one currently selected, that is, all 
sequencer notes, all devices in the rack, etc.

You can use this to quickly apply a command to all items you are working on, for 
example deleting all devices in the rack (select Select All and then press [De-
lete]) or for Quantizing all notes in the Edit View (select Select All and then click 
the Quantize button).

D Whether the Select All function applies to the track list, the Ar-
range/Edit View or the rack depends on which area has focus in the 
program.
Focus is indicated by a thin frame around an area in the document window. 
To set focus to the desired area, click somewhere in it.

Browse Device Patches...
This menu item allows you to select a new Patch for a device. The menu item re-
flects which device is selected - in other words, you must select the device for 
the corresponding Browse Patches item to appear on the Edit menu.

When you select the menu item, the Browser dialog appears, allowing you to lo-
cate and select the patch, on the hard disk or within a ReFill.

When you select a patch, the device’s parameters will be set according to the 
values stored in the patch, and the name of the patch will be shown in the patch 
name display. As with any change you make, this operation can be undone.

! Any parameter adjustments you make on the device panel after se-
lecting a patch will not affect the actual patch file (for this you need 
to save the patch).
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If referenced samples are missing

Patches for the Redrum, NN-19 and NN-XT contain references to samples. Just 
like patches, samples can be independent files on the hard disk or elements 
within a ReFill or a SoundFont. However, if sample files have been moved or re-
named after a patch was saved, the sample file references in the patch will not 
be accurate.

If this is the case when you select a patch, the program will tell you so. You can 
then choose to either manually locate the missing files, to have the program 
search for them in the database and ReFills or to proceed with missing sounds.

Browse ReCycle/REX Files...
This menu item is used to add a loop to the selected Dr.Rex device. Files to be 
imported can be in REX, RCY or REX2 file format. 

Loading a new REX file will replace any currently loaded file.

Browse Samples...
This menu item lets you load samples into the devices that use them; the Re-
drum, the NN-19 and the NN-XT. 

The following sample formats can be loaded:

D Wave (.wav)
This is the standard audio format for the PC platform.

D AIFF (.aif)
This is the standard audio format for the Mac platform.

D SoundFont samples (.sf2)
This is an open standard format for wavetable synthesized audio, developed 
by E-mu systems and Creative Technologies.

D REX file slices (.rex2, .rex, .rcy)
REX files are music loops created in the ReCycle program. This program 
“slices” up loops into several, separate samples. These samples - or slices - 
can be loaded into the devices mentioned.

Redrum

To use this menu item to load a new drum sound into Redrum, proceed as fol-
lows:

1. Select a channel in the drum machine, by clicking its Select button.

2. Select Browse Samples.
The Redrum sample browser opens.

3. Navigate to a location containing any of the sample formats listed 
above, select one and click Open.

NN-19

This menu item can also be used to add a sample to a key zone in a key map in 
the NN19 sampler.

1. Select a key zone.
This can be empty, or contain a sample - it doesn’t matter for now.

2. Use the browser to add one or several (see below) sample(s).

The following will happen:

D If the zone contained a sample prior to loading, this will be re-
placed, both in the zone and in the sample memory, unless the 
sample was also used by another key zone.

D If you loaded several samples, one of the samples (the sample that 
was selected furthest down in the Browser list) will be loaded into 
the key zone, and the other samples will be loaded into the sample 
memory.

NN-XT

This menu item is used for adding one or more sample(s) to a key map in the 
NN-XT:

1. Make sure the Remote Editor panel is folded out, by clicking the 
small arrow in the bottom left corner.
If the remote editor panel is folded in, you will only be able to browse for NN-
XT patches.

2. Use the sample browser to add one or several sample(s).
The sample(s) will be placed in separate zones and mapped across the 
same key range.

! If a key map already contains a zone with a sample in it, and this is 
selected prior to loading, it will be replaced if you load a new, single 
sample. If you load several samples at once though, they will in-
stead be added below any already loaded samples.
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Automap Samples
This menu item applies to the NN 19 Sampler. If you have a number of samples 
that belong together but haven’t been mapped to key zones, you can use the 
“Automap Samples” function. This is used in the following way:

1. Select all samples that belong together and load them in one go, 
using the sample browser.
One of the samples will be loaded to a key zone spanning the whole range, 
and the rest will reside in the sample memory.

2. Select Automap Samples from the Edit menu.

Now the samples currently in memory will be arranged automatically so that:

D Each sample will be placed correctly according to its root note, and 
will be tuned according to the information in the sample file.
Most audio editing programs can save root key information as part of the file.

D Each sample will occupy half the note range to the next sample’s 
root note.
The root key will always be in the middle of each zone, with the zone extend-
ing both down and up in relation to the root position. Hence, no key zone 
high or low limits have to be manually set!

Mapping Samples Without Root Key or Tuning Information

Some samples may not have any information about root key or tuning stored in 
the file (nor indicated in the file name). If this is the case, you can still make use 
of the Automap function:

1. Select all samples that belong together and load them in one go, 
using the sample browser.
One of the samples will be loaded to a key zone spanning the whole range, 
and the rest will reside in the sample memory. 

2. Manually set the root key, and adjust the tune knob if the sample 
needs pitch fine-tuning.
Without any information stored in the file, or if the file name doesn’t indicate 
the root key, you will have to use your ears for this step. Play the sample 
across different areas of the keyboard and listen to where it sounds the most 
“natural”. As long as you are in the general area of the correct root key, the 
result should be o.k. You can always adjust this later.

3. Select the next sample using the Sample knob, and repeat the pre-
vious step.
Proceed like this until you have set a root key for all the samples.

4. Select “Automap Samples” from the edit menu.
The samples will be automatically mapped according to their set root key po-
sitions!

Delete Sample/Remove Sample

Redrum

D To remove a sample from a Redrum drum machine, select its drum 
sound channel and then select “Delete Sample” from the Edit 
menu.
The sample is removed from the drum sound channel and from sample mem-
ory.

NN-I9

D To remove a sample from an NN-19 Sampler’s memory, select the 
zone it belongs to, and then select “Delete Sample” from the Edit 
menu.
The sample is removed from the zone and from sample memory.

NN-XT

D To remove a sample from an NN-XT Sampler’s memory, select the 
zone it belongs to, and then select “Remove Samples” from the 
Edit menu.
The sample is removed from the zone and from sample memory. The zone 
still remains though. To delete a zone, you must use the option “Delete 
Zones”.

Delete Unused Samples
This menu item is used for the NN-19 Sampler. When you select it, all samples 
that are not assigned to a key zone are deleted from sampler memory.

This way you can make sure that you are not wasting any sample memory for 
samples that are not actually used.

Split Key Zone
This menu item is used for the NN-19 Sampler. It splits the currently selected 
key zone in the middle. The new zone is the upper half of the split, and is empty. 
The dividing point has a “handle” above it.

Delete Key Zone
This menu item is used for the NN-19 Sampler. It deletes the currently selected 
key zone from the key map.



MENU AND DIALOG REFERENCE262

Copy REX Loop to Track
This menu item is used for the Dr. Rex loop player device. To be able to make 
your REX loop start at the same time as other sequencer or pattern data, you 
“convert” the slices in the loop to notes in the sequencer:

1. Select a sequencer track connected to the Dr.Rex device.

2. Set the left and right locators to encompass the section you want to 
fill with REX notes.
You may want to make sure that this area doesn’t contain any notes already, 
to avoid confusion.

3. Select the Dr. Rex player, so that it has focus.

4. Pull down the Edit menu and select “Copy REX Loop to Track”.
Now, the program will create a note for each slice, positioned according to 
the timing of the slices. The notes will be pitched in semitone steps, with the 
first note on C1, the second on C#1 and so on, with one pitch for each slice. 
If the area between the locators is longer than the loop length, the loop 
notes will be repeated to fill out the loop.

Now you can reorder, overdub onto, and otherwise edit the note data, using the 
REX or Key edit lanes in the sequencer.

Copy Pattern to Track
This menu item is used for the Redrum drum machine and Matrix pattern se-
quencer. It converts the selected pattern to notes on a sequencer track. Pro-
ceed as follows:

1. Select a sequencer track connected to the Redrum/Matrix.

2. Set the left and right locators to the desired range or length.
If the range set is longer than the pattern(s), the data will be repeated to fit 
the range.

3. Select the pattern device, so that it has the focus.

4. Pull down the Edit menu and select “Copy Pattern to Track”.
Notes will be created between the left and right locators, according to the 
selected pattern.

! When copying Matrix patterns, only the Gate and Keys values will 
be included!

D If you copied a Redrum pattern, you may want to turn off the “En-
able Pattern Section” before playing back the new track data.
Otherwise, both the main sequencer and the pattern sequencer will play the 
drum sounds, simultaneously.

D If you copied a Matrix pattern, you need to connect the track to an 
instrument device (such as the device which was originally con-
trolled by the Matrix), since the Matrix in itself doesn’t produce any 
sound.
Furthermore, you may want to disconnect the Matrix (or even remove it), to 
avoid having both the Matrix and the sequencer notes playing at the same 
time.

Shift Pattern Left/Right
These menu items are used for the Redrum and Matrix respectively.

The Shift Pattern functions move the notes in a pattern one step to the left or 
right. 

Shift Drum Left/Right
These menu items are used for the Redrum.

The Shift Drum functions move the notes for the selected instrument one step to 
the left or right.

Shift Pattern Up/Down
These menu items are used for the Matrix.

The Shift Pattern functions will transpose all the notes in a pattern one semitone 
up or down.

! This function does not alter the Curve CV.

Randomize Pattern
This menu item is used for the Redrum and Matrix.

The Randomize Pattern function create random patterns. These can often be 
great starting points and help you get new ideas.

! Note that for the Matrix, Randomize affects both the Gate, Note and 
Curve CV!

Randomize Drum
The Randomize Drum functions creates random patterns for the selected drum 
sound channel in the Redrum drum machine.

Alter Pattern
This menu item is used for the Redrum and Matrix.

The Alter Pattern function modifies existing patterns. Note that there must be 
something in the pattern for the function to work on - using an Alter function on 
an empty pattern will not do anything.
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! Note that for the Matrix, Alter affects both the Gate, Note and Curve 
CV!

Alter Drum
The Alter Pattern function modifies existing patterns for the selected drum 
sound. Note that there must be something in the pattern for that channel for the 
function to work - using an Alter function on an empty pattern will not do any-
thing.

Auto-route Device
Auto-routing is when devices’ audio and CV/gate connections are automatically 
routed according to default rules. Auto-routing is normally performed:

• When a new device is created.
• When moving, duplicating or pasting devices with [Shift] pressed.

However, if a device is already in the rack, you can “force” it to be auto-routed by 
selecting it and then select this menu item.

For more information about auto-routing rules, see page 37.

Disconnect Device
This disconnects all audio and CV/gate connections from the selected de-
vice(s).

Duplicate Track
This creates a copy of the selected track, complete with all events. The dupli-
cated track will appear below the original track in the track list.

Group
This puts a selection of events in the Arrange view into a Group:

1. Select the events that you want to Group.
It doesn’t matter which lanes you select - all notes, pattern changes and con-
trollers within the area will be included in the Group.

D If you select events on several tracks, one Group for each track will 
be created.
Each Group can only contain events on one track.

2. If you want the Group to have a specific length, activate Snap and 
select an appropriate Snap value.
Often it is practical to create Groups that are one or several whole bars of 
length.

3. Select Group from the Edit menu.

Ungroup
This menu item is used to dissolve a Group:

1. Select the Group.

2. Select Ungroup from the Edit menu.

Find Identical Groups
This command helps you locate all Groups with the same contents:

1. Select a Group.

2. Select “Find Identical Groups” from the Edit menu.
All Groups with the same contents are selected in the Arrange View.

Insert Bars Between Locators
This function inserts an empty area between the locators in the main sequencer. 
All events after the left locator are moved to the right to “make room” for the in-
serted area.

Remove Bars Between Locators
This function removes all material between the locators in the main sequencer. 
All events after the right locator are moved to the left to “fill out” the gap after the 
removed section.

Convert Pattern Track to Notes
If you have recorded or drawn pattern changes on a Redrum or Matrix track, you 
can have the whole track converted to notes, in the following way:

1. Select the track with the pattern changes.

2. Select “Convert Pattern Track to Notes” from the Edit menu or the 
context menu for the track.
For each bar, the corresponding pattern is converted to notes on the track 
(following the same rules as for the “Copy Pattern to Track” function). The 
track will play back just the same as when you played the pattern device with 
the pattern changes (including the Pattern Enabled/Mute switch).

D After the operation, all pattern changes are automatically removed 
from the track.

Redrum notes

• The “Enable Pattern Section” switch is automatically turned off when you 
use this function.
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Matrix notes

• After performing “Convert Pattern Track to Notes”, you need to move the 
contents to another track, or re-route the track to another device.
Having the track connected to the Matrix itself is pointless, since the Matrix 
cannot produce any sound.

• You may want to disconnect or even remove the Matrix after performing this 
function. 
This is because you probably don’t want both the Matrix and the sequencer 
notes to play back at the same time.

Get User Groove
You can create your own groove and apply this using Groove Quantize:

1. Create or record a rhythmic note “pattern” of some kind.
You may for example record a drum pattern, or use the notes playing the 
slices in a REX loop.

2. Select the notes you want to include in the user groove.
The groove can be of any length, but it’s usually most practical to make it 
one or two bars long.

3. Select “Get User Groove” from the Edt menu or sequencer context 
menu.
Your pattern is stored as the User groove.

4. Select any notes you want to quantize, make sure “User” is se-
lected as Quantize value, and quantize as usual.
The rhythmic feel of your groove is applied to the notes.

! The User Groove is only stored temporarily - it isn’t included when 
you save your Song.

Clear Automation
To remove all automation for a controller, select “Clear Automation” from the 
Edit menu.

This requires that the controller subtrack has focus. Click in the subtrack if you 
are uncertain.

Selecting “Clear Automation” will remove all controller values from the subtrack, 
and the text “Not Automated” will be shown.

Quantize Notes
In Reason, you use the Quantize function in the following way:

1. Select the notes you want to quantize.
Only notes will be affected, so you can select Groups or complete Tracks if 
you like.

2. Pull down the Quantize pop-up menu on the sequencer toolbar and 
select a Quantize value.
This determines to which note values the notes will be moved when you 
quantize. For example, if you select sixteenth notes, all notes will be moved 
to (or closer to) the closest sixteenth note position.

3. Select a value from the Quantize Strength pop-up menu.
This is a percentage, governing how much each note should be moved. If 
you select 100%, notes will be moved all the way to the closest Quantize 
value positions; if you select 50%, notes will be moved half-way, etc.

4. Click the Quantize button or select “Quantize Notes” from the Edit 
menu.
The selected notes are quantized.

Change Events...

The Change Events dialog contains some special editing functions. Proceed as 
follows:

1. Select the events to which you want to apply the editing functions.
The Change Events functions are mainly used with notes, but the Scale 
Tempo function will also affect controllers and pattern changes (see below).

2. Select Change Events from the Edit menu or the context menu for 
the selected events.
The Change Events dialog appears.



MENU AND DIALOG REFERENCE 265

3. Make settings for one of the functions in the dialog and click the 
Apply button next to the settings.
All settings can be made by clicking the spin controls or by clicking in a 
value field and entering a value numerically. The functions are described be-
low.

4. If you like, use other settings in the same way.
You can use the transport controls as usual while the dialog is open. This al-
lows you to play back the events to check out the changes.

5. When you are done, close the dialog.

Transpose

This function transposes the selected notes up or down, by the specified num-
ber of semitones.

Velocity

Adjusts the velocity of the selected notes.

D The Add field lets you add a fixed amount to the velocity values.
To subtract, enter a negative amount. Note that the possible velocity range is 
0-127. Adding an amount to a note with velocity 127 will not make any dif-
ference.

D The Scale field allows you to scale velocities by a percentage factor.
Scaling with a factor above 100% will increase the velocity values, but also 
make the difference between soft and hard notes bigger. Scaling with a fac-
tor below 100% will decrease the velocity values, but also make the differ-
ence between soft and hard notes smaller.

D By combining the Add and Scale functions, you can adjust the “dy-
namics” of the notes in various ways.
For example, by using a Scale factor below 100% and Add a suitable 
amount, you can “compress” the velocity values (decreasing the difference 
between the velocity values without lowering the average velocity).

Scale Tempo

This function will make the selected events play back faster (Scale factor above 
100%) or slower (Scale factor below 100%). This is achieved by changing the 
position of the events (starting from the first selected event) and adjusting the 
length of the notes accordingly.

D The buttons [*2] and [/2] are “shortcuts” to Scale factors 200% and 
50%, respectively.
These are probably the most common values used, simulating double tempo 
and half tempo.

! This function affects all types of events: notes, controllers and pat-
tern changes! 

Alter Notes

This function alters the properties pitch, length and velocity of the selected 
notes in a random fashion. 

D The function will only “use” values that already exist among the se-
lected notes.
For example, if you have selected notes within a specific pitch interval, the al-
tered notes will remain within this pitch interval. Similarly, only velocity values 
and note lengths that were already used in the selection will be applied by 
the Alter function. You could say that the function “shuffles” the existing 
properties in a selection and redistributes them among the notes.

! This means that the less variation there is among the selected 
notes, the less the effect of the Alter function.

D You can adjust the amount of Altering with the Amount value.

✪ This function is especially useful for experimenting with REX loops. 
Select some notes on a Dr.Rex track and use Alter Notes to create 
instant variations, without losing the timing and rhythmic feel of the 
loop!

Reload Samples
This menu item is used with the NN-XT sampler. When you select this, any 
changes you have made on a loaded sample using the single adjustment sample 
parameters are immediately undone, and the settings revert back to the original.

Add Zone
This menu item is used with the NN-XT sampler. It is used for adding an empty 
zone to the key map. An empty zone can be resized, moved and edited in the 
same way as zones that contain samples.

An empty zone is indicated with the text “**No Sample**”. After you have added 
an empty zone, you can assign a sample to it.

Single adjustment parameters
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Copy Zones
This menu item is used with the NN-XT sampler. It copies the selected zone(s), 
and all of its settings - including references to any sample it may contain - and 
places it in the clipboard buffer. You can then select “Paste Zones” to create a 
new zone that is an exact replica of the copied zone(s). Note that copying/past-
ing zones can also be performed between NN-XT devices.

Paste Zones
This menu item is used with the NN-XT sampler. If you have used the “Copy 
Zones” command, with any number of selected zones, you can create exact du-
plicates of these by using the “Paste Zones” command. The pasted zones will 
then be added below any existing zones in the key map.

Duplicate Zones
This menu item is used with the NN-XT sampler. It lets you duplicate any number 
of already existing zones (containing samples or empty).

1. Select the zone(s) you want to copy.

2. Select “Duplicate Zones”.
The selected zones will now be copied and automatically inserted below the 
last one in the key map display. 

The duplicated zones will contain references to the same samples as the original 
zones. They will also have the exact same key ranges and parameter settings.

Delete Zones
This menu item is used with the NN-XT sampler. Selecting this option will re-
move both the selected zones, and any samples they may contain.

Select All Zones
This menu item is used with the NN-XT sampler. This option will automatically 
select all zones in a key map.

Copy Parameters to Selected Zones
This menu item is used with the NN-XT sampler. It lets you easily copy parameter 
settings from one zone to any number of other zones. Proceed as follows:

1. Select all the zones you want to involve in the operation.
By this we mean the zone with the settings you wish to copy, and the zone(s) 
to which you want to copy the settings.

2. Make sure the zone that contains the settings you want to copy has 
edit focus by clicking on it.

3. Select “Copy Parameters to Selected Zones”.
All the selected zones will now get the exact same parameter settings.

! Observe that this only applies to the synth parameters (LFOs, enve-
lopes etc.). Sample parameters (root key, velocity range etc.) can 
not be copied.

Sort Zones by Note
This menu item is used with the NN-XT sampler. This option lets you automati-
cally sort the selected zones within a Group in descending order according to 
their key ranges.

When you invoke this option, the selected zones will be sorted from top to bot-
tom in the display starting with the one with the lowest range.

If two or more zones have the same key range, they are instead sorted by veloc-
ity range.

Sort Zones by Velocity
This menu item is used with the NN-XT sampler. This option lets you automati-
cally sort the selected zones within a Group in descending order according to 
their set low or high velocity values.

When you invoke this option, the selected zones will be sorted from top to bot-
tom starting with the one with the highest “Lo Vel “value.

If two or more zones have the same velocity range, they are instead sorted by 
key range.

Group Selected Zones
This menu item is used with the NN-XT sampler. It lets you put any number of se-
lected zones together in a group.

Grouping zones is good for two things:

D To allow you to quickly select a number of zones that “belong to-
gether.”
For example if you have created a layered sound consisting of piano and 
strings, you could put all string samples in one group and all piano samples 
in one group. Then you can quickly select all piano samples and make an ad-
justment to them by trimming a parameter.

D To group zones that need to share group settings together.
For example, you may want to set a group to legato and monophonic mode 
and add some portamento so that you can play a part where you slide be-
tween notes.

Proceed as follows:
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1. Select the zones you want to group together.
The zones don’t have to be contiguous in order to be grouped. Regardless 
of their original positions in the samples column, they will all be put together 
in succession.

2. Select “Group Selected Zones”.
The zones are grouped.

Note that there is always at least one group, since the zones you create are al-
ways grouped together by default.

Set Root Notes from Pitch Detection
This menu item is used with the NN-XT sampler. All instrument sounds have an 
inherent pitch. When playing a sample of such a sound on the keyboard, the 
keys you play must correspond to that pitch. For example, you may have re-
corded a piano playing the key “C3”. When you map this onto the NN-XT key 
map, you must set things up so that the sampler plays back the sample at origi-
nal pitch when you press the key C3, and this is done by adjusting the root note.

The NN-XT features a pitch detection function to help you set the root keys of 
loaded samples. This is useful if you for example load a sample that you haven’t 
recorded yourself, and you don’t have any information about its original pitch.

Proceed as follows:

1. Select all the zones you want to be subject to pitch detection.

2. Select “Set Root Notes from Pitch Detection”.
The samples in all the selected zones will now be analyzed, and the detected 
root keys will automatically be set for you.

! Note that for this to work properly, the samples must have some 
form of perceivable pitch. If it is sampled speech, or a snare drum 
for example, it probably doesn’t have any discernible pitch.

Automap Zones
This menu item is used with the NN-XT sampler. The automap function can be 
used as a quick way of creating a key map, or as a good starting point for further 
adjustments of a key map.

Automap works under the assumption that you intend to create a key map for a 
complete instrument, for example a number of samples of a piano, all at different 
pitches.

1. Load the samples you want to Automap.
Now you have three options:

• Trust that the root note information in the files is already correct.
• Manually adjust the root notes (and tuning) for all the samples.
• Use “Set Root Notes from Pitch Detection” to automatically set up the root 

notes.

2. Select all zones you want to automap.

3. Select Automap Zones.

All the selected zones will now be arranged automatically in the following way:

D The zones will be sorted in the display (from top to bottom - lowest 
key first) according to the root keys.

D The zones will be assigned key ranges according to the root keys.
The key ranges are set up so that the split between two zones is exactly in 
the middle between the zones’ root notes. If two zones have the same root 
key they will be assigned the same key range.

Create Velocity Crossfades
This menu item is used with the NN-XT sampler. This is used for automatically 
setting up velocity crossfades for smooth transitions between overlapping 
zones. To set up crossfades, you adjust the fade out and fade in values for the 
overlapping zones.

An example:

D Two zones are both set to play in the full velocity range of 1-127.

D Zone 1 has a fade out value of 40.
This means that this zone will play at full level with velocity values below 40, 
With higher velocity values, it will gradually fade out.

D Zone 2 has a fade in value of 80.
This has the effect that as you play velocity values up to 80, this zone will 
gradually fade in. With velocity values above 80, it will play at full level.

Instead of manually setting up a crossfade, you can let NN-XT do it for you. Pro-
ceed as follows:

1. Set up the zones so that their velocity ranges overlap, as desired.

2. Select the zones.
You can select as many zones as you wish, not just one pair of overlapping 
zones.

3. Select “Create Velocity Crossfades”.
NN-XT will analyze the overlapping zones and automatically set up what it 
deems to be appropriate fade in and fade out values for the zones.

Note the following important points:

D This operation will not work if both zones have full velocity ranges.
At least one of the zones must have a partial velocity range (see page 170).

D This operation will not work if the zones are completely overlap-
ping.
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Preferences – General

Mouse Knob Range

This lets you adjust the response sensitivity of the various knobs in Reason when 
manipulating them with the mouse. A higher sensitivity gives a higher degree of 
precision. You can choose between Normal, Precise and Very Precise.

Show Song/ReFill Splashes

This option allows you to decide whether the Browser should display the Splash 
Pictures or not when Browsing for a song or a ReFill. Furthermore, if this option 
is deactivated, song splashes will not be shown when you open songs.

Cable Animation

Cables in Reason are animated in a lifelike fashion when flipping the Rack and 
making connections. Should you so wish, you can choose to disable the cable 
movement animation by deactivating this checkbox.

Show Parameter Value Tool Tip

Normally, if you hold the mouse pointer over a parameter on a device panel for a 
moment, a Tool Tip appears displaying the name and the current value of the pa-
rameter. If you uncheck this option, Tool Tips will not be displayed.

Show Automation Indication

If a parameter is automated in the sequencer, this is, by default, indicated by a 
colored square around the parameter on the device panel. If you uncheck this 
option, automation will not be indicated.

Default Song

Every time you start Reason, and every time you select “New” from the File 
menu, a default song opens. The “standard” default song contains a few select 
devices. 

This section lets you decide exactly what you want the default song to look like, 
by using the radio buttons to the left:

• Empty Rack - This is an empty rack. Well, almost empty, since it contains the 
Reason hardware interface.

• Built In - This is a built-in Reason Song, containing a few devices. Note that 
it is not possible to open this song by regular means - via the browser - since 
it is not an “independent”.rns-file, and thus does not reside anywhere in the 
Reason folder. 

• Custom - This allows you to select a custom default song. Any Reason song 
can be used, so if you often create songs using the same or similar device 
setups, you can use a previously created song as the default song. This way, 
all new songs you create will have the same device setup.

To customize the contents of new songs, proceed as follows:

1. Select New from the File menu to create a new song document win-
dow.

2. Add/remove devices and make settings as desired.
Typically, you may want the default song to contain your choice of devices 
and possibly some patterns. You could also make some special routing be-
tween devices, or even add some sequencer data.

3. Save the song anywhere you like (preferably in the Reason program 
folder though) and under any name.

4. Pull down the Edit menu and open the Preferences dialog.

5. Go to the General page, and under “Default Song” click the radio 
button marked “Custom”.

6. Click the browser button to the right in the dialog, navigate to the 
song you saved earlier and click “Open”.
The name of the song appears in the textbox in the dialog.
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7. Close the Preferences dialog.
The next time you launch the program or select New from the File menu, the 
new song document will contain the devices and settings you made.

CPU Usage Limit

Reason is a powerful program but also demanding in terms of processing 
power. The more devices you add to your rack, the more of your computer’s re-
sources it will use.

Furthermore, as you use more and more of your computer resources for creating 
audio, less will be available for the user interface, resulting in slower perfor-
mance in terms of graphics and overall responsiveness.

The CPU Usage Limit setting allows you to set a limit on how much of the CPU 
(computer processor) that can be used for creating audio. The remaining capac-
ity is reserved for the user interface and the graphics.

Set this so that you feel comfortable using the program, even when a very de-
manding song document is played back.

Use High Resolution Samples

Reason has the capability to play back samples with practically any resolution. 
This means that if for instance 24-bit samples are loaded in a sampler or the Re-
drum, playback of the samples can be in 24-bit resolution as well. If you are us-
ing such samples and want Reason to play them back in their original high 
resolution, make sure that this checkbox is ticked.

If this is activated, and if your audio card supports it, Reason will play back high 
resolution samples in their original resolution. If this option is not activated, Rea-
son will play back all samples in 16-bit resolution, regardless of their original res-
olution.

Preferences – Audio

Master Tune

This lets you adjust the global tuning in Reason. Standard tuning is “middle A” at 
440 Hz. You can adjust this by +/- 100 cents.

Audio Card Driver – Windows

This menu lists all the available Audio Card Drivers on your system, and lets you 
select which one Reason should use. Which option to select depends on the 
audio hardware:

D If you are using audio hardware for which there is a specific ASIO 
driver, you should select this. 
With an ASIO driver written specifically for the audio hardware you will get 
lower latency (see below), support for higher sampling frequencies (up to 96 
kHz in 24 bit/32 bit float resolution), and possibly better support for addi-
tional hardware features such as multiple outputs.
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D If there is no specific ASIO driver, you should select the Direct 
Sound driver for the audio hardware. 
This makes Reason communicate with the hardware via Direct Sound (a part 
of the Microsoft DirectX package). For this to be possible, you need to have 
DirectX installed on your computer, and there must be a Direct Sound driver 
for the audio hardware.

D If the audio hardware doesn’t support Direct Sound (i.e. there is no 
Direct Sound driver for the audio hardware), select the MME driver 
for the audio hardware. 
This makes use of Windows Multimedia Extensions, the part of Windows 
that handles audio, MIDI, etc. Using MME often results in larger latency val-
ues (see below).

Audio Card Driver – Mac OS X

This menu lists all the available Audio Card Drivers on your system, and lets you 
select which one Reason should use. Which option to select depends on the 
audio hardware:

D Normally, you should select one of the driver options that start with 
the word “CoreAudio”.
Select the option that corresponds to the hardware you want to use (the 
built-in audio connectors or some additional audio hardware that you have 
installed).

D Other options may be available, mainly for compatibility with all 
possible hardware/software configurations.
You should use these only when required.
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Audio Card Driver – Mac OS 9

This menu lists all the available Audio Card Drivers on your system, and lets 
you select which one Reason should use. Which option to select depends 
on the audio hardware:

D If you are using audio hardware for which there is a specific ASIO 
driver, you should select this. 
With an ASIO driver written specifically for the audio hardware you will get 
lower latency (see below), support for higher sampling frequencies (up to 96 
kHz in 24 bit/32 bit float resolution), and possibly better support for addi-
tional hardware features such as multiple outputs.

If there is no specific ASIO driver for your audio hardware, you will use the Apple 
Sound Manager. This is the sound driver protocol that comes with the Mac OS, 
and Reason communicates with the audio hardware using this.

D If you plan to use the internal audio outputs on your computer, 
please select “SM Built-in”. 

D If you have some additional audio hardware (such as USB-speak-
ers) installed, please select “SM Device Name”, where “Device 
Name” is the name of your audio hardware.

Active Channels (ASIO and CoreAudio Only)

This displays the number of audio channels (outputs) the currently selected au-
dio hardware supports. For a regular stereo card, this number will be “2”. If your 
audio card has multiple outputs and an ASIO or CoreAudio driver is selected for 
it, the “Channels” button will be available. By clicking on it, you will be able to se-
lect which channel outputs (stereo pairs) should be active. Active outputs will be 
indicated in the Reason Hardware Interface.

Clock Source (ASIO Only)

If you are using an ASIO driver for your audio hardware, you have the possibility 
of selecting a Clock Source. This is used for determining the source to which 
audio playback should synchronize its sample rate. If you have an audio card and 
a driver that supports it, you can choose to synchronize to external sources.

ASIO Control Panel (ASIO Only)

If you have selected an ASIO driver, this button brings up a control panel win-
dow specifically for that audio hardware. This may contain buffer settings, rout-
ing options, synchronization alternatives etc.

Sample Rate

This lets you specify the playback sample rate. The options available on this 
menu depends on which sample rates are supported by your audio hardware.

Play in Background

When this is activated, Reason will not “release its grip” on the audio hardware 
when another application is active.

• The advantage is that Reason will keep playing while you work in the other 
application.

• The disadvantage is that other audio applications may not be able to play 
any audio, depending on the type of driver used.

Output Latency & Buffer Size

The Output latency is the delay between when audio is “sent” from the program 
and when you actually hear it. The latency in an audio system depends on the 
audio hardware, its drivers and their settings.

If the latency is large, you will notice that the sound is delayed when you play a 
device from a MIDI keyboard. You may also notice that reactions are delayed 
when adjusting controls on the device panels (for example, if you lower the vol-
ume of a device, you will not hear this immediately but after the latency time). 
Therefore, you want to get as low a latency value as possible.

When you select a driver, its latency value is automatically reported and dis-
played in the Preferences-Audio dialog. Depending on the audio hardware and 
the driver, you may be able to adjust this value:

D If you are running Reason under Windows using a Direct Sound or 
MME driver, or Mac OS X using a CoreAudio driver, you can adjust 
the latency value by using the Buffer Size slider or the up/down ar-
row buttons. The highest and lowest possible values depend on the 
driver.
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D If you are using an ASIO driver specifically written for the audio 
hardware, you can in most cases make settings for the hardware by 
clicking the Control Panel button. This opens the hardware’s ASIO 
Device Control Panel, which may or may not contain parameters for 
adjusting the latency. Usually this is done by changing the number 
and/or size of the audio buffers - the smaller the audio buffers, the 
lower the latency. Please consult the documentation of your audio 
hardware and its ASIO drivers for details!

D If you are running Reason on a Mac using the Sound Manager 
driver protocol, you cannot change the latency.

OK, so why not just set the latency to the lowest possible value? The problem is 
that selecting too low a latency is likely to result in playback problems (clicks, 
pops, dropouts, etc.). There are several technical reasons for this, the main one 
being that with smaller buffers (lower latency), the average strain on the CPU will 
be higher. This also means that the more CPU-intensive your Reason song (i.e. 
the more devices you use), the higher the minimum latency required for avoiding 
playback difficulties.
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Latency Compensation

This control should normally only be adjusted when synchronizing Reason to ex-
ternal MIDI Clock.

Because of the latency problem, you might need to adjust Reason’s playback in 
relation to the MIDI Clock sync master, so that they are in perfect time. The 
tempo will not differ between the two, but Reason might play ahead or behind 
the other application. You might need to adjust this. However, this is something 
you only need to do once. The setting is stored with your other preferences, so 
you don’t need to adjust it again.

Proceed as follows:

1. Set up the other application so that it generates a solid click, on for 
example quarter or eighth notes, preferably with a special sound on 
the downbeat. This click can either come from an internal metro-
nome or from a MIDI source. If you use a MIDI source, make sure 
you pick one that has solid MIDI timing.

2. Set up Reason so that it plays a similar rhythm as the other applica-
tion. You might for example use the Redrum drum computer for 
this.

3. Start the two applications in sync.

4. Make sure you hear both applications at approximately equal level.

5. Open the Preferences dialog in Reason and select the Audio page.

6. Trim the “Latency compensation” setting until the “clicks” from the 
both sources sound at exactly the same time.

7. Close the Preferences dialog in Reason.

Preferences – MIDI

Sequencer Input & Channel

The Sequencer is the “standard” port for receiving MIDI input. This is what you 
should be using if you intend to use the Reason sequencer.

Once you have selected your MIDI interface on the Sequencer Port pop-up (and 
which channel it should receive on), you can direct incoming MIDI to any device 
by just clicking the “In” column to the left of a track name in the track list.

Preferences – Advanced MIDI

External Control Bus Inputs

The External Bus inputs provide up to 64 MIDI input channels divided into four 
buses, each with 16 channels.

D These MIDI inputs are primarily for controlling Reason Devices from 
an external sequencer.

This could be an external hardware sequencer or sequencer software that is in-
stalled on the same computer as Reason. You should preferably use a multiple 
port MIDI interface, so you can select separate ports for Reason and the other 
MIDI devices to use, although this isn’t strictly required. See the chapter “Rout-
ing MIDI to Reason” in the electronic documentation.

Remote Control Input

The Remote Control input is used for assigning a MIDI port for receiving MIDI 
Controller messages. How to use Remote Control is described in the electronic 
documentation in the chapter “MIDI and Keyboard Remote Control”.

MIDI Clock Input

Using MIDI Clock, you can slave (synchronize) Reason to hardware devices 
(tape recorders, drum machines, stand alone sequencers, workstations etc.) 
and other computer programs running on the same or another computer. MIDI 
Clock is a very fast “metronome” that can be transmitted in a MIDI Cable. As 
part of the MIDI Clock concept there are also instructions for Start, Stop and lo-
cating to sixteenth note positions.

D By first selecting the appropriate MIDI input using the MIDI Clock 
pop-up and then selecting “MIDI Clock Sync” on the Options menu, 
Reason is made ready to receive MIDI Clock sync. 
See the “Synchronization” chapter for more information.

Disable MIDI Priority Boost (Windows & Mac OS 9 only)

Reason normally tries to trim your computer system so that MIDI Input gets a 
higher priority than it normally does. This is to ensure best possible performance 
when for example recording notes via MIDI.

However, we can not guarantee that this attempt to boost MIDI priority will work 
on all systems and with all MIDI Interfaces. If you run into problems with your 
MIDI, try activating this switch.
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Preferences – Sound Locations

Sound and Patch Search Paths

Reason songs and patches can contain references to other files on your hard 
disk, such as samples. To keep track of all files, Reason makes use of a “data-
base”. If you keep your Reason files within the database, Reason can update file 
paths, automatically search for missing files, etc.

This database consists of up to four different folders on disk (and all their sub-
folders). You specify which folders to use as database in the following way:

1. Click the “1” folder button below the heading “Sound and Patch 
Search Paths”.
A file dialog appears.

2. Navigate to the desired folder and select it.
You can select a folder on any drive (including mapped network drives under 
Windows).

3. Click OK.
The folder is added as the first search path in the database.

4. If you like, specify search path 2 to 4 in the same way.
It is normally enough to specify a single path, since all underlying folders are 
automatically included in the database. Use the additional paths if you use 
more than one hard drive, CD-ROM drives etc.

When you add sound files or save Reason files, you should place them within 
the database (under one of the specified search path folders).
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Create Menu
Sequencer Track
Tracks are automatically created when you create instrument devices in the rack. 
Still, you may need to create additional tracks (e.g. for recording effect device 
automation):

D To create a new sequencer track, pull down the Create menu and 
select Sequencer Track.
The new track will appear below the currently selected track in the track list. 
Initially, it will not be connected to any device.

D You can also create a new sequencer track specifically for a device 
by using the Create Sequencer Track for Device item on the device’s 
context menu.
This works the same as when creating a new device, i.e. the new track is 
connected to the device and has the same name.

Device List
To create a new device, select the desired item on the Create menu.

D The new device is added directly below the currently selected de-
vice in the rack.
If no device is selected, the new device is added at the bottom of the rack.

D When you add a new device, Reason attempts to route it in a logical 
way.

D A new track will automatically be created in the sequencer, and 
routed to the new device.
The track will have the same name as the device. MIDI input will also auto-
matically be set to the new track, allowing you to immediately play the cre-
ated device via MIDI. 

! By default, this only applies to instrument devices, not to mixers or 
effect devices. If you hold down [Option] (Mac) or [Alt] (Windows) 
when you create the device, the opposite is true, i.e. mixers and ef-
fect devices get new tracks but instrument devices don’t.

Options Menu
Internal Sync/MIDI Clock Sync/ReWire Sync
These three options are used to specify which type of tempo synchronization 
you prefer:

Internal Sync

When this is activated, the program is not synchronized to any external source. It 
plays in the tempo set on the transport panel.

MIDI Clock Sync

When this is activated, the program is synchronized to external MIDI Clock, as 
set up in the Preferences dialog. The tempo setting on the Transport is of no rel-
evance, Reason plays in the tempo of the incoming MIDI Clock signals.

ReWire Sync

When this is activated, Reason is synchronized to another application via Re-
Wire. This is not a setting that you can activate yourself, it is automatically en-
abled when the program is in ReWire slave mode.

Enable Keyboard Remote
When this is activated, keyboard keys can be used to control devices, as set up 
with the Edit Keyboard Remote feature.
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Edit Keyboard Remote
D To get an overview of which parameters are remote controllable se-

lect “Edit Keyboard Remote” from the Options menu. 
When done, each device you select will show a yellow arrow symbol beside 
every parameter that can be assigned a keyboard remote.

D If you click on an assignable parameter, a dialog appears allowing 
you to select a key command for that parameter.
You may use any key or a combination of [Shift] + any key.

D Simply press the key (or key combination) you wish to use to re-
mote control the parameter.
The “Key Received” field momentarily indicates that it is “learning” the key-
stroke(s), and then the dialog displays the name of the key you have 
pressed. If [Shift] was used, the box beside the word Shift in the dialog is 
ticked. 

! Note that the transport panel uses the numeric keypad for various 
commands. If you assign a parameter to a single numeric key, the 
corresponding transport functionality will be overridden!

About the two Edit Keyboard Remote Modes

If Edit Keyboard Remote is enabled (ticked) on the Options menu, assigned pa-
rameters are “tagged”, showing the remote key for that parameter. In this mode, 
however, you cannot operate Reason normally, as every parameter you click on 
will open the Key Remote dialog. This mode is primarily for overview of available 
parameters and the current assignments.

D Another way to assign keyboard remote commands is to have “Edit 
Keyboard Remote” deselected on the Options menu, and to simply 
[Ctrl]-click (Mac) / right-click (Windows) the parameter you wish to 
remote control.
This opens a pop-up menu, where one of the options will be “Edit Keyboard 
Remote”. Selecting this opens the Key Remote dialog. Thus, you do not 
have to enable/disable Edit mode from the Options menu if you know that a 
parameter is assignable.

! If you try to assign a Remote Key that is already in use, you will get 
an alert asking if you wish to change the current assignment.

Clear All Keyboard Remote
This menu command removes all keyboard mapping you have set up for the 
song.

Enable MIDI Remote Mapping
When this is activated, MIDI messages can be used to control devices, as set 
up with the Edit MIDI Remote feature.

Edit MIDI Remote Mapping
1. To get an overview of which parameters are MIDI remote controlla-

ble select “Edit MIDI Remote Mapping” from the Options menu. 
When done, each device you select will show a green arrow symbol beside 
every parameter that can be assigned a MIDI remote.

2. If you click on a assignable parameter, a dialog appears allowing 
you to select a MIDI controller (or a Note number) to control that 
parameter.
Note numbers function exactly like Keyboard remote - they can only control 
on/off or min/max values.

3. Make sure that the “Learn from MIDI Input” box is ticked.

4. Simply turn the knob (or slider etc.) that you wish to use to remote 
control the parameter.
The “MIDI Received” field momentarily flickers as you turn the knob, and 
then the dialog shows the controller number and the channel it is transmitted 
on.

5. Click “OK” to exit the dialog.
The selected parameter now has a tag, displaying the controller number, and 
the MIDI channel used.

6. To exit Edit MIDI Remote Mapping mode, deselect it from the Op-
tions menu.
You do not always have to use this method - see below.

About the two Edit MIDI Remote Mapping Modes

If Edit MIDI Remote Mapping is enabled (ticked) on the Options menu, assigned 
parameters are “tagged”, and the arrow indicators show the assignable parame-
ters. In this mode, however, you cannot operate Reason normally, as every pa-
rameter you click on will open the MIDI Remote dialog. The Edit mode is 
primarily for overview of available parameters and the current assignments.

D Another way to assign keyboard remote commands is to have “Edit 
MIDI Remote Mapping” deselected on the Options menu, and to 
simply [Ctrl]-click (Mac) / right-click (Windows) the parameter you 
wish to remote control.
This opens a pop-up menu, where one of the options will be “Edit MIDI Re-
mote Mapping”. Selecting this opens the MIDI Remote dialog. Thus, you do 
not have to select Edit mode from the Options menu if you already know that 
a parameter is free and assignable.

Clear All MIDI Remote Mapping
This menu command removes all MIDI Remote mapping that you have set up for 
the song.



MENU AND DIALOG REFERENCE 277

Toggle Rack Front/Rear
This switches the rack between the front and rear views. A quicker way to do 
this is to press [Tab].

Show Cables
If you have made many connections in Reason, the cables can sometimes ob-
scure the view, making it difficult to read the text printed on the back panels of 
the devices. You can hide/show all cables in the following way:

D Select “Show/Hide cables” on the Options menu to hide all cables.
When cables are hidden, connections are indicated by a colored connector. 
Repeating the above procedure makes the cables appear again.

D When hidden, you can still connect or disconnect cables in the 
same way as when they are shown.

Checking Connections

It is possible to check to which device a jack is connected, which is useful if the 
cables are hidden, or if the connected devices are located far apart in the rack:

D Positioning the pointer over a connector makes a tool tip appear af-
ter a moment, showing the device and the specific connector at the 
other end.

Follow Song
When this is activated, the sequencer Arrange and Edit views will scroll with the 
song pointer, on playback. When this item is deactivated, the view will not scroll 
automatically.

Windows Menu 
(Windows Version)
Stay on top
When this is activated, the Reason window will always stay on top of other pro-
gram’s windows.

Adjust frame to clients
This changes the size of the application window so that it exactly fits the docu-
ment windows.

Detach/Attach Sequencer Window
Selecting this will detach the sequencer pane from the rack, and open it in a 
separate window. When the sequencer is detached, the menu item text changes 
from Detach to Attach. Selecting this will then reattach the sequencer to the 
rack.

Cascade
This moves and resizes the open song documents, so that they are arranged in 
an overlapping pattern.

Tile Horizontally
This moves and resizes the open song documents, in a horizontal pattern.

Tile Vertically
This moves and resizes the open song documents, in a vertical pattern.

Arrange Icons
If you have minimized windows and moved them around in the application win-
dow, this command cleans up their positions on screen.

Window List
This lists all open song documents. Selecting one makes it the active window.
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Windows Menu 
(Mac OS Version)
Detach/Attach Sequencer Window
Selecting this will detach the sequencer pane from the rack, and open it in a 
separate window. When the sequencer is detached, the menu item text changes 
from Detach to Attach. Selecting this will then reattach the sequencer to the 
rack.

Minimize (Mac OS X only)
This minimizes a selected song document.

Window List
This lists all open song documents. Selecting one makes it the active window.

Help/Contacts Menu 
Contents (Windows only)
This menu item opens up the Help system with the Contents tab selected.

Index (Windows only)
This menu item opens up the Help system with the Index tab selected.

Search (Windows only)
This menu item opens up the Help system with the Search tab selected.

Internet Page Menu Options

About the Internet menu alternatives

Regardless of which of the Internet options you select, you will be connected to 
the Internet using your preferred browser. The browser will then take you to the 
page specified in the dialog.

Go to the Propellerhead Homepage
This takes you to the main entrance on the Propellerheads web site.

Download Reason Songs
This takes you to our archives of song files that you can download and use. You 
can also contribute with your own creations!

Download Reason ReFills
This takes you to ReFill archives with the latest offerings in free sounds for Rea-
son!

Reason Tech Info and Support
If you have a problem or a technical question, this is the place to go!

Order Reason Now
This allows you to purchase your own personal copy of this exquisite applica-
tion!
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Register Reason Now
This takes you to the Propellerhead Software registration pages. Once regis-
tered you can download free sounds, chat with other Reason users and upload 
songs for others to hear!

About Reason (Windows only)
This menu item opens up a dialog that informs you about the version of the pro-
gram and the people behind it.
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General Information
Audio Quality
The general audio quality in a computer based synthesizer system depends on 
two things:

D The quality of the software calculating the audio.

In our case, this is the Reason DSP (Digital Signal Processing) code.

• Reason uses 32-bit floating point arithmetic for all internal audio operations 
which ensures the highest possible resolution throughout the signal chain.

• The program supports 16, 20, and 24 bit audio output.
• The program supports sampling frequencies from 22kHz to 96kHz.
• A number of digital audio techniques are implemented that reduce the risk of 

“aliasing”, background noise, unwanted distortion and “zipper noise”.

There is no technical reason why this program should not sound as good as or 
better than dedicated, professional hardware.

D The quality of the hardware playing back the sound.

In a PC this is the sound card. In the Mac it is the built in audio circuitry or any 
audio card you have installed. Don’t be fooled by the “16 bit, 44.1kHz, CD qual-
ity” tags. How good some audio hardware actually sounds depends on a num-
ber of things, its frequency range and frequency response curve, the signal to 
noise ratio, the distortion under various circumstances, etc. Furthermore, some 
designs are more prone to disturbance from the other electronics in the com-
puter than others. Such disturbance might add hum or high pitched noise to the 
signal.

As you probably understand by now, this is a big subject and there’s no way we 
can help you find the right solution in this manual. There are a number of text 
books and magazines covering this subject and any music dealer specializing in 
computers will happily help you out. The only advice we can give is that if you are 
serious about sound, choose your audio hardware carefully! 

About Latency
On any personal computer system, there is a delay between the moment you 
“ask” the hardware to play a sound and when it actually does it. This delay is re-
ferred to as the “latency” of the design. This imposes a problem for any system 
where you want real time user input to affect the sound.

! See the Optimizing chapter for basic information on adjusting Out-
put Latency!

Why is there latency?

Any audio application creates its audio in chunks. These chunks are then 
passed on to the audio card where they are temporarily stored before being con-
verted into regular audio signals.

The storage place for these chunks are called “buffers” (an analogy would be a 
bucket brigade, where a number of people each have a bucket, and water is 
poured from one bucket to another to reach its final destination).

The smaller the buffers and the fewer they are, the more responsive the system 
will be (lower latency) However, this will also raise the demands on the com-
puter and its software. If the system can’t cope up with moving the data to and 
from the buffers fast enough, there will be problems that manifest themselves as 
glitches in audio playback.

To make things worse, audio playback always competes with other activities on 
your computer. For example, under Windows, an Output Latency setting that 
works perfect under normal circumstances might be far too low when you try to 
open files during playback, switch over to another program while Reason is play-
ing or simply play back a very demanding song.

What is acceptable?

Normally, hardware synthesizers provide you with a latency of 3 to 7 ms (milli-
seconds – thousands of a second), at least if the instrument is targeted towards 
a “professional” audience.

On a regular PC or Mac, the latency can vary from anything from 2ms to 750ms! 
This wide range of values is an effect of the fact that computers and their oper-
ating systems were created for many purposes, not just playing back audio. For 
multimedia and games, a latency of a 100ms or more is perfectly acceptable, 
but for playing a musical instrument it is not!

• The internal audio under Mac OS 9.x provides an output latency of 11ms. 
This is deemed acceptable by most users.

• A regular PC “SoundBlaster” type audio card with an MME driver (see later 
in this chapter) might at best give you a latency of around 160ms.

• The same card with a DirectX driver provides at best around 40ms.
• A card specifically designed for low latency, with an ASIO driver, can give 

you figures as low as 3 ms under both Mac OS and Windows. This is just as 
good as any dedicated hardware synthesizer!

• The best possible situation is achieved using a fairly powerful MacIntosh 
computer, running Mac OS X and using a CoreAudio driver. Such a setup 
can give as low a latency figure as 1 ms! This is better than most dedicated 
hardware synthesizers.
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Reason’s built in sequencer is not affected by latency!

When Reason’s sequencer is playing back a song, the timing between notes is 
perfect! Once playback of a Reason pattern or song is up and running, latency 
isn’t a consideration at all. The computer clocks the audio between the steps 
and does this with perfect quartz accuracy! The timing is immaculate!

ReWire and Latency

When you run Reason as a ReWire slave, it is the other program, the Rewire 
master that is responsible for actually creating the audio and playing it back via 
the audio card. This means that it is the master program’s latency you will get as 
a final result.

! When Reason runs as a ReWire slave, what audio card you have, 
what driver you use, and settings you have made in the Preferences 
dialog are of no importance at all! All audio card settings are then 
instead done in the ReWire master application!

For information on ReWire, see “Using Reason as a ReWire Slave”.

Reducing latency

✪ Please note that internal audio under Mac OS 9 has a fixed latency 
of 11ms which is very stable under all normal circumstances. The 
tips below are for Windows users and for Mac OS 9 users with addi-
tional audio cards.

There are a few general methods for making sure latency is as low as possible:

D Use a card with an ASIO driver.
While this in itself is no guarantee for low latency, ASIO drivers generally 
perform better than MME or DirectX.

D Select an audio card that supports low latency (small buffers) and 
which is known for well written ASIO drivers.

D Remove background tasks on your computer.
This might be any background utility you have installed as well as network-
ing, background internet activities etc.

D Optimize your songs.
You might run into situations where you have to raise the Output Latency 
setting to be able to play back a very demanding song on your computer. 
Another option would be to actually optimize the song. See “Optimizing Per-
formance” for details.

D Get a faster computer.
This is related to the point above and only required if you find that you need 
to increase Output Latency because your computer can’t really cope with 
the songs you try to play.

PC Specific Information
About ASIO DirectX, MME and the Sound Buffer 
setting
There are three ways for Windows to access an audio card:

Via an MME (MultiMedia Extensions) driver

This system has been around since Windows 3.0, and it is this type of driver that 
is normally installed in the Control Panel and via Plug’n’Play. Most regular sound 
playback (like when Windows goes “bing” on startup) happens via MME.

• Practically all cards come with an MME driver. If your card appears in the 
System part of the Control Panel, you have an MME driver installed.

• Using a card via an MME driver gives you the worst latency figures, espe-
cially under Windows 98.

• Only one program at a time can use a card accessed via MME.

Via a DirectX driver

DirectX is a later system developed by Microsoft to provide developers with 
more efficient routines to access audio.

• Not all cards come with DirectX drivers. However, drivers for some cards are 
included with DirectX itself.

• Using a card via a DirectX driver gives you a shorter latency, between 40 
and 90 milliseconds.

• If you use DirectX 3 or later, all programs that access the card via DirectX 
and make use of the DirectX “secondary buffer” feature can use it at the 
same time, and Reason can play in the background.

! Only use DirectX if you are sure that there is a “certified” DirectX 
driver installed for your sound card.

• If in doubt, contact your audio card vendor to check whether there’s a Di-
rectX driver for your card or not.

✪ More information about DirectX can be found on Microsoft’s Di-
rectX web pages, at www.microsoft.com/directx.

Via an ASIO Driver

This is your best option if it is available. More and more audio cards designed for 
serious music and audio use come with ASIO drivers.

As stated above, ASIO does not guarantee low latency, but it allows for it if the 
audio card designers take advantage of its possibilities.
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• Not all cards come with ASIO drivers. If in doubt check with the audio card 
manufacturer.

• Using a card via an ASIO driver can give latency figures as low as 3ms.
• When you use ASIO, only one program at a time can access the card.

✪ More information about ASIO can be found on Steinberg Media 
Technologies’ web pages, www.steinberg.net.

Intel vs. Other Processors
When you run Reason under Windows, the clock speed of the processor is a 
major factor determining how many devices you can use at the same time. How-
ever, there are other factors that should be taken into account, and one impor-
tant such factor is “floating point arithmetic performance”.

All audio operations in Reason are done with floating point calculations (count-
ing with decimal numbers rather than with non-decimal numbers, integers) to en-
sure the highest possible audio quality. You can get high audio quality on an 
integer system too, but floating point is effective and accurate when it is avail-
able.

Intel Pentium processors are fast at floating point mathematics. Some other 
lower priced processor have taken shortcuts which reduce their performance in 
this particular aspect. This will have noticeable effect on the performance of the 
program. Our advice is:

✪ If you plan to buy a computer specifically for Reason, you can play it 
safe and choose an Intel processor. Alternatively, make sure you 
select a processor that is renowned for high floating point arith-
metic performance!

Macintosh Specific 
Information
Mac OS X
Under Mac OS X, all communication with most audio hardware can be handled 
by the internal CoreAudio framework.

D You should normally use one of the driver options that start with 
the word “CoreAudio”.
Select the option that corresponds to the hardware you want to use (the 
built-in audio connectors or some additional audio hardware that you have 
installed).

D Other options may be available as well, mainly for compatibility 
with all possible hardware/software configurations.
You should only use these when required.

Mac OS 9
Under Mac OS 9 there are two ways you can play back audio:

• Using the Sound Manager
• Using ASIO

What the Sound Manager does/is

The Sound Manager is a set of software routines in the Mac OS. These routines 
take care of everything related to sound. If you are using the internal audio on 
your Macintosh computer you are using the Sound Manager, it is built into the 
system. 

One specific character of the Sound Manager is its ability to mix audio from sev-
eral applications. This means that even when you run Reason, you can run other 
Sound Manager compatible applications at the same time, and they will all 
sound.

Mac Audio Cards that play back via the Sound Manager

There are a rare few Mac audio cards that play back via the Sound Manager.

! If you have an audio card for your Macintosh, we strongly recom-
mend you to try and find an ASIO driver for it instead of using a 
Sound Manager driver. This will give you higher reliability and per-
formance.
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Mac Audio Cards with an ASIO Driver

An audio card with an ASIO driver is your best option if it is available. ASIO does 
not guarantee low latency, but it allows for it if the audio card designers take ad-
vantage of its possibilities.

• Using a card via an ASIO driver can give latency figures as low as 3ms.
• When you use ASIO, only one program at a time can access the card.
• Note that to use ASIO you need to add an ASIO driver file to the ASIO Driv-

ers folder in your Reason folder.
If several program take advantage of ASIO this means you will have to dupli-
cate this driver to each program’s ASIO Driver folder.

✪ More information about ASIO can be found on Steinberg Media 
Technologies’ web pages, www.steinberg.net.
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About This Chapter

 

This chapter briefly describes the way various MIDI messages are implemented 
in Reason. It is mainly intended for those who control the rack directly via MIDI, 
but direct MIDI input can also be put to good use when recording into the se-
quencer.

The basics on how to send MIDI to Reason is described on page 43 and page 
45. This chapter only deals with the details on various MIDI messages.

 

MIDI Direct Control vs. MIDI Remote

 

Please do not confuse direct MIDI control of devices with MIDI Remote.

• Direct MIDI Control uses a fixed set of MIDI messages for each device 
whereas MIDI Remote requires you to define which MIDI message to use for 
a certain control.

• MIDI Remote can not be recorded into the sequencer. If you send MIDI Con-
troller messages via the sequencer input, they get recorded along with all 
other MIDI data, just as if you moved the controller with the mouse.

 

ReWire vs. Regular MIDI

 

You can use ReWire 2 to send MIDI messages to Reason. This uses exactly the 
same MIDI implementation as regular MIDI. 

 

The MIDI Implementation Charts

 

In your program folder you will find a document called MIDI Implementation 
Charts.pdf. This contains tables of how all MIDI messages are implemented in 
various devices. Below follows a summary of various MIDI messages and their 
use.

 

How various MIDI 
messages are 
Implemented

 

Notes

 

The machines that receive MIDI notes are:

• Mixer 14:2 (for muting, soloing and activating EQ).
• Subtractor
• NN-19 
• Redrum
• Dr. Rex
• NN-XT
• Malström
• RV7000
• BV512
• ECF-42

The exact ranges and usage can be found in the MIDI Implementation Charts.

 

Controllers

 

Reason makes heavy use of MIDI controllers. Practically all controls on all de-
vices can be controlled via MIDI.

The exact implementation of MIDI controllers for each device can be found in the 
MIDI Implementation Charts.

Modulation wheel, Expression and Breath can on some devices be routed to var-
ious controls by use of the device’s front panel.

 

Pitch Bend

 

This is implemented on all devices where it makes sense to be able to bend 
notes via MIDI. Where pitch bend is implemented, there is a bend range control 
on the front panel.

 

Aftertouch

 

This is implemented on Subtractor, Malström, NN-19 and NN-XT. It can be used 
to modulate various parameters.

 

Program Change and Polyphonic Aftertouch

 

These two MIDI messages are not implemented in any device.



D Index



INDEX290

A
ADSR 109
Alter

Notes 33, 265
Pattern (Matrix) 202
Pattern (Redrum) 93

Arrange View 15
ASIO Control Panel 66
ASIO Driver 283, 285
Attach Sequencer Window 22, 277
Audio Out Clipping 74
Audio Outputs (Hardware Interface) 79
Audio Quality 282
Automap Samples 142, 261
Automap Zones 168, 267
Automatic Quantize 32
Automation

Clearing 28
Editing 26
Pattern Changes 10
Recording 9
Resetting during recording 9
Showing and Hiding 26
Showing in Device Panels 268
Static Controller Value 8

AUX Sends and Returns 85

B
Bipolar Curves 201
Bit Depth 258
Browse Device Patches 259
Browse Samples 260
Buffer Size Slider 66
Built In (Default Song) 268
Bypass 224

C
Cables

Color 37
Deactivating Animation 268
Disconnecting 38
Dragging 38
Hiding and Showing 36

CF-101 Chorus/Flanger 244
Chaining 86
Change Events 32
Channel 8 & 9 Exclusive 96
Chorus 244
Clear All Keyboard Remote 276
Clear All MIDI Remote Mapping 276
Clear Automation 28, 30, 264
Click 74
Clipping 74
Compatible EQ 84
Compressor 246
Controller pop-up menu 27
Controllers see Automation
Convert Pattern Track to Notes 13
Copy 258
Copy Parameters to Selected Zones 266
Copy Pattern to Track 12
Copy Zones 163
CoreAudio Driver 270, 284
CoreMIDI 43
CPU Meter 75
CPU Usage Limit 269
Create Sequencer Track for... 275
Create Velocity Crossfades 267
Curve (Matrix)

About 198
Unipolar/Bipolar 201

Custom (Default Song) 268
Cut 258
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CV
About 36
Merging 249
Routing 39
Splitting 251
vs. Gate 200

CV Trim knobs 39

D
D-11 Distortion 241
DDL-1 Delay 240
Decay/Gate Switch 94
Default Song 268
Delay 240
Delete Unused Samples 140
Detach Sequencer Window 22, 277
DirectX Driver 283
Disable MIDI Priority Boost 273
Disconnect (Routing) 38
Distortion

D-11 241
Scream 4 225

Dr.Rex
About 186
Adding Loops 187
Editing Slices 189
Parameters 190
Playing from Sequencer 188

Drawing
Automation 27
Groups in the sequencer 18
Notes 23

Drum Lane 23
Duplicate Track 16
Dynamics 91

E
E Marker 258
ECF-42 Envelope Filter 241

Edit Automation 26
Edit Keyboard Remote 57
Edit MIDI Remote Mapping 56
Edit View 21
Empty Rack (Default Song) 268
Enable Keyboard Remote 57
Enable MIDI Remote Mapping 55
Enable Pattern Section 13, 92
Envelope Filter 241
Envelopes 109
EQ

Mixer 83
Parametric 247
RV7000 Advanced Reverb 237
Vocoder mode 213

Eraser tool
Controllers 28
Groups in the sequencer 20
Notes 25

Export Device Patch 257
Export MIDI File 34
Export Song/Loop as Audio File 257
Ext Mod (Subtractor) 116
External Control Bus Inputs 42

F
FFT (Vocoder) 210
Filter

Dr.Rex 190
Effect Device 241
Malström 124
NN-19 144
NN-XT 179
Subtractor 105

Find Identical Groups 20
Flam 92
Flanger 244
FM 104
Focus switches 74
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Follow Song 277

G
Gate

About 36
Programming in Matrix 199
Routing 39
vs. CV 200

Gate (Matrix) 198
Gate (RV7000 Advanced Reverb) 237
Gate mode (Redrum) 94
Get User Groove 32
Grooves 32
Group Selected Zones 266
Groups

NN-XT 163
Sequencer 18

H
Hand tool 22
Hardware Interface 78
Help Menu (Windows) 278
Hide All Controllers 27
High Quality Interpolation

Dr Rex 194
NN-XT 155
Redrum 96

High Resolution Samples 137, 161, 269
Host application 48

I
IAC 44
Import MIDI File 34
Improved EQ 84
Init patch

NN-19 137
Redrum 90
Subtractor 100

Input meter (Effect devices) 224

Insert Bars Between Locators 17
Internet Options 278

K
Key Lane 22
Key Maps

NN-19 140
NN-XT 161

Key Zones
NN-19 139
NN-XT 152

Keyboard Remote 57
Keys (Matrix) 198

L
Lane buttons 21
Latency 66, 282
Latency Compensation 62
LFO Sync

Dr. Rex 192
NN-19 146
Subtractor 112

Line tool
Controllers 27
Velocity 26

Locators 73
Loops

Creating Sequencer Notes 188
Editing Slices 189
Editing Sound 190
In Drum Samples 95
In Samples 141
Loading 187

Low BW 148, 194

M
Mac OS X audio 270
Magnifying glass tool 21
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Malström
About 120
Filters 124
Graintables 120, 122
Modulators 123
Oscillators 121
Routing 128
Routing external audio to 133
Shaper 127

Master Tune 269
Matrix

About 198
Application Examples 204
Programming 199

Maximize Sequencer 22
Memory Requirements 69
MIDI Clock 60
MIDI Clock Input 42
MIDI Files 34
MIDI In Device 78
MIDI Inputs

About 42
Setting Up 43

MIDI Remote
Clearing 276
Mapping 56
Selecting Input 54

MIDI Sync 74
Mixer

About 82
Chaining 86
Signal Flow 84

MME Driver 283
Mono

Considerations 68
In Effect Devices 224

Mouse Knob Range 268
MultiMedia Extensions Driver 283

Mute
Mixer 83
Redrum 93

N
New 254
NN-19

About 136
Loading Samples 138
Parameters 143

NN-XT
About 152
Group Parameters 174
Groups 163
Loading Samples 153
Main Panel 154
Remote Editor Panel 156
Sample Parameters 173
Synth Parameters 175
Velocity Ranges 169

Notes
Altering 33, 265
Editing 23
Editing Velocity 25, 33, 265
Recording 8
Transposing 33, 265

O
OMS 44
Open 254
Outputs (Hardware Interface) 79
Overdub/Replace 8

P
P button 83
Parametric EQ 247
Paste 258
Paste Zones 163
Patch Cables 38
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Patches
Browsing 259
Exporting 257
Malström 120
Missing Sounds 260
NN-19 137
NN-XT 153
Redrum 89
RV7000 230
Scream 4 225
Subtractor 100

Pattern Changes
Clearing 30
Converting patterns to notes 13
Editing 29
Recording 10

Pattern Controlled Filter 243
Pattern Shuffle 92
Patterns

Matrix 199
Muting 92
Redrum 90
Transferring between songs 259

Pencil tool
Controllers 27
Groups in the sequencer 18
Notes 23

PEQ-2 EQ 247
Phase Controls (Subtractor) 103
Phaser 245
Polyphony

Dr.Rex 194
Malström 130
NN-19 148
NN-XT 174
Subtractor 115

Post-fader Sends 83
Preferences Dialog 268
Preview (Dr.Rex) 187

Publish Song 255
Punched In 9

Q
Quantize 31
Quantize Notes during Recording 32

R
RAM 69
Randomize

Pattern (Matrix) 202
Pattern (Redrum) 93

RCY files 186
Reason Hardware Interface 78
Reason Song Archive 255
ReBirth Input Machine 208
Recording

Controllers see Automation
Notes 8
Pattern Changes 10

ReCycle 186
Redo 258
Redrum

Individual Outputs 97
MIDI Notes for 97
Parameters 93
Patches 89
Programming Patterns 90

Registering Reason 279
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